EOSDIS Core System Project

ECS Project Training Material
Volume 6: Production Planning and Processing

March 2001

Raytheon Company
Upper Marlboro, Maryland
Preface

This document is a contract deliverable with an approval code of 3. As such, it does not require formal Government approval. This document is delivered for information only, but is subject to approval as meeting contractual requirements.

Any questions should be addressed to:

Data Management Office
The ECS Project Office
Raytheon Systems Company
1616 McCormick Dr.
Upper Marlboro, MD 20774-5301

Note: This document contains change bars to indicate the addition or revision of material since the issuance of the predecessor document containing training material for Release 5B of the Earth Observing System Data and Information System (EOSDIS) Core System (ECS).
This page intentionally left blank.
Abstract

This is Volume 6 of a series of lessons containing the training material for Release 6A of the Earth Observing System Data and Information System (EOSDIS) Core System (ECS). This lesson provides a detailed description of the process required for creating, modifying, and implementing production requests and production plans and monitoring the processing of data processing requests.

Keywords: training, instructional design, course objective, production request, production plan, data processing request, production, planning, processing Release 6A.
# Change Information Page

## List of Effective Pages

<table>
<thead>
<tr>
<th>Page Number</th>
<th>Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Original</td>
</tr>
<tr>
<td>iii through xviii</td>
<td>Original</td>
</tr>
<tr>
<td>1 through 456</td>
<td>Original</td>
</tr>
<tr>
<td>Slide Presentation 1 through 419</td>
<td>Original</td>
</tr>
</tbody>
</table>

## Document History

<table>
<thead>
<tr>
<th>Document Number</th>
<th>Status/Issue</th>
<th>Publication Date</th>
<th>CCR Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>625-CD-606-001</td>
<td>Original</td>
<td>March 2001</td>
<td></td>
</tr>
</tbody>
</table>
This page intentionally left blank.
Contents

Preface

Abstract

Introduction
Identification ......................................................................................................................................................... 1
Scope ...................................................................................................................................................................... 1
Purpose ................................................................................................................................................................. 1
Status and Schedule ........................................................................................................................................... 1
Organization .......................................................................................................................................................... 1

Related Documentation
Parent Document .................................................................................................................................................. 3
Applicable Documents ......................................................................................................................................... 3
Information Documents ....................................................................................................................................... 3
Information Documents Referenced .................................................................................................................. 3
Information Documents Not Referenced .......................................................................................................... 4

Production Planning and Processing Overview
Lesson Overview ..................................................................................................................................................... 7
Lesson Objectives ................................................................................................................................................. 7
Importance ............................................................................................................................................................ 15
Production Planning and Processing

ECS Context .............................................................................................................................. 17
Planning Subsystem .................................................................................................................. 20
Data Processing Subsystem ..................................................................................................... 26
System Changes for Release 6A ................................................................................................. 30

Production Requests

Science Software and Production Requests ................................................................................ 33
Types of Processing ................................................................................................................... 34
  SCF Processing Requests ................................................................................................ 35
Production Rules ....................................................................................................................... 36
  Syntax of Production Rules ............................................................................................... 38
  Basic Temporal Production Rule ...................................................................................... 41
  Advanced Temporal Production Rule ................................................................................ 51
  Alternate Input and Optional Input Production Rules ...................................................... 54
  Minimum/Maximum Number of Granules Production Rule ............................................... 61
  Optional DPRs Production Rule ........................................................................................ 66
  Metadata Checks and Metadata Query Production Rules ............................................... 69
  Spatial Query Production Rule .......................................................................................... 78
  Closest Granule Production Rule ...................................................................................... 83
  Orbital Processing Production Rule ................................................................................... 87
Production Planning Considerations ....................................................................................... 92
  Chain Heads ...................................................................................................................... 93
  Intermittent Activation ...................................................................................................... 95
  Data Preprocessing (DPREP) ............................................................................................ 96
  ASTER Expedited Data Processing .................................................................................. 101
  ASTER On-Demand Processing ......................................................................................... 103
  Reprocessing .................................................................................................................... 106
  Regeneration ..................................................................................................................... 108
Launching the Production Request Editor

Launching the Production Request Editor ................................................................. 111

Creating/Updating/Deleting a Production Request

Creating a New Production Request ........................................................................ 115
Editing or Modifying a Production Request .............................................................. 130
Deleting a Production Request ................................................................................ 136

Reviewing/Deleting Data Processing Requests

Data Processing Requests .......................................................................................... 141
Displaying DPR Information ....................................................................................... 141
Deleting a Data Processing Request ......................................................................... 149
Deleting or Aborting an On-Demand Processing Request ....................................... 151

Launching Planning Workbench-Related GUIs

Launching the Production Strategies GUI ................................................................. 153
Launching Planning Workbench-Related GUIs ......................................................... 154

Creating a New Production Plan

Production Plan .......................................................................................................... 161
Production Strategy ..................................................................................................... 163
  Defining a Production Strategy ............................................................................... 164
  Reviewing the Current Active Strategy .................................................................. 170
  Deleting a Production Strategy ............................................................................... 172
Production Plans ......................................................................................................... 174
  Creating a New Production Plan ........................................................................... 174
  Reactivation/Replanning ......................................................................................... 180
  Deleting a Production Plan ..................................................................................... 183
Reviewing a Plan Timeline ..................................................................................................................183

Reseting/Cleaning the PDPS Database

Resetting/Cleaning the PDPS Database .............................................................................................191
Cleaning the PDPS Database .............................................................................................................194
Cleaning DPS Disks .............................................................................................................................196

Troubleshooting Production Planning Problems

Trouble Symptoms ...............................................................................................................................207
Handling a Failure to Generate DPRs ...............................................................................................216
  Checking the Production Request Editor ALOG File .................................................................217
  Using ISQL to Check Database Tables .........................................................................................220
  Checking the PDPS Database for Causes of Failure to Generate DPRs ...................................221
  DPR Explosion Fails Because Production Request Editor does Not Query DSS for Data ..........225
  Checking the Production Request Editor Debug File for Evidence of Metadata Queries .........226
Responding to PR or DPR Deletion that Hangs ..................................................................................227
  Checking for Database Deadlocks .............................................................................................227
  Checking for Resource Locks in the PDPS Database .................................................................230
Responding to DPR Deletion that Fails .............................................................................................232
  Handling a DPR Scheduling failure ............................................................................................234
    Responding to a "DPR Validation Failed" Error .........................................................................234
    Responding to an "information (INFO) Production Request {Production Request Id} has
unschedulable DPR {DPR Id}" Error .........................................................................................238
Checking Log Files ............................................................................................................................245
Checking Database Connections ........................................................................................................247

Production Processing

Processing Considerations ..................................................................................................................251
  DPR Chaining ...............................................................................................................................251
  Copy on Demand Feature .............................................................................................................254
  DPR Output Files Immediately Available as Input .........................................................................254
AutoSys/AutoXpert Production Scheduling Tool ................................................................. 254

**Launching the AutoSys GUI Control Panel**

Launching the AutoSys GUI Control Panel ................................................................. 259

**Configuring AutoSys Screens/Displays**

Configuring AutoSys/AutoXpert Runtime Options ...................................................... 263
Selecting Jobs to Be Displayed on AutoSys/AutoXpert GUIs ................................. 269
Setting the Current Job on AutoSys/AutoXpert GUIs ............................................. 272
Configuring Hardware Groups ............................................................................... 274

**Reviewing Hardware Status, DPR Dependency, DPR Production Timeline, Alarms, and Job Activities**

Reviewing Hardware Status ...................................................................................... 279
  Changing the Hardware Status View ..................................................................... 280
Reviewing DPR Dependencies .................................................................................. 282
  Changing the JobScape View Using the Pull-Down Menu ..................................... 285
Reviewing the DPR Production Timeline .................................................................. 288
Reviewing Alarms ...................................................................................................... 290
Specifying Job Selection Criteria ........................................................................... 299
Reviewing Job Activities ......................................................................................... 303

**Modifying Job Status**

Methods for Modifying Job Status .......................................................................... 309
  Guidelines for Reporting Unsuccessful Completion of On-Demand Jobs ............. 313
  Guideline for Putting Jobs “On Ice” or “On Hold” ............................................... 313
  Guidelines for Force-Starting Jobs ....................................................................... 313
Determining the Ownership of an AutoSys Job ....................................................... 314
Sending an Event to a Job ................................................................. 317
  Sending an Event to a Job from an AutoXpert GUI ........................ 317
  Sending an Event to a Job from the Job Activity Console ............ 319
  Sending an Event to a Job from the Send Event GUI .................... 320
  Canceling a Sent Event .................................................................. 325
  Performing Job Management Client Functions ............................. 327

Reviewing Activity and Job Dependency Reports
Reviewing a Job Activity Report .......................................................... 331
Reviewing a Job Dependency Report .................................................... 333

Defining and Running Monitors/Browsers
Defining Monitors/Browsers ............................................................... 337
Running Monitors/Browsers ............................................................... 340

Changing the Database Maintenance Time
Database Maintenance Time ................................................................. 343

Tuning System Parameters
Tuning System Configuration Parameters ........................................... 345
Monitoring the Load on Processing Resources .................................... 347

Troubleshooting Processing Problems
Trouble Symptoms ............................................................................ 349
Processing Problems ......................................................................... 352
Responding to Hanging of the Processing System .............................. 352
  Checking AutoSys Status .............................................................. 352
Responding to Failure of Jobs to Start in AutoSys .............................. 358
  Checking Job Management Server Status ..................................... 358
Checking to Determine Whether the DPR Is Waiting in the AutoSys Queue (Never Got Released) ..........................................................359
Responding to a DPR That Was Released But Failed Due to an AutoSys ID Failure ..........373
Responding to a DPR That Was Released But Failed Due to Invalid DPR ..................376
Responding to a DPR That Was Released But Failed to Be Received by Job Management Server .................................................................381
Single DPS Job Has Failed or Is Hanging ..................................................................................382
   Handling a Box Job that is Hanging in AutoSys ...............................................................382
   Handling a Hanging Allocation Function .................................................................383
   Handling a Failed Allocation Function .................................................................387
   Handling a Hanging Staging Function ...............................................................393
   Handling a Failed Staging Function ...............................................................394
   Handling a Failed Preprocessing Job ...............................................................401
   Handling a Hanging Execution Job ...............................................................405
   Handling a Failed Execution Job ........................................................................405
   Handling a Failed Postprocessing Job ...............................................................417
   Handling a Failed Insertion Function ...............................................................420
   Handling a Failed Deallocate Function ...............................................................425
Handling a Failed On-Demand Processing Request ..........................................................426
   Responding to a DPR that Failed in OdMgr because the PGE ID Could Not Be Found .426
Checking Log Files ...............................................................................................................427

Launching the QA Monitor

Launching the QA Monitor .................................................................................................431

Performing Science Product Quality Assurance

Science Product Quality Assurance .........................................................................................435

Regenerating Granules

Regenerating Granules in Response to Loss of Files from the Archive ..................................439
Practical Exercise

Launching the Production Request Editor ................................................................. 443
Creating a New Production Request ....................................................................... 443
Editing/Modifying a Production Request .............................................................. 444
Deleting a Production Request ............................................................................. 444
Reviewing Data Processing Requests ................................................................. 444
Deleting a Data Processing Request ................................................................... 445
Launching the Production Strategies GUI .......................................................... 445
Launching Planning Workbench-Related GUIs ..................................................... 445
Defining a Production Strategy ........................................................................... 446
Creating a New Production Plan ........................................................................... 446
Reviewing a Plan Timeline .................................................................................... 446
Cleaning the PDPS Database ............................................................................... 447
Troubleshooting Production Planning Problems .................................................. 447
Launching the AutoSys GUI Control Panel ......................................................... 447
Configuring AutoSys Runtime Options ............................................................... 448
Reviewing Hardware Status (Including Changing Hardware Status Views) .......... 448
Reviewing DPR Dependencies ............................................................................. 449
Reviewing the DPR Production Timeline ............................................................ 449
Reviewing Alarms (Including Selecting Alarms to Be Displayed) ......................... 449
Specifying Job Selection Criteria and Reviewing Job Activities ......................... 449
Determining the Ownership of an AutoSys Job .................................................... 450
Modifying Job Status (Including Sending an Event to a Job) Using AutoSys ........ 450
Reviewing Activity Reports and Job Dependency Reports .................................... 451
Defining and Running Monitors/Browsers ............................................................ 451
Reviewing the Database Maintenance Time .......................................................... 451
Troubleshooting Processing Problems .................................................................. 452
Launching the QA Monitor GUI ........................................................................................................452
Updating Quality Assurance (QA) Metadata ................................................................................452
Regenerating Granules in Response to Loss of Files from the Archive ....................................453

Slide Presentation

Slide Presentation Description ........................................................................................................455
This page intentionally left blank.
Introduction

Identification
Training Material Volume 6 is part of Contract Data Requirements List (CDRL) Item 129, whose requirements are specified in Data Item Description (DID) 625/OP3 and is a required deliverable under the Earth Observing System Data and Information System (EOSDIS) Core System (ECS), Contract (NAS5-60000).

Scope
Training Material Volume 6 describes the procedures by which the production team prepares production plans and monitors production processing. This lesson is designed to provide the operations staff with sufficient knowledge and information to satisfy all lesson objectives.

Purpose
The purpose of this Student Guide is to provide a detailed course of instruction that forms the basis for understanding production planning and processing. Lesson objectives are developed and will be used to guide the flow of instruction for this lesson. The lesson objectives will serve as the basis for verifying that all lesson topics are contained within this Student Guide and slide presentation material.

Status and Schedule
This lesson module provides detailed information about training for Release 6A. Subsequent revisions will be submitted as needed.

Organization
This document is organized as follows:

Introduction: The Introduction presents the document identification, scope, purpose, and organization.

Related Documentation: Related Documentation identifies parent, applicable and information documents associated with this document.

Student Guide: The Student Guide identifies the core elements of this lesson. All Lesson Objectives and associated topics are included.

Slide Presentation: Slide Presentation is reserved for all slides used by the instructor during the presentation of this lesson.
This page intentionally left blank.
Related Documentation

Parent Document
The parent document is the document from which this ECS Training Material’s scope and content are derived.

423-41-01 Goddard Space Flight Center, EOSDIS Core System (ECS) Statement of Work

Applicable Documents
The following documents are referenced within this ECS Training Material, or are directly applicable, or contain policies or other directive matters that are binding upon the content of this document:

420-05-03 Goddard Space Flight Center, Earth Observing System (EOS) Performance Assurance Requirements for the EOSDIS Core System (ECS)

423-41-02 Goddard Space Flight Center, Functional and Performance Requirements Specification for the Earth Observing System Data and Information System (EOSDIS) Core System (ECS)

Information Documents

Information Documents Referenced
The following documents are referenced herein and amplify or clarify the information presented in this document. These documents are not binding on the content of the ECS Training Material.

184-TP-001 Terra Spacecraft Ephemeris and Attitude Data Preprocessing

505-41-33 Interface Control Document Between EOSDIS Core System (ECS) and Science Computing Facilities (SCF)


611-CD-600 Mission Operation Procedures for the ECS Project

910-TDA-022 Custom Configuration Parameters for ECS Release 6A

AutoSys User Manual
### Information Documents Not Referenced

The following documents, although not referenced herein and/or not directly applicable, do amplify or clarify the information presented in this document. These documents are not binding on the content of the ECS Training Material.

<table>
<thead>
<tr>
<th>Document Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>305-CD-600</td>
<td>Release 6A Segment/Design Specification for the ECS Project</td>
</tr>
<tr>
<td>311-CD-600</td>
<td>Release 6A Data Management Subsystem Database Design and Database Schema Specifications for the ECS Project</td>
</tr>
<tr>
<td>311-CD-601</td>
<td>Release 6A Ingest Database Design and Database Schema Specifications for the ECS Project</td>
</tr>
<tr>
<td>311-CD-602</td>
<td>Release 6A Interoperability Subsystem (IOS) Database Design and Database Schema Specifications for the ECS Project</td>
</tr>
<tr>
<td>311-CD-603</td>
<td>Release 6A Planning and Data Processing Subsystem Database Design and Schema Specifications for the ECS Project</td>
</tr>
<tr>
<td>311-CD-604</td>
<td>Release 6A Science Data Server Database Design and Schema Specifications for the ECS Project</td>
</tr>
<tr>
<td>311-CD-605</td>
<td>Release 6A Storage Management and Data Distribution Subsystems Database Design and Database Schema Specifications for the ECS Project</td>
</tr>
<tr>
<td>311-CD-606</td>
<td>Release 6A Subscription Server Database Design and Schema Specifications for the ECS Project</td>
</tr>
<tr>
<td>311-CD-607</td>
<td>Release 6A Systems Management Subsystem Database Design and Schema Specifications for the ECS Project</td>
</tr>
<tr>
<td>311-CD-608</td>
<td>Release 6A Registry Database Design and Schema Specifications for the ECS Project</td>
</tr>
<tr>
<td>313-CD-600</td>
<td>Release 6A ECS Internal Interface Control Document for the ECS Project</td>
</tr>
<tr>
<td>334-CD-600</td>
<td>6A Science System Release Plan for the ECS Project</td>
</tr>
<tr>
<td>601-CD-001</td>
<td>Maintenance and Operations Management Plan for the ECS Project</td>
</tr>
<tr>
<td>603-CD-003</td>
<td>ECS Operational Readiness Plan for Release 2.0</td>
</tr>
<tr>
<td>604-CD-001</td>
<td>Operations Concept for the ECS Project: Part 1-- ECS Overview</td>
</tr>
<tr>
<td>605-CD-002</td>
<td>Release B SDPS/CSMS Operations Scenarios for the ECS Project</td>
</tr>
<tr>
<td>607-CD-001</td>
<td>ECS Maintenance and Operations Position Descriptions</td>
</tr>
<tr>
<td>152-TP-001</td>
<td>ACRONYMS for the EOSDIS Core System (ECS) Project</td>
</tr>
<tr>
<td>152-TP-003</td>
<td>Glossary of Terms for the EOSDIS Core System (ECS) Project</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>211-TP-005</td>
<td>Transition Plan 4PX to 4PY, 4PY to 5A, and 5A to 5B for the ECS Project</td>
</tr>
<tr>
<td>220-TP-001</td>
<td>Operations Scenarios - ECS Release B.0 Impacts</td>
</tr>
<tr>
<td>500-1002</td>
<td>Goddard Space Flight Center, Network and Mission Operations Support (NMOS) Certification Program, 1/90</td>
</tr>
</tbody>
</table>
Lesson Overview

This lesson will provide you with the complete process by which the production team prepares production plans and monitors production processing. The processes described in the lesson apply primarily to Production Planners and Production Monitors. The procedures involved in production planning and processing include such tasks as preparing production requests, preparing production plans and monitoring data processing.

Lesson Objectives

**Overall Objective** - The overall objective of the Production Planning and Processing lesson is for Maintenance and Operations (M&O) personnel to develop proficiency in the procedures that apply to production planning and production processing operations for the Earth Observing System (EOS) Data and Information System (EOSDIS) Core System (ECS).

**Condition** - The student will be given oral or written information and requirements for performing production planning and processing activities, access to the planning and production processing systems, a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - The student will perform production planning and processing activities in accordance with the prescribed procedures without error.

**Specific Objective 1** - The student will describe the general functions and processes included in the Planning Subsystem and the Data Processing Subsystem (in the context of ECS operations).

**Condition** - The student will be given written or oral questions concerning the general functions and processes included in the Planning and Data Processing Subsystems.

**Standard** - The student will state without error the general functions and processes included in the Planning and Data Processing Subsystems in accordance with the lesson content.

**Specific Objective 2** - The student will describe the purposes and general functions of production rules in the context of ECS operations.

**Condition** - The student will be given written or oral questions concerning the purposes and general functions of production rules.

**Standard** - The student will state without error the purposes and general functions of production rules in accordance with the lesson content.

**Specific Objective 3** - The student will perform the steps involved in launching the Production Request Editor.
**Condition** - The student will be given a statement of the requirements for launching the Production Request Editor, access to the Planning Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will log in to the appropriate host and start the Production Request Editor graphical user interface (GUI) in the specified mode.

**Specific Objective 4** - The student will perform the steps involved in creating a new production request.

**Condition** - The student will be given a statement of the requirements for creating a new production request, access to the previously launched Production Request Editor GUI in the Planning Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will select the PR Edit tab on the Production Request Editor GUI, prepare a new production request that is consistent with the written or stated requirements, and save the new production request.

**Specific Objective 5** - The student will perform the steps involved in modifying a production request.

**Condition** - The student will be given a statement of the requirements for modifying a production request, access to the previously launched Production Request Editor GUI in the Planning Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will select the PR Edit tab on the Production Request Editor GUI, select the Production Request to be modified, make production request modifications consistent with the written or stated requirements, and save the modified production request.

**Specific Objective 6** - The student will perform the steps involved in deleting a production request.

**Condition** - The student will be given a statement of the requirements for deleting a production request, access to the previously launched Production Request Editor GUI in the Planning Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will select the PR List tab on the Production Request Editor GUI, select the production request to be deleted (from those listed), and delete the production request.
Specific Objective 7 - The student will perform the steps involved in reviewing data processing requests.

Condition - The student will be given a statement of the requirements for reviewing data processing requests, access to the previously launched Production Request Editor GUI in the Planning Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project, and a copy of 611-CD-600-001, Mission Operation Procedures for the ECS Project.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will select the DPR List tab on the Production Request Editor GUI, select a Production Request from the list on the option button, select a DPR from the list displayed, open the DPR, and respond to questions concerning the characteristics of the DPR.

Specific Objective 8 - The student will perform the steps involved in deleting a data processing request.

Condition - The student will be given a statement of the requirements for deleting a data processing request, access to the previously launched Production Request Editor GUI in the planning system (through a workstation or X terminal), a copy of 609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project, and a copy of 611-CD-600-001, Mission Operation Procedures for the ECS Project.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will select the DPR List tab on the Production Request Editor GUI, select the appropriate Production Request from the list on the option button, select the DPR to be deleted from the list displayed, and delete the DPR.

Specific Objective 9 - The student will perform the steps involved in launching the Production Strategies GUI.

Condition - The student will be given a statement of the requirements for launching the Production Strategies GUI, access to the Planning Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project, and a copy of 611-CD-600-001, Mission Operation Procedures for the ECS Project.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will log in to the appropriate host using secure shell and start the Production Strategies GUI in the specified mode.

Specific Objective 10 - The student will perform the steps involved in launching the Planning Workbench-related GUIs.

Condition - The student will be given a statement of the requirements for launching the Planning Workbench-related GUIs, access to the Planning Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project, and a copy of 611-CD-600-001, Mission Operation Procedures for the ECS Project.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will log in to the appropriate host using secure shell and start the
Specific Objective 11 - The student will perform the steps involved in defining a production strategy.

Condition - The student will be given a statement of the requirements for defining a production strategy, access to the previously launched Production Strategies GUI in the Planning Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will select priorities for the values for PR Type, User Type, and PGE Type, enter weights for the various attribute categories; enter a weight in the Production Request Editor field; normalize the weighting; and save the production strategy.

Specific Objective 12 - The student will perform the steps involved in creating a new production plan.

Condition - The student will be given a statement of the requirements for creating a new production plan, access to the previously launched Planning Workbench GUI in the Planning Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will access the Planning Workbench; prepare a new production plan as directed; save the new production plan; activate the plan as directed; and shut down the Planning Master Timeline, Planning Workbench, Message Handler, Resource Model, and System Name Server.

Specific Objective 13 - The student will perform the steps involved in reviewing a production plan timeline.

Condition - The student will be given a statement of the requirements for reviewing a production plan timeline, access to the previously launched Production Planning Master Timeline in the Planning Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will access the specified Planning Master Timeline, review the specified Production Planning Master Timeline, and respond to questions concerning the Production Planning Master Timeline.

Specific Objective 14 - The student will perform the steps involved in cleaning the PDPS database.
**Condition** - The student will be given a statement of the requirements for cleaning the PDPS database, access to the Planning Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will log in to the appropriate host using secure shell, set environmental variables if necessary, and start the EcPlDbClean script using the appropriate arguments.

**Specific Objective 15** - The student will perform the steps involved in troubleshooting production planning problems.

**Condition** - The student will be given a statement of the requirements for troubleshooting production planning problems, access to the Planning, Data Processing, Interoperability, Data Server, and Communications Subsystems (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will review the trouble symptoms, check the status of relevant hosts/servers (as necessary), check log files (as necessary), take action to correct the problem(s), and respond to questions concerning the possible cause(s) of the trouble symptoms.

**Specific Objective 16** - The student will perform the steps involved in launching the AutoSys GUI Control Panel.

**Condition** - The student will be given a statement of the requirements for launching the AutoSys GUI Control Panel, access to the Data Processing Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will log-in to the appropriate host, set the necessary environmental variables, source the appropriate file, and start the GUI for the appropriate instance of AutoSys.

**Specific Objective 17** - The student will perform the steps involved in configuring AutoSys runtime options.

**Condition** - The student will be given a statement of the requirements for configuring AutoSys runtime options, access to the previously launched AutoSys GUI Control Panel in the Data Processing Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will access AutoSys functions as directed, select AutoSys runtime options as directed, and apply specified AutoSys runtime options.

**Specific Objective 18** - The student will perform the steps involved in reviewing hardware status (including changing hardware status views) using AutoSys.
**Condition** - The student will be given a statement of the requirements for reviewing hardware status (including changing hardware status views) using AutoSys, access to the previously launched AutoSys GUI Control Panel in Data Processing Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will access AutoXpert HostScape, review hardware status, and change hardware status views as directed.

**Specific Objective 19** - The student will perform the steps involved in reviewing data processing request (DPR) dependencies.

**Condition** - The student will be given a statement of the requirements for reviewing DPR dependencies, access to the previously launched AutoSys GUI Control Panel in the Data Processing Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will access AutoXpert JobScape and review DPR dependencies.

**Specific Objective 20** - The student will perform the steps involved in reviewing the DPR production timeline.

**Condition** - The student will be given a statement of the requirements for reviewing the DPR production timeline, access to the previously launched AutoSys GUI Control Panel in the Data Processing Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will access AutoXpert TimeScape and review the DPR production timeline.

**Specific Objective 21** - The student will perform the steps involved in reviewing AutoSys alarms (including selecting alarms to be displayed).

**Condition** - The student will be given a statement of the requirements for reviewing AutoSys alarms (including selecting alarms to be displayed), access to the previously launched AutoSys GUI Control Panel in the Data Processing Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will access the AutoSys Alarm Manager, select alarms to be displayed on the Alarm Manager, and review alarms displayed on the Alarm Manager.

**Specific Objective 22** - The student will perform the steps involved in specifying job selection criteria and reviewing job activities using AutoSys.
**Condition** - The student will be given a statement of the requirements for specifying job selection criteria and reviewing job activities using AutoSys, access to the previously launched AutoSys GUI Control Panel in the Data Processing Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will access the AutoSys Job Activity Console, specify job selection criteria, review job activities, and exit from the AutoSys Job Activity Console.

**Specific Objective 23** - The student will perform the steps involved in determining the ownership of an AutoSys job.

**Condition** - The student will be given a statement of the requirements for determining the ownership of an AutoSys job, access to the previously launched AutoSys GUI Control Panel in the Data Processing Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will access the pop-up menu from the relevant job on either the AutoXpert JobScape or TimeScape GUI, access the AutoSys Job Definition GUI from the pop-up menu, review the entry in the Owner field of the Job Definition GUI, and exit from the Job Definition GUI.

**Specific Objective 24** - The student will perform the steps involved in modifying job status (including sending an event to a job) using AutoSys.

**Condition** - The student will be given a statement of the requirements for modifying job status (including sending an event to a job) using AutoSys, access to the previously launched AutoSys GUI Control Panel in the Data Processing Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*.

**Standard** - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will access the AutoSys Job Activity Console (Ops Console), specify job selection criteria for the AutoSys Job Activity Console, select the job with the status to be modified, and send the specified event to the job using either the corresponding button in the Actions region of the Job Activity Console or the Send Event GUI (as applicable).

**Specific Objective 25** - The student will perform the steps involved in reviewing activity reports and job dependency reports.

**Condition** - The student will be given a statement of the requirements for reviewing activity reports and job dependency reports, access to the Data Processing Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, *Release 6A Operations Tools Manual for the ECS Project*, and a copy of 611-CD-600-001, *Mission Operation Procedures for the ECS Project*. 

13 625-CD-606-001
Standard - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will access the command shell, enter the appropriate command for an activity report, review the activity report, enter the appropriate command for a job dependency report, and review the job dependency report.

Specific Objective 26 - The student will perform the steps involved in defining and running monitors/browsers.

Condition - The student will be given a statement of the requirements for defining and running monitors/browsers, access to the previously launched AutoSys GUI Control Panel in the Data Processing Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project, and a copy of 611-CD-600-001, Mission Operation Procedures for the ECS Project.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will access the Monitor/Browser GUI, define monitors/browsers, save the monitors/browsers, and run the monitors/browsers.

Specific Objective 27 - The student will perform the steps involved in reviewing the database maintenance time.

Condition - The student will be given a statement of the requirements for reviewing the database maintenance time, access to the Data Processing Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project, and a copy of 611-CD-600-001, Mission Operation Procedures for the ECS Project.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will access the command shell, access the AutoSys configuration file, and review the database maintenance time.

Specific Objective 28 - The student will perform the steps involved in troubleshooting processing problems.

Condition - The student will be given a statement of the requirements for troubleshooting processing problems, access to the Data Processing Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project, and a copy of 611-CD-600-001, Mission Operation Procedures for the ECS Project.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will review the trouble symptoms, check the status of relevant hosts/servers (as necessary), check log files (as necessary), take action to correct the problem(s), and respond to questions concerning the possible cause(s) of the trouble symptoms.

Specific Objective 29 - The student will perform the steps involved in launching the Quality Assurance (QA) Monitor GUI.

Condition - The student will be given a statement of the requirements for QA Monitor GUI, access to the Data Processing Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project, and a copy of 611-CD-600-001, Mission Operation Procedures for the ECS Project.
Standard - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will log in to the appropriate host and start the QA Monitor GUI in the appropriate mode.

Specific Objective 30 - The student will perform the steps involved in updating quality assurance (QA) metadata of a science product granule.

Condition - The student will be given a statement of the requirements for updating QA metadata, access to the previously launched QA Monitor GUI in the Data Processing Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project, and a copy of 611-CD-600-001, Mission Operation Procedures for the ECS Project.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will set up and query the database using the QA Monitor GUI, select the granule with QA metadata to be updated, set the operational and SCF quality flags to the appropriate values, and verify that the flags have actually been set in the database.

Specific Objective 31 - The student will perform the steps involved in regenerating granules in response to a loss of files from the archive.

Condition - The student will be given a statement of the requirements for regenerating granules in response to a loss of files from the archive, access to the Planning and Data Processing Subsystems (through a workstation or X terminal), a copy of 609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project, and a copy of 611-CD-600-001, Mission Operation Procedures for the ECS Project.

Standard - In accordance with the lesson content, the applicable procedure, and the statement of requirements the student will retrieve the Production History files (PH) for lost granules, create Production Requests for the generation of replacement granules, create and activate a Production Plan that includes the Production Requests for the generation of replacement granules, and prepare (if applicable) a “PDPS Residual Granules List.”

Importance

This lesson applies to students who will be members of the ECS production team (especially Production Planners and Production Monitors). The lesson will provide them with the knowledge and skills needed when performing their assigned tasks. Those tasks include (among other things) preparing production requests, preparing production plans and monitoring DPR processing. The lesson describes why and how the activities are performed. Consequently, the students will become aware of what tasks they will be performing on the job and how to accomplish those tasks.
This page intentionally left blank.
Production Planning and Processing

ECS Context

ECS production planning and processing processes are accomplished at the Distributed Active Archive Centers (DAACs). The people involved in production planning and processing activities are Production Planners and Production Monitors.

- The Production Planner performs planning functions; especially, using the Planning Subsystem (PLS) to create Data Processing Requests and specify which requests are to be processed as part of a particular Production Plan.

- The Production Monitor keeps track of operations in the Data Processing Subsystem, especially the execution of science data processing jobs (creation of data products).

The ECS Context Diagram (Figure 1) shows the relationships among the Planning Subsystem, Data Processing Subsystem, Data Server Subsystem, and the other subsystems within the Science Data Processing component of ECS. It is apparent that the interfaces the Planning and Data Processing Subsystems have with each other and that each has with the Data Server Subsystem (which manages access to the data archive) are critically important. Of course the context diagram shows a generalized (high-level) view of ECS. The Planning Subsystem and Data Processing Subsystem Architecture diagrams (Figures 2 and 3 respectively) focus on the individual subsystems and their relationships with other subsystems.

The Planning Subsystem (Figure 2) provides a mechanism for accomplishing the following general functions:

- Defining DAAC production resources.
- Scheduling production resources for non-production-related activities.
- Defining data processing jobs to be performed at the DAAC.
- Generating efficient plans for scheduling defined data processing jobs.
- Coordinating production with the Data Server Subsystem and Data Processing Subsystem to achieve a highly automated production system.

The Data Processing Subsystem PRONG computer software configuration item (CSCI) shown in Figure 3 is involved in the following general functions:

- Managing the allocation of data processing jobs to the site’s data processing resources.
- Managing, queuing, and executing data processing jobs to produce data products.
- Supporting preliminary processing of ancillary data sets.
Figure 1. ECS Context Diagram
Figure 2. Planning Subsystem (PLANG CSCI) Architecture
Figure 3. Data Processing Subsystem (PRONG CSCI) Architecture

Planning Subsystem

The Planning Subsystem (Figure 2) is the ECS Science Data Processing subsystem that the Production Planner uses when developing production plans. The Production Planner has access to the Planning Subsystem primarily through the Production Request Editor and the Planning Workbench. The Production Request Editor (PRE) is used for creating or modifying production requests (PRs). The Planning Workbench is used for scheduling PRs.

The Planning Subsystem is composed of just one computer software configuration item (CSCI); i.e., PLANG. (The designation “PLANG” is derived from PLANNING.) The subsystem has the following major components as shown in Figure 2:

- Resource Planning Workbench.
  - Resource Editor (EcPlRpRe) - Graphical user interface (GUI) for defining/editing the resources at the site.
  - Resource Scheduler (EcPlRpSi) - GUI for creating/approving/committing resource reservations for non-production-related events and preparing a site resource schedule.
• Resource Reservation Planning Master Timeline GUI (EcPlRptl) - Graphical interface for displaying the resource schedule.

• Production Request Editor (EcPlPREditor).
  
  - GUI for submitting production requests that describe the data products to be produced; uses product generation executive (PGE) descriptions to generate the data processing requests (DPRs) necessary to fulfill the production requests.

• Production Planning Workbench.
  
  - Planning Workbench GUI (EcPlWb) - GUI for preparing and activating a site production schedule.
  
  - Production Strategies GUI (EcPlProdStrat) - GUI for defining production strategies (assign priorities for DPRs based on such characteristics as the type of production request, who is requesting processing, and the type of PGE to be run).
  
  - Planning Master Timeline GUI (EcPlTl) - Graphical interface for displaying production schedules, including resource reservations.

• On-Demand Manager (EcPlOdMgr).
  
  - Also known as the On-Demand Product Request Manager or ODPRM.
  
  - Server that receives on-demand product requests (via the ODFRM web page) from authorized researchers/scientists.
  
  - Generates Production Requests needed to fill on-demand product requests and submits the PRs to the Data Processing Subsystem for processing.

• Subscription Manager (EcPlSubMgr).
  
  - Server that manages receipt of subscription notifications (e.g., availability of input data needed for DPRs).

• Sybase Adaptive Server Enterprise (ASE) Server.
  
  - Commercial off-the-shelf (COTS) software application that handles insertion of data for planning and processing activities into the Planning and Data Processing Subsystems’ (PDPS) shared database.

In addition to the preceding major components the Planning Subsystem includes the following components associated with both the resource planning applications and the production planning workbench:

• Message Handler (EcPlMsh).
  
  - GUI that displays various types of messages including warning messages and information messages.
• System Name Server (EcPISns).
  − Handles interprocess communication.

• Resource Model (EcPIRpRm, EcPIRm).
  − Underlying resource data coordinators for the planning software.

The Message Handler, System Name Server, and Resource Model are associated with both the resource planning workbench and the production planning workbench applications.

Planning/production personnel use the following start-up and shutdown scripts (which are available in the /usr/ecs/MODE/CUSTOM/utilities directory) to either start or shut down many of the preceding applications:

• EcPISomeStart.
  − Launches the System Name Server, Message Handler, and Resource Model needed by the Planning Workbench GUI.
  − Does not launch the Planning Workbench GUI.

• EcPIAllStart.
  − Launches the Planning Workbench and Planning Master Timeline as well as the Message Handler, System Name Server, and Resource Model.

• EcPIPRE_IFStart.
  − Launches the Production Request Editor.

• EcPIProdStratStart.
  − Launches the Production Strategies GUI.

• EcPIRpAllStart.
  − Launches the Message Handler, System Name Server, and Resource Planning Resource Model needed by the Resource Editor and Resource Scheduler GUIs.

• EcPIRpReStart.
  − Launches the Resource Editor after the Message Handler, System Name Server, and Resource Planning Resource Model have been started (using EcPIRpAllStart).

• EcPIRpSiStart.
  − Launches the Resource Scheduler after the Message Handler, System Name Server, and Resource Planning Resource Model have been started (using EcPIRpAllStart).
• EcPlSubsEditStart.
  − Starts the Subscription Editor.

• EcPlTlStart.
  − Launches the Production Planning Master Timeline (assuming that the Message Handler, System Name Server, and Resource Model have been started).

• EcPlWbStart.
  − Launches the Planning Workbench if the Message Handler, System Name Server, and Resource Model have already been started.

• EcDpPrQaMonitorGUIStart.
  − Launches the Quality Assurance (QA) Monitor GUI.

• EcPlSlay.
  − Shuts down a Planning Subsystem executable that must be specified by name and application ID (message-service ID).

• EcPlSlayAll.
  − Shuts down the Planning Master Timeline, Message Handler, System Name Server, and Resource Model (and the Planning Workbench if it has not already been shut down).

• EcPlRpSlayAll.
  − Shuts down the Resource Planning Master Timeline, Message Handler, System Name Server, and Resource Model (and the Resource Scheduler and Resource Editor GUIs if they have not already been shut down).

The following start-up scripts in the /usr/ecs/MODE/CUSTOM/utilities directory are typically called by other applications and are not normally invoked directly by planning/production personnel:

• EcPlMshStart.
  − Starts the Message Handler individually.

• EcPlRmStart.
  − Starts the Resource Model individually.

• EcPlRpRmStart.
  − Starts the Resource Model individually.
• **EcPlSnsStart.**
  - Starts the System Name Server individually.

• **EcPlStart.**
  - Starts the Subscription Manager individually.

In addition to the preceding start-up scripts the following scripts are available in the `/usr/ecs/MODE/CUSTOM/utilities` directory:

• **EcPlCdsPingServers.**
  - Sends requests to a list of servers in an operating mode that is specified when the command is entered.
  - Reports whether each server sent a response to the request.
  - Communication with the servers in the list is critical to production planning and processing activities.

• **EcPlDbClean.**
  - Cleans up some tables in a PDPS database. Cleans up database tables by deleting records that meet specified criteria. [calls a stored procedure]

• **EcPlDbBuild.**
  - Supports installation of the PDPS database. Creates new database schema (builds tables and other database objects for the current release). Drops any previously existing objects, including any data in the tables. (The script automatically invokes additional scripts; such as EcPlDbDrop.) Designed to be run from ECS Assistant. The user must be Database Operator (DBO) with sso_role (Site Security Officer).

• **EcPlDbDrop.**
  - Drops all tables and related objects in the database. Designed to be run from ECS Assistant. Parameters are the same as for EcPlDbBuild. The user must be DBO.
  - EcPlDbDrop is called automatically by EcPlDbBuild. Due to complaints from some sites that obsolete tables were still present in their databases, EcPlDbDrop automatically drops all obsolete tables that still exist.
• EcPlDbDump.
  – Dumps the transaction log, the database, and the master database to a flat file that can be used for database recovery. Designed to be run from ECS Assistant. Creates files in the directory `/usr/ecs/{MODE}/COTS/sybase/sybase_dumps` with filenames `pdps_tran_dmp.<timestamp>`, `pdps_dmp.<timestamp>`, and `master_dmp.<timestamp>` respectively. Parameters are the same as for EcPlDbBuild. The user must be a System Administrator (SA) or at least DBO with OPER role.

• EcPlDbMigrate.
  – Migrates data from one version of the PDPS database to another.

• EcPlDbPatch.
  – Used in upgrading an existing PDPS database schema to the next valid database version level. Patches any modified or new database structures to the database without having to re-install the entire database. Allows for existing data to be maintained. Invoked through ECS Assistant.
  – Changes only those objects that have been modified since the last release, preserving existing data in the tables. Parameters are the same as for EcPlDbBuild. The user must be DBO.

• EcPlRpfFetchBaseline.
  – [not used].

• reset_db.
  – Clears the data in the database tables and loads the values in the specified “saved database” file.

• list_db.
  – Provides a listing of saved databases.

• save_db.
  – Saves the current database.

The following application is available in the `/usr/ecs/MODE/CUSTOM/eosview` directory:

• EOSView.
  – EOSView is an HDF-EOS viewer for visualizing ECS data. EOSView can take any HDF-EOS data file and perform visualization functions; however, it does not provide sophisticated data analysis functions.
Data Processing Subsystem

The Data Processing Subsystem is the ECS Science Data Processing subsystem that the Production Monitor uses when monitoring data processing. The Production Monitor has access to the Data Processing Subsystem primarily through AutoSys/AutoXpert and the Quality Assurance Monitor (QA Monitor). AutoSys is used for monitoring the processing of DPRs. The QA Monitor is used primarily for updating QA metadata flags.

The Data Processing Subsystem is composed of the following three computer software configuration items (CSCIs):

- **PRONG (derived from PROCESSING).**
  - Provides the services required to manage and monitor the Science Data Processing environment, which executes Science Software items (PGEs) and produces data products.

- **Algorithm Integration & Test Tools (AITTL).**
  - Set of tools used for test and integration of new science software, new versions of science software, and user methods into the Science Data Processing operational environment.

- **Science Data Processing (SDP) Toolkit.**
  - Provides a set of software libraries, which are used to integrate Science Software into the ECS environment.

The PRONG CSCI is the focus of this section. PRONG (shown in Figure 3) has the following major components:

- **Job Management (EcDpPrJobMgmt).**
  - Uses the AutoSys COTS product to create and initiate execution of PRONG administrative jobs for managing science processor hardware assets and for PGE execution.
  - Responsible for efficient AutoSys management so the maximum number of jobs possible can be continuously run using the product. (Controls the flow of jobs through AutoSys by only allowing jobs ready to run into the product and by removing jobs as they complete.)
  - Creates and starts execution of Ground Event jobs in AutoSys.

- **Ground Event process (EcDpPrGE).**
  - Initiated by the Job Management server when the server gets a ground event request.
  - The ground event process starts at a specified time and runs a specified duration.
During the time the ground event process runs, it sets a computer resource [central processing unit (CPU), random-access memory (RAM), etc.] off-line and the computer resource is not available for running PGEs.

Job Management Client (EcDpPrJobMgmtClient).

Used by programs that need access to the Job Management Server services to modify jobs in AutoSys (i.e., change the priority of jobs in AutoSys).

- AutoSys/AutoXpert.
  - Event Processor (AutoSys daemon).
    - COTS job scheduling software application used to accomplish the execution of jobs that support PGE execution in an automated fashion.
  - Event Server.
    - Sybase database server for the AutoSys database.
  - AutoSys GUIs.
    - Allow human intervention in the AutoSys job stream.
    - Provide various mechanisms for monitoring and altering the job stream.
  - AutoXpert GUIs.
    - Provide graphical depictions of scheduled jobs, completed jobs, and jobs being processed.
    - Provide graphical depictions of the status of hosts in the Planning Subsystem and Data Processing Subsystem.
    - Allow human intervention in the AutoSys job stream.
    - Provide various mechanisms for monitoring and altering the job stream.

- Execution Management (EcDpPrEM).
  - Initiates PGE execution (via AutoSys).
  - Supports the preparation activities prior to the execution of each PGE and activities subsequent to the execution of each PGE.

- Data Management (EcDpPrDM).
  - Manages the flow of science data to and from science processing resources.
  - Provides additional functions to manage the retention of data on science processing resources to support many PGE executions.
• PGE Execution Manager (EcDpPrRunPGE).
  − Controls and monitors the execution of a PGE, including the creation of a Process Control File (PCF) and the growth of the output products.
  − Provides a buffer between AutoSys and the PGE. It serves as a wrapper to the PGE process, initiates the PGE execution and captures the PGE’s exit status.
  − Monitors the PGE’s computer resources. If the PGE’s computer resources exceed its expected usage an alarm is sent to AutoSys.

• Resource Usage (EcDpPrRusage).
  − Measures the actual resources used by a PGE.
  − Reports unexpected resource usage to AutoSys.

• View Job States (EcDpPrViewJobStates).
  − Allows the Production Monitor to view jobs in the queue to determine the jobs that have completed, the jobs that are executing, and the jobs awaiting execution.

• Data Preprocessing (DPREP).
  − Set of PGEs that use a statistical approach to convert Level 0 (L0) attitude and ephemeris ancillary data for a particular satellite (e.g., Terra, Aqua) into SDP Toolkit native binary format without altering or modifying the scientific content of the data sets.
  − Terra DPREP consists of the following PGEs:
    · AM1Eph or Step 1 (EcDpPrAm1EdosEphAttDPREP_PGE).
    · FddAtt or Step 2 (EcDpPrAm1FddAttitudeDPREP_PGE).
    · RepEph or Step 3 (EcDpPrAm1FddEphemerisDPREP_PGE).
    · EcDpPrDumpAttitudeDPREP.
    · EcDpPrDumpEphemerisDPREP.
  − Aqua DPREP consists of the following PGEs:
    · Aqua Predictive Orbit DPREP (EcDpPrPrm1PredFddEphemerisDPREP).
    · Aqua Definitive Orbit DPREP (EcDpPrPrm1DefFddEphemerisDPREP).
    · Aqua Quick Attitude DPREP (EcDpPrPrm1PredAttitudeDPREP).
    · Aqua Refined Attitude DPREP (EcDpPrPrm1DefAttitudeDPREP).
• Deletion Server (EcDpPrDeletion).
  – Notifies Science Data Server to remove interim granules via the data management process once they are no longer needed.
  – Interim product is removed after the last PGE in the chain has used the interim product and a pre set time has expired after its last use.

• Sybase ASE Server.
  – COTS product that acts as an ASE server for the PDPS database.

Quality Assurance Monitor (EcDpPrQaMonitorGUI).
  – Simple interface that allows DAAC operators to transfer science data from the archives, browse data images, and examine and update science metadata.

Production personnel use the following start-up script (which is available in the /usr/ecs/MODE/CUSTOM/utilities directory):

• EcDpPrAutosysStart.
  – Launches the AutoSys GUI Control Panel.

The following start-up scripts in the /usr/ecs/MODE/CUSTOM/utilities directory are typically called by other applications and are not normally invoked directly by production personnel:

• EcDpPrDeletionStart.
  – Starts the Deletion Server.

• EcDpPrJobMgmtClientStart.
  – Starts the Job Management Client.

• EcDpPrJobMgmtStart.
  – Starts the Job Management Server.

• EcDpPrStart.
  – Starts Data Processing.

• EcDpProcessingAppStart.
  – Starts Data Processing applications.

• EcEcsAppStart.
  – Starts ECS applications.

• EcPIPlanningAppStart.
  – Starts Planning applications.
• EcPIStart.
  − Starts Planning.
• EcPISubMgrStart.
  − Starts the Subscription Manager.

The following start-up script is available in the /usr/ecs/MODE/CUSTOM/utilities directory on the Planning/Management Workstation:

• EcDpPrQaMonitorGUIStart
  − Launches the QA Monitor GUI.

In addition to the preceding start-up scripts the following script is available in the /usr/ecs/MODE/CUSTOM/utilities directory:

• EcDpPrCleanup
  − Cleans up stale end points (automatically invoked by server start-up scripts).
• EcDpPrRmFilesWOGranules.pl
  − Ensures consistency between the file references in various tables in the PDPS database and the files actually staged on the data processing disks (removes files from the disks or references in the database tables as necessary).

**System Changes for Release 6A**

Release 6A involves changes in the following areas:

• Increased data processing load at certain DAACs in support of…
  − Reprocessing of Terra satellite data (in addition to routine processing of Terra data).
    · Essentially doubles the previous Terra processing load.
  − Processing of data from the Aqua satellite.
    · Release 5B supported Aqua Science Software Integration and Test (SSI&T) only.

• Greater volume of data to be ingested.
  − Supports more interfaces and a larger number of Earth Science Data Types (ESDTs).

• Higher volume of data products to be distributed.
ECS hardware configuration upgrades for Release 6A include the following changes:

- Replacement of the Fiber Distributed Data Interface (FDDI) networks with gigabit Ethernet networks at two DAACs [i.e., Goddard Spaceflight Center (GSFC) and Earth Resources Observation Systems Data Center (EDC)].
  
  – The gigabit Ethernet networks are expected to handle the increased throughputs of Terra reprocessing along with routine processing for Aqua.

- Addition of an SGI Origin processor to the Science Processing configuration at GSFC to handle the additional Aqua MODIS processing load.

- Replacement of SGI Challenge archive machines with SGI Origin machines.

- Upgrading of Science Data Server configurations (both the SDSRV and Sybase/SQS hosts) at EDC and GSFC so that the request load is shared between two separate host configurations.

- Additional staging disks in the Release 6A configuration to handle increased Ingest and Data Distribution loads.
This page intentionally left blank.
Science Software and Production Requests

Science software is one of the keys to production planning and processing:

- Performs the actual data processing to create desired products.
- Is developed at Science Computing Facilities (SCFs) external to ECS.
- Is embodied in Product Generation Executives (PGEs) when the software is integrated into the ECS production processing environment.
  - PGEs are science software code (e.g., executable programs or shell scripts) that contain the instructions for processing data to create the desired products.

The Production Request (PR) is another key to production planning and processing. The Production Planner defines ECS science data processing in terms of PRs.

- A PR is an order for data to be produced by the Data Processing Subsystem.
- A single PR may specify several jobs (using the same PGE) that are to be run over a period of time or a single job producing a single set of data.
- PRs may apply to the processing of new data (standard PRs or standing orders) or the reprocessing of existing data (reprocessing PRs).
- Each PR identifies a specific PGE for generating a particular type of product.
  - Some PGEs are dependent on others; i.e., some PGEs require input data that are the output of other PGEs.
  - The planning software will recognize and reject a PR when the PR specifies a PGE that requires data from another PGE that has not yet been specified in a PR.

The Planning Subsystem performs the following functions:

- Uses each PR to generate either one or a series of Data Processing Requests (DPRs).
  - Each DPR corresponds to one execution of a single PGE.
  - Each DPR contains the information that is needed by the SDP processing function, including PGE-related information.
- Checks the availability of the data required for the DPR, either from the Science Data Server (if the data have been previously ingested) or from internal predictions (if the data are expected to arrive in the future).
• Determines what data will be included in the DPR output so the system can make predictions concerning the availability of data for subsequent PGEs.

Figure 4 shows the relationships among the PGEs, PRs, and DPRs as they are accessed through the Production Request Editor GUI.

![Figure 4. Production Request Editor Flow](image)

**Types of Processing**

ECS accommodates the following four general types of data processing:

- Routine Processing.
- Reprocessing.
- Regeneration.
- On-Demand Processing.

Routine processing is pre-defined software production processing that is periodic and keyed to data arrival. For example, every day a Production Planner includes in the daily schedule a DPR for generating a particular Level 1A product from the most recent Level 0 data from the applicable satellite instrument.
Reprocessing typically involves using a new, improved PGE to process data that had previously been processed with an older version of the PGE. The upgraded products are archived in addition to the versions that were previously archived.

Reprocessing is likely to be a large-scale operation, especially if several years worth of data are to be reprocessed. (The reprocessing load for Release 6A is expected to equal that of standard production.) Consequently, the Production Planner schedules reprocessing in manageable quantities so the processing resources can accommodate routine and on-demand processing in addition to the reprocessing.

Regeneration is a type of reprocessing that is performed for the purpose of replacing a missing or damaged product. It is necessary when an existing product has been corrupted or deleted. If the damaged or missing product is needed for shipping or as input for additional processing, it must be recreated. To the extent possible the regenerated file is created using the same input, the same processing parameters, and the same algorithm as the original file.

On-demand processing involves ad-hoc processing initiated by an end-user (as opposed to the Production Planner). For example, a researcher using data from the Advanced Spaceborne Thermal Emission and Reflection Radiometer (ASTER) instrument on the Terra satellite may need a particular Level 2 product. The ASTER researcher would use the EOS Data Gateway (EDG) web client to gain access to the ODFRM Hypertext Markup Language (HTML) interface in the Client Subsystem (CLS), which allows authorized scientists/researchers to create ASTER On-Demand Product Requests. The researcher would submit an on-demand request to have the product generated from a Level 1B product stored in the archive. The On-Demand Manager (EcPlOdMngr, also known as the ODPRM) in PLS would create the appropriate PRs and DPR(s) for processing and order(s) for distribution of the output product(s). The PLS would notify the DPS to initiate processing of the DPR(s) when the necessary input data became available.

Further details concerning the types of processing are provided in subsequent sections of this training lesson.

**SCF Processing Requests**

As specified in the *Interface Control Document Between EOSDIS Core System (ECS) and Science Computing Facilities (SCF)* (505-41-33) SCFs may request the DAACs to process or reprocess data produced using SCF-provided science software. The SCFs' processing/reprocessing request messages can include optional run-time parameters, in case of changes from the original processing parameters.

SCF staff send Processing Requests to the DAAC staff using one of the following three protocols:

- e-mail.
- X11/internet.
- X11/modem.
SCFs must use the e-mail interface unless the DAAC has authorized their use of the Processing Request X11 Interfaces. The specific protocol used in each instance will have been defined in an Operations Agreement (or lower-level type of document) between the SCF and the DAAC.

SCF Processing Requests provide the DAAC operations staff with the following types of information:

- PGE Name.
- PGE Version.
- Optional PGE Profile (number 1-99 defining how the PGE is to be run).
- The time window for which the product should be regenerated.
- Optional run-time parameters for Production Request Editor.
- Optional comment.

DAAC operations personnel acknowledge receipt of an SCF’s Processing Request by replying to the SCF in an e-mail message that includes the SCF’s original request and the following statement:

- "This is an acknowledgment of the receipt of the following Processing Request: . . ."

**Production Rules**

Production rules are the instructions about how a particular PGE is to be run. The instructions specify a wide range of information such as the input and output data types, the frequency of execution, activation conditions and error handling instructions.

A single PGE may use one or more sets of production rules, known as PGE profiles, since it may be desirable to run the same PGE with different input data sets, or activation conditions. The production rules are entered when a PGE undergoes Science Software Integration and Test (SSI&T) at the DAAC. Where applicable, default parameter values are entered at that time. The initially selected runtime parameters, metadata check parameters, and many of the default parameters can be overridden in the production environment when a Production Request is entered.

Production rules define the PGE to the Planning and Data Processing Subsystems (PDPS). The following types of conditions can be specified for each PGE:

- The time period for which the PGE will run.
  - A PGE can run every hour, every day, or for every orbit of a satellite. The frequency of how often a PGE runs must be defined to PDPS so that it knows when to plan and execute the PGE. A definition of a satellite's orbit could be included if the PGE were to be executed for some number of satellite passes.
• **PGE Inputs.**
  
  − A PGE can have any number of inputs. The types of the inputs and how frequently they are available helps determine on what basis the PGE is scheduled.
  
  − Most inputs to a PGE are retrieved based on time; the specified inputs are retrieved from the Data Server Subsystem for the time which the PGE is defined to execute. Production Rules allow other conditions to be added to the mix, such as checks or queries against the metadata of the input granules, or the lists of inputs as alternates (for when a primary input is not available) or optionals (for inputs without which the PGE can still run successfully). If inputs are defined as alternate or optional, the number of inputs staged for the execution of the PGE may vary from one run to the next.

• **PGE Outputs.**

  − A PGE can have any number of outputs. The characteristics of the outputs can have effects on any downstream PGEs that use them as inputs. For example, it is possible for an output to be defined as optional, in which case it may or may not even be produced. (When an output is not generated, it cannot be used as input for a downstream PGE.)

• **Runtime Parameter Values.**

  − A PGE can have any number of runtime parameters, which are values that are placed in the process control file (PCF) under specified logical IDs before the PGE executes. The PGE treats them as constants and normally they are set either during SSI&T or when the Production Request is entered.

  − For some production rules (such as Orbital Processing) there is specific information that can be placed in a runtime parameter if so desired by the PGE.

  − The following two pieces of information can be placed in a runtime parameter if so desired by the PGE:

    - **Data Collection Start and Stop Times.** The times are specified to the PGE via two logical IDs in the Process Control File for the PGE. Logical IDs 10258 and 10259 have the Start Data Collection and Stop Data Collection times for the current DPR run of the PGE. The date/times are only accurate to the second and may not exactly match the times in the data supplied to the PGE because PDPS can match granules that are seconds (or even minutes) from the time set for the DPR.

    - **Year, Month and Day of the Data Collection Start.** The year/month/day information can be placed under any Logical ID that the PGE desires. They are separate entries (each goes under a different logical ID) and can
provide the PGE with the **year**, **month** and the **day** of input data collection.

Some (but not all) production rules can work with other production rules.

Production rules are often used for the selection of dynamic inputs.

- **Dynamic inputs** can be either internal or external.
  - **Dynamic internal** inputs are produced by other PGEs (they are called dynamic internal inputs because they are produced at an ECS DAAC).
  - **Dynamic external** inputs are periodically ingested and stored in the Data Server Subsystem (they are termed dynamic external inputs because they are produced outside of the DAAC).

- **Static inputs** are granules that are inserted during the SSI&T process and are retrieved not on the basis of time but by Earth Science Data Type (ESDT) and science group. Static inputs can be chosen through the following two production rules only:
  - Metadata Query.
  - Spatial Query.

PGE profiles allow a PGE to be defined to PDPS multiple times, each with a different set of inputs, outputs, or even scheduling information. Each PGE's definition is made up of its name, its version and its profile number. Different PGE name/version pairs define different PGEs to PDPS. The addition of the profile allows for multiple definitions of a PGE name/version pair. There can be up to 99 profiles for each PGE.

**Syntax of Production Rules**

Production rules are defined in the following two ways:

- Through science metadata that is entered in various types of files during the SSI&T process.
- By entering parameter values when a Production Request is created to schedule the PGE.

During SSI&T, production rules are defined in files written in Object Description Language (ODL) in a parameter equals value format. There are three general categories of ODL files:

- PGE Science Metadata ODL Files.
- ESDT Science Metadata ODL Files.
- Production Rule-Specific Science Metadata ODL Files.
  - Orbit Definition ODL Files.
  - Path Map Definition ODL Files.
When a Production Request is created to schedule a PGE, it is necessary to enter certain information that is essential to implementing the production rules that affect the particular PGE. The information may concern the date and time-range.

**PGE Science Metadata ODL Files**

The PGE science metadata ODL file defines a PGE (or at least the current plan for its operation) to PDPS. It specifies everything from the PGE name and version, to the period for the PGE (how often it runs), all inputs and outputs, any runtime parameters and any exit messages or dependencies. A template version of the PGE science metadata ODL file is created by the **SSIT Create ODL Template** program from a PCF from the PGE.

**ESDT Science Metadata ODL Files**

The ESDT science metadata ODL file defines a PGE input or output to PDPS. Each input and output of a PGE must have a corresponding ESDT science metadata ODL file defined. It describes everything that PDPS needs to know about the subject input or output file, from its name and version, to its period (how often data is collected), to where it is used and archived. Note that many PGEs can use the same input or output type, and thus can share the same ESDT science metadata ODL file.

Unlike the PGE science metadata ODL file, there is no tool for automatically generating a template ESDT science metadata ODL file. A template version exists under the data directory called ESDT_ODL.template. The template must be copied to a file that follows the naming convention `ESDTShortName#ESDTVersionID.odl`.

**Production Rule-Specific Science Metadata ODL Files**

The production rule-specific science metadata ODL files provide specific information to PDPS about production rules used by a PGE. They are needed only when the PGE is subject to one of the following conditions:

- Is executed on the basis of a satellite orbit.
- Needs to know the orbital path of a satellite.

Since not every PGE is based on orbits, not all PGEs require these files. The comments in the `PGE_ODL.template` describe when setting a specific parameter means that a production rule-specific science metadata ODL file needs to be created.

The production rule-specific science metadata ODL files are broken into two types, which are defined as follows:

- **Orbit ODL File.**
  - Defines the orbital period of the satellite from which the PGE’s input data is created.
  - Defines when a given orbit starts, how long it lasts, and the number of the orbit.
PDPS uses the information in the orbit ODL file to extrapolate future orbits and is able to plan PGEs that are required to run every so many orbits of the satellite.

- **Pathmap ODL File.**
  - Defines the mapping between the cyclic 0-233 orbits that the satellite makes with the actual path number that the PGE requires.
  - PDPS computes the path number from the orbit number (specified in the orbit ODL file) by incrementing it until it reaches the 233 maximum, then resetting it to zero.
  - Many instruments expect the path number to be a fixed swath on the Earth, so it is not just incremented for each satellite pass.
  - The Pathmap ODL file creates a mapping from the sequential path numbers to the path numbers expected by the PGEs.

Unlike the PGE science metadata ODL file, there is no tool to automatically generate a template production rule-specific science metadata ODL file. Because the files themselves tend to be small, this is not usually a problem. A template version of each kind of production rule-specific science metadata ODL file (e.g., ORBIT_ODL.template) exists in the /usr/ecs/<MODE>/CUSTOM/data directory on the AIT Workstation. The templates must be copied, named properly, and edited in order to create the appropriate production rule-specific science metadata ODL file.

### Release 6A Production Rules

The following statements provide some simplified descriptions of the production rules that are available in Release 6A:

- **Basic Temporal** - Temporal (time) range of inputs matches the temporal range of outputs.
- **Advanced Temporal** - Temporal range of inputs is offset from the expected temporal range of inputs and outputs.
- **Alternate Inputs** - PGE is run with different inputs based on the availability of various alternate input data sets.
- **Optional Inputs** - PGE is run with specified optional inputs if available; otherwise, PGE is run without them.
- **Minimum/Maximum Number of Granules** - Minimum number of input granules needed for full data coverage and maximum number of input granules to search for may be specified. Minimum and maximum number of outputs expected from the PGE may be specified.
• **Optional DPRs** – The only DPRs executed are those for which the non-routine key input data actually become available (i.e., are either produced in data processing or can be acquired from the archive).

• **Metadata Checks** - DPR is run only if input data’s metadata value(s) meet(s) certain criteria.

• **Metadata Query** - Input granule selection is based on metadata value.

• **Spatial Query/Spatial Pad** - Input granule selection is based on the spatial coverage of another input (i.e., the key input). Spatial Pad involves adding area to all sides of the key input's spatial shape. All granules that intersect the expanded area are retrieved.

• **Closest Granule** – DPR is generated if a required input granule within a particular time range (rather than an exact time) is available; otherwise, no DPR is generated. (Supersedes the Most Recent Granule Production Rule)

• **Orbital Processing** - Selection of input times is based on orbit information.

**Basic Temporal Production Rule**

The Basic Temporal Production Rule defines the timeframe for the PGE along with its input and output data. PGEs subject to the Basic Temporal Production Rule generally have the following characteristics in common:

• Typically scheduled to run using input data that become available periodically (every hour, every day, etc.).

• Use input data for a particular period of time.

• Produce output for a specified length of time.

The data the PGE takes in (its input) and the data it produces (its output) have the same period (or some subset of the same period) as the PGE.

• Example One:
  - A MODIS PGE processes data for five-minute intervals, producing Level 1B granules.
  - The PGE requires as input the specific five-minute Level 1A granule that is contemporaneous with (covers the same five-minute time period as) the Level 1B granule to be produced.
  - Using the Basic Temporal Production Rule, a five-minute Level 1A granule is staged as input to the PGE and a five-minute Level 1B granule is expected as output, both matching the timeframe for which the PGE is run.
• Example Two:
  − A CERES PGE processes data for 24-hour intervals, producing 24-hour Level 1A granules as output.
  − As input the PGE takes Level 0 data that is ingested every two hours.
  − Using the Basic Temporal Production Rule, twelve two-hour Level 0 granules are staged as input to the PGE and a 24-hour Level 1A granule is expected as output, matching the timeframe for which the PGE is run.

The fundamental elements used to define the Basic Temporal Production Rule are “period: and “boundary.”

• **Period** is the length of time for which a PGE processes data or the length of time for which input and output data is collected.
  − A PGE that is subject to the Basic Temporal Production Rule only and that processes data in two-hour blocks, takes in data that relates to a particular two-hour interval and produces output data for that same two-hour period.
  − Data that has a period of 15 minutes was collected or produced for a 15-minute time period.

• **Boundary** is the starting point for the data or PGE.
  − Depending on the characteristics of the data or PGE, the boundary may be the start of a minute or hour or day or week (etc.).
  − If a PGE’s boundary is the start of the hour, it processes data that starts every hour and runs on data for the length of its period.
  − If data comes in every day, PDPS predicts that the data is going to be available at the start of the day and allows scheduling of PGEs that use the data as input accordingly.

Both the PGE itself and the input data have a boundary and period associated with them. That is how PDPS determines the frequency of processing for a Basic Temporal PGE and the time period for its inputs and outputs.

PDPS uses **period** and **boundary** in combination to plan the processing of each PGE, including determining its input requirements and anticipated output (which may be input to other PGEs). If a PGE has a period of one hour and a boundary of “start of day,” it is scheduled every hour, beginning at midnight. If an input has a period of 15 minutes and boundary of “start of hour,” PDPS predicts it every 15 minutes beginning on the hour.

**Boundary offset** is an addition to the Basic Temporal Production Rule that allows a PGE or data to start on an offset from a given boundary. For example, if a PGE would normally run every day but not start until two or three hours into the day (e.g., beginning at 3:00 a.m. instead of
A boundary offset can be used to add three hours to the “start of day” boundary. This would mean the PGE would run on data that occurred three hours after the boundary.

**Non-routine data** can be used as an input to a Basic Temporal DPR. Such data must exist at the Science Data Server for the time period of the DPR when the DPR is created or it can be retrieved using the **Closest Granule** or **Optional Input** Production Rules. If no other Production Rule is used and the non-routine data is not available at Science Data Server, the DPR fails at creation time. Because there is no Boundary or Period associated with non-routine data, PDPS cannot predict it; consequently, it must be available at Production Request time.

**Running with data that falls within the time of the DPR only** is a special case that is applicable to some PGEs. Normally, PDPS would match any granules that intersect the time of the DPR. However, some PGEs require data that falls within the time of the DPR only. For example:

- A data set is composed of granules with the following time ranges:
  - 01:00-02:00
  - 02:00-03:00
  - 03:00-04:00
- The DPR has the following time range:
  - 01:30-03:30

Usually a PGE would want all three granules in the data set because they all intersect the time of the DPR. But if a PGE wants the data that falls within the DPR time only, the 02:00-03:00 granule would be the only one selected. Restriction of the data to the time of the DPR is accomplished using the **DPR Align Flag** (ALIGN_DPR_TIME_WITH_INPUT_TIME).

The **end-of-month anomaly** is an addition to the Basic Temporal Production Rule that allows a PGE or data to cover a specific number of days within a month. The month is broken into thirds. The first third is composed of the first 10 days of the month. The second third consists of days 11 through 20. And the last third varies in length depending on the total number of days in the month (i.e., for November it would have 10 days; for December it would have 11 days). A specific boundary and period allow a PGE or its data to be scheduled into thirds of a month.

Figure 5 provides an illustration of the Basic Temporal Production Rule. The PGE has a boundary of “start of day” and a period of one hour, so it is scheduled for every hour through the day. If a Production Request were entered for two full days of processing, a DPR would be created for the PGE to run every hour; i.e., 48 DPRs total. If a Production Request were created for a four-hour period in the middle of a single day (for example, from 12:00 noon to 4:00 p.m.), then four DPRs would be created, one for 12:00-1:00, one for 1:00-2:00, one for 2:00-3:00, and one for 3:00-4:00.
In the example (Figure 5), Input One has a boundary of “start of day” and a period of two hours, so when PDPS plans for its availability, it expects a granule every two hours beginning at midnight. Consequently, each granule of Input One is associated with two DPRs for the PGE, because the PGE encompasses only one hour of the two-hour granule's period.

Input Two has a boundary of “start of day” and a period of ½ hour, so when PDPS plans for its availability, it expects a granule every ½ hour beginning at midnight. As a result two granules of Input Two are associated with each DPR for the PGE, because the PGE encompasses an hour of the ½-hour granule's Period. Thus, every DPR of the PGE will wait for two granules of Input Two to arrive before it can be processed.

**PGE Science Metadata ODL File Parameters**

The following parameters must be set properly in the applicable PGE science metadata ODL file in order to implement the Basic Temporal Production Rule:

- SCHEDULE_TYPE.
- PROCESSING_PERIOD.
- PROCESSING_BOUNDARY.
The SCHEDULE_TYPE parameter specifies the type of scheduling that will be done for the PGE. The following values are applicable to the Basic Temporal Production Rule:

- "Time"
  - The PGE is scheduled on the basis of the specified boundary/period and the availability of data for that boundary/period.
- "Snapshot"
  - The PGE is scheduled for a single date/time.
  - Note that PROCESSING_PERIOD and PROCESSING_BOUNDARY are not needed when "Snapshot" is specified.

Other values for SCHEDULE_TYPE apply to other production rules, such as the following values:

- "Data"
  - The PGE is scheduled on the basis of the availability of data produced by other PGEs.
- "Orbit"
  - PGE scheduling is based on the orbit of the spacecraft.

The PROCESSING_PERIOD parameter describes the length of time for which the PGE executes. Data will be acquired (barring any combination of Production Rules) for the specified period and output data will be planned for the given period. It is of the format "<Period Type>=<Length of Period>". Note that "length of period" can be specified as a positive integer only. The following values are acceptable "period type" entries for the Basic Temporal Production Rule:

- "YEARS"
  - PGE processes data applicable to a given year or years.
  - "YEARS" might be specified for a PGE that computes a yearly average.
  - For example, PROCESSING_PERIOD = "YEARS=1" relates to a PGE that processes one year’s worth of data.
- "MONTHS"
  - PGE processes data applicable to a particular month or several months.
  - "MONTHS" is most likely to be used for some kind of averaging PGE.
  - For example, PROCESSING_PERIOD = "MONTHS=2" relates to a PGE that processes two months’ worth of data at a time.
• "THIRDS"
  – PGE processes data applicable to some number of thirds of the month.
  – For example, PROCESSING_PERIOD = "THIRDS=1" relates to a PGE that processes data applicable to 1/3 of the month.

• "WEEKS"
  – PGE processes data applicable to some number of weeks.
  – For example, PROCESSING_PERIOD = "WEEKS=2" relates to a PGE that processes two weeks’ worth of data every time it runs.

• "DAYS"
  – PGE processes data applicable to some number of days.
  – For example, PROCESSING_PERIOD = "DAYS=5" relates to a PGE that processes five days’ worth of data.

• "HOURS"
  – PGE processes data applicable to some number of hours.
  – For example, PROCESSING_PERIOD = "HOURS=4" relates to a PGE that processes four hours’ worth of data when it is executed.

• "MINS"
  – PGE processes data applicable to some number of minutes.
  – For example, PROCESSING_PERIOD = "MINS=5" relates to a PGE that processes five minutes’ worth of data.

• "SECS"
  – PGE processes data applicable to some number of seconds.
  – For example, PROCESSING_PERIOD = "SECS=2" relates to a PGE that runs on two seconds’ worth of data.

There are other types of values for PROCESSING_PERIOD but they apply to other production rules (as described in the applicable sections of the lesson).

The PROCESSING_BOUNDARY parameter specifies the boundary (starting point in time) of the PGE. It tells when each instance of the PGE should start. Note that the PROCESSING_BOUNDARY and PROCESSING_PERIOD are used in conjunction to schedule the PGE.
The following PROCESSING_BOUNDARY values are used for implementing the Basic Temporal Production Rule:

- "START_OF_HOUR" – PGE processes data for each hourly interval.
- "START_OF_6HOUR" - PGE processes data for every 6-hour interval.
- "START_OF_DAY" - PGE processes data for every daily interval.
- "START_OF_WEEK" - PGE processes data for every weekly interval.
- "START_OF_ONE_THIRD_MONTH" - PGE processes data for every 1/3 of a month.
- "START_OF_MONTH" - PGE processes data for every monthly interval.
- "START_OF_YEAR" - PGE processes data for every yearly interval.
- "START_OF_TIME" - PGE runs from the specified date/time in the form "START_OF_TIME=DD/MM/YYYY HH:MM:SS".
  - Can be used in conjunction with all types of PROCESSING_PERIOD.

There are other values for PROCESSING_BOUNDARY that apply to other production rules (as described in the applicable sections of the lesson).

**Retrieving Data that Falls within the DPR Time Only**

When the ALIGN_DPR_TIME_WITH_INPUT_TIME flag is set to "Y" (i.e., ALIGN_DPR_TIME_WITH_INPUT_TIME = “Y”) PDPS uses only the granules for the input that fall within (instead of intersecting) the time of the DPR. If the flag is not set or is set to "N", granules for the input will be chosen on the basis of whether or not they intersect the time of the DPR.

**ESDT Science Metadata ODL File Parameters**

The following parameters must be set properly in the applicable ESDT science metadata ODL file in order to implement the Basic Temporal Production Rule:

- DYNAMIC_FLAG.
- PERIOD.
- BOUNDARY.

The DYNAMIC_FLAG describes the type of data that is defined in the ESDT science metadata ODL file. It specifies to PDPS what kind of data the PGE requires as input or produces as
output. It can have any of the following four possible values, all of which are valid for Basic Temporal data:

- **"S"**
  - Static Data.
  - Data do not change at regular intervals.
  - The same granule can be used as input for many runs of the PGE.
  - Calibration files are a good example of static data.

- **"I"**
  - Dynamic Internal.
  - Data are produced by a PGE running at the local DAAC.
  - All output products are either “dynamic internal” or “interim” kinds of data.

- **"E"**
  - Dynamic External.
  - Data are produced by an external source (not a PGE running at the local DAAC).
  - Earth Observing System (EOS) Data and Operations System (EDOS) data is a primary example.
  - Dynamic external can be set for PGE inputs only.

- **"T"**
  - Interim/Intermediate.
  - Data are stored only temporarily by the Data Server Subsystem.

The PERIOD parameter specifies the length of time covered by the data. Data are expected to be either ingested or produced for the length of the PROCESSING_PERIOD described in PGE science metadata ODL files. However, the PERIOD of the data does **not** have to match the PROCESSING_PERIOD defined for the PGE. PDPS plans for data where the ESDT period is less or more than the processing period of the PGE that uses it. For example, if the PGE PROCESSING_PERIOD = "HOURS=1" and the input data PERIOD = "MINS=5", then PDPS plans to acquire twelve granules of the input data to cover the PROCESSING_PERIOD.

The following “period type” values are used for implementing the Basic Temporal Production Rule:

- **"YEARS"**
  - Data span a year or years.
“YEARS” might be selected for a yearly average output product.
For example, PERIOD = "YEARS=1" specifies data that cover a period of a year.

- "MONTHS"
  - Data span a month or several months.
  - “MONTHS” is most likely used for some kind of averaging output product.
  - For example, PERIOD = "MONTHS=2" specifies data that cover a period of two months.

- "THIRDS"
  - Data span some number of thirds of a month.
  - For example, PERIOD = "THIRDS=1" specifies data that cover a period of 1/3 month.

- "WEEKS"
  - Data span some number of weeks.
  - For example, PERIOD = "WEEKS=2" specifies data that cover a period of two weeks.

- "DAYS"
  - Data span some number of days.
  - For example, PERIOD = "DAYS=5" specifies data that cover a period of five days.

- "HOURS"
  - Data span some number of hours.
  - For example, PERIOD = "HOURS=4" specifies data that cover a period of four hours.

- "MINS"
  - Data span some number of minutes.
  - For example, PERIOD = "MINS=5" specifies data that cover a period of five minutes.

- "SECS"
  - Data span some number of seconds.
For example, PERIOD = "SECS=2" specifies data that cover a period of two seconds.

- "ORBITS"
  - Data span some number of orbits of the spacecraft.
  - For example, PERIOD = "ORBITS=1" specifies data that cover one orbit.
  - A PGE can be time-scheduled (using the Basic Temporal Production Rule) but use orbit-based data.

The BOUNDARY parameter is the starting point in time of the data granule. It tells when each data granule should start. Note that the BOUNDARY and PERIOD are used in conjunction to determine the starting and ending time for the granules.

The following values for BOUNDARY apply to the Basic Temporal Production Rule:

- "START_OF_HOUR"
  - Data granules start every hour.

- "START_OF_6HOUR"
  - Data granules start every six hours.

- "START_OF_DAY"
  - Data granules start every day.

- "START_OF_WEEK"
  - Data granules start every week.

- "START_OF_ONE_THIRD_MONTH"
  - Data granules start every 1/3 of a month.

- "START_OF_MONTH"
  - Data granules start every month.

- "START_OF_YEAR"
  - Data granules start every year.

- "START_OF_ORBIT"
  - Data granules start every orbit.
The PREDICTION_METHOD parameter specifies the method of prediction that the Planning and Data Processing Systems use when creating DPRs that use the ESDT. The parameter has two possible values:

- "ROUTINE"
  - Data granules come in at regular intervals.
  - Boundary and Period are used when predicting the inputs to DPRs.
- "NONROUTINE"
  - Data granules come in at odd or random intervals.
  - DPRs that use the input can work off data that exists in the Science Data Server when the production request is created. This is because PDPS cannot predict the data.
  - When PREDICTION_METHOD = NONROUTINE, Boundary and Period are not used.

Advanced Temporal Production Rule

The Advanced Temporal Production Rule allows for input data to be acquired for a time period other than that of the PGE or its planned inputs/outputs. It provides an offset mechanism, specifying on an input basis that the data required for processing is some number of seconds earlier or later than the planned time period for the PGE.

- Example One:
  - A PGE requires data from its previous execution for interpolation purposes (e.g., one of its inputs is the output of the very same PGE the last time that it ran).
  - If the PGE processes data for each one-hour interval (producing an hourly product), the Advanced Temporal Production Rule is specified with an offset of minus 3600 seconds (one hour) for the input of the ESDT produced by previous runs.

- Example Two:
  - A PGE takes as input two-hour Level 0 data to produce an L1A product.
  - Because the edges of the Level 0 data can be difficult to process without preceding and succeeding data, the PGE requires three Level 0 granules, one from the time period before it runs, one for the time period it is currently processing and one for the next time period.
The PGE is defined as having three inputs, the first with an Advanced Temporal offset of minus 7200 seconds (two hours), the second with no Advanced Temporal offset and the third with an Advanced Temporal offset of plus 7200 seconds (two hours).

The Advanced Temporal Production Rule uses the times specified in the Basic Temporal Production Rule as a reference point for specifying offset(s) to request data from a “period” and/or “boundary” different from that of the DPR or its input. The offsets are specified as either negative or positive numbers to indicate whether the time period of the input data is before or after that of the DPR (a particular run of a PGE).

- **Begin Period Offset** is an amount of time (in seconds) that is specified with respect to the DPR start time. A negative beginning offset requests data that was collected before the DPR start time. A positive beginning offset requests data with a collection time after the start time of the DPR.

- **End Period Offset** is an amount of time (in seconds) that is specified with respect to the DPR end time. A negative ending offset requests data that ended collection before the DPR end time was reached. A positive ending offset requests data that ended collection after the end time of the DPR boundaries.

Note that the beginning and ending offsets are not absolute cut-offs for data. Overlapping granules (granules that start or end outside of the offsets) will be staged as inputs to the DPR.

Figure 6 provides an illustration of the Advanced Temporal Production Rule. The PGE shown in the example processes data for every one-hour interval. However, Input One comes in at two-hour intervals and Input Two is produced every 1/2 hour.

Both the Begin Period Offset and End Period Offset for Input One are -7200 seconds (minus two hours). Consequently, every DPR will stage the "previous" Input One. This could be used to get the "previous" or "next" granule of an input.

The Begin Period Offset for Input Two is zero, meaning that it will match the Start Time of the DPR. The End Period Offset is +1800 seconds (plus 1/2 hour). Therefore, all Input Two granules will be staged that fall within the time period of the DPR plus 1/2 hour. The effect is to acquire all Input Two granules within the time period of the DPR, plus the one from the next 1/2-hour time period, for a total of three granules. The additional granule acquired by means of the End Period Offset might be used for interpolation purposes at the end point.

The same types of parameter settings that apply to the Basic Temporal Production Rule apply to the Advanced Temporal Production Rule. In addition, there are some parameters in the PGE science metadata ODL file that apply specifically to the Advanced Temporal Production Rule. However, the values applicable to the Basic Temporal Production Rule must be set before the Advanced Temporal Production Rule syntax is added.
Figure 6. Example of the Advanced Temporal Production Rule

PGE Science Metadata ODL File Parameters

During the SSI&T process the PGE science metadata ODL file is generated from the PCF delivered with the science algorithm. A PCF_ENTRY object is generated for each file entry in the PCF. In order to implement the Advanced Temporal Production Rule the PCF_ENTRY object for each type of input file to which the rule applies uses the following syntax:

```
OBJECT = PCF_ENTRY
.
.
.
BEGIN_PERIOD_OFFSET =
END_PERIOD_OFFSET =
.
.
.
END_OBJECT = PCF_ENTRY
```
Accordingly, the following parameters must be set properly in order to implement the Advanced Temporal Production Rule:

- **BEGIN_PERIOD_OFFSET.**
- **END_PERIOD_OFFSET.**

BEGIN_PERIOD_OFFSET is the offset added to or subtracted from the Data Start Time of the DPR. The value assigned to BEGIN_PERIOD_OFFSET can be either a positive or negative value, specified in seconds. If the value is positive, it is added to the Data Collection Start Time (looking for the input forward in time). If the value is negative, it is subtracted from the Data Collection Start Time (looking backward in time). For example, BEGIN_PERIOD_OFFSET = -3600 requests data that was collected one hour (3600 seconds) before the DPR start time.

END_PERIOD_OFFSET is the offset added to or subtracted from the Data Collection End Time of the DPR. The value assigned to END_PERIOD_OFFSET can be either a positive or negative value, specified in seconds. If the value is positive, it is added to the Data Collection End Time (looking for the input forward in time). If the value is negative, it is subtracted from the Data Collection End Time (looking backward in time). For example, END_PERIOD_OFFSET = +2700 requests data that was collected 45 minutes (2700 seconds) after the DPR end time.

The BEGIN_PERIOD_OFFSET and END_PERIOD_OFFSET parameters can be specified for any input PCF_ENTRY in the PGE science metadata ODL file. If not specified, the parameters are set to zero (0) and the Advanced Temporal Production Rule does not apply to the PGE.

### Alternate Input and Optional Input Production Rules

The Alternate Input and Optional Input Production Rules are very similar and use much the same processing in PDPS. Both rules allow a PGE to select various inputs based on timers and priority lists. The major difference is that Alternate Inputs requires that one of alternates on the list be used, whereas Optional Inputs allows successful execution of the PGE if no optional input on the list is available.

The Alternate Input Production Rule allows for a PGE to evaluate a list of inputs in priority order and be scheduled and executed with the best priority input that could be found. In essence, a PGE using Alternate Inputs is saying "I would like to run with Input A, but if it's not available, I am willing to run with Input B." A timer can be used to specify how long to wait for a given alternate choice before proceeding with a choice of lesser priority. The PGE is not executed until one of the alternate choices has been found.

- **Example:**
  - A PGE requires model wind data as an input but is capable of accepting wind data from a Data Assimilation Office (DAO) model, a National Centers for Environmental Prediction (NCEP) model, or (as a last resort) climatology.
The PGE would use the Alternate Input Production Rule to list each input in priority order, giving a timer value for how long to wait before trying the next input.

If the DAO data are most desirable, DAO would be listed as first choice or "primary" data.

NCEP would be the second choice.

Climatology would be the last choice.

If a timer value is specified for DAO data, the PGE will wait for that timer to expire before running with either NCEP data or climatology.

If a timer had been placed on the NCEP input, the PGE would wait before running with the climatology data.

The Optional Input Production Rule allows for a PGE to list inputs that are desired but not required for it to execute. The inputs are ranked as previously stated and timers are set to wait before choosing a lower-priority type of input. However, if none of the inputs on the list becomes available, the PGE starts because the alternatives are classified as "optional." In essence the PGE is saying "I would like to run with Input A, but if its not available, I can run (and produce reasonable output) without it."

Example:

It would be preferable to run a particular MODIS PGE with the output of a MISR PGE as input.

However, the MISR output may not be produced every day.

So the MODIS PGE lists the MISR input as optional with a two-hour timer.

On those occasions when no MISR output is produced, the MODIS PGE waits for two hours and then is executed without the MISR input.

Figure 7 provides an illustration of the Alternate Input Production Rule. The PGE in the illustration has two inputs that are “required” so they must available for the PGE to be run. It also has one input that is “alternate.” The alternate input can be one of three choices, the first choice is the primary, then there are second and third choices.

After the pair of required inputs has become available, the alternate inputs are evaluated as follows:

- If the primary alternate is available, it is used as input and the PGE is scheduled for execution.

- There is a one-hour timer on the primary alternate. If the primary alternate is unavailable, the PGE waits until the primary alternate becomes available or the one-hour timer expires, whichever occurs first.
Figure 7. Example of the Alternate Input Production Rule

- If the second alternate is available after the timer for the primary alternate has expired, the second alternate is used as input and the PGE is scheduled for execution.

- There is a four-hour timer on the second alternate. If the second alternate is unavailable, the PGE waits until either the primary alternate or the secondary alternate becomes available or the four-hour timer expires, whichever occurs first.

- If the third alternate is available after the timer for the second alternate has expired, the third alternate is used and the PGE is scheduled for execution.

- There is no timer on the third alternate. If the third alternate is not available, the PGE waits until either the primary alternate, the secondary alternate, or the third alternate becomes available, whichever occurs first.

- The PGE will not start processing until one of the alternates becomes available.

If instead of an alternate the third input for the PGE had been defined as an optional input, the preceding scenario would have been the same, except that if neither the primary alternate, the
second alternate nor the third option was available after the timers had expired, the PGE would not wait; it would be scheduled for execution without the third input. It would run with the two required inputs only.

The Alternate Input and Optional Input Production Rules are additions to settings/syntax put into the ODL files for other production rules. Inputs deemed “optional” or “alternate” can be searched for and acquired by other production rules (e.g., Basic Temporal or Metadata Checks/Query). The syntax for the rules used to search for the inputs have to be filled out in addition to the syntax required to make the input an alternate or optional input.

**PGE Science Metadata ODL File Parameters**

The following parameter must be set properly in the applicable PGE science metadata ODL file in order to implement the Alternate Input or Optional Input Production Rule:

- **INPUT_TYPE.**

In addition, one of the following two ODL objects is used within a PCF_ENTRY to define either the Alternate Input Production Rule or the Optional Input Production Rule:

- **ALTERNATE_INPUT** object.
- **OPTIONAL_INPUT** object.

**INPUT_TYPE** is a type of data defined by a PCF_ENTRY object (i.e., between OBJECT = PCF_ENTRY and END_OBJECT = PCF_ENTRY). It can have one of four possible values, only three of which are used to define an alternate or optional inputs:

- **"Required"**
  - A required input.
  - The data must be available or the PGE does not execute.
  - It is the "normal" value for the parameter (i.e., INPUT_TYPE = “Required”); consequently, the input is neither an alternate input nor an optional input.

- **"Primary"**
  - The primary alternate input.
  - The data is the first choice in a list of alternates.

- **"Alternate"**
  - An alternate input (except the primary alternate) in a list of alternates.
  - The data is not the first choice in a list of alternates; it is a subsequent choice if the primary (or a higher-priority alternate) is not available.

- **"Optional"**
  - An optional input.
Availability of the data will be checked and if a timer has been specified, execution of the PGE will wait.

The PGE can be executed without the data if it is not available.

Although the Alternate Input and Optional Input Production Rules are similar, there are two different ODL objects used to define them within a PCF_ENTRY; i.e., the ALTERNATE_INPUT object and the OPTIONAL_INPUT object.

The ALTERNATE_INPUT object has the following syntax:

```
OBJECT = PCF_ENTRY
  .
  .
  OBJECT = ALTERNATE_INPUT
  .
  .
END_OBJECT = ALTERNATE_INPUT
END_OBJECT = PCF_ENTRY
```

The ALTERNATE_INPUT ODL object surrounds an Alternate Input definition. An OBJECT/END_OBJECT pair separates the parameters defining the Alternate Input from the rest of the parameters defining the PCF_ENTRY. The following parameters define an ALTERNATE_INPUT object:

- CLASS.
- CATEGORY.
- ORDER.
- RUNTIME_PARM_ID.
- TIMER.
- WAITFOR.
- TEMPORAL [not implemented].

CLASS is a simple counter used to differentiate the different ALTERNATE_INPUT objects within the file. Since each ALTERNATE_INPUT object resides within a different PCF_ENTRY object, the CLASS for an ALTERNATE_INPUT object can always be 1.

CATEGORY is the name of the list of alternates to which the ALTERNATE_INPUT belongs. The PDPS uses CATEGORY to associate different alternates within a list. CATEGORY can be set to any string value of 20 characters or less (e.g., CATEGORY = "Snow Ice"). Alternates that are part of the same list should have matching CATEGORY values.
ORDER is the numerical place that the particular alternate holds in the list of alternates. The first choice or Primary Alternate (with the INPUT_TYPE = "Primary") should have ORDER = 1.

RUNTIME_PARM_ID specifies the Logical ID (in the PCF) for which the PGE will find the Logical ID of the alternate chosen. Since all alternates must be contained within different PCF_ENTRY objects, they all must have different Logical IDs (but all alternates within the same CATEGORY should have the same value of RUNTIME_PARM_ID). The RUNTIME_PARM_ID parameter specifies the Logical ID of a runtime parameter that the PGE may read to find out which alternate was chosen for the particular execution of the PGE.

The TIMER parameter specifies how long to wait for the particular alternate before checking for the next alternate in the list. The parameter value is expressed in the format "<Period Type>=<Length of Period>". Note that “Length of Period” can be specified as a positive integer only.

The Alternate Input Production Rule accepts the following “Period Type” values:

- **"WEEKS"**
  - PDPS should wait for some number of weeks before searching for the next alternate in the list.
  - For example, TIMER = "WEEKS=2" would make PDPS wait two weeks before checking for the next alternate input.

- **"DAYS"**
  - PDPS should wait for some number of days before searching for the next alternate in the list.
  - For example, TIMER = "DAYS=5" would make PDPS wait five days before checking for the next alternate input.

- **"HOURS"**
  - PDPS should wait for some number of hours before searching for the next alternate in the list.
  - For example, TIMER = "HOURS=4" would make PDPS wait four hours before checking for the next alternate input.

- **"MINS"**
  - PDPS should wait for some number of minutes before searching for the next alternate in the list.
  - For example, TIMER = "MINS=5" would make PDPS wait five minutes before checking for the next alternate input.
"SECS"

PDPS should wait for some number of seconds before searching for the next alternate in the list.

For example, TIMER = "SECS=2" would make PDPS wait two seconds before checking for the next alternate input.

The WAITFOR parameter specifies whether or not the PGE can be run without the alternate input. Setting WAITFOR = "N" means that the PGE can run without the input if it cannot be found. In a list of alternate inputs, this would have meaning for the last choice only. If WAITFOR = "Y", the PGE is not executed (even after the last alternate timer expires) until one of the alternates in the list can be found.

The TEMPORAL parameter is an unimplemented feature that would allow for searching for alternates from the same time period but a different date. It is currently stored in the PDPS database but is not used.

The OPTIONAL_INPUT object has the following syntax:

```
OBJECT = PCF_ENTRY
  .
  .
  .
  .
  OBJECT = OPTIONAL_INPUT
  .
  .
  .
END_OBJECT = OPTIONAL_INPUT
END_OBJECT = PCF_ENTRY
```

The OPTIONAL_INPUT ODL object surrounds an Optional Input definition. An OBJECT/END_OBJECT pair separates the parameters defining the Optional Input from the rest of the parameters defining the PCF_ENTRY. The following parameters define an OPTIONAL_INPUT object:

- CLASS.
- CATEGORY.
- ORDER.
- RUNTIME_PARM_ID.
- TIMER.
- TEMPORAL [not implemented].
The parameters that apply to the Optional Input Production Rule are defined in the same way that the corresponding parameters are defined for the Alternate Input Production Rule. However, note that the Optional Input Production Rule has no WAITFOR parameter. It is irrelevant; in fact, the very essence of the Optional Input Production Rule depends on not “waiting for” the last option but going ahead with the execution of the PGE without the unavailable optional input(s).

**Minimum/Maximum Number of Granules Production Rule**

The Minimum/Maximum Number of Granules Production Rule makes it possible to specify a range of possible granules for a given input or output for a PGE.

- **Inputs.**
  - Minimum number of granules the PGE needs for full data coverage.
  - Maximum number of granules for the time period.

- **Outputs.**
  - Minimum number of outputs that the PGE is expected to produce.
  - Maximum number of outputs that the PGE is expected to produce.

For example, a PGE processes data for every 90-minute interval, has a period of 90 minutes, and takes as input a granule with a period of two hours.

- In many instances one granule of the input will satisfy the PGE.
- In other instances, because of the way the two-hour and 90-minute periods overlap, the PGE needs two input granules to cover the time period.
- Therefore,…
  - Minimum Number of Granules = 1.
  - Maximum Number of Granules = 2.

The Minimum/Maximum Number of Granules Production Rule is different from most production rules because it works for both input and output granules. It allows the PGE to request of a range of inputs (i.e., 1-10 granules), so that it runs with as few as one granule but with as many as ten granules. If a PGE needs at least three granules of a particular input, the minimum number of granules is defined as three and the PGE is not executed until at least three granules are available.

**Optional outputs** are defined when the Minimum Number of Granules is set to zero. In such cases the PGE can produce none of the particular type of output and still be considered to have executed successfully. If a PGE has a non-zero value for a Minimum Number of Granules associated with an output, and fails to produce any granules of that output type, it is marked as failed.
Figure 8 provides an illustration of the Minimum/Maximum Number of Granules Production Rule. In the example the PGE processes data related to a one-hour period and takes in both Input 1 and Input 2. Since Input 1 has a PERIOD of 1/2 hour, every PGE run requires two Input 1 granules. Input 2 has a PERIOD of 15 minutes, so there are four Input 2 granules for every PGE run.

The PGE produces three Output 1 granules for each run. In this case it does not produce any Output 2 granules.

Minimum and maximum values can affect each input and output as follows:

- **Input 1:**
  - If Minimum Granules is set to anything equal to or less than two for Input 1, the PGE is scheduled and executed.
  - If Minimum Granules is set to three, the PGE is not scheduled because there are not enough Input 1 granules to make the minimum.
  - If Maximum Granules is set to anything equal to or greater than two for Input 1, the PGE is scheduled and executed.

**Figure 8. Example of the Minimum/Maximum Number of Granules Production Rule**
• If Maximum Granules is set to one, the PGE is not scheduled because there are too many Input 1 granules (the number exceeds the maximum that the PGE can process).

• Input 2:
  • If the Minimum Granules is set to anything equal to or less than four for Input 2, the PGE is scheduled and executed.
  • If Minimum Granules is set to five, the PGE is not scheduled because there are not enough Input 2 granules to make the minimum.
  • If Maximum Granules is set to anything equal to or greater than four for Input 2, the PGE is scheduled and executed.
  • If Maximum Granules is set to three, the PGE is not scheduled because there are too many Input 2 granules (the number exceeds the maximum that the PGE can process).

• Output 1:
  • If Minimum Granules is set to anything equal to or less than three for Output 1, the PGE is scheduled and executes successfully.
  • If Minimum Granules is set to four, the PGE is marked as failed because it did not produce the expected number of output granules.
  • If Maximum Granules is set to anything equal to or greater than three for Output 1, the PGE is scheduled and executes successfully.
  • If Maximum Granules is set to two, the PGE is marked as failed because it produced too many output granules.

• Output 2:
  • If Minimum Granules is set to anything other than zero, the PGE is marked as failed because it did not produce the expected number of output granules.
  • If Maximum Granules is set to anything equal to or greater than zero for Output 2, the PGE is scheduled and executes successfully.

The Minimum/Maximum Granules Production Rules are additions to settings/syntax put into the ODL files for other production rules. All Production Rules have a Minimum and Maximum Granule setting for both inputs and outputs, even though both values may be set to one (1).
PGE Science Metadata ODL File Parameters

The PGE science metadata ODL file syntax for implementing the Minimum/Maximum Production Rule for input data includes the following types of entries:

```
OBJECT = PCF_ENTRY
.
PCF_FILE_TYPE =
.
.
MIN_GRANULES_REQUIRED =
MAX_GRANULES_REQUIRED =
.
.
END_OBJECT = PCF_ENTRY
```

Accordingly, the following parameters must be set properly in order to implement the Minimum/Maximum Production Rule:

- **PCF_FILE_TYPE**.
- **MIN_GRANULES_REQUIRED**.
- **MAX_GRANULES_REQUIRED**.

The **PCF_FILE_TYPE** parameter is defined by integers in the range of 1 to 8 (inclusive). The integers are codes for the following types of files:

- 1 - product input files.
- 2 - product output files.
- 3 - support input files.
- 4 - support output files.
- 5 - user defined runtime parameters.
- 6 - interim/intermediate input files.
- 7 - interim/intermediate output files.
- 8 - temporary input/output.
For inputs (any PCF_ENTRY with a PCF_FILE_TYPE equal to 1, 3 or 6) the following pair of values must be set for each PCF_ENTRY:

- **MIN_GRANULES_REQUIRED**
  
  - Minimum number of granules required for the input.
  
  - A value of zero (MIN_GRANULES_REQUIRED = 0) would mean that the PGE could execute if no granules for that particular input could be found (in effect, the input is an *optional input*).
  
  - A value of three (for example) would mean that the PGE must have at least three granules of the input before the PGE can be executed.

- **MAX_GRANULES_REQUIRED**
  
  - Maximum number of granules for the input that the PGE is able to successfully process.
  
  - A value of four (for example) would mean that the PGE would process at most four granules for the input.
  
  - If MAX_GRANULES_REQUIRED = 4 and more than four granules are found for the given input, the PGE is not executed.

The PGE science metadata ODL file syntax for implementing the Minimum/Maximum Production Rule for output data includes the following types of entries:

```plaintext
OBJECT = PCF_ENTRY
.
  PCF_FILE_TYPE =
  .
  MIN_GRANULE_YIELD =
  MAX_GRANULE_YIELD =
  .
  .
END_OBJECT = PCF_ENTRY
```

For outputs (any PCF_ENTRY with a PCF_FILE_TYPE equal to 2, 4 or 7) the following pair of values must be set for each PCF_ENTRY:

- **MIN_GRANULE_YIELD**
  
  - Minimum number of granules that the PGE produces for the output.
  
  - A value of zero (MIN_GRANULE_YIELD = 0) means that the PGE produces no granules for the output (the output is an *optional output*).
• A value of three (for example) means that the PGE produces at least three granules of the output during a successful execution.

• MAX_GRANULE_YIELD
  – Maximum number of granules that the PGE produces for this output.
  – A value of four (for example) means that at most the PGE produces four granules for the output.
  – Note that sizing of disk space is based on this number, so making it too small could cause problems on the science processor disks.

Optional DPRs Production Rule
The Optional DPRs Production Rule (also called the Data-Scheduled Production Rule) makes the execution of a PGE subject to the availability of a key input. The system generates DPRs for every possible instance of the key input data but executes only the DPRs for which data are either produced in data processing or can be acquired from the archive.

The Optional DPRs Production Rule applies to PGEs that process certain kinds of non-routine data.

• Routine Data
  – Data that can be predicted, that come in at specific intervals and are always of a specified length.
  – Routine data makes it possible for the Basic Temporal Production Rule to schedule PGEs based on their input data.

• Non-Routine Data
  – Data that cannot be predicted because they come in at random periods and/or their length is variable.
  – Examples include an "optional" output of an upstream PGE, or data that are archived at random periods (e.g., some forms of ASTER data).

An Optional DPR has as its key input a non-routine data type. There are two sets of circumstances that lead to the scheduling of Optional DPRs:

• Every possible time that the input is produced in data processing (i.e., the key input is produced as an "optional" output by an upstream PGE).

• Whenever a new granule (of a particular data type) can be acquired from the archive (e.g., archived data that were inserted at unpredictable times).
NOTE: Key input applies to the Spatial Query Production Rule as well as the Optional DPRs Production Rule. Consequently, it is possible for the Optional DPRs and Spatial Query Production Rules to be used in combination only when they use the same key input.

An example of the first condition starts with a MODIS PGE that produces a certain product only when the input data were collected during the satellite’s "Day" mode. A second MODIS PGE is scheduled to use the optional (“Day”-mode) product from the first MODIS PGE as its key input. The second MODIS PGE is scheduled to run after every instance of the first MODIS PGE; however, only the DPRs that can use the optional products resulting from runs of the first MODIS PGE are executed. The remaining DPRs cannot be executed because there is no input data for them.

The second condition is illustrated by ASTER routine processing, which makes use of the Optional DPRs Production Rule to schedule and execute ASTER PGEs for new data that have been archived. (Note that the DAAC ingests and archives ASTER production data from tapes supplied by the ASTER Ground Data System on a frequent but not entirely predictable basis.) When the Production Planner creates a Production Request for an ASTER PGE, it is necessary to specify the **insertion time** range (i.e., the time period when the desired data were archived) as opposed to the **collection time** (when the satellite instrument gathered the data). DPRs specifying the ASTER PGE are scheduled and executed for the data granules that were actually inserted in the archive during the time period specified in the Production Request.

An illustration of the Optional DPRs production rule is presented in Figure 9. In the figure there are two DPRs (i.e., DPR-1 and DPR-2) for the upstream PGE and two DPRs (i.e., OPT-1 and OPT-2) for the PGE subject to the Optional DPRs Production Rule. The “Optional DPRs” PGE takes as input the optional output of the upstream PGE. When it is executed, DPR-1 produces the optional output, so the dependent DPR (OPT-1) is executed. However, OPT-2 is not executed because DPR-2 (on which OPT-2 depends) does not produce the optional output.

The Optional DPRs Production Rule is set up during the SSI&T process. It uses many of the same parameter settings as the Basic Temporal Production Rule so the values specified in the Basic Temporal Production Rule (or other production rules) are set first, then the Optional DPRs Production Rule syntax is added.

**PGE Science Metadata ODL File Parameters**

The following two types of PGE science metadata ODL file entries must be made in order to set up the Optional DPRs Production Rule:

- **SCHEDULE_TYPE**.
- **KEY_INPUT**.
The SCHEDULE_TYPE parameter is set as follows:

- **SCHEDULE_TYPE = “Data”**
  - This demonstrates the appropriateness of the term “Data-Scheduled Production Rule.”
  - Other schedule types include Time, Orbit, and Snapshot.

The key input is designated by including the following parameter in the PCF_ENTRY for whichever input is to be the key input:

- **KEY_INPUT = “Y”**
  - Assigning a value of “Y” to the KEY_INPUT parameter identifies the data as a key input and it is subsequently treated as such.
  - Either assigning a value of “N” to the KEY_INPUT parameter or leaving out the parameter entirely identifies the non-key input data.
  - Only one key input is allowed per PGE profile.
The Production Planner’s role in the implementation of the Optional DPRs Production Rule was described in the MODIS and ASTER examples previously described and varies with the kind of key input:

- Optional output of an upstream PGE (MODIS example).
  - Production Planner creates Production Requests for the PGE subject to the Optional DPRs Production Rule and specifies the same date/time range as for the upstream PGE.
  - Some of the DPRs generated as a result of the Production Request will never run due to lack of input data.

- Ingested on an irregular time schedule (ASTER example).
  - Production Planner specifies the data insertion time range when creating Production Requests.
  - All DPRs generated as a result of the Production Requests should be capable of running.

Metadata Checks and Metadata Query Production Rules

The Metadata Checks and Metadata Query Production Rules are similar in definition and use. Both production rules allow the PGE to specify granule-level metadata values that define whether the PGE can accept one (or more) of its inputs. The rules differ only in the results of metadata search performed.

- Metadata Checks Production Rule.
  - When PLS requests the Science Data Server to search for the input(s), the Science Data Server "checks" the metadata of all granules that match the time frame with respect to the value(s) allowed by the PGE.
  - If any granule fails to match the specified value(s), the PGE is not executed.

- Metadata Query Production Rule.
  - When PLS requests the Science Data Server to search for the input(s), the Science Data Server adds to the query the metadata value(s) desired by the PGE.
  - Only the granules that match the time frame of the PGE plus the granule-level metadata value(s) specified by the PGE are staged for the PGE to use as input.
  - If no granules are found matching the conditions and the input is not optional, the PGE is not executed.

- Example of Metadata Checks:
  - A MODIS PGE is run when the Percent Cloud Cover of its inputs is greater than 25 percent.
The Metadata Checks Production Rule is used to specify the granule-level metadata value of greater than 25.

When the PGE is scheduled and is ready to start, two granules match the timeframe of the Production Request for the input with the Metadata Check.

If both granules have a Percent Cloud Cover greater than 25 percent, execution of the PGE starts and both granules are staged.

If one of the granules has a Percent Cloud Cover of 15 percent, the PGE is not executed.

Example of Metadata Query:

A MODIS PGE is run when as many granules as possible of one of its inputs have a QA Value = "Good".

The Metadata Query Production Rule is used to specify the granule-level metadata value = "Good".

When the PGE is scheduled and is ready to start, two granules match the timeframe of the production request for the input with the Metadata Query.

If both granules have a QA Value = "Good", execution of the PGE starts and both granules are staged.

If one of the granules has a QA Value = "Bad", the PGE executes but with only one granule (the one with QA Value = "Good").

The Metadata Checks and Metadata Query Production Rules are used in conjunction with the times specified in the Basic Temporal Production Rule or other production rules. The Metadata Check or Query is added information that further refines what granules are sought by the PGE.

The Metadata Checks and Metadata Query Production Rules work differently depending on whether the Production Request is created for a time in the past or for a time in the future.

Past data.

The Production Request Editor performs the Metadata Query or Metadata Check immediately.

Depending on what other production rules may be applicable, if no data is found to match the “query” (or data is found that does not match the “check”), the DPR fails to be created.

Future data.

The Metadata Query/Metadata Check is put off until the DPR Data Collection Stop Time passes plus the value defined in the ODL for QUERY_DELAY.

The delay allows the Metadata Query/Metadata Check to be put off until it's likely that all matching data will be present.
Multi-Granule ESDTs are a special case of the Metadata Query Production Rule. Multi-Granule ESDTs are used for PGE inputs or outputs when more than one granule of the same ESDT exists for the same temporal range (time period). The Multi-Granule ESDT mechanism employs a metadata parameter to differentiate between the "equal in time" granules. A metadata parameter is selected that is unique across granules for the same time period and that is used by PDPS to keep track of which granule is which when the granules are produced. Later, if only one of a pair of granules for a particular time period is needed as input to the PGE, the Metadata Query is used to ensure that PDPS schedules the correct granule as input.

Using runtime parameter values is a capability of the Metadata Query and Metadata Checks Production Rules. Rather than use a hard-coded value for the check or query, a value computed from one of the other production rules can be used.

Figure 10 illustrates the Metadata Checks and Metadata Query Production Rules. If no Metadata Check or Query were applicable, the PGE shown in the figure would use three granules of input (i.e., Granules A through C). However, let us assume that the metadata value to be checked/queried is %CloudCover. Each granule has a different value for %CloudCover.

![Figure 10. Example of the Metadata Checks and Query Production Rules](image-url)
The following results demonstrate the differences between the Metadata Checks and Metadata Query Production Rules, especially with respect to the number of inputs that the PGE receives when different values are specified:

- **Metadata Check of %CloudCover < 80:**
  - In this case all three granules are acquired and the PGE is scheduled and executed.

- **Metadata Query of %CloudCover < 80:**
  - All three granules are acquired and the PGE is scheduled and executed.

- **Metadata Check of %CloudCover = 50:**
  - The PGE is not scheduled because only one of the three granules (Granule C) meets the criterion.

- **Metadata Query of %CloudCover = 50:**
  - Granule C is found and if the PGE’s Min/Max Granules parameters are set to allow one granule, that one granule is acquired and the PGE is scheduled and executed.

- **Metadata Check of %CloudCover < 50:**
  - The PGE is not scheduled because only two of the three granules (Granule A and B) meet the criterion.

- **Metadata Query of %CloudCover < 50:**
  - Granules A and B are found and if the PGE’s Min/Max Granules parameters are set to allow two granules, the granules are acquired and the PGE is scheduled and executed.

- **Metadata Check of %CloudCover <= 50:**
  - The PGE is scheduled and executed because all three granules meet the criterion.

- **Metadata Query of %CloudCover <= 50:**
  - All three granules are found and acquired and the PGE is scheduled and executed.

- **Metadata Check of %CloudCover = 20:**
  - The PGE is not scheduled because only one of the three granules (Granule B) meets the criterion.
• Metadata Query of %CloudCover = 20:
  – Granule B is found and if the PGE’s Min/Max Granules parameters are set to allow one granule, the granule is acquired and the PGE is scheduled and executed.

• Metadata Check of %CloudCover < 20:
  – The PGE is not scheduled because only one of the three granules (Granule A) meets the criterion.

• Metadata Query of %CloudCover < 20:
  – Granule A is found and if the PGE’s Min/Max Granules parameters are set to allow one granule, the granule is acquired and the PGE is scheduled and executed.

• Metadata Check of %CloudCover = 10:
  – The PGE is not scheduled because none of the three granules meets the criterion.

• Metadata Query of %CloudCover = 10:
  – The PGE is not scheduled because no granules are returned from the query (unless Minimum Granules is set to 0).

Note that there can be more than one Metadata Check or Metadata Query on a given input. In the preceding example, a Metadata Check on %CloudCover can be combined with a Metadata Query on another parameter to further limit the input.

The Metadata Checks and Metadata Query Production Rules are additions to settings/syntax put into the ODL files for other production rules. The addition of a Metadata Check or a Metadata Query to an input means that other production rules used to evaluate that input will be applied in combination with the Metadata Check or Metadata Query.

### PGE Science Metadata ODL File Parameters

At the main ODL level (not inside any objects) both the Metadata Checks and Metadata Query Production Rules use the following parameter to determine when to perform the check/query:

\[
\text{QUERY\_DELAY = } 
\]

The parameter is a positive integer (number of seconds) that defines the amount of time to wait before performing the Metadata Query or Metadata Check. When planning DPRs to run on future data, the Production Request Editor sets a timer for all Metadata Checks/Queries at the Data Collection Stop Time (end of the DPR) plus the value specified for the QUERY\_DELAY parameter.
parameter. The value adds time to the Query/Check so the PGE can be assured that all matching
data will be present when the Query/Check is performed.

Both production rules use also need the following setting in the PCF_ENTRY to ensure that
Planning and Data Processing consider metadata values when acquiring input data:

```
OBJECT = PCF_ENTRY
    .
    .
    QUERY_TYPE = "Metadata"
    .
END_OBJECT = PCF_ENTRY
```

QUERY_TYPE tells Planning and Data Processing how to retrieve the data for the input. For
inputs based on metadata (whether Metadata Check or Metadata Query), the value is set to
"Metadata".

Although the Metadata Checks and Metadata Query Production Rules are similar, there are two
different ODL objects used to define them within a PCF_ENTRY in the PGE science metadata
ODL file; i.e., the METADATA_CHECKS object and the METADATA_QUERY object.

The METADATA_CHECKS object has the following syntax:

```
OBJECT = PCF_ENTRY
    .
    .
    .
    .
    OBJECT = METADATA_CHECKS
        .
        .
    END_OBJECT = METADATA_CHECKS
END_OBJECT = PCF_ENTRY
```

The METADATA_QUERY object has the same syntax except “METADATA_QUERY”
replaces “METADATA_CHECKS” in every instance.

Most of the following parameters must be set in the PGE science metadata ODL file within the
METADATA_CHECKS or METADATA_QUERY ODL object (as applicable) in order to
implement either the Metadata Checks or Metadata Query Production Rule:

- CLASS.
- PARM_NAME.
• OPERATOR.
• VALUE.
• DATABASE_QUERY.
• KEY_PARAMETER_NAME (optional).
• KEY_PARAMETER_VALUE (optional).

CLASS is a simple counter used to differentiate the different Metadata Checks or Metadata Query objects within the file. Since each Metadata Checks or Metadata Query object resides within a different PCF_ENTRY object, the CLASS for an METADATA_CHECKS or METADATA_QUERY object can always be 1 (e.g., CLASS = 1).

PARM_NAME is the name of the metadata parameter on which the check or query is to be performed. The value specified for PARM_NAME (e.g., PARM_NAME = “%CloudCover”) must be part of the granule-level metadata of the ESDT. In addition, it must match the parameter name specified in the ESDT science metadata ODL file.

OPERATOR is the operator (e.g., OPERATOR = “==”) on which the check/query is to be performed. The following values are valid for OPERATOR:

• ">
  – Value in metadata must be greater than.
• "<
  – Value in metadata must be less than.
• ">=
  – Value in metadata must be greater than or equal to.
• "<<
  – Value in metadata must be less than or equal to.
• "==
  – Value in metadata must be equal to.
• "!=
  – Value in metadata must be not equal to.

VALUE is the value (e.g., VALUE = 50) against which the metadata parameter (defined by PARM_NAME) is compared (using the operator specified by the OPERATOR parameter). The value for the VALUE parameter should be the type of data (e.g., integer, string) as defined in the ESDT ODL metadata for the parameter.
DATABASE_QUERY indicates whether the value for the Metadata Check or Query should be retrieved from the PDPS database rather than through the use of the VALUE parameter. Specifying DATABASE_QUERY permits runtime parameter values to be used for Metadata Query or Metadata Checks. The following values are valid for the DATABASE_QUERY parameter:

- "NONE"
  - Use the value in the VALUE parameter; no value from the PDPS database is used.
- "PATH NUMBER"
  - Use the Path Number (0-233) of the orbit for which the PGE is scheduled.
- "ORBIT NUMBER"
  - Use the Orbit Number of the orbit for which the PGE is scheduled.

KEY_PARAMETER_NAME is an optional parameter that is used to specify the container within a multi-container metadata group (i.e., the MeasuredParameters metadata group in most ESDTs). The KEY_PARAMETER_NAME (e.g., KEY_PARAMETER_NAME = "ParameterName" for metadata checks or queries within the MeasuredParameters group) in conjunction with the KEY_PARAMETER_VALUE allows PDPS to determine which container within the multi-container group is to be the object of the check or query. KEY_PARAMETER_NAME is not used for product-specific attributes.

KEY_PARAMETER_VALUE is an optional parameter that is used to specify the value (e.g., KEY_PARAMETER_VALUE = "LandCoverage") for the container within a multi-container metadata group (i.e. the MeasuredParameters metadata group in most ESDTs). The KEY_PARAMETER_VALUE in both the PGE science metadata ODL file and ESDT science metadata ODL file must match.

Multi-Granule ESDTs are created by adding the following parameter to the PCF_ENTRY in the PGE science metadata ODL file:

- DISTINCT_VALUE.

The DISTINCT_VALUE must be set to the value of the metadata parameter that is used to differentiate granules within the Multi-Granule ESDT. In addition, the input or output defined by the PCF entry must have a corresponding DISTINCT_PARAMETER entry in the ESDT science metadata ODL file.

**ESDT Science Metadata ODL File Parameters**

The METADATA_DEFINITION ODL object surrounds the definition for Metadata Checks or Metadata Query information within the ESDT science metadata ODL file. An
OBJECT/END_OBJECT pair is needed to separate the parameters defining the Metadata Definition from the rest of the parameters defining the ESDT with the following syntax:

```plaintext
OBJECT = METADATA_DEFINITION
```

.  

.  

```plaintext
END_OBJECT = METADATA_DEFINITION
```

A METADATA_DEFINITION object can match multiple Metadata Checks or Metadata Query objects in various PGE science metadata ODL files. There is no difference between the two production rules with respect to the parameters that need to be set in the ESDT science metadata ODL file. Most of the following parameters must be set:

- CLASS.
- PARM_NAME.
- CONTAINER_NAME.
- TYPE.
- KEY_PARAMETER_NAME (optional).
- KEY_PARAMETER_VALUE (optional).

CLASS is a simple counter used to differentiate the different Metadata Definition objects within the file. Each Metadata Definition object within the file must have a **different** CLASS value.

PARM_NAME is the name of the Metadata parameter on which the check or query will be performed. The value specified for PARM_NAME must be part of the granule-level metadata of the ESDT. It must also match the parameter name specified in the PGE science metadata ODL file(s).

CONTAINER_NAME is the name of the Metadata Group within which the metadata parameter defined by PARM_NAME is contained. For product-specific attributes CONTAINER_NAME is set to the string "AdditionalAttributes" (i.e., CONTAINER_NAME = "AdditionalAttributes").

TYPE indicates the type of data within the metadata parameter. The following values are valid for TYPE:

- "INT"
  - Integer data.
- "FLOAT"
  - Floating point data.
"STR"

- String or character data.
- Note that dates and times are considered string data.

KEY_PARAMETER_NAME and KEY_PARAMETER_VALUE are optional parameters that are used to specify the value for the container within a multi-container metadata group (i.e., the MeasuredParameters metadata group in most ESDTs). They allow PDPS to determine which container within the multi-container group is to be the object of the check or query. There must be a match between the KEY_PARAMETER_VALUE in both the ESDT science metadata ODL file and the PGE science metadata ODL file for any PCF_ENTRY that uses the ESDT.

The ESDT science metadata ODL file for an input specifying Multi-Granule ESDTs needs to have the following parameter added:

- DISTINCT_PARAMETER.

The DISTINCT_PARAMETER must be set to the name of the metadata parameter that is used to differentiate granules within the Multi-Granule ESDT. A corresponding METADATA_DEFINITION must be created to help PDPS find the specified metadata parameter when querying the Science Data Server.

**Spatial Query Production Rule**

The Spatial Query Production Rule allows a PGE to select input(s) based on the spatial coverage of another input (called the key input). The PDPS queries the Science Data Server for the spatial coverage of the key input, then uses it in acquiring any subsequent inputs that the PGE has requested that have the same spatial coverage.

- Example:
  
  - Level 0 input data for an ASTER DPR covers a small section of the Earth.
  
  - The PGE requires ancillary data that covers the same area to complete its processing.
  
  - The PGE uses the Spatial Query Production Rule to mark the geographic input as its key input.
  
  - The PGE specifies that the ancillary input is to be retrieved for the same spatial coverage as that of the key input.
  
  - When PDPS finds an input granule for the PGE, it performs a Spatial Query to acquire the ancillary input with the same spatial coverage as that of the key input.

Without specifying coordinates, PDPS can match inputs against the spatial constraint of the key input, and give to a PGE only those granules, which overlap in area.
Spatial Pad is an addition to the Spatial Query Production Rule. Spatial Pad is a means of padding the spatial constraints of the key input. The specified pad is added to all sides of the key input's spatial shape. All granules that intersect the expanded area are retrieved.

Due to the limitations in the current version of the SQS COTS package, the spatial region defined (i.e., the original size of the polygon combined with the size of the pad) must not exceed 60 degrees in latitude and longitude. If no spatial pad is specified or the pad is equal to zero, normal spatial query is used.

The **Spatial Query** Production rule (unlike most time based production rules) will work with both static and dynamic granules. Thus the Digital Elevation Models (DEM) can be retrieved via a Spatial Query.

Figure 11 is an illustration of the Spatial Query Production Rule. The figure shows a PGE that has two input types, one of which is the key input. The other type of input has granules labeled with the names of various colors. One granule (i.e., “green”) of the key input is found. The spatial coordinates of the granule are retrieved and all inputs of the second ESDT are checked for overlap with the key input’s coordinates.

**Figure 11. Example of the Spatial Query Production Rule**

Assuming that all granules relate to the same time period, the granules are evaluated as follows:

- The “yellow” granule is not retrieved as an input because its spatial coordinates do not overlap with those of the key input.
• The “red” granule is not retrieved as an input because its spatial coordinates do not overlap with those of the key input.

• The “blue” granule is retrieved as an input because its spatial coordinates overlap with those of the key input. Part of its spatial constraint is within the constraint of the key input.

• The “maroon” granule is retrieved as an input because its spatial coordinates overlap with those of the key input. The spatial constraint of this granule is completely within the constraint of the key input.

• The “pea green” granule is retrieved as an input because its spatial coordinates overlap with those of the key input. Part of its spatial constraint overlaps with that of the key input.

• The “purple” granule is not retrieved as an input because its spatial coordinates do not overlap with those of the key input. It does not matter that it overlaps with another input that is accepted (i.e., the “blue” granule).

The Spatial Query Production rule is somewhat of an addition to other production rules. As such, it needs the same parameter settings as the Basic Temporal Production Rule. The values specified in the Basic Temporal Production Rule (or other production rules) are set first, then the Spatial Query Production Rule syntax is added.

**Spatial Query with Spatial Pad**

Figure 12 is an illustration of Spatial Query with Spatial Pad. As in Figure 11 the PGE has two input types, one of which is the key input (in green). The Spatial Pad value (the dotted line in Figure 12) is added around the key input to increase the area covered by the spatial coordinates. Then all inputs of the second ESDT are checked for overlap with the padded coordinates.

Assuming that all granules relate to the same time period, the granules are evaluated as follows:

• The “yellow” granule is retrieved as an input; although its spatial coordinates do not overlap with those of the key input, they do overlap the padded area (the dotted line).

• The “red” granule is not retrieved as an input because its spatial coordinates do not overlap with either the key input or the pad.

• The “blue” granule is retrieved as an input because its spatial coordinates overlap with the key input. Part of its spatial constraint is within the constraint of the key input.

• The “maroon” granule is retrieved as an input because its spatial coordinates overlap with the key input. The spatial constraint of this granule is completely within the constraint of the key input.
The “pea green” granule is retrieved as an input because its spatial coordinates overlap with the key input. Part of its spatial constraint overlaps with that of the key input.

The “purple” granule is not retrieved as an input because its spatial coordinates do not overlap with the key input. It does not matter that it overlaps with another input that is accepted, the “blue” granule.

PGE Science Metadata ODL File Parameters

Each input file is defined by a separate PCF_ENTRY object in the PGE science metadata ODL file. To mark a particular input as being subject to a Spatial Query the QUERY_TYPE parameter needs to be set to “Spatial” within that input’s PCF_ENTRY:

```plaintext
OBJECT = PCF_ENTRY
.
.
.
QUERY_TYPE = "Spatial"
.
.
.
END_OBJECT = PCF_ENTRY
```
QUERY_TYPE indicates what type of query is to be done to acquire the input defined by the PCF_ENTRY object. Valid values are as follows:

- "Temporal" - Input is acquired based on time.
  - The Basic Temporal and/or the Advanced Temporal Production Rules is/are used to get the input.
  - “Temporal” is the value that is assumed if the parameter is left out of the PCF_ENTRY object.

- "Spatial" - Input is acquired based on spatial coordinates (as well as time).
  - An input must be designated the key input to be used in determining the spatial constraints of the search.
  - “Spatial” is the value specified for each input that uses the Spatial Query Production Rule.

The PCF_ENTRY object for the key input includes the following syntax:

```plaintext
OBJECT = PCF_ENTRY
.
.
KEY_INPUT = 'Y'
.
.
END_OBJECT = PCF_ENTRY
```

The KEY_INPUT is the input on which the spatial queries for other inputs will be based. When a KEY_INPUT parameter is assigned a value of “Y” the corresponding input is designated a key input and is treated as such. A value of “N” or leaving out the parameter entirely specifies a non-key input. Only one (1) key input is allowed per PGE Profile.

If a pad is designated as an addition to the spatial constraints of the KEY_INPUT, the SPATIAL_PAD parameter must be set. The pad value is added to the key input's spatial constraints. The value for the SPATIAL_PAD parameter is set within the PCF_ENTRY defining the key input using the following syntax:

```plaintext
OBJECT = PCF_ENTRY
.
.
KEY_INPUT = 'Y'
SPATIAL_PAD =
.
.
END_OBJECT = PCF_ENTRY
```
The SPATIAL_PAD represents the number of kilometers (from 0.0 to 1000.0) that should be added to the Spatial Query. The value is a real number between 0 and 1000 and if not specified, it is set to 0.0 (and thus no pad is added to the spatial queries).

To allow for a temporal offset when performing a spatial query, the SPATIAL_TIME_DELTA parameter is specified to add or subtract time (in seconds) from the query. Consequently, the temporal range for the query may be different from the temporal range of the key input. The value for the SPATIAL_TIME_DELTA parameter is set within the PCF_ENTRY for the spatial input:

```
OBJECT = PCF_ENTRY
  .
  .
  QUERY_TYPE = "Spatial"
  SPATIAL_TIME_DELTA =
  .
END_OBJECT = PCF_ENTRY
```

The SPATIAL_TIME_DELTA adds or subtracts seconds to/from the start and stop times of the DPR when performing the spatial query for the input defined by the PCF_ENTRY. In effect it widens the temporal query. For example…

- DPR Time = 2:00:00 to 3:00:00
- SPATIAL_TIME_DELTA = 20 [seconds]
- Query time for spatial input: 1:50:40 to 3:00:20

**Closest Granule Production Rule**

The Closest Granule Production Rule allows a PGE to request the nearest input granule from the Data Processing Request time. The PDPS requests a search forward or backward for a specified period of time until it finds a granule that matches the request. However, there is a limit to the number of queries that are performed. The number of queries and the period length of the query are specified during SSI&T.

- Example:
  - A PGE processes data at daily intervals and could use a particular type of calibration granule that would allow it to determine the nearest parameters of the instrument.
Although most calibration coefficients are defined as static granules, in this case there is a dynamic granule that is received about once a month.

The closest such granule would be optimum, so the PGE uses the Closest Granule Production Rule to search forward or backward from the time of the DPR to find the nearest calibration granule.

The Closest Granule Production Rule supersedes the Most Recent Granule Production Rule. The latter allowed the search for inputs to go backward in time from the start of the DPR. The Closest Granule Production Rule allows the search for input granules to go either backward or forward in time, increasing the flexibility of the rule. The Closest Granule Production Rule has all of the ability of Most Recent Granule, plus the ability to search forward in time for input data.

The Closest Granule Production Rule uses three values to determine what to query. The three values are concerned with the period of time to query, the direction of the query and the number of queries allowed.

- **Period (Offset).**
  - Tells the PDPS software the query duration.

- **Direction.**
  - Indicates whether the query goes forward (positive) or backward (negative) in time.
  - In the PDataTypeReq table in the PDPS database, the Direction and the Period information are combined, so the sign of value (+ or -) indicates the Direction and the magnitude indicates the Period.

- **Maximum Number of Queries.**
  - Tells the PDPS software how many time periods (as defined by the Offset) to search (either forward or backward in time) for a matching granule.

The PDPS does a Basic Temporal query before using Closest Granule to find the input. If the desired input is not found within the time period of the DPR, PDPS performs a query (in the specified direction) against the Science Data Server for the period defined by the offset. Again, if no matching granule is found, PDPS repeats the query, going backward or forward in time by the value specified in the offset. If no acceptable granule has been found before the maximum number of queries is reached, PDPS fails to generate the DPR due to insufficient input data. However, there is a special case for the forward search; i.e., when the next search interval exceeds the current time, the search stops at the current time.

If the DPR is planned for a future time, the DPR is created using place-holder granules and a timer is activated. When the current time reaches the stop time of DPR, the timer invokes the Closest Granule method to search for the actual granules, which are then used to replace the dummy granules.
The PGE has defined the Closest Granule Production rule with a 6-hour period and a direction of backward, meaning that it queries back in time in six-hour intervals. The maximum number of queries is two. The PDPS performs a query for the input based on the time period of the DPR. Not finding any matching data, it uses the Closest Granule information to query for a six-hour period beginning six hours before the start time of the DPR. Again nothing is found, so a second Closest Granule query is performed, this one six hours before the last Closest Granule query. The second query results in the discovery of two matching granules. The PDPS selects the granule that is later in time and schedules the PGE to use it as input.

If the Closest Granule Production Rule were used in conjunction with the Minimum/Maximum Number of Granules Production Rule, it might be possible for both granules to be selected in the previously described Closest Granule query. If the example included setting the Maximum Number of Granules to two, both granules would be selected as input to the PGE.

The Closest Granule Production Rule needs the same parameter settings as the Basic Temporal Production Rule. The values needed for the Basic Temporal Production Rule must be set before the Closest Granule Production Rule syntax is added.
PGE Science Metadata ODL File Parameters

In addition to the parameter settings for the Basic Temporal Production Rule, the following parameters must be set within the appropriate PCF_ENTRY in the PGE science metadata ODL file in order to implement the Closest Granule Production Rule:

- **CLOSEST_QUERY_OFFSET**.
- **CLOSEST_QUERY_RETRIES**.
- **CLOSEST_QUERY_DIRECTION**.

**CLOSEST_QUERY_OFFSET** is the offset added to or subtracted from the Data Start Time of the DPR and uses as the query for the requested input data type. The specified value has the format "<Period Type>=<Length of Period>" (e.g., \texttt{CLOSEST\_QUERY\_OFFSET = "HOURS=6"}). The following “Period Type” values are used in implementing the Closest Granule rule:

- **"WEEKS"**
  - Offset is some number of weeks.
  - For example, "WEEKS=2" would be a 14-day offset.
- **"DAYS"**
  - Offset is some number of days.
  - For example, "DAYS=5" would be a 120-hour offset.
- **"HOURS"**
  - Offset is some number of hours.
  - For example, "HOURS=4" would be a 240-minute offset.
- **"MINS"**
  - Offset is some number of minutes.
  - For example, "MINS=5" would be a 300-second offset.
- **"SECS"**
  - Offset is some number of seconds.

**CLOSEST_QUERY_RETRIES** is the maximum number of Closest Granule queries before the DPR fails due to insufficient input data. The specified value is an integer value that is limited only by the maximum size of an integer on the executing hardware.
CLOSEST_QUERY_DIRECTION is the direction ("Forward" or "Backward") in time to search the CLOSEST_QUERY_OFFSET for a matching granule. The following “Direction” values are used in implementing the Closest Granule rule:

- "Forward"
  - Search forward in time (from the end of the DPR).
- "Backward"
  - Search backward in time (from the start of the DPR).

Note that the longer the offset value or the greater the number of retries, the more time that each query requires due to search time at the Science Data Server and processing time of any granules returned. The combination of a large offset with a large number of retries can (if no data granules are found) consume a lot of time while failing to generate a DPR.

**Orbital Processing Production Rule**

The Orbital Processing Production Rule is similar to the Basic Temporal Production Rule in that both define the time period for the inputs and outputs of the PGE. The difference is that the Orbital Processing Production Rule uses the orbit of the spacecraft to determine that time period. A PGE that processes data related to every orbit of a satellite uses data related to a time period that is computed from the orbit of that satellite.

- Example:
  - A PGE processes Level 0 data related to each orbit of the Terra satellite.
  - The Terra satellite has an orbital period of 98 minutes so the PGE is scheduled to process data for each 98-minute interval.
  - Since Level 0 data are received every two hours, the data staged for the PGE include every Level 0 granule that falls within the 98-minute PGE interval.
  - Only one granule of Level 0 data is relevant to some 98-minute orbits.
  - Two granules of Level 0 data are relevant to other 98-minute orbits.

The Orbital Processing Production Rule uses the “period” and “boundary” concept just like the Basic Temporal Production Rule. The difference is that for Orbital Processing, the orbit of the spacecraft is taken into account when a PGE or its data are marked as **orbit scheduled**.

When responding to a Production Request for orbit-scheduled processing, PDPS determines the orbit of the satellite via information provided during the SSI&T process. The information (stored in the PDPS database) gives the start time and length of a particular orbit or set of orbits. PDPS extrapolates (or interpolates in the case of an orbit between two orbital periods stored in the database) the start and end times of the PGE that is specified in the Production Request. Data are sought on the basis of the derived start and stop times and the appropriate data granule(s) is/are staged before the PGE is executed.
**Orbit model** is a model of the satellite’s orbits that allows PDPS to perform extrapolations for the Orbital Processing Production Rule. The model is a combination of a database table and a simple algorithm. The database table stores Orbit Number/Orbit Start Time/Orbital Period combinations. The algorithm uses the data to compute the same type of data relevant to subsequent orbits. For example, if Orbit Number 1000 is defined in the database table, the algorithm can calculate the start and end times for Orbits 1001, 1015, 2000, etc.

The Orbit Model works by extrapolation. It is unable to calculate data for any orbit that precedes the earliest entry in the database table. Data for the Orbit Model is specified in the Orbit Model ODL file, which is read only if the PGE requires orbital information.

**Orbital path** is the path of the satellite over the Earth. It is a number from 0-233 that indicates the region of the Earth covered by a particular orbit. Note that because of the implementation of Orbital Path, there needs to be a mapping between the orbital path calculated by PDPS and the orbital path number expected by the PGEs.

**Runtime parameters** can be set to values associated with Orbital Processing. The following list of orbital parameters can be placed under runtime parameters:

- **Orbit Number.**
  - The number of the orbit (starting from zero) and continually increasing.

- **Orbital Path Number.**
  - The number of the path that maps to the orbit number.
  - The orbital path number is the 0-233 orbital path traversed by the satellite.

- **Orbit Number within the Day.**
  - The number of the orbit within the given day.
  - It includes any orbit that ends within the given day.

- **Granule Number within the Orbit.**
  - The number of the granule within a given orbit.
  - It includes any granule that starts within the given orbit.

Figure 14 provides an illustration of the Orbital Processing Production Rule. The PGE in the diagram takes a two-hour input, but is scheduled based on the orbit time and period of the satellite. PDPS uses the data collected at SSI&T to predict the time of the orbit and performs the query to the Science Data Server for the input based on that extrapolated or interpolated orbital time. Granules of input data are allocated to DPRs based on their ability to cover the time period relevant to the DPR.
In the example shown in Figure 14 the length of an orbit is less than the period of the two-hour input, so sometimes a single granule may cover the input time range of a PGE execution and at other times two granules are required. The production rule would work equally well if the data were of a shorter period (e.g., 1/2 hour) than the orbit of a satellite (e.g., 90 minutes). In such a case three granules would be staged for every execution of the PGE.

The Orbital Processing Production Rule is based (at least for the PGE science metadata ODL file) on the same fields used for the Basic Temporal Production Rule. However, the values specified for the parameters provide orbit information rather than time-period information.

**PGE Science Metadata ODL File Parameters**

The following parameters must be set in the PGE science metadata ODL file in order to implement the Orbital Processing Production Rule:

- PLATFORM.
- SCHEDULE_TYPE.
- PROCESSING_PERIOD.
- PROCESSING_BOUNDARY.

The PLATFORM parameter is the name of the platform (satellite) for which the PGE is processing data. Information concerning the orbits of a satellite is stored in the PDPS database.
Values that can be assigned to the parameter are subject to the following constraints:

- The string specified can have no more than 25 characters.
- The string specified should match the string specified in the orbit science metadata ODL file. If no matching file is found, an error is reported during SSI&T.

The SCHEDULE_TYPE parameter describes the type of scheduling that is required for the PGE. "Orbit" is the value used for Orbital Processing. As a result, the PGE is scheduled based on the start time and period of the satellite's orbit. Note that PROCESSING_PERIOD and PROCESSING_BOUNDARY must be set correspondingly.

The PROCESSING_PERIOD is the time interval for the data that the PGE processes. Assuming no combination of production rules that would affect the period, data are acquired for the specified PROCESSING_PERIOD and output data are planned for the given period. The value assigned to PROCESSING_PERIOD is of the format "<Period Type>=<Length of Period>". The “Period Type” applicable to the Orbital Processing Production Rule is "ORBITS". For example, "ORBITS=1" would be applied to a PGE that processes data related to one orbit’s worth of data.

The PROCESSING_BOUNDARY is the boundary (starting point in time) of the PGE. It specifies when each instance of the PGE should start. Note that the PROCESSING_BOUNDARY and PROCESSING_PERIOD are used in conjunction when scheduling the PGE. Consequently, "START_OF_ORBIT" is the acceptable PROCESSING_BOUNDARY for the Orbital Processing Production Rule. It indicates that the PGE processes data related to each satellite orbit. It must be used in conjunction with a PROCESSING_PERIOD that specifies a “Period Type” of “ORBITS”.

**Orbit Science Metadata ODL File Parameters**

The following parameter must be set in the orbit science metadata ODL file in order to implement the Orbital Processing Production Rule:

- PLATFORM.

In addition, the following ODL object is used in defining orbits for the Orbital Processing Production Rule:

- ORBIT_MODEL object.

The value assigned to the PLATFORM parameter in the orbit science metadata ODL file must be exactly the same as that specified for the same parameter in the PGE science metadata ODL file.

The ORBIT_MODEL object is an ODL object that surrounds each orbit definition. An OBJECT/END_OBJECT pair (as shown in the example that follows) is needed for each orbit
that is to be expressly defined. PDPS extrapolates or interpolates orbits that are not specifically defined within the file.

```
OBJECT = ORBIT_MODEL
  CLASS = 1
  ORBIT_NUMBER = 1000
  ORBIT_PATH_NUMBER = 68
  ORBIT_PERIOD = "MINS=98"
  ORBIT_START = "09/21/1999 14:50:00"
END_OBJECT = ORBIT_MODEL
```

The following parameters are set in the ORBIT_MODEL object in order to implement the Orbital Processing Production Rule:

- **CLASS**.
- **ORBIT_NUMBER**.
- **ORBIT_PATH_NUMBER**.
- **ORBIT_PERIOD**.
- **ORBIT_START**.

**CLASS** is a simple counter used to differentiate the different ORBIT_MODEL objects within the file. Each ORBIT_MODEL object needs to have a different CLASS value.

**ORBIT_NUMBER** is simply the number of the orbit being specified. Each orbit of the satellite has a sequential number associated with it. This is the integer value of the orbit number for the orbit being defined in the ORBIT_MODEL object.

**ORBIT_PATH_NUMBER** is value of the path for the specified orbit. The orbital path is a number from 0-233 that repeats every 16 days. This is the integer value of the orbital path number for the orbit being defined in the ORBIT_MODEL object.

**ORBIT_PERIOD** is the length of time it takes for the satellite to complete one orbit. The value assigned to ORBIT_PERIOD has the format "<Period Type>=<Length of Period>" (e.g., “MINS=98”). Note that the “Length of Period” is specified as a positive integer only.

Period Type values for the orbit model science metadata ODL file are:

- "WEEKS"
  - Orbit spans some number of weeks.
  - For example, "WEEKS=2" would be an orbit that takes two weeks to complete.

- "DAYS"
  - Orbit spans some number of days.
  - For example, "DAYS=5" would be an orbit that takes five days to complete.
• "HOURS"
  – Orbit spans some number of hours.
  – For example, "HOURS=4" would be an orbit that takes four hours to complete.

• "MINS"
  – Orbit spans some number of minutes.
  – For example, "MINS=85" would be an orbit that takes eighty-five minutes to complete.

• "SECS"
  – Orbit spans some number of seconds.
  – For example, "SECS=7200" would be an orbit that takes 7200 seconds (two hours) to complete.

ORBIT_START is the start date and time for the orbit defined by the particular ORBIT_MODEL object. Its format is either "MMM DD YYYY HH:MM:SS" or "MM/DD/YYYY HH:MM:SS".

Production Planning Considerations

During normal operations it is expected that the Production Planner will have to add PR information to the PDPS database on a regular basis. The frequency of this activity is, to some extent, determined by the types of PGEs that run at the DAAC and by the requirements for supporting the SCF(s) responsible for the science software. PGEs vary greatly in the number of input and output files associated with them and the production rules associated with them. The amount of time it takes PLS to generate DPRs from a Production Request varies accordingly.

The following factors can affect how long it takes to create a DPR for a PGE and consequently how many DPRs should be considered for each PR:

• Number/size of input granules.

• Number/size of output granules.

• Number of times PGE should be run per day (number of DPRs per day).

• Number/characteristics of applicable Production Rules.

It may take a few minutes to generate the DPRs for a day’s worth of data for one PGE; it may take several hours to generate the DPRs for a day’s worth of data for another PGE. It takes some
experience with creating Production Requests for a PGE to determine the optimum planning period for the PGE.

- The PR is a template request to generate a particular data product and results in a production run of the associated SCF-provided PGE.
  - PR specifies a range (time, snapshot, data, or orbit) over which the data products are to be produced or the PGEs are to be scheduled.
    - PR might request that the data product be produced for only a single day’s data.
    - PR might request that data products be produced for every opportunity of input data for several days or weeks, resulting in several hundred jobs being planned and run as the input data become available.
  - Early in a mission the SCF is gaining an understanding of the on-orbit behavior of the instrument, the resulting data, and the interaction of the science processing software with real data.
    - SCF reviews the quality of the products and notifies the DAAC of the need for any changes to the PR (e.g., discontinue the PR or modify input parameters).
  - DAAC operations may have operational reasons for issuing processing requests for a limited time period.

- The Production Planner has to balance the various considerations when creating PRs.

Planning decisions are made on the basis of locally defined planning strategies for supporting the SCFs’ data processing needs. The production planning tools are intended to be flexible enough in their design to support the particular planning and scheduling cycles of the operations organization at each DAAC.

Before planning production the Production Planner must coordinate with the Resource Planner to resolve all resource allocation issues. The Resource Planner notifies the Production Planner of changes to the resources available for use in processing.

The Production Planner should be aware of the anticipated processing requirements for the next week and month as well as the next day. The first step in the planning process is creating production requests using the Production Request Editor.

**Chain Heads**

The Production Request Editor provides a means by which the Production Planner can identify a PR as the first in a chain of PRs. The outputs of the DPR(s) that PLS creates from the PR at the
head of the chain (or "chain head") are used as inputs to one or more subsequent DPR(s) specified in other PRs.

- Any downstream DPR (i.e., that requires the output of a preceding DPR as its input) is known as a "child" DPR.
- Any DPR that provides output for use as an input to a child DPR is a "parent" DPR.
  - Chain heads are parent DPRs.

In addition to designating chain heads in a PR, the Production Planner may select a particular virtual computer for running the chain-head DPRs. However, the selection of a virtual computer is optional. If no machine is specified, the system tries to schedule the DPR on the machine where the bulk of its accepted inputs (both static and dynamic inputs) are staged.

- A DPR is scheduled to run on the virtual computer that the Production Planner specifies using the Production Request Editor.
  - If no virtual computer is specified, the system tries to schedule the DPR on the machine where the bulk of its accepted inputs (including both static and dynamic inputs) are already staged.

The implementation of chain heads includes the following factors:

- The following columns were added to the PlDataProcessingRequest and PlProductionRequest database tables in the PDPS database:
  - chainFlag.
  - scheduledMachine.
- The following column was added to the PlDataProcessingRequest database table in the PDPS database:
  - chainId.
- The Production Request Editor sets the chainFlag and scheduledMachine values based on Production Planner input when a PR is created.
- It is also possible to set the chainFlag value using the Planning Workbench GUI at plan activation time for DPRs that have no "parent" DPRs producing data used for their input.

The Planning Workbench GUI calls the "Determine Chain" script (i.e., /usr/ecs/MODE/CUSTOM/bin/PLS/EcPlDetermineChain.pl) when a plan is activated. At that time, chainFlag values for previously unflagged chain heads can be set and a chainId can be assigned to each DPR. If the Determine Chain script fails for some reason, the plan is not activated.
**Intermittent Activation**

The conditions for executing most PGEs are well defined. The most common activation condition is the availability of all input data sets. Similarly, the frequency of execution is usually well defined (e.g., run once for every granule or run monthly averages once a month). However, some PGEs have additional or different constraints on when they are run.

A PGE can be set up to run on every $n^{th}$ instance of input data. For example, a QA PGE that is run on a daily product may need to be run only every fifth day to provide a spot check. Note that this does not refer to the common case of running a weekly averaging PGE only once each week, which would be handled by the Basic Temporal Production Rule and the time ranges specified for the input and output ESDTs. Rather, this is a special case where a PGE can be run every day (or hour, week, etc.), but for some reason (such as a QA check) it is desired to run the PGE only every $n^{th}$ day.

To implement Intermittent Activation the Production Planner supplies the following information (via the Production Request Editor) when creating a production request:

- **Number to Skip**
  - Number of DPRs to be skipped (not executed).
  - Entered in the **Skip** field on the Production Request Editor.

- **Number to Keep**
  - After skipping the specified number of DPRs, how many are to be kept?
  - Entered in the **Keep** field on the Production Request Editor.
  - The number to keep is usually one but could be any number.

- **Skip First**
  - Button on the Production Request Editor.
  - Selected to skip the first DPR.
  - Not selected if the first DPR is to be run.

The Planning Subsystem uses the preceding information to establish a pattern of execution. The pattern is effective for the single PR in which the “number to skip” and the “number to keep” are specified; it is not maintained between PRs.

The following example of Intermittent Activation is illustrated in Figure 15:

- The Production Planner prepares a production request for a 14-day period, generating 14 DPRs.
- The Production Planner made the following selections on the Production Request Editor:
  - Entered “4” in the **Number to Skip** field.
Figure 15. Example of Intermittent Activation

- Entered “1” in the Number to Keep field.
- Did not select the Skip First button.

Consequently, the following results are obtained:

- First DPR runs.
- Four DPRs (second through fifth) are skipped.
- Sixth DPR runs.
- Four DPRs (seventh through tenth) are skipped.
- Eleventh DPR runs.
- Remaining three DPRs (twelfth through fourteenth) are skipped.

Data Preprocessing (DPREP)

As previously mentioned, DPREP (data preprocessing) consists of sets of PGEs that use a statistical approach to convert Level 0 (L0) ephemeris and attitude ancillary data for a particular satellite (e.g., Terra, Aqua) into SDP Toolkit native binary format without altering or modifying the scientific content of the data sets.
DPREP PGEs are supplied by ECS, unlike most PGEs, which are provided by the Science Computing Facilities that ECS supports. Release 6A DPREP supports Terra and Aqua operations.

**Terra DPREP**

Terra DPREP consists of the following three PGEs:

- **AM1Eph or Step 1** (EcDpPrAm1EdosEphAttDPREP_PGE), a ksh script that serves as a driver for the following three executables:
  - EcDpPrAm1EdosAncillary
  - EcDpPrAm1EdosEphemerisRepair
  - EcDpPrAm1ToolkitToHdf
- **FddAtt or Step 2** (EcDpPrAm1FddAttitudeDPREP_PGE).
- **RepEph or Step 3** (EcDpPrAm1FddEphemerisDPREP_PGE).

There are several sources of information on the Terra DPREP PGEs and how to run them:

- 184-TP-001-001, Terra Spacecraft Ephemeris and Attitude Data Preprocessing.
- 611-CD-600-001, Mission Operation Procedures for the ECS Project, Chapter 11.
- Two files installed on the science processor hosts (e.g., e0spg01, g0spg01, l0spg01) in the /usr/ecs/MODE/CUSTOM/data/DPS directory.
  - “DPREP_README”
  - “HowtoRunDPREP”

The Terra DPREP PGEs process Level 0 Terra (AM-1) spacecraft data (e.g., ESDT AM1ANC) provided by EDOS. The output files/granules of the DPREP PGEs are subsequently used in the processing of data from various instruments on the satellite. They provide the following types of ancillary (non-science) data:

- **Ephemeris.**
  - Spacecraft location: ephemeris (or orbit) data include: latitude, longitude, and height.
- **Attitude.**
  - Orientation of the satellite, including yaw, pitch, and roll angles; and angular rates about three axes.
Am1eph (Step 1 DPREP: EDOS Level 0 Ancillary Data)

EcDpPrAm1EdosAncillary reads in an AM-1 L0 (EDOS) ancillary data set (ESDT AM1ANC). It also reads another set of AM-1 L0 (EDOS) ancillary data set. The second set of L0 data is required to ensure that incomplete orbits in the first data set get complete orbit metadata records. The only data that is extracted from the second data set is the descending node time and longitude. EcDpPrAm1EdosAncillary also reads in ephemeris and attitude data (ESDT AM1EPHN0 and ESDT AM1ATTN0). These would be the last ephemeris/attitude data sets generated from a previous run of the PGE.

If EcDpPrAm1EdosAncillary signals that a short gap was detected, EcDpPrAm1EdosEphemerisRepair reads the scratch file created by EcDpPrAm1EdosAncillary, fills the gap, and writes a gap-filled native-format ephemeris file.

EcDpPrAm1ToolkitToHdf takes the native format ephemeris file and produces a corresponding HDF file and a metadata file.

The PGE produces Toolkit- and HDF-format attitude (ESDTs AM1ATTN0 and AM1ATTH0) and ephemeris (ESDTs AM1EPHN0 and AM1EPHH0) data sets.

Note: The Level 0 (input) data sets represent two-hour periods of time but processing cannot be performed on the most recently available two-hour data set. Step 1 processing needs to look forward in the time stream in order to complete orbit metadata processing.

FddAtt (Step 2 DPREP: Definitive Attitude Data)

EcDpPrAm1FddAttitudeDPREP_PGE reads in both the current Flight Dynamics Division (FDD) attitude data set (AM1ATTF) and the next FDD attitude data set. It also reads in the attitude data set it produced with its last run. The output of the process is a native-format attitude file (ESDT AM1ATTNF) and an HDF-format attitude file (ESDT AM1ATTHF). A metadata file is produced for each data file.

RepEph (Step 3 DPREP: Repaired Ephemeris Data)

If Step 1 finds too many missing data points in the ephemeris data (e.g., AM1EPHH0 and AM1EPHN0 granules have gaps of greater than 60 seconds), it signals that there are problems with the data. The Production Planner receives an e-mail message indicating the problems in the preprocessed Terra ephemeris granules and notifies the FDD (e.g., by telephone) that a repaired ephemeris file (AM1EPHF) is needed for the time span of the granule that has the gap.

When the repaired ephemeris file has been ingested, EcDpPrAm1FddEphemerisDPREP_PGE reads in the repaired ephemeris data set and the EOS_AM1 ephemeris data in toolkit native format. It produces replacement ephemeris data sets (AM1EPHH0 and AM1EPHN0).

Operationally, Steps 1 and 2 are scheduled daily and run independently of one another. Step 3 is scheduled and run on an as-needed basis.
**Terra DPREP Profiles**

As previously mentioned DPREP processing has data requirements beyond the current two-hour segment. Data from the preceding and following segments are used for performing consistency checks on the ephemeris and attitude data streams when the data streams bridge segment boundaries. However, there is no guarantee that data from the preceding and following segments will always be available. Consequently, four data processing profiles have been developed for each of the three DPREP steps to accommodate the various permutations of data availability:

- Profile 1 is used when data are available from the preceding, current, and following segments.
- Profile 2 is used when data are available from the current and following segments only.
- Profile 3 is used when data are available from the preceding and current segments only.
- Profile 4 is used when data are available from the current segment only.

Profile 1 is used for nominal DPREP operation. It is the profile of each DPREP step that is run on a routine basis.

Profile 2 (no preceding data, but following data is available) initializes DPREP's processing of a given step's ephemeris and/or attitude data stream. When Profile 2 has been run on a data segment, Profile 1 (preceding and following data available) assumes processing responsibility on all data segments thereafter until data dropout or mission end is encountered.

Profile 3 (preceding data available, but no following data) processes the data segment that immediately precedes data dropout and, therefore, terminates processing on a given step's ephemeris and/or attitude data stream.

Profile 4 is used for processing isolated data segments and is not likely to be scheduled operationally.

In the big picture of the mission, DPREP processing on the very first data segment would require running Profile 2. The next data segments would be processed using Profile 1 processes. The very last data segment of the mission would be processed using Profile 3.

**Aqua DPREP**

Aqua DPREP consists of the following processes:

- Aqua Predictive Orbit DPREP (EcDpPrPm1PredFddEphemerisDPREP).
- Aqua Definitive Orbit DPREP (EcDpPrPm1DefFddEphemerisDPREP).
- Aqua Quick Attitude DPREP (EcDpPrPm1PredAttitudeDPREP).
- Aqua Refined Attitude DPREP (EcDpPrPm1DefAttitudeDPREP).
One source of information on the Aqua DPREP PGEs and how to run them is the "HowtoRunPm1DPREP" file installed on the science processor hosts (e.g., e0spg01, g0spg01, l0spg01) in the /usr/ecs/MODE/CUSTOM/data/DPS directory.

Aqua DPREP includes the processing of both orbit and attitude data. Orbit data is received from the FDF in both predictive and definitive orbit data files. Predictive orbit data for a particular day [e.g., day N, a 24-hour period of time based on Coordinated Universal Time (UTC)] would arrive about fourteen to sixteen hours before the end of the day N (or eight to ten hours after the beginning of day N). The amount of time required for the receipt of the predictive orbit data corresponds approximately with the amount of time required for the receipt of the first two-hour chunk of Level 0 science data for day N. Definitive orbit data arrives at the DAAC daily about eight to ten hours after the end of the UTC day. Although the accuracy of Aqua predictive orbit data is less accurate than that of definitive orbit data, predictive orbit data are available earlier and some instrument teams have determined that the accuracy is acceptable for science processing.

Ground-Based Attitude Determination (GBAD) data, which is used in the processing of attitude data, is received from the ECS Mission Operations Segment (EMOS) in "carry-out" files. The GBAD carry-out files (PMCOGBAD) are used in conjunction with predictive orbit data to produce "quick" attitude data. In addition, the GBAD carry-out files are used in conjunction with definitive orbit data to prepare "refined" attitude data.

**Aqua Orbit Processing**

Aqua orbit processing includes reformatting the FDD definitive and predictive ephemeris data sets into toolkit native format and HDF format. In addition, orbit metadata records are generated for the product data sets.

The Aqua Predictive Orbit and Aqua Definitive Orbit DPREP PGEs process Aqua ancillary data sets (i.e., PM1EPHP, predictive ephemeris data and PM1EPHD, definitive ephemeris data respectively) supplied by FDF. The output files/granules of the Aqua DPREP PGEs provide satellite ephemeris data and are subsequently used in the processing of Aqua satellite attitude data.

The Aqua Predictive Orbit DPREP PGE reads in both the current PM1EPHP predictive ephemeris data set for Aqua and a previous PM1EPHND preprocessed Aqua platform definitive ephemeris data set in native format. The outputs of the process are preprocessed Aqua platform predictive ephemeris data sets in native format (PM1EPHNP) and HDF format (PM1EPHHP). A metadata file is produced for each data file.

The Aqua Definitive Orbit DPREP PGE reads in both the current PM1EPHD definitive ephemeris data set for Aqua and a previous PM1EPHND preprocessed Aqua platform definitive ephemeris data set in native format. The outputs of the process are preprocessed Aqua platform definitive ephemeris data sets in native format (PM1EPHND) and HDF format (PM1EPHHD). A metadata file is produced for each data file.
Aqua Attitude Processing

There are two streams of Aqua Attitude DPREP. The difference in the streams is the orbit data used for input. The streams are called Aqua Quick Attitude DPREP and Aqua Refined Attitude DPREP.

Aqua Quick Attitude DPREP inputs are from ESDTs PMCOGBAD [Aqua (PM1) carry-out ground-based attitude determination] and PM1EPHNP (preprocessed Aqua platform predictive ephemeris data in native format). The outputs of Aqua Quick Attitude DPREP are PM1ATTHQ (Aqua quick attitude data in HDF-EOS format) and PM1ATTNQ (Aqua quick attitude data in native format).

Aqua Refined Attitude DPREP inputs are from ESDTs PMCOGBAD and PM1EPHND (preprocessed Aqua platform definitive ephemeris data in native format). The outputs of Aqua Refined Attitude DPREP are PM1ATTHR (Aqua refined attitude data in HDF-EOS format) and PM1ATTNR (Aqua refined attitude data in native format).

Each of the attitude DPREP streams executes twelve times per day at two-hour intervals. The PMCOGBAD data is received at the DAAC approximately every two hours. The predicted orbit data arrives ahead of the PMCOGBAD data and the definitive orbit data arrives after the PMCOGBAD data.

Interpretation of the attitude data depends on the value of the GNCC status word contained in the carry-out file GBAD data. If the value of the GNCC status word is 110 (which specifies "fine pointing" mode) the attitude is good for science processing. Any other value indicates a mode that provides inadequate attitude for science data.

Aqua DPREP Profiles

Because there is no guarantee that data from the preceding and following segments will always be available, two data processing profiles have been developed for each of the Aqua DPREP PGEs to accommodate variations in data availability:

- Profile 1 is used when both current and previous data sets are available.
- Profile 2 is used when the current data set only is available.

Profile 1 is used for nominal Aqua DPREP operation. It is the profile that is run on a routine basis.

Profile 2 (no previous or next data sets) initializes DPREP’s processing of a data stream. When Profile 2 has been run on a data segment, Profile 1 assumes processing responsibility.

ASTER Expedited Data Processing

ECS supports the ingest of ASTER expedited data sets (EDSs) from the EOS Data and Operations System (EDOS) and their immediate availability to selected ASTER Scientists. In addition, ECS supports the production of ASTER Level 1A/1B expedited data products from the
ingested expedited data sets. The higher-level expedited data products are produced at the EDC DAAC.

The overall process for ASTER expedited data processing occurs as follows:

- ASTER expedited data sets are selected and produced.
  - The ASTER instrument control center determines the set of scenes that are to be selected for expedited handling by the ground system.
  - The command loads to the spacecraft are created and uplinked to the spacecraft to identify the data that is subject to expedited handling.
  - The data are separated from the routine downlink data by EDOS, processed into expedited data sets (EDSs) and routed to the GSFC DAAC ahead of the routine production data sets (PDSs).
- ASTER EDS data granules are transferred to the EDC DAAC from the GSFC DAAC via the cross-DAAC transfer mechanism in response to a subscription for the data.
- The ASTER Ground Data System (GDS) produces a daily Observation Schedule File (OSF) (including the ASTER Observation Schedule and the ASTER One-Day Schedule), reflecting the planned operations of the ASTER instrument.
  - The OSF file is sent daily to EDC (outside the context of ECS at the DAAC).
  - The OSF is processed by the ASTER OSF Parser tool at the EDC DAAC, again outside the ECS context.
    - The output of the processing is referred to as Parsed OSF (POSF) data files.
- At the EDC DAAC, the POSF files and associated metadata are inserted into the ECS system via the Science Investigator-Led Processing Systems (SIPS) interface mechanism.
  - The ESDT shortname is AST_POSF.
- The Production Planner uses the Production Request Editor to delete all successfully completed L1AE and L1BE DPRs from PDPS.
- The Production Planner runs the ASTER Expedited Planning Script (i.e., "GetGranTimes.pl").
  - The script queries the SDSRV for the temporal metadata of any AST_EXP and AST_L1AE granules that were inserted to SDSRV since the last time the script was run.
  - The output of the script is a set of candidate DPR start/stop times.
  - The script writes the actual granule times discovered to a log file for further review if needed.
The Production Planner uses the Production Request Editor to generate a set of Production Requests (PRs) for both the L1AE PGE and the L1BE PGE using the DPR start/stop times that were identified using the GetGranTimes.pl script.

- ASTER Expedited Level 1A/1B Processing (L1AE/L1BE) PGEs must have been installed/configured previously at the EDC DAAC. L1AE/L1BE PGEs are configured to run with Collection Time (rather than Insertion Time) production rules.

- If the matching AST_POSF granule has not been inserted, a L1AE PR is still generated with a subscription for AST_POSF.

- The L1BE PGEs being planned are not those corresponding to the L1AE PGEs being planned.
  - The L1AE PGEs must be finished and their DPRs deleted from PDPS prior to planning the corresponding L1BE PGEs.

- The Production Planner uses the Planning Workbench to create a new production plan, merging the newly created L1AE and L1BE PRs with any other PRs from the currently active plan.

- The Production Planner activates the new plan, allowing the L1AE and L1BE DPRs to be released for execution.
  - The DAAC may find it appropriate to assign higher priority to the expedited PGEs.

- Subsequent processing, archiving and access activities are the same as for other data types.

**ASTER On-Demand Processing**

ECS supports authorized ASTER scientists' requests for on-demand high-level production. Authorized ASTER scientists may submit requests that can be divided into several different categories:

- Pre-defined (standard) ASTER high-level products.
- High-level products with nonstandard input parameters.
- Digital Elevation Model (DEM) products.

In any case, the ASTER scientist selects the granule to be used and/or the additional non-standard parameters to generate the high-level product. Then the ASTER scientist submits a request for the system to create the high-level product.
ASTER Standard On-Demand Processing

ECS provides support for ASTER scientists to request processing of ASTER L1A and L1B data to higher information levels via requests for on-demand processing. A request for on-demand processing may require a sequence of algorithms to be run on the specified data. Granules produced by on-demand processing are not permanently archived.

- The ODFRM HTML interface in the Client Subsystem allows authorized scientists/researchers to create ASTER On-Demand Product Requests.
- The EcClOdRequest CGI program in the Client Subsystem...
  - Submits ASTER On-Demand Product Requests to the Planning Subsystem (i.e., PLANG).
  - Interfaces with the Systems Management Subsystem (MSS) to create an order for the product(s) associated with On-Demand Product Requests.
  - Provides the requesting scientist/researcher with an Order ID from MSS.
- The On-Demand Manager (EcPlOdMgr) in PLS manages on-demand orders received from the ODFRM in CLS.
  - On-Demand Manager is also known as the On-Demand Product Request Manager or ODPRM.
  - Upon receipt of an order, the On-Demand Manager determines the order type. The order type can be a standard higher-level product order, a non-standard L1B, or a Digital Elevation Model (DEM).
  - Once the order type is determined, the On-Demand Production Request class verifies that the inputs provided by the ODFRM are valid.
  - The ODPRM periodically checks each order it is tracking to determine if all of the required inputs are available. If all required inputs for a given order are present, the ODPRM marks all of the corresponding DPRs as “completed processing.”
  - If the order is for a standard higher-level product, the ODPRM creates the PRs and DPRs necessary to fill the order. If all input data are available, the production request is added to the list of on-demand requests maintained by the manager, and the DPR(s) are submitted to the Data Processing Subsystem.
- Job Management (EcDpPrJobMgmt) gets the activated on-demand DPRs from PLS.
  - If the on-demand DPRs are waiting for data to arrive or if there are not enough processing resources, Job Management places them in the On-Demand Queue.
  - When all input data are available and there are adequate processing resources, the on-demand DPRs are released to AutoSys for processing.
Execution Management (EcDpPrEM) sends updates to MSS concerning the status of the on-demand jobs.

In Release 6A, ECS provides the additional capability for an ASTER scientist to specify a data processing request (DPR) associated with the submission of an ASTER Data Acquisition Request (DAR). When the Level 1B product specified in the DAR is ingested at the EDC DAAC, the associated DPR is automatically submitted for processing. Attached DPRs are supported for ECS generated products only.

**ASTER On-Demand Non-Standard L1B Production**

ASTER non-standard L1B processing allows authorized ASTER scientists to request an L1B data product to be generated using nonstandard input parameters. The processing of a non-standard L1B product is conducted at the GDS in Japan.

- An ASTER scientist submits a request to ECS using the ODFRM On-Demand Form web page, which is supported by the ECS Client Subsystem (CLS).
  - The web page enables the ASTER scientist to choose from a list of non-standard parameters.
- Upon receipt of an on-demand order, ODPRM determines the order type.
- ODPRM sends the request to GDS via the ASTER gateway.
- The ODPRM creates a dummy production request and DPR along with a placeholder granule.
- Processing of the non-standard L1B product occurs at the GDS in Japan.
- The final product is delivered on tape to the ECS DAAC (i.e., EDC) from the GDS in Japan.
- The final product is archived at the ECS DAAC.
- When the non-standard L1B product is inserted, the Subscription Manager updates the placeholder granule with a Universal Reference (UR) and marks it as accepted.
- The ASTER scientist is notified of final product availability.

**ASTER On-Demand DEM Production**

Requests for ASTER on-demand DEM production are submitted to ECS through the On Demand Form Request Manager (ODFRM) and are forwarded to the ASTER DEM SIPS for processing. The ASTER DEM SIPS is located at EDC in close proximity to the ECS DAAC.

When the ASTER DEM SIPS has created the requested product, ECS ingests it and distributes the product to the requester.

- The ASTER scientist submits a request for ASTER on-demand DEM production to ECS through the ODFRM.
- Upon receipt of an on-demand order, ODPRM determines the order type.
- The ODPRM submits a subscription (to the subscription server) to be notified when the ASTER DEM product has been inserted in the archive.
- The ODPRM sends an e-mail message to the ASTER DEM Operator.
- The ASTER DEM Operator creates the DEM in accordance with the order information.
- When the requested product has been created, the ASTER DEM operator puts a PDR file on the PDR server.
  - The PDR file identifies the location of the ASTER DEM data file and the corresponding metadata file.
- ECS ingests the DEM product using the polling-with-delivery-record interface.
- Upon successful insertion of the DEM product in the archive, the science data server triggers the appropriate "insert event" qualified with the UR of the inserted granule.
- The subscription server queries the subscription database to determine which subscriptions need to be activated (fired).
- The status of the on-demand request is updated to "Processing Complete."
- ODPRM receives subscription notification and sends a "user acquire" request to the science data server to have the on-demand product sent to the requester.
- The DEM product is sent to the requester via the requested medium.
  - The data may be sent via ftp or on a physical medium (e.g., tape).

Reprocessing

The term "reprocessing" has been used in the following two ways in the ECS context:

- A PGE has been run in the past and produced a product and for some unspecified reason (e.g., a file has been corrupted/deleted) the PGE needs to be run again to reproduce the exact same outputs.
- A PGE that was run in the past over a given time period or set of data has been improved (software or static inputs) by the Instrument Team, who would like to have the modified PGE run on the data from the previously processed time period/data set.

The second case is the more important. It leads to the requirement that ECS be able to support a workload for reprocessing that is equal in size to the current or first-time processing load.

PGE changes leading to reprocessing may occur for any of the following reasons:

- An error that must be corrected may have been discovered in the software.
• An improved algorithm may be found based on an improved understanding of the instrument or physical phenomena.

• Static files, such as calibration data, may need to be updated for several reasons including compensation for instrument degradation.

• Changes to software design may be required to incorporate new or different ancillary data files.

• Changes to production rules may be needed.

• Changes to or addition of run-time parameters may be needed.

Note also that changes to an upstream PGE resulting in a new or improved product very likely mean that a downstream PGE has to be modified if for no other reason than to insure that the correct, updated version of the upstream product is picked up for processing.

Operations concepts associated with reprocessing include the following considerations:

• A PGE that is being used for reprocessing represents a new version of a PGE.
  − The new version of the PGE must go through the SSI&T process.
  − PGEs may be updated several times in the course of the mission.

• A reprocessing PGE may specify new static or dynamic inputs rather than new PGE software.
  − The new version of the PGE must go through the SSI&T process and must be identified with a new PGE version tag.
  − The PGE appears to PDPS as a completely new PGE with a distinct profile.

• Output granules from reprocessing PGEs are represented under the existing ESDT used for the previous generation or version of the data granules.

• The distinction between generations of the data can be made through the ReprocessingActual attribute that is associated with each granule.
  − Other mechanisms for distinguishing reprocessing levels include the ProductionDateTime and PGEVersion attributes.
  − The instrument team associated with the PGE must supply the value for the ReprocessingActual attribute.

• DPRs specifying the exact same PGE may be scheduled for both reprocessing and routine processing in the same production plan.
  − For example, first-time processing may have been carried out for the time period from Day 1 to Day N, at which point an improved PGE is introduced.
  − The improved PGE is used for processing from Day N+1 forward, and is also used concurrently in reprocessing from Day 1 to Day N.
For Release 6A it is expected that in a typical planning session the Production Planner will plan time ranges for reprocessing that are comparable in extent with the routine processing.

- For example, for routine processing the Production Planner will plan the processing for the data acquired during the most recent 24-hour period.
- For reprocessing during the Release 6A period, the Production Planner will plan the processing for the next 24-hour period from the time span of data that needs to be reprocessed.
- During later phases of the mission (e.g., Launch + 24 months), the operator might plan the next 48-hour period from the time span of data that needs to be reprocessed.

DPRs created via planning are organized and managed in separate queues for processing and reprocessing.

- A fixed number of processing "slots" are reserved for:
  - On-Demand processing.
  - Routine processing.
  - Reprocessing.
- DPRs are dispatched for processing from either queue against the appropriate slot when the slot becomes available, i.e., as a job of that slot's type finishes and the input data become available.
- Operations personnel can configure the number of slots of each type.
- Operations personnel can change the number of slots of each type (and as a result the total number of concurrent processing slots) at run time.
- Operations personnel have to change the number of slots of each type; there is no dynamic slot allocation (e.g., based upon unused slots for some period of time).

**Regeneration**

The reason for regenerating granules is to produce replacements for previously generated granules that have been lost or corrupted due to failure in the ECS archive. The overall process involves the following general operations:

- Retrieval of the Production History files (PH) for lost granules to determine parameters for the generation of replacement granules.
- Creating Production Requests for the generation of replacement granules.
• Creating and activating a Production Plan that includes the Production Requests for
  the generation of replacement granules.

• Preparing (if applicable) a “PDPS Residual Granules List,” which identifies granules
  that either cannot or should not be regenerated at the DAAC.
  
  − Some granules do need not be reproduced; e.g., if there is a more recent version
    of the product available.

The regeneration process is initiated when the Production Planner receives a list of “Granules for
PDPS Re-Generation.” The list contains information about the granules to be regenerated and
Universal References (URs) for the associated Production History tar files. The list is the
product of a Science Data Server (SDSRV) procedure concerning SDSRV Retrieval of Granule
Production History Metadata.

The following considerations apply to the regeneration of granules in response to the loss of files
from the archive:

• When regenerating lost granules, all outputs of the PGE [not just those equivalent to
  the lost granule(s)] are to be produced and archived.

• There is no guarantee that when a PGE is re-run it will use the same inputs as were
  used during the original execution of the PGE; consequently, the output may be
  different from the original granule(s).
  
  − The variability of: Optional/Alternate inputs, Metadata Checks, Metadata Query
    and other production rules affects PGE output.

  − It is possible that at the time of the original run of the PGE, certain
    optional/alternate inputs were not available, which became available later.
    During the re-run of the PGE use of those additional or other optional inputs
    cannot be avoided. However, it can be assumed that an equivalent or better
    product than the original will be produced as a result.

• PDPS maintains a minimal amount of granule-level versioning. By design, only the
  latest version of the granule is used.
  
  − If the PGE to be re-run uses inputs that have more than one granule-level
    version, PDPS uses only the latest version of those inputs.

  − However, if references to those granules have been deleted from the PDPS
    database (a delete script, which runs periodically, cleans up unused database
    entries), PDPS chooses the first one returned from SDSRV. SDSRV does not
    guarantee any sort of ordering in this case but PDPS selects the latest granule
    from those returned.
• At Production Request time, the default values for metadata checks can be overridden. The new values used are stored in the PDPS database but not in the Production History. If at the time a PGE is re-run the references to the PGE have been deleted from PDPS database, the default metadata checks are used.
  – It is possible that default metadata check values would cause the DPR not to be run; e.g., if the metadata checks are more restrictive than those used in the original run.
  – If changes to metadata checks were required in order to get DPRs to run originally, it is assumed that the values were saved as part of the PGE profile.

• For reasons of production timing or updated QA values, during regeneration a PGE subject to a metadata query could have input which is different from that used in the original processing.
  – The assumption is that regeneration will result in a better product.

• Other production rules (e.g., spatial query) could make it impossible to reproduce identical granules.

• If a PGE (PGE name, version and profile) has to support lost granule regeneration, the PGE should not be deleted from the PDPS database.
  – In the SSIT Operational Metadata GUI, the delete flag for the PGE should not be checked.

The procedure for Regenerating Granules in Response to Loss of Files from the Archive is described in a subsequent section of this lesson.
Launching the Production Request Editor

The following software applications are associated with the Production Request Editor:

- Production Request Editor.
- Subscription Manager.
- Sybase ASE Server for the PDPS database.

Access to the Production Planning and Processing tools is gained through the use of UNIX commands.

Launching Production Request Editor applications starts with the assumption that the applicable servers are running and the Production Planner has logged in to the ECS system.

Launching the Production Request Editor

NOTE: Commands in Steps 1 through 10 are typed at a UNIX system prompt.

1. Type `setenv DISPLAY clientname:0.0` then press the Return/Enter key.
   - Use either the X terminal/workstation IP address or the machine-name for the `clientname`.
   - When using secure shell, the DISPLAY variable is set just once, before logging in to remote hosts. If it were to be reset after logging in to a remote host, the security features would be compromised.

2. Start the log-in to the Planning/Management Workstation by typing `/tools/bin/ssh hostname` (e.g., `e0pls03`, `g0pls01`, or `l0pls02`) in the new window then press the Return/Enter key.
   - If you receive the message, Host key not found from the list of known hosts. Are you sure you want to continue connecting (yes/no)? type yes (“y” alone will not work).
   - If you have previously set up a secure shell passphrase and executed sshremote, a prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with Step 3.
   - If you have not previously set up a secure shell passphrase; go to Step 4.
If a prompt to **Enter passphrase for RSA key '<user@localhost>'** appears, type your **Passphrase** then press the **Return/Enter** key.

- Go to Step 5.

At the **<user@remotehost>'s password:** prompt type your **Password** then press the **Return/Enter** key.

Type **dce_login** then press the **Return/Enter** key.

At the **Enter Principal Name:** prompt type your **DCE UserID** then press the **Return/Enter** key.

At the **Enter Password:** prompt type your **DCE Password** then press the **Return/Enter** key.

Type **setenv ECS_HOME /usr/ecs/** then press the **Return/Enter** key.

- When logging in as a system user (e.g., cmshared), the ECS_HOME variable may be set automatically so it may not be necessary to perform this step.

Type **cd /usr/ecs/MODE/CUSTOM/utilities** then press **Return/Enter**.

- Change directory to the directory containing the production planning startup scripts (e.g., EcPlPRE_IFStart).

- The **MODE** will most likely be one of the following operating modes:
  - OPS (for normal operation).
  - TS1 (for Science Software Integration and Test (SSI&T)).
  - TS2 (new version checkout).

- Note that the separate subdirectories under /usr/ecs apply to (describe) different operating modes.

Type **EcPlPRE_IFStart MODE** then press **Return/Enter** to launch the **Production Request Editor** GUI.

- The **Production Request Editor** graphical user interface (GUI) introductory window (Figure 16) is displayed.
Figure 16. Production Request Editor Introductory GUI
This page intentionally left blank.
Creating/Updating/Deleting a Production Request

Creating a New Production Request

The new Production Request process begins when the Production Planner starts the Production Request Editor graphical user interface (GUI) from a UNIX prompt. The Production Planner enters the Request Definition, PGE parameters, duration, production rule related information, and comments for the new Production Request.

Before creating the new PR the Production Planner must be prepared to provide the following types of information:

- Name of the PR.
- Priority of the PR.
- PGE to be used in processing the PR.
- Start Date.
- Start Time.
- End Date.
- End Time.
- Beginning orbit (if orbit-based).
- Ending orbit (if orbit-based).
- Production rules that affect the PGE and applicable values to be entered (if any).
- Comments (if applicable).

The procedure for creating a new production request starts with the assumption that all applicable servers and the Production Request Editor GUI are currently running and the Production Request Editor Introductory GUI (Figure 16) is being displayed.

Creating a New Production Request

1. Click on the PR Edit tab.
   - The PR Edit GUI (Figure 17) is displayed.
Figure 17. PR Edit GUI
2 Click and hold the **PR Type** option button to display a menu of types of production requests, move the mouse cursor to the desired selection (highlighting it), then release the mouse button.

- The following production request types are listed:
  - **Routine**.
  - **On-Demand** [not currently available for selection].
  - **Reprocessing**.

3 Click and hold the **User Type** option button to display a menu of types of users, move the mouse cursor to the desired selection (highlighting it), then release the mouse button.

- The following user types are listed:
  - **Operator**.
  - **DAAC Manager**.
  - **Scientist**.
  - **Researcher**.

**NOTE:** The **PR Name** and **Origination Date** fields will be filled automatically when the Production Request is saved at the end of the procedure. (You do not need to fill in these fields.)

4 Type the identification of the person creating the production request in the **Originator** field.

- Either UserID or actual name of a person may be used, depending on DAAC policy (if applicable).

5 Type the priority for the PR in the **Priority** field.

- Enter a number in the range of one (1) to ten (10).
  - One (1) has the highest priority; ten (10) has the lowest priority.

- The **Priority** field specifies the Production Request Editor priority to be included in the Data Processing Request(s) that result(s) from the Production Request.

- The Production Request Editor **Priority** is subsequently weighted according to the value specified in the Production Strategy selected from the Planning Workbench when a Production Plan is created using the Production Request.

6 Click on the **PGE...** button.

- The **PGE Selection** GUI (Figure 18) is displayed.
<table>
<thead>
<tr>
<th>PGE Name</th>
<th>PGE Version</th>
<th>Profile Id</th>
<th>Satellite Name</th>
<th>Instrument Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACT</td>
<td>OnDemand</td>
<td>1</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>ACT</td>
<td>OnDemand</td>
<td>2</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>ACT</td>
<td>OnDemand</td>
<td>3</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>ACT</td>
<td>OnDemand</td>
<td>4</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>ACT</td>
<td>syn1</td>
<td>1</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>ACVS</td>
<td>OnDemand</td>
<td>1</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>ACVS</td>
<td>OnDemand</td>
<td>2</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>ACVS</td>
<td>OnDemand</td>
<td>3</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>ACVS</td>
<td>OnDemand</td>
<td>4</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>AM1Eph</td>
<td>30101</td>
<td>1</td>
<td>AM1</td>
<td>All</td>
</tr>
<tr>
<td>AM1Eph</td>
<td>30101</td>
<td>2</td>
<td>AM1</td>
<td>All</td>
</tr>
<tr>
<td>BT5</td>
<td>OnDemand</td>
<td>1</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>BT5</td>
<td>syn1</td>
<td>1</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>DSTS5</td>
<td>OnDemand</td>
<td>1</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>DST5D</td>
<td>OnDemand</td>
<td>1</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>DSTVD</td>
<td>OnDemand</td>
<td>1</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>ETS</td>
<td>OnDemand</td>
<td>1</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>ETS</td>
<td>OnDemand</td>
<td>2</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>ETS</td>
<td>OnDemand</td>
<td>3</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>ETS</td>
<td>OnDemand</td>
<td>4</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>ETS</td>
<td>syn1</td>
<td>1</td>
<td>AM1</td>
<td>ASTER</td>
</tr>
<tr>
<td>FddAtt</td>
<td>30101</td>
<td>1</td>
<td>AM1</td>
<td>All</td>
</tr>
<tr>
<td>FddAtt</td>
<td>30101</td>
<td>2</td>
<td>AM1</td>
<td>All</td>
</tr>
<tr>
<td>MISRLIKE</td>
<td>syn1</td>
<td>1</td>
<td>AM1</td>
<td>MISR</td>
</tr>
<tr>
<td>MISRLIKE</td>
<td>syn1</td>
<td>2</td>
<td>AM1</td>
<td>MISR</td>
</tr>
<tr>
<td>MODPGE01</td>
<td>syn1</td>
<td>1</td>
<td>AM1</td>
<td>MODIS</td>
</tr>
<tr>
<td>MODPGE02</td>
<td>syn1</td>
<td>1</td>
<td>EOSAM1</td>
<td>MODIS</td>
</tr>
<tr>
<td>MODPGE01</td>
<td>syn1</td>
<td>1</td>
<td>AM1</td>
<td>MODIS</td>
</tr>
<tr>
<td>MODPGE02</td>
<td>syn1</td>
<td>1</td>
<td>EOSAM1</td>
<td>MODIS</td>
</tr>
<tr>
<td>MODPGE03</td>
<td>syn1</td>
<td>1</td>
<td>EOSAM1</td>
<td>MODIS</td>
</tr>
</tbody>
</table>

*Figure 18. PGE Selection GUI*
Select the desired PGE from the list by clicking on the appropriate row in the table.

- The PGE list is scrollable. (If there are items on the list in addition to those currently visible in the window, the additional items can be viewed by clicking on the arrows associated with the scrollbars.)

Click on the OK button.

- The PR Edit GUI page (Figure 17) is displayed. The following fields are automatically filled in:
  - Satellite Name.
  - Instrument Name.
  - PGE Name.
  - PGE Version.
  - Profile ID.

Click on the PGE Parameters… button.

- The PGE Parameter Mappings GUI page (Figure 19) is displayed.
- The PGE Parameter Mappings GUI has a table that lists the following information:
  - Parameter Name.
  - Logical Id.
  - Default Value.
  - Override Value.
  - Description.

- The PGE parameters (if any) listed in the table are the parameters relevant to the particular PGE. (Different PGEs may have different parameters.) The parameters and their default values are defined during the Science Software Integration and Test (SSI&T) process. They are included with the PGE information stored in the PDPS database. The Production Request Editor retrieves the parameter information from the database.

If any PGE parameter(s) should be changed, first select (highlight) a parameter to be changed by clicking on the corresponding row in the list of parameters.

- The parameter row is highlighted.
- If you do not change the parameters, the values in the Default column will be used.
### Figure 19. PGE Parameter Mappings GUI

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Logical Id Def</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spacecraft Name</td>
<td>950 EOS</td>
</tr>
<tr>
<td>AlternateInputOne</td>
<td>970 0</td>
</tr>
<tr>
<td>AlternateInputTwo</td>
<td>980 0</td>
</tr>
<tr>
<td>PGE Version</td>
<td>990 3014</td>
</tr>
<tr>
<td>Profile ID</td>
<td>999 1</td>
</tr>
<tr>
<td>Toolkit Format Attitude Data Logical ID</td>
<td>1255 100</td>
</tr>
<tr>
<td>Toolkit Format Ephemeris Data Logical ID</td>
<td>1256 115</td>
</tr>
<tr>
<td>Maximum QA Check Window Size (number of records)</td>
<td>5000 75</td>
</tr>
<tr>
<td>Minimum QA Check Window Size (number of records)</td>
<td>5001 23</td>
</tr>
<tr>
<td>Position Vector Yellow Limit (st dev or absolute)</td>
<td>5004 8.6</td>
</tr>
<tr>
<td>Position Vector Red Limit (st dev or absolute)</td>
<td>5005 15.4</td>
</tr>
<tr>
<td>Velocity Vector Yellow Limit (st dev or absolute)</td>
<td>5006 8.6</td>
</tr>
<tr>
<td>Velocity Vector Red Limit (st dev or absolute)</td>
<td>5007 15.4</td>
</tr>
<tr>
<td>Ephemeris Long Gap Threshold (number of records)</td>
<td>5008 60</td>
</tr>
<tr>
<td>Attitude Long Gap Threshold (number of records)</td>
<td>5009 1</td>
</tr>
<tr>
<td>Limits Threshold Unit; 0 = st dev, 1 = absolute</td>
<td>5025 0</td>
</tr>
<tr>
<td>Ephemeris QA Uncertainty (st dev)</td>
<td>5026 0.0</td>
</tr>
<tr>
<td>Generate Attitude Data; 0 = FALSE, else TRUE</td>
<td>5028 1</td>
</tr>
<tr>
<td>Maximum S/C Distance from ECI center (meters)</td>
<td>5030 738</td>
</tr>
<tr>
<td>Minimum S/C Distance from ECI center (meters)</td>
<td>5031 650</td>
</tr>
<tr>
<td>Maximum S/C Velocity about ECI center (meters/sec)</td>
<td>5032 830</td>
</tr>
<tr>
<td>Minimum S/C Velocity about ECI center (meters/sec)</td>
<td>5033 683</td>
</tr>
<tr>
<td>Ignore replacement request; 0 = FALSE, else TRUE</td>
<td>5038 0</td>
</tr>
<tr>
<td>Euler Angle Order, 1st angle; 1 - X, 2 - Y, 3 - Z</td>
<td>5039 3</td>
</tr>
<tr>
<td>Euler Angle Order, 2nd angle; 1 - X, 2 - Y, 3 - Z</td>
<td>5040 1</td>
</tr>
<tr>
<td>Euler Angle Order, 3rd angle; 1 - X, 2 - Y, 3 - Z</td>
<td>5041 2</td>
</tr>
<tr>
<td>Expected Data Interval (seconds)</td>
<td>5050 1.0</td>
</tr>
<tr>
<td>Maximum Orbital Period (seconds)</td>
<td>5053 642</td>
</tr>
<tr>
<td>Minimum Orbital Period (seconds)</td>
<td>5054 525</td>
</tr>
</tbody>
</table>
• Modify parameter values when and as directed by the customer (e.g., MODIS) only.
  – The SCF will provide notification if PGE parameters other than the default values should be used.

• The PGE parameter mappings list is scrollable.

11 Type the desired value in the **Override Value** field.

12 Click on the **Apply** button at the bottom of the **PGE Parameter Mappings** window.
  • The value in the **Override Value** column is updated.

13 If any other parameter is to be changed, repeat Steps 10 through 12.

14 Click on the **OK** button at the bottom left of the **PGE Parameter Mappings** window to approve the changes and dismiss the window.
  • The **Production Request - PR Edit** GUI (Figure 17) is displayed.

15 If the PGE is subject to a metadata-based production rule and the value(s) to be checked need(s) to be changed, click on the **Metadata Checks**… button.
  • If the **Metadata Checks**… button has been selected, perform Steps 16 through 20 as applicable; otherwise go to Step 21.
  • The **MetadataChecks** GUI page (Figure 20) is displayed.
  • The **MetadataChecks** GUI has an **InputDataType** window that lists input data types.
  • In addition, the **MetadataChecks** GUI has a metadata checks (**MetaDataField-Operator-Value-Type**) window in which there is a table that lists the following information concerning each metadata check:
    – **MetaDataField**.
    – **Operator**.
    – **Value**.
    – **Type**.
  • Initial values for metadata checks are entered during SSI&T; however, it is possible to modify the values using the **MetadataChecks** GUI when creating a production request.

16 If it is necessary to change any value(s) for metadata checks, first select (highlight) an input data type with a value to be changed by clicking on the corresponding row in the **InputDataType** window.
  • The input data type row is highlighted.
Figure 20. MetadataChecks GUI
The metadata check information for the highlighted input data type is displayed in the **MetaDataField-Operator-Value-Type** window.

Select (highlight) a metadata field with a comparison value to be changed by clicking on the corresponding row in the **MetaDataField-Operator-Value-Type** window.

- The metadata field row is highlighted in the **MetaDataField-Operator-Value-Type** window.
- The identity of the metadata field is displayed in the **MetaDataField** window.

Type the new value for the metadata check in the **Value** field.

Click on the appropriate button from the following selections:

- **OK** - to approve the new value and dismiss the **MetadataChecks** GUI.
  - The **Production Request - PR Edit** GUI (Figure 17) is displayed.
  - Go to Step 21.

- **Apply** - to approve the new value without dismissing the **MetadataChecks** GUI.
  - Go to Step 20.

- **Cancel** - to return to the **Production Request - PR Edit** GUI without saving the new value.
  - The **Production Request - PR Edit** GUI (Figure 17) is displayed.
  - Go to Step 21.

If any additional value(s) to be checked need to be changed, repeat Steps 16 through 19 as necessary.

If the PGE is subject to the Alternate Inputs Production Rule and the timer settings or the order of alternate inputs need to be changed, click on the **Alternate Input Values...** button.

- If the **Alternate Input Values...** button has been selected, perform Steps 22 through 27 as applicable; otherwise go to Step 28.
- The **AlternateInputValues** GUI page (Figure 21) is displayed.
- The **AlternateInputValues** GUI has an **AlternateListName** window that lists the applicable alternate inputs.
- In addition, the **AlternateInputValues** GUI has an alternate input (**Order-DataType-LogicalID-Timer**) window in which there is a table that lists the following information concerning each alternate input:
  - **Order.**
Figure 21. AlternateInputValues GUI
- **DataType.**
- **LogicalID.**
- **Timer.**

- The initial set-up for alternate inputs is entered during SSI&T; however, it is possible to modify the set-up using the **AlternateInputValues** GUI when creating a production request.

22 If it is necessary to change timer settings or the order of alternate inputs, first select (highlight) an alternate input to be changed by clicking on the corresponding row in the **AlternateListName** window.

- The alternate input row is highlighted.
- Information concerning the highlighted alternate input is displayed in the **Order-DataType-LogicalID-Timer** window.

23 Select (highlight) an alternate input with timer settings or the order of alternate inputs to be changed by clicking on the corresponding row in the **Order-DataType-LogicalID-Timer** window.

- The alternate input row is highlighted in the **Order-DataType-LogicalID-Timer** window.
- The data type of the alternate input is displayed in the **DataType** field.

24 If it is necessary to change the order of alternate inputs, click on the up/down arrow buttons adjacent to the **Order-DataType-LogicalID-Timer** window as necessary until the highlighted alternate input has the proper order listed in the **Order** column of the window.

- If necessary, repeat Steps 23 and 24 to change the order of additional alternate inputs.

25 If the timer setting for an alternate input is to be modified, verify that the alternate input with the timer setting to be changed has been highlighted then type the new timer setting in the **Timer** fields.

- Another method of changing timer settings (other than typing the numbers) is to click in each of the timer fields in turn and click on the up/down buttons adjacent to the **Timer** fields until the correct time is indicated.

26 Click on the appropriate button from the following selections:

- **OK** - to approve the new alternate input setting(s) and dismiss the **AlternateInputValues** GUI.
  - The **Production Request - PR Edit** GUI (Figure 17) is displayed.
  - Go to Step 28.
• **Apply** - to approve the new alternate input setting(s) without dismissing the AlternateInputValues GUI.
  
  – Go to Step 27.

• **Cancel** - to return to the Production Request - PR Edit GUI without saving the new alternate input setting(s).
  
  – The Production Request - PR Edit GUI (Figure 17) is displayed.
  
  – Go to Step 28.

27 If any additional alternate input setting(s) need to be changed, repeat Steps 21 through 26 as necessary.

28 Click on either the Collection Time or Insertion Time button (as applicable) if data are to be processed on the basis of time (rather than orbit).

• Normally the Collection Time (time when the data were collected by the instrument on the satellite) is used for specifying what data are to be processed.

• The Insertion Time option is available primarily for ASTER processing to allow the generation of DPRs for all data contained on an ASTER tape received from the ASTER Ground Data System (GDS).

29 Click on either the UTC Time (Coordinated Universal Time) button or the Orbit button, depending on whether data to be processed is specified by time or orbit.

• If UTC Time is selected, perform Steps 30 and 31.

• If Orbit is selected go to Step 32.

30 Type the desired data start date and time (in MM/DD/YYYY hh:mm:ss format) in the Begin fields.

• As data are typed in each field the cursor automatically advances to the next field.

• Another method of entering date and time (other than typing the numbers) is to click in each of the date/time fields in turn and click on the up/down buttons adjacent to the date/time fields until the correct date/time is indicated.

31 Type the desired data end date and time (in MM/DD/YYYY hh:mm:ss format) in the End fields.

32 If the Orbital Processing Production Rule applies, type the number of the first orbit of data to be processed in the From field.

33 If the Orbital Processing Production Rule applies, type the number of the last orbit of data to be processed in the To field.
Click on the appropriate button from the following selections under **PGE Chain Head**:

- **Yes** - to designate the DPRs resulting from the PR as chain heads.
  - If designated as chain heads, the DPRs produce outputs that are to be used as inputs to downstream DPRs.

- **No** - to indicate that the DPRs resulting from the PR are not chain heads.

If the PGE specified in the PR is at the head of a chain and should be run on a particular virtual computer, click and hold the button adjacent to the **Computer** field to display a menu of available virtual computers, move the mouse cursor to the desired selection (highlighting it), then release the mouse button.

- If a particular virtual computer is selected, each DPR will be scheduled to run on the corresponding machine.

- If no virtual computer is selected, the system will try to schedule the DPRs on the machine where the bulk of the DPR's accepted inputs (both static and dynamic inputs) are already staged.

If Intermittent Activation applies, type the number of DPRs to skip in the **Skip** field.

- If Intermittent Activation applies, perform Steps 37 and 38.

- If Intermittent Activation does not apply, go to Step 39.

Type the number of DPRs to keep in the **Keep** field.

If the first DPR is to be skipped, click on the **SkipFirst** button.

Type any relevant comments in the **Comments** field.

Select **Save As** from the **File** pull-down menu (**File → Save As**).

- The **File Selection** window (Figure 22) is displayed.

Type a file name for the production request in the **Selection** field.

Click on the **OK** button to save the production request.

- Eventually a **Production Request Explosion into DPRs** dialogue box (similar to Figure 23) is displayed.
  - It may take several minutes or even hours for the process to complete.
  - If the explosion into DPRs is successful, the production request and corresponding DPR(s) are saved in the PDPS database and the Production Request **PR Name** and **Origination Date** fields are automatically updated.
Figure 22. Production Request Editor File Selection Window
Figure 23. Production Request Explosion into DPRs Dialogue Box

- If the explosion into DPRs is not successful, the dialogue box contains a message to that effect and it will be necessary to troubleshoot the problem. (This lesson contains a section on troubleshooting production planning problems.)

43 Click on the OK button to dismiss the Production Request Explosion into DPRs dialogue box.
  - The dialogue box is dismissed.

44 Select File → New to clear the entries on the Production Request Editor GUI.
  - Return to Step 2 to create another new PR.

45 To start the process of exiting from the Production Request Editor GUI select File → Exit from the pull-down menu.
  - A Do you really want to exit? dialogue box is displayed.

46 Click on the appropriate button from the following selections:
  - OK - to exit from the Production Request Editor GUI.
    - The Production Request - PR Edit GUI (Figure 17) is dismissed.
  - Cancel - to return to the Production Request - PR Edit GUI.

It is also possible to create a new PR by editing or modifying an existing PR and renaming it. This is particularly quick and useful if there are only minor differences between the existing PR and the new one.
Editing or Modifying a Production Request

Editing or modifying a Production Request is typically a means of using an existing Production Request as a template for a new request.

- **Examples:**
  - A Production Request for processing Tuesday’s data using PGE A may be used as a template for a Production Request for processing Wednesday’s data using PGE A.
    - Only the beginning and ending dates would have to be changed.
  - A Production Request for processing Tuesday’s data using PGE A may be used as a template for a Production Request for processing Tuesday’s data using PGE B.
    - Only the PGE would have to be changed.
- Whenever a Production Request is successfully saved, DPRs are generated.
  - The DPRs are consistent with the Production Request’s specifications.
- It is not possible to change existing DPRs so saving a modified Production Request results in the generation of new DPRs.

To edit/modify a new Production Request, execute the procedure steps that follow. Perform only those steps of the procedure that are applicable to the changes you want to make. You do not have to go through all of the fields in the PR to successfully modify it. However, you must save the modified PR (Steps 38 - 40) to make the changes effective.

The procedure for editing/modifying a production request starts with the assumption that all applicable servers and the **Production Request Editor** GUI are currently running and the **Production Request Editor** Introductory GUI (Figure 16) is being displayed.

**Editing/Modifying a Production Request**

1. Click on the **PR Edit** tab.
   - The **PR Edit** GUI (Figure 17) is displayed.
2. Select **File → Open** from the pull-down menu to display a list of Production Requests from which to select the PR to be edited/modified.
   - The **File Selection** window (Figure 22) is displayed.
3. Select (highlight) the PR to be edited/modified by clicking on the corresponding PR name in the list of PRs.
   - The selected PR is displayed in the **Selection** field.
4 Click on the OK button.

5 If the type of production request shown on the PR Type option button is not the desired type, click and hold the PR Type option button to display a menu of types of production requests, move the mouse cursor to the desired selection (highlighting it), then release the mouse button.

   • The following production request types are available:
     − Routine.
     − On-Demand [not currently available for selection].
     − Reprocessing.

6 If the type of user shown on the User Type option button is not the desired type, click and hold the User Type option button to display a menu of types of users, move the mouse cursor to the desired selection (highlighting it), then release the mouse button.

   • The following user types are listed:
     − Operator.
     − DAAC Manager.
     − Scientist.
     − Researcher.

NOTE: The PR Name and Origination Date fields will be filled automatically when the Production Request is saved at the end of the procedure. (You do not need to fill in these fields.)

7 If the identification of the person editing/modifying the production request is not already displayed in the Originator field, type it there.

   • Either UserID or actual name of a person may be used, depending on DAAC policy (if applicable).

8 If the PR’s priority is to be changed, type the new priority in the Priority field.

   • Enter a number in the range of one (1) to ten (10).
     − One (1) has the highest priority; ten (10) has the lowest priority.

   • The Priority field specifies the Production Request Editor priority to be included in the Data Processing Request(s) that result(s) from the Production Request.

   • The Production Request Editor Priority is subsequently weighted according to the value specified in the Production Strategy selected from the Planning Workbench when a Production Plan is created using the Production Request.
If the PGE is to be changed, click on the PGE... button.

- The PGE Selection GUI (Figure 18) is displayed.
- Perform Steps 10 and 11 to designate the new PGE.

Select the desired PGE by clicking on the appropriate row in the table.

Click on the OK button.

- The Production Request - PR Edit GUI page (Figure 17) is displayed.
- The following fields are automatically filled:
  - Satellite Name.
  - Instrument Name.
  - PGE Name.
  - PGE Version.
  - Profile ID.

If any PGE parameter(s) should be changed, click on the PGE Parameters... button.

- The PGE Parameter Mappings GUI (Figure 19) is displayed.
- Modify parameter values when and as directed by the customer (e.g., MODIS) only.
  - The SCF will provide notification if PGE parameters other than the default values should be used.
- Perform Steps 13 through 15 to designate the new PGE parameter(s).

Select (highlight) a parameter to be changed by clicking on the corresponding row in the list of parameters.

- The parameter row is highlighted.
- If you do not change the parameters, the values in the Default column will be used.

Type the desired value in the Override Value field.

Click on the Apply button at the bottom of the PGE Parameter Mappings window.

- The value in the Override Value column is updated.

If any other parameter is to be changed, repeat Steps 13 through 15.

Click on the OK button at the bottom left of the PGE Parameter Mappings window to approve the changes and dismiss the window.

- The Production Request - PR Edit GUI (Figure 17) is displayed.
18 If any metadata check value needs to be changed, click on the Metadata Checks…
button.

- The MetadataChecks GUI page (Figure 20) is displayed.
- Perform Steps 19 through 23 to change the metadata check value(s).

19 Select (highlight) an input data type with a value to be changed by clicking on the corresponding row in the InputDataType window.

- The input data type row is highlighted.
- The metadata check information for the highlighted input data type is displayed in the MetaDataField-Operator-Value-Type window.

20 Select (highlight) a metadata field with a comparison value to be changed by clicking on the corresponding row in the MetaDataField-Operator-Value-Type window.

- The metadata field row is highlighted in the MetaDataField-Operator-Value-Type window.
- The identity of the metadata field is displayed in the MetaDataField window.

21 Type the new value for the metadata check in the Value field.

22 Click on the appropriate button from the following selections:

- **OK** - to approve the new value and dismiss the MetadataChecks GUI.
  
  - The Production Request - PR Edit GUI (Figure 17) is displayed.

- **Apply** - to approve the new value without dismissing the MetadataChecks GUI.

- **Cancel** - to return to the Production Request - PR Edit GUI without saving the new value.
  
  - The Production Request - PR Edit GUI (Figure 17) is displayed.

23 Repeat Steps 20 through 22 as necessary to change any additional value(s) to be checked.

24 If any alternate input timer settings or the order of alternate inputs should be changed, click on the Alternate Input Values… button.

- The AlternateInputValues GUI page (Figure 21) is displayed.

- Perform Steps 25 through 30 as applicable to change alternate input timer settings or the order of alternate inputs.

25 Select (highlight) an alternate input to be changed by clicking on the corresponding row in the AlternateListName window.

- The alternate input row is highlighted.
• Information concerning the highlighted alternate input is displayed in the **Order-DataType-LogicalID-Timer** window.

26 Select (highlight) an alternate input with timer settings or the order of alternate inputs to be changed by clicking on the corresponding row in the **Order-DataType-LogicalID-Timer** window.

• The alternate input row is highlighted in the **Order-DataType-LogicalID-Timer** window.

• The data type of the alternate input is displayed in the **DataType** field.

27 To change the order of alternate inputs click on the up/down arrow buttons adjacent to the **Order-DataType-LogicalID-Timer** window as necessary until the highlighted alternate input has the proper order listed in the **Order** column of the window.

• Repeat Steps 26 and 27 as necessary to change the order of additional alternate inputs.

28 To modify the timer setting for an alternate input verify that the alternate input with the timer setting to be changed has been highlighted then type the new timer setting in the **Timer** fields.

29 Click on the appropriate button from the following selections:

• **OK** - to approve the new alternate input setting(s) and dismiss the **AlternateInputValues** GUI.
  
  − The **Production Request - PR Edit** GUI (Figure 17) is displayed.

• **Apply** - to approve the new alternate input setting(s) without dismissing the **AlternateInputValues** GUI.

• **Cancel** - to return to the **Production Request - PR Edit** GUI without saving the new alternate input setting(s).
  
  − The **Production Request - PR Edit** GUI (Figure 17) is displayed.

30 Repeat Steps 23 through 27 as necessary to change any additional alternate input setting(s).

31 If **UTC Time** is to be changed, first click on either the **Collection Time** or **Insertion Time** button (as applicable).

• Normally the **Collection Time** (time when the data were collected by the instrument on the satellite) is used for specifying what data are to be processed.

• The **Insertion Time** option is available primarily for ASTER processing to allow the generation of DPRs for all data contained on an ASTER tape received from the ASTER Ground Data System (GDS).
If UTC Time is to be changed, type the desired data start date and time (in
MM/DD/YYYY hh:mm:ss format) in the Begin fields.

If UTC Time is to be changed, type the desired data end date and time (in
MM/DD/YYYY hh:mm:ss format) in the End fields.

If the start of the Orbit range is to be changed, type the number of the first orbit of data
to be processed in the [Orbit] From field.

If the end of the Orbit range is to be changed, type the number of the last orbit of data to
be processed in the [Orbit] To field.

If the DPRs resulting from the PR are to be designated as chain heads, click on the Yes
button under PGE Chain Head.

If the DPRs resulting from the PR are not to be designated as chain heads, click on the No
button under PGE Chain Head.

If the PGE specified in the PR is at the head of a chain and should be run on a particular
virtual computer, click and hold the button adjacent to the Computer field to display a
menu of available virtual computers, move the mouse cursor to the desired selection
(highlighting it), then release the mouse button.

If the number of DPRs to be skipped is to be changed, type the number of DPRs to skip in the Skip field.

If the number of DPRs to be kept is to be changed, type the number of DPRs to keep in the Keep field.

If the state of the SkipFirst button is to be changed, click on the SkipFirst button.

Type any relevant comments in the Comments field.

Select Save As from the File pull-down menu (File → Save As).

• The File Selection window (Figure 22) is displayed.

Type a file name for the production request in the Selection field.

Click on the OK button to save the production request.

• Eventually a Production Request Explosion into DPRs dialogue box (similar to
Figure 23) is displayed.

Click on the OK button to dismiss the Production Request Explosion into DPRs
dialogue box.

• The dialogue box is dismissed.

Select File → New to clear the entries on the Production Request Editor GUI.

• Return to Step 1 to modify another new PR.
To start the process of exiting from the Production Request Editor GUI select File → Exit from the pull-down menu.

- A Do you really want to exit? dialogue box is displayed.

Click on the appropriate button from the following selections:

- OK - to exit from the Production Request Editor GUI.
  - The Production Request - PR Edit GUI (Figure 17) is dismissed.
- Cancel - to return to the Production Request - PR Edit GUI.

Deleting a Production Request

To delete a Production Request, execute the procedural steps that follow. The procedure starts with the assumption that all applicable servers are currently running and the Production Request Editor Introductory GUI (Figure 16) is being displayed.

Deleting a Production Request

1. Select the list of Production Requests by clicking on the PR List tab.
   - The PR List GUI page (Figure 24) is displayed.
   - A list of Production Requests is displayed.

2. If filtering of the list of Production Requests is desired, click and hold the PR Type option button to display a menu of types of Production Requests, move the mouse cursor to the desired selection (highlighting it), then release the mouse button.
   - The following Production Request types are available:
     - All [default selection].
     - Routine.
     - Reprocessing.
     - OnDemand.
   - A list of Production Requests of the specified type is displayed.

3. Click on the Production Request to be deleted.
   - The Production Request to be deleted is highlighted.

4. Select Edit → Delete.
   - A dialogue box is displayed requesting confirmation of the decision to delete the Production Request.
Figure 24. PR List GUI
5 Select **OK** to delete the Production Request.

- If there are no dependencies among Production Requests, a confirmation dialogue box similar to Figure 25 is displayed.
- If there are dependencies among Production Requests, a “List Of Orphan DPRs” dialogue box similar to Figure 26 is displayed.

![Production Request Deletion Confirmation Dialogue Box](Image)

**Figure 25. Production Request Deletion Confirmation Dialogue Box**

6 Click on the appropriate button from the following selections:

- **OK** - to confirm deletion of the Production Request(s) and dismiss the dialogue box.
  - A deletion completed dialogue box (similar to Figure 27) is displayed.
  - The Production Request(s) is/are deleted.
- **Cancel** - to preserve the Production Request(s) and dismiss the dialogue box.
  - The dialogue box is dismissed.
  - The Production Request(s) is/are not deleted.

7 Select **OK** to dismiss the dialogue box.

- The deletion completed dialogue box is dismissed.

8 To start the process of exiting from the Production Request Editor GUI select **File → Exit** from the pull-down menu.

- A **Do you really want to exit?** dialogue box is displayed.

9 Click on the appropriate button from the following selections:

- **OK** - to exit from the Production Request Editor GUI.
  - The Production Request Editor GUI is dismissed.
Figure 26. Production Request List of Orphan DPRs Dialogue Box

Figure 27. Production Request Deletion Completed Dialogue Box
• Cancel - to return to the Production Request Editor GUI.
Reviewing/Deleting Data Processing Requests

Data Processing Requests
Data Processing Requests (DPRs) are generated automatically by the Planning Subsystem.

- DPR is generated automatically from:
  - a PR (which specifies a PGE).
  - information concerning the PGE acquired during the Science Software Integration and Test (SSI&T) process.
- DPRs are complex, reflecting the complexity of the PGEs.
- DPRs contain information that is used by the Data Processing Subsystem and the AutoSys production scheduling software.

The Production Planner can review DPRs.

- DPRs may provide useful information.
- DPR fields cannot be edited by Operations personnel.
  - Modifications to DPR information would have undesirable side-effects.

Displaying DPR Information
The Production Request Editor can display DPR information in two ways:

- List of all DPRs applicable to a particular Production Request.
- Data concerning an individual DPR.

The following characteristics pertain to the DPR List:

- The DPR list is filtered, so that only DPRs associated with a particular PR are displayed.
- Each line of the DPR List display represents a DPR, i.e., a job that when made part of an active production plan will be run, assuming all data and resource needs have been satisfied.
- For each DPR the list includes the DPR identification, relevant PGE, name of the corresponding PR, data start date and time, etc.
The Production Planner can select a particular DPR and obtain data on that DPR, including the following characteristics:

- **PGE parameters.**
  - Displayed in the same format as the PGE Parameter Mappings GUI (Figure 19) used in creating a PR.

- **UR File Mappings.**
  - Displays the input and output files for a particular DPR on the UR File Mappings GUI (Figure 28)
  - GUI displays one line of information for each file that may be used by or be produced by the PGE, including the following data:
    - Logical ID - The identification (ID) or tag used within the PGE to access the file.
    - Granule ID - The reference used to identify the granule uniquely.
    - Start/Stop Time - The start and stop date and time for the data contained in this file.
    - Availability - Data and time when the data file is expected to be accessible for use in processing.
    - UR (Universal Reference) - The unique identifier for each individual data granule.

The procedure for reviewing data processing requests starts with the assumption that all applicable servers and the Production Request Editor GUI are currently running and the Production Request Editor Introductory GUI (Figure 16) is being displayed.

**Reviewing Data Processing Requests**

1. Select the Data Processing Request List by clicking on the DPR List tab.
   - The DPR List GUI page (Figure 29) is displayed.
   - The table shown on the GUI provides the following information on the DPRs:
     - DPR Id - identification (name) of the DPR.
     - PGE Id - identification of the PGE specified in the DPR.
     - PR Name - name of the PR that led to the creation of the DPR.
     - Tile Id – identification of the applicable tile (does not apply currently).
     - Data Start Time (UTC) - DPR’s start date and time.
     - Data Stop Time (UTC) - DPR’s stop date and time.
Figure 28. UR File Mappings GUI
Figure 29. DPR List GUI
2 If filtering of the list of Production Requests is desired, click and hold the PR Type option button to display a menu of types of Production Requests, move the mouse cursor to the desired selection (highlighting it), then release the mouse button.

- The following Production Request types are available:
  - ALL [default selection].
  - Routine.
  - Reprocessing.
  - OnDemand.

3 To list the DPRs associated with a particular Production Request, first click on the option button associated with the Production Request field.

- An option menu of Production Requests is displayed.

4 Highlight the desired PR in the option menu then click on the Filter button.

- The DPRs for the specified PR only are shown in the DPR List.

- An alternative method of filtering PRs is to type the name of the PR in the Production Request field then click on the Filter button.

5 Identify a DPR to be reviewed from those shown in the list of Data Processing Requests, then click on the DPR View tab.

- The DPR View GUI (Figure 30) is displayed.

6 Select File → Open from the pull-down menu.

- The DPR File Selection window (Figure 31) is displayed.

- The Data Processing Requests associated with the selected PR are listed.

7 Select (highlight) the DPR to be reviewed by clicking on the corresponding DPR name in the list of DPRs.

8 Click on the OK button.

- The DPR View GUI shows the following information concerning the selected DPR:
  - DPR Name.
  - PR Name.
  - Origination Date
  - Originator
  - PGE Id.
Figure 30. DPR View GUI
Figure 31. DPR File Selection Window

- Data Start Time.
- Data Stop Time.
- Predicted Start Time (date and time).
- Actual Start Time (date and time).
- Priority.
- Status.
To obtain information concerning the PGE parameters (of the PGE associated with the DPR), click on the **PGE Parameters...** button.

- The **PGE Parameters** GUI (same format as Figure 19 except there is no Parameter Mapping field) is displayed.

When finished reviewing the PGE parameters, click on the **OK** button to return to the **DPR View** GUI.

- The **DPR View** GUI (Figure 30) is displayed.

Click on the **PGE File Mappings...** button.

- The **UR File Mappings** GUI (Figure 28) is displayed.
- The **UR File Mappings** GUI displays one line of information for each file that may be used by or be produced by the PGE associated with the selected DPR:
  - Logical Id.
  - Granule Id.
  - Start Time (UTC) (date and time).
  - Stop Time (UTC) (date and time).
  - Availability (date and time).
  - UR (granule universal reference).

- The PGE’s input data and output data are displayed in separate areas.

When finished reviewing the **UR File Mappings**, click on the **OK** button to return to the **DPR View** GUI.

- The **DPR View** GUI is displayed.

Review the **Data Start Time** and **Data Stop Time**.

Review the **Request Data and Status** area of the GUI.

- The **DPR View** GUI displays the following information concerning the selected DPR:
  - Predicted Start Time (date and time).
  - Actual Start Time (date and time).
  - Priority.
  - Status.

- Predicted Start Date/Time and Actual Start Date/Time are displayed only if the Production Request has been scheduled.
When finished reviewing information concerning the DPR, repeat Steps 1 through 14 to review additional DPRs.

To start the process of exiting from the Production Request Editor GUI select File → Exit from the pull-down menu.

- A Do you really want to exit? dialogue box is displayed.

Click on the appropriate button from the following selections:

- OK - to exit from the Production Request Editor GUI.
  - The Production Request Editor GUI is dismissed.
- Cancel - to return to the Production Request Editor GUI.

Deleting a Data Processing Request

To delete a DPR, execute the procedure steps that follow. The procedure starts with the assumption that all applicable servers are currently running and the Production Request Editor Introductory GUI (Figure 16) is being displayed.

Deleting a Data Processing Request

1. Select the DPR List by clicking on the DPR List tab.
   - The DPR List GUI page (Figure 29) is displayed.

2. If filtering of the list of Production Requests is desired, click and hold the PR Type option button to display a menu of types of Production Requests, move the mouse cursor to the desired selection (highlighting it), then release the mouse button.
   - The following Production Request types are available:
     - ALL [default selection].
     - Routine.
     - Reprocessing.
     - OnDemand.

3. Click on the Production Request option button.
   - A list of Processing Requests is displayed.

4. Click on the Production Request with which the DPR to be deleted is associated.
   - The Production Request is displayed in the Production Request field.
5 Click on the **Filter** button.

- A list of the DPRs associated with the selected Production Request is displayed.

6 Click on the DPR to be deleted.

- The DPR to be deleted is highlighted.

7 Select **Edit**→**Delete**.

- A DPR deletion confirmation dialogue box (similar to Figure 32) is displayed requesting confirmation of the decision to delete the DPR.

8 Click on the appropriate button from the following selections:

- **OK** - to confirm deletion of the DPR and dismiss the dialogue box.
  - A deletion dialogue box (similar to Figure 33) is displayed.
  - The DPR is deleted.
  - If the DPR was the only DPR in the Production Request, the PR is deleted too.

- **Cancel** - to preserve the DPR and dismiss the dialogue box.
  - The deletion confirmation dialogue box is dismissed.
  - The DPR is not deleted.

9 Select **OK** to dismiss the dialogue box.

- The dialogue box is dismissed.

10 To start the process of exiting from the **Production Request Editor** GUI select **File** ⇒ **Exit** from the pull-down menu.

- A **Do you really want to exit?** dialogue box is displayed.
Deleting or Aborting an On-Demand Processing Request

The Planning Subsystem detects changes in the status of ASTER on-demand processing requests, whether the changes were made by the system or by operations personnel. However, PLS is not able to determine why operations personnel have canceled or aborted a request. Consequently, if it is necessary to cancel or abort an on-demand processing request, notify User Services personnel so they can send an e-mail message to the requester explaining why the request was canceled or aborted.
This page intentionally left blank.
Launching Planning Workbench-Related GUIs

Launching the Production Strategies GUI

The following software applications are associated with the Production Strategies GUI:

- Production Strategies GUI.
- Sybase ASE Server for the PDPS database.

Production Strategies are high-level sets of priorities that the Production Planner makes available to the Planning Workbench for determining the priorities and preferences in the processing of DPRs. The values included in the selected strategy are read by the Planning Workbench when prioritizing the DPRs in a production plan.

Access to the Production Strategies GUI is gained through the use of UNIX commands. Launching the Production Strategies GUI starts with the assumption that the applicable servers are running and the Production Planner has logged in to the ECS system.

Launching the Production Strategies GUI

NOTE: Commands in Steps 1 through 7 are typed at a UNIX system prompt.

1. Type `setenv DISPLAY clientname:0.0` then press the Return/Enter key.
   - Use either the X terminal/workstation IP address or the machine-name for the `clientname`.
   - When using secure shell, the DISPLAY variable is set just once, before logging in to remote hosts. If it were to be reset after logging in to a remote host, the security features would be compromised.

2. Start the log-in to the Planning/Management Workstation by typing `/tools/bin/ssh hostname` (e.g., `e0pls03`, `g0pls01`, or `l0pls02`) in the new window then press the Return/Enter key.
   - If you receive the message, Host key not found from the list of known hosts. Are you sure you want to continue connecting (yes/no)? type yes (“y” alone will not work).
   - If you have previously set up a secure shell passphrase and executed `sshremote`, a prompt to Enter passphrase for RSA key `<user@localhost>` appears; continue with Step 3.
   - If you have not previously set up a secure shell passphrase; go to Step 4.
3 If a prompt to Enter passphrase for RSA key 'user@localhost' appears, type your Passphrase then press the Return/Enter key.

- Go to Step 5.

4 At the <user@remotehost>'s password: prompt type your Password then press the Return/Enter key.

5 Type setenv ECS_HOME /usr/ecs/ then press the Return/Enter key.

- When logging in as a system user (e.g., cmshared), the ECS_HOME variable may be set automatically so it may not be necessary to perform this step.

6 Type cd /usr/ecs/MODE/CUSTOM/utilities then press Return/Enter.

- Change directory to the directory containing the production planning startup scripts (e.g., EcPlPRE_IFStart).

- The MODE will most likely be one of the following operating modes:
  - OPS (for normal operation).
  - TS1 (for SSI&T).
  - TS2 (new version checkout).

- Note that the separate subdirectories under /usr/ecs apply to (describe) different operating modes.

7 Type EcPlProdStratStart MODE then press Return/Enter to launch the Production Strategies GUI.

- The Production Strategies GUI (Figure 34) is displayed.

## Launching Planning Workbench-Related GUIs

The following software applications are associated with the Planning Workbench:

- System Name Server.
- Message Handler.
- Resource Model.
- Planning Workbench.
- Production Timeline.
- Sybase ASE Server for the PDPS database.
Access to the Planning Workbench GUIs is gained through the use of UNIX commands. Launching Planning Workbench-related GUIs starts with the assumption that the applicable servers are running and the Production Planner has logged in to the ECS system.

**Launching Planning Workbench-Related GUIs**

**NOTE:** Commands in Steps 1 through 7 are typed at a UNIX system prompt.

1. Type `setenv DISPLAY clientname:0.0` then press the Return/Enter key.
   - Use either the X terminal/workstation IP address or the machine-name for the *clientname*.
   - When using secure shell, the DISPLAY variable is set just once, before logging in to remote hosts. If it were to be reset after logging in to a remote host, the security features would be compromised.
2 Start the log-in to the Planning/Management Workstation by typing /tools/bin/ssh hostname (e.g., e0pls03, g0pls01, or l0pls02) in the new window then press the Return/Enter key.

• If you receive the message, Host key not found from the list of known hosts. Are you sure you want to continue connecting (yes/no)? type yes (“y” alone will not work).

• If you have previously set up a secure shell passphrase and executed sshremote, a prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with Step 3.

• If you have not previously set up a secure shell passphrase; go to Step 4.

3 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your Passphrase then press the Return/Enter key.

• Go to Step 5.

4 At the <user@remotehost>'s password: prompt type your Password then press the Return/Enter key.

5 Type setenv ECS_HOME /usr/ecs/ then press the Return/Enter key.

• When logging in as a system user (e.g., cmshared), the ECS_HOME variable may be set automatically so it may not be necessary to perform this step.

6 Type cd /usr/ecs/MODE/CUSTOM/utilities then press Return/Enter.

• Change directory to the directory containing the production planning startup scripts (e.g., EcPIPRE_IFStart).

• The MODE will most likely be one of the following operating modes:
  – OPS (for normal operation).
  – TS1 (for SSI&T).
  – TS2 (new version checkout).

• Note that the separate subdirectories under /usr/ecs apply to (describe) different operating modes.

NOTE: The selection of a start-up script for launching the Planning Workbench GUI depends on the number of DPRs in the PDPS database. If the number is very high (~4000), the EcPlSomeStart script is used to start the underlying processes (Message Handler, System Name Server, and Resource Model). Then additional scripts are used to start the Planning Workbench GUI and the Production Planning Master Timeline GUI. If the number of DPRs in the PDPS database is not very high (less than about 4000), the EcPlAllStart script is used to start the
underlying processes, Planning Workbench GUI and Production Planning Master Timeline GUI.

If the number of DPRs in the PDPS database is not large (less than about 4000), type `EcPIAllStart MODE ApplicationID` then press `Return/Enter` to launch the Message Handler, System Name Server, Resource Model, Planning Workbench GUI, and Production Planning Master Timeline GUI.

- The **Message Handler** GUI (Figure 35) is displayed.
- Eventually, the **Planning Workbench** GUI (Figure 36) is displayed. Then the **Production Planning Master Timeline** GUI (Figure 37) is displayed.
  - The **Production Planning Master Timeline** GUI usually occupies the entire screen when it is initially displayed.
- The **Message Handler** GUI displays messages of the following types:
  - Engineering.
  - Information.
  - Warning.
  - Internal.
- The **System Name Server** (SNS) handles interprocess communication.
- The **Resource Model** is an underlying resource data coordinator for the planning software.
Figure 36. Planning Workbench GUI
- The **ApplicationID** is any number from 1 to 5. It identifies the message service in use so messages can be directed to the proper message handler GUI. Consequently, it is a good idea to use the same ApplicationID (also called MSGSRV_ID) consistently during a planning session.

- Go to Step 11.

8 If the number of DPRs in the database is large (~4000 or more), type **EcPlsSomeStart MODE ApplicationID** then press **Return/Enter** to launch the Message Handler, System Name Server, and Resource Model.

- The **Message Handler** GUI (Figure 35) is displayed.

- Wait until the Resource Model is completely up before proceeding with starting the **Planning Workbench** GUI.
If the number of DPRs in the database is large (~4000 or more), type `EcPlWbStart MODE ApplicationID` then press `Return/Enter` to launch the Planning Workbench GUI.

- The Planning Workbench GUI (Figure 36) is displayed.

If the number of DPRs in the database is large (~4000 or more), type `EcPlTlStart MODE ApplicationID` then press `Return/Enter` to launch the Production Planning Master Timeline GUI.

- The Production Planning Master Timeline GUI (Figure 37) is displayed.

If the Production Planning Master Timeline GUI is occupying the whole screen, either click on the “minimize” icon in the upper right corner of the GUI or adjust the window size and the view of the timeline as necessary using the mouse.

- Grab a corner of the timeline window with the cursor and resize the window as desired.
Creating a New Production Plan

Production Plan

The planning process involves the Production Planner preparing monthly and weekly production plans as well as a daily production schedule from the most current weekly plan. Much of the planning occurs off line; however, the Production Planner uses the Planning Workbench GUI to create and activate the current or active plan.

Each DAAC has created its own policy and process for creating, reviewing, publishing and distributing production plans. Daily plans may be posted on a Worldwide Web page or distributed in hardcopy form or via e-mail.

The most important factor in production planning is meeting the customers' needs. The ultimate customers are the Science Computing Facilities that have provided science software to ECS to be run on a routine basis. They expect timely generation and archiving of products using their science software. However, there may be other considerations as well, so the Production Planner typically has to consider the following types of factors when creating production plans:

- Keeping up to date with routine processing of products using the SCFs' science software.
- Performing reprocessing of data using new versions of science software.
- Regenerating products (as needed) that have been damaged or lost from the archive.
- Taking into account the effects of ASTER on-demand processing, which circumvents the normal planning process but uses processing resources.

Although production planning varies from DAAC to DAAC, the following guidelines are generally applicable:

- Monthly plans.
  - Developed for the coming month and one or two months in advance.
  - Produced, reviewed, updated, published and distributed approximately two weeks before the beginning of the month.
  - Plan for the coming month is used to establish a baseline against which production targets can be measured.

- Weekly plans.
  - Produced, reviewed, updated, published and distributed approximately five days before the beginning of the coming week.
• Used to produce a baseline for comparison of planned vs. actual production results.

• Daily plan or schedule.
  – Produced each day for the next processing day.
  – Developed from the current weekly plan, adjusted to reflect the actual processing accomplished and the actual resources available at the time the daily schedule is generated.

• Current (active) plan.
  – Activated as needed (one or more plans a day, depending on circumstances) using the Planning Workbench.
  – Implements the daily plan (or some portion of the daily plan).

During normal processing, when reasonably accurate predictions of the processing time for the PGEs are available, the processing schedule should result in a reasonably accurate prediction of when data products will be generated. However, during abnormal situations (e.g., hardware or software failure), what is actually accomplished could depart significantly from the plan. In addition, a daily plan may be divided into several segments to be activated separately. In such situations, the Production Planner is likely to develop a new current plan to continue processing or to change the processing priorities. This process is known as “replanning.” Further information concerning replanning is provided in a subsequent section of this lesson.

The Production Planner uses the Planning Workbench when creating a current (active) plan for production data processing at the DAAC. The Planning Workbench provides the means by which the Production Planner selects and schedules specific PRs whose DPRs are to be run.

The Planning Master Timeline tool provides a forecast of the start and completion times of the jobs based upon experience in running the PGEs during the SSI&T process. When the generated plan is “activated” through the Planning Workbench, information in the plan is transferred to Job Management in the Data Processing Subsystem. Job Management creates and releases jobs into the Platinum AutoSys tool, where production processing is managed.

Figure 38 shows the general flow of production requests/data processing requests from the Production Request Editor through the Planning Workbench to the AutoSys production management tool.
Production Strategy

As previously mentioned, Production Strategies are high-level sets of priorities created by the Production Planner. The strategies are available for selection on the Planning Workbench. The Production Planner’s choice of a strategy for a current production plan determines the priorities and preferences in the processing of associated DPRs.

Production Strategies work on two levels. First, the Production Planner can update lists of DPR attributes so that each value an attribute can have is tied to a particular priority. For example, the DPR attribute “PR Type” has three values that may have their default priority of 2 changed as follows (on a scale of 1 to 10):

- Routine: 6
- On-Demand: 10
- Reprocessing: 4

Next, the Production Planner can change the weight that each attribute’s priority is given. For example, weights (from 1 to 100) might be assigned to the DPR attributes as follows:

- PR Type: 45
- User Type: 15
- PGE Type: 20
A weight is also given to the priority specified when the user (e.g., the Production Planner) created the Production Request as shown in the following example:

- Production Request Editor 20

The total weights assigned to PR Type, User Type, PGE Type and Production Request Editor [Priority] must equal 100.

The values included in the selected strategy are read by the Planning Workbench when prioritizing the DPRs in a production plan. Figure 39 provides an illustration of how priority is calculated for a DPR.

\[
\text{Priority} = 6 \times 0.45 + 3 \times 0.20 + 8 \times 0.15 + 7 \times 0.20 = 5.9 = 6
\]

Finally, there is a Late Start Delta that can be used to increase the priority of all jobs that have been waiting in the Production Queue for more than a day.

**Defining a Production Strategy**

The Production Planner uses the Production Strategies GUI to develop Production Strategies. The procedure that follows describes how to define or modify a Production Strategy.
The procedure for defining a production strategy starts with the assumption that all applicable servers are currently running and the Production Strategies GUI (Figure 34) is being displayed.

**Defining a Production Strategy**

1. If defining a new production strategy, select **File → New** from the pull-down menu.

   - The fields of the Production Strategies GUI (Figure 34) are reset.

2. If modifying an existing production strategy, first click on the option button associated with the Production Strategies field, then highlight (in the option menu) the name of the production strategy to be modified.

   - Data pertaining to the selected production strategy are displayed in the applicable fields of the Production Strategies GUI (Figure 34).
   - Alternatively, it is possible to select **File → Open** from the pull-down menu, select the desired production strategy from the list on the Open window (Figure 40), and click on the Ok button to open the production strategy.

3. If changing the default priority for PR Type, click in the Default field below the PR Type button and type the desired default value.

   - The range for the default is from 1 to 10.

4. If changing the default priority for User Type, click in the Default field below the User Type button and type the desired default value.

5. If changing the default priority for PGE Type, click in the Default field below the PGE Type button and type the desired default value.

6. If defining or modifying a priority for a type of production request, first click on the PR Type button.

   - The different types of production requests are displayed in the Type List field at the bottom left of the GUI.

7. If defining a priority for a type of production request not currently listed in the PR Type Value-Priority list, click on that PR type in the Type List field.

   - The PR type is highlighted.
   - It is possible to highlight multiple PR types (by clicking on each one in turn) if they are all going to be assigned the same priority.

8. If redefining or deleting a priority for a type of production request already listed in the PR Type Value-Priority list, click on that PR type in the Value-Priority list.

   - It is possible to highlight multiple PR types (by clicking on each one in turn while holding down either the Shift key or the Ctrl key) if the same action is going to be taken with respect to all of them.
9 If defining or modifying (not deleting) a priority, click on the up/down arrow buttons to the right of the Priority field until the desired priority value is displayed in the Priority field.

- An alternative method of entering the priority is to type the desired priority value in the Priority field.

- The acceptable range for the priority is from 1 to 10.

10 Click on the appropriate button from the following selections:

- Add - to approve a priority for an additional PR type and display the selected PR type and priority in the PR Type Value-Priority list at the left center of the GUI.
• Modify - to approve a revised priority for the selected PR type and display the PR type and modified priority in the PR Type Value-Priority list.

• Delete - to delete the priority for the selected PR type and remove the PR type and priority from the PR Type Value-Priority list.

11 Repeat Steps 6 through 10 as necessary until all PR Type priorities (as shown in the PR Type Value-Priority field) are correct.

12 If defining or modifying a priority for a type of user, first click on the User Type button.

• The different types of users are displayed in the Type List field at the bottom left of the GUI.

13 If defining a priority for a type of user not currently listed in the User Type Value-Priority list, click on that user type in the Type List field.

• The user type is highlighted.

• It is possible to highlight multiple user types (by clicking on each one in turn).

14 If redefining or deleting a priority for a user type already listed in the User Type Value-Priority list, click on that user type in the Value-Priority list.

• The user type is highlighted.

• It is possible to highlight multiple user types (by clicking on each one in turn while holding down either the Shift key or the Ctrl key).

15 If defining or modifying (not deleting) a priority, click on the up/down arrow buttons to the right of the Priority field until the desired priority value is displayed in the Priority field.

• An alternative method of entering the priority is to type the desired priority value in the Priority field.

• The acceptable range for the priority is from 1 to 10.

16 Click on the appropriate button from the following selections:

• Add - to approve a priority for an additional user type and display the selected user type and priority in the User Type Value-Priority list near the center of the GUI.

• Modify - to approve a revised priority for the selected user type and display the user type and modified priority in the User Type Value-Priority list.

• Delete - to delete the priority for the selected user type and remove the user type and priority from the User Type Value-Priority list.

17 Repeat Steps 12 through 16 as necessary until all user type priorities (as shown in the User Type Value-Priority field) are correct.
18 If defining a priority for a type of PGE, first click on the **PGE Type** button.

- The different types of PGEs are displayed in the **Type List** field at the bottom left of the GUI.

19 If defining a priority for a type of PGE **not** currently listed in the **PGE Type Value-Priority** list, click on that PGE type in the **Type List** field.

- The PGE type is highlighted.
- It is possible to highlight multiple PGE types (by clicking on each one in turn).

20 If redefining or deleting a priority for a PGE type **already** listed in the **PGE Type Value-Priority** list, click on that PGE type in the **Value-Priority** list.

- The PGE type is highlighted.
- It is possible to highlight multiple PGE types (by clicking on each one in turn while holding down either the **Shift** key or the **Ctrl** key).

21 If defining or modifying (not deleting) a priority, click on the up/down arrow buttons to the right of the **Priority** field until the desired priority value is displayed in the **Priority** field.

- An alternative method of entering the priority is to type the desired priority value in the **Priority** field.
- The acceptable range for the priority is from 1 to 10.

22 Click on the appropriate button from the following selections:

- **Add** - to approve a priority for an additional PGE type and display the selected PGE type and priority in the **PGE Type Value-Priority** list near the center of the GUI.
- **Modify** - to approve a revised priority for the selected PGE type and display the PGE type and modified priority in the **PGE Type Value-Priority** list.
- **Delete** - to delete the priority for the selected PGE type and remove the PGE type and priority from the **PGE Type Value-Priority** list.

23 Repeat Steps 18 through 22 as necessary until all PGE type priorities (as shown in the **PGE Type Value-Priority** field) are correct.

24 Click in the **Weight** field below the **PR Type** button and type the desired weight.

- The acceptable range for weights is from 1 to 100.
- The **Total Weight** field displays updated totals of all weighting factors as they are entered.
- When entering weights for the PR Type, User Type, PGE Type, and Production Request Editor [Priority] factors, relative values can be typed in without regard to whether the values in the four categories add up to 100. The **Normalize** button
provides a means of eventually ensuring that the total of all four categories equals 100.

- The assigned weight in each category is multiplied by the priority for each type. To maintain a high priority (low number, such as one), assign a low weight; to ensure a low priority, assign a relatively high weight.

25 Click in the **Weight** field below the **User Type** button and type the desired weight.

26 Click in the **Weight** field below the **PGE Type** button and type the desired weight.

27 Click in the **Production Request Editor** field and type the desired weight.

- The priority to which the Production Request Editor weight is applied is the priority assigned using the Production Request Editor when a production request is created.

28 Click on the **Normalize** button.

- The Planning Subsystem adjusts all weighting factors to produce a total weight of 100 (as displayed in the **Total Weight** field).

29 If it is necessary to change the priority of jobs that have been waiting in the Production Queue for more than a day, click in the **Late Start Delta Priority** field and type the desired value.

- The range for the Late Start Delta Priority is from 1 to 100.

30 Select **File → Save As** from the pull-down menu.

- A **Save As** window (Figure 41) is displayed.

31 Type the desired file name for the new production strategy in the **Save As** field.

32 Click on the appropriate button from the following selections:

- **OK** - to accept the file name in the **Save As** field.
  - The **Save As** window is dismissed.
  - The production strategy is saved with the specified file name.

- **Cancel** - to dismiss the **Save As** window without saving the production strategy.

33 To start the process of modifying or creating another production strategy select **File → New** to clear the entries on the **Production Strategies** GUI.

- Return to Step 2 to modify an existing production strategy.

- Return to Step 3 to create another new production strategy.

34 To start the process of exiting from the **Production Strategies** GUI select **File → Exit** from the pull-down menu.

- A **Do you really want to exit?** dialogue box is displayed.
Click on the appropriate button from the following selections:

- **OK** - to exit from the Production Strategies GUI.
  - The Production Strategies GUI is dismissed.
- **Cancel** - to return to the Production Strategies GUI.

**Reviewing the Current Active Strategy**

The Production Planner uses the Production Strategies GUI to review the production strategy applied to the currently active production plan. The procedure that follows describes how to review the current active strategy.
The procedure for reviewing the current active strategy starts with the assumption that all applicable servers are currently running and the Production Strategies GUI (Figure 34) is being displayed.

**Reviewing the Current Active Strategy**

1. Select **Options → activeStrategy** from the pull-down menu.
   - The Active Production Strategy window (Figure 42) is displayed.

![Figure 42. Active Production Strategy Window](image)
2 Review the data displayed in the **Active Production Strategy** window:

- **PR Type.**
  - Weight.
  - Default [value].
  - [Individual PR types and values if any are listed.]

- **User Type.**
  - Weight.
  - Default [value].
  - [Individual user types and values if any are listed.]

- **PGE Type.**
  - Weight.
  - Default [value].
  - [Individual PGE types and values if any are listed.]

- **Production Request Editor Weight.**
- **Late Start Delta Priority.**

3 To exit from the **Active Production Strategy** window and return to the **Production Strategies** GUI click on the **Cancel** button.

- The Active Production Strategy window is dismissed.
- The **Production Strategies** GUI is displayed.

---

**Deleting a Production Strategy**

The Production Planner uses the Production Strategies GUI to delete production strategies that are no longer needed. The procedure that follows describes how to delete a production strategy.

The procedure for deleting a production strategy starts with the assumption that all applicable servers are currently running and the **Production Strategies** GUI (Figure 34) is being displayed.
Deleting a Production Strategy

1. Click on the option button associated with the Production Strategies field, then highlight (in the option menu) the name of the production strategy to be deleted.
   - Data pertaining to the selected production strategy are displayed in the applicable fields of the Production Strategies GUI.
   - Alternatively, it is possible to select File → Open from the pull-down menu, select the desired production strategy from the list on the Open window (Figure 40), and click on the Ok button to open the production strategy.

2. Select Edit → Delete from the pull-down menu.
   - A production strategy deletion confirmation dialogue box (Figure 43) is displayed requesting confirmation of the decision to delete the production strategy.
   - The Active Production Strategy window is displayed.

3. Click on the appropriate button from the following selections:
   - OK - to confirm deletion of the production strategy and dismiss the dialogue box.
     - The deletion confirmation dialogue box is dismissed.
     - The production strategy is deleted.
   - Cancel - to preserve the production strategy and dismiss the dialogue box.
     - The deletion confirmation dialogue box is dismissed.
     - The production strategy is not deleted.
To start the process of exiting from the **Production Strategies** GUI select **File → Exit** from the pull-down menu.

- A **Do you really want to exit?** dialogue box is displayed.

Click on the appropriate button from the following selections:

- **OK** - to exit from the **Production Strategies** GUI.
  - The **Production Strategies** GUI is dismissed.
- **Cancel** - to return to the **Production Strategies** GUI.

---

**Production Plans**

**Creating a New Production Plan**

The Production Planner creates a production plan by selecting PRs from two lists of PRs, i.e., the list of available “Unscheduled” PRs and the list of “Scheduled” PRs. Using arrow buttons, the Production Planner moves the PRs between lists until the “Scheduled” list contains the desired set of PRs that define the new plan.

Before creating a new production plan the Production Planner must be prepared to provide the following information:

- Name of the plan.
- PRs to be included in the new production plan.
- Comments (if any).

The Production Planner uses the Planning Workbench GUI to prepare Production Plans. The procedure that follows describes how to create a new Production Plan. The procedure starts with the assumption that all applicable servers are currently running and the **Planning Workbench** GUI (Figure 36) is being displayed.

**Creating a New Production Plan**

1. Select **File → New** on the **Planning Workbench** GUI.
   - The **New Plan** window (Figure 44) is displayed.

2. Type the **Plan Name** in the **Plan Names** field.
   - Name is displayed in **Plan Names** field.
   - Status is **Candidate**.
Click on the appropriate button from the following selections:

- **Ok** - to accept the file name in the **Plan Names** field.
  - The **New Plan** window is dismissed.
  - The production plan is saved with the specified file name.
- **Apply** - to save the production plan without dismissing the **New Plan** window.
  - The production plan is saved with the specified file name.
- **Cancel** - to dismiss the **New Plan** window without saving the production plan.

If applicable, click on the option button associated with the **Strategy** field, then highlight the desired production strategy in the option menu.
Move PRs between the **Unscheduled** and **Scheduled** lists as necessary by selecting (highlighting) the PR to be moved by clicking on the PR in the list from which it is to be moved then clicking on the up or down arrow button (as applicable) to move the PR to the other list.

- Highlighted PR disappears from one list and appears on the other.
- The **Unscheduled** and **Scheduled** PR lists are scrollable.
- In the **Scheduled** list, items with the prefix “GE_” are resource reservations (also called “ground events”).
  - Ground events are resource reservations for non-production-related purposes, including such activities as testing, preventive maintenance, or system upgrades.
  - Ground events are scheduled through the resource planning process.
- If processing of the currently active plan is to be continued when the new plan is activated, include the PR(s) for the currently active plan in the new plan.

6 Type any relevant comments (up to 255 characters) in the **Comments** field.

7 If the priority of any PR in the **Scheduled** list needs to be changed, perform Steps 8 through 12; otherwise go to Step 13.

8 Click on the PR entry in the **Scheduled** list to highlight it.

9 Click on the **Prioritize** button.

- The **Priority popup** window (Figure 45) is displayed.

10 Type the new priority in the **Production Request(s) priority** field.

*Figure 45. Priority Popup Window*
Click on the appropriate button from the following selections:

- **OK** - to accept the new priority in the **Production Request(s)** priority field.
  - The **Priority popup** window is dismissed.
  - The new priority for the PR is saved in the database.
- **Cancel** - to dismiss the **Priority popup** window without saving the new priority.

Repeat Steps 8 through 11 for any additional PR(s) needing a change of priority.

Select **File → Save As** from the pull-down menu.

- The **Save Plan** window is displayed.
  - Except for the title, the **Save Plan** window looks the same as the **New Plan** window (Figure 44).

If the **Plan Name** for the production plan is not displayed in the **Plan Names** field, type the **Plan Name** in the **Plan Names** field.

Click on the appropriate button from the following selections:

- **Ok** - to accept the file name in the **Plan Names** field.
  - The **Save Plan** window is dismissed.
  - The production plan is saved with the specified file name.
  - The **Planning Workbench** GUI (Figure 36) is displayed.
  - The **Plan Name** is displayed.
  - The **Status** displayed is **Candidate**.
- **Apply** - to save the production plan without dismissing the **Save Plan** window.
  - The production plan is saved with the specified file name.
- **Cancel** - to dismiss the **Save Plan** window without saving the production plan.

If the production plan is to be activated immediately, perform Steps 17 and 18; otherwise, go to Step 19.

Click on the **Activate** button.

- A **Confirm Activation** dialogue box (Figure 46) is displayed.
Click on the appropriate button from the following selections:

- **Yes** - to activate the plan.
  - The **Confirm Activation** dialogue box is dismissed.
  - The new plan is activated.
  - The time of plan activation is displayed next to **Rollover Time** on the **Planning Workbench** GUI.

- **No** – to dismiss the **Confirm Activation** dialogue box without activating the plan.

If the production plan is to be used as a baseline plan, perform Steps 20 through 24; otherwise, go to Step 25.

Click on the **Baseline** button.

- A confirmation dialogue box containing the message **The current plan is Plan Name. Do you wish to baseline it?** is displayed.

- Clicking on the **Baseline** button records the plan and the time of baselining.

- A baseline plan can be used as a point of comparison with which to compare future plans and results.

Click on the appropriate button from the following selections:

- **Yes** - to baseline the plan.
  - The confirmation dialogue box containing the message **The current plan is Plan Name. Do you wish to baseline it?** is dismissed.
  - The plan is baselined.

- **No** – to dismiss the confirmation dialogue box containing the message **The current plan is Plan Name. Do you wish to baseline it?** without baselining the plan.
Select **File → Save As** from the pull-down menu.

- The **Save Plan** window is displayed.

If the **Plan Name** for the production plan is not displayed in the **Plan Names** field, type the **Plan Name** in the **Plan Names** field.

Click on the appropriate button from the following selections:

- **Ok** - to accept the file name in the **Plan Names** field.
  - The **Save Plan** window is dismissed.
  - The production plan is saved with the specified file name.

- **Apply** - to save the production plan without dismissing the **Save Plan** window.
  - The production plan is saved with the specified file name.

- **Cancel** - to dismiss the **Save Plan** window without saving the production plan as a baseline plan.

Repeat Steps 1 through 24 to perform additional production planning activities.

To view the Planning Master Timeline perform the procedure for **Reviewing a Plan Timeline** (subsequent section of this lesson).

To start the process of exiting from the **Planning Workbench** GUI select **File → Exit** from the pull-down menu.

- A **Do you really want to exit?** dialogue box is displayed.

Click on the appropriate button from the following selections:

- **OK** - to exit from the **Planning Workbench** GUI.
  - The **Planning Workbench** GUI is dismissed.

- **Cancel** - to return to the **Planning Workbench** GUI.

After quitting the **Planning Workbench** GUI click in the UNIX window used to start the **Planning Workbench** GUI.

- The Message Handler, System Name Server, and Resource Model should be shut down to eliminate unneeded processes and allow other operators to gain access to the Planning Workbench if necessary.

Type **EcPISlayAll MODE ApplicationID** then press **Return/Enter** to shut down the Planning Master Timeline, Message Handler, System Name Server, and Resource Model (and the Planning Workbench if it has not already been shut down).

- The **Message Handler** GUI (Figure 35) disappears.
31  Type `ps -ef | grep MODE` then press **Return/Enter** to obtain a list of active processes in the specified mode.

- A list of active processes in the specified mode is displayed.
- If an error message is received when `ps -ef | grep MODE` is entered, type `ps -auxwww | grep MODE` then press **Return/Enter**.

32  Examine the list of processes running in the specified mode to determine whether the Message Handler, System Name Server, and Resource Model processes have actually been shut down.

- None of the following processes should be active:
  - EcPIWb
  - EcPITI
  - EcPIMsh
  - EcPISns
  - EcPIRm

33  If any of the specified processes [especially the Message Handler, System Name Server, and/or Resource Model process(es)] is/are still active, type `kill -15 process_id1 [process_id2] [process_id3] […]` to terminate the active process(es).

34  Repeat Steps 31 through 33 as necessary.

---

**Reactivation/Replanning**

"Reactivation" or "replanning" assumes that there is a current plan. The current plan may or may not have DPRs associated with it.

- If there are no DPRs in a plan, it may be because all the DPRs that were in the plan have run to completion.
- Alternatively, there may never have been any DPRs associated with the plan because an empty plan was activated to cancel DPRs from a previously activated plan.

Reactivation/replanning occurs in the following three types of situations:

- No DPR in old plan but DPR(s) in new plan.
  - A current active plan without DPRs (e.g., the DPRs have finished processing) can be re-planned/reactivated as a new plan with DPRs.
• DPR(s) in old plan but not in new plan.
  − A current active plan with DPRs in the Job Management queue can be re-planned/reactivated as a new plan without DPRs (e.g., to cancel the DPRs that have been released to Data Processing but that have not started processing yet).

• DPR(s) in both old plan and new plan.
  − A current active plan with DPRs can be re-planned/reactivated as a new plan with those same DPRs (e.g., to add DPRs to a plan without canceling DPRs already in the plan).

**No DPR in Old Plan but DPR(s) in New Plan**

The overall process for replanning when there are no DPRs in the old plan but there will be DPRs in the new plan occurs as follows:

- Enter a new plan name.
  − The plan is created using the Planning Workbench GUI.
- Select the PRs to be included.
- Schedule the PRs to be activated.
- Save the new plan.
- Activate the new plan.
  − The new plan is activated and the new DPRs are ready to run.
- Check on the state of the jobs in AutoSys.
  − New DPRs should be in AutoSys and should begin to run.

**DPR(s) in Old Plan but Not in New Plan**

The overall process for replanning when there are DPRs in the old plan but there will be no DPRs in the new plan occurs as follows:

- Verify that DPRs in the active plan are in the Job Management queue.
  − The current DPRs should be in the queue and can be viewed by pressing the Jobs Waiting button on the AutoSys Job Activity Console (Ops Console).
- Create a new plan without PRs/DPRs to replace the old plan (with DPRs).
  − Enter a new plan name.
    − The plan is created using the Planning Workbench GUI.
  − Do not schedule any PRs to be activated.
Save the new plan.

- Activate the new plan.
- Verify the state of the new plan’s DPRs.
  - Use the AutoSys Jobscape GUI to verify the state of the new jobs.
- Verify the state of the old (existing) plan’s DPRs.
  - Use the Jobs Waiting button on the AutoSys Job Activity Console (Ops Console) to verify the cancellation of old DPR jobs.
  - Only jobs that are in the Job Management queue are cancelled.
  - Jobs that have already been released to AutoSys are not deleted during the replan (they continue processing to termination).

**DPR(s) in Both Old Plan and New Plan**

The overall process for replanning when there are DPRs in both the old plan and the new plan occurs as follows:

- Verify that DPRs in the active plan are in the queue.
  - The current DPRs should be in the Job Management queue and can be viewed using the Jobs Waiting button on the AutoSys Job Activity Console (Ops Console).
- Enter a new plan name.
  - The plan is created using the Planning Workbench GUI.
- Select the PRs to be included.
  - Include relevant PRs used in the old plan; i.e., those PRs with DPRs to be re-prioritized that are in the Job Management queue.
- Schedule the PRs to be activated.
- Save the new plan.
- Activate plan.
- Verify the priorities of the plan’s DPRs in the Job Management queue.
  - The new DPR(s) must be in the Job Management queue.
  - The old DPR(s) must be cancelled.
  - If priorities differ between old and new DPR, the old DPR should have been cancelled and a new DPR created.
  - Only jobs that are in the Job Management queue have their priorities changed.
Jobs that have already been released to AutoSys are not changed during the replan because their priorities are no longer relevant.

Deleting a Production Plan

The Production Planner uses the Planning Workbench GUI to delete production plans that are no longer needed. The procedure that follows describes how to delete a production plan.

The procedure for deleting a production plan starts with the assumption that all applicable servers are currently running and the Planning Workbench GUI (Figure 36) is being displayed.

Deleting a Production Plan

1. Select File → Delete on the Planning Workbench GUI.
   - The Delete Plan window (Figure 47) is displayed.
   - A list of Production Plans is displayed in the Delete Plan window.

2. Select (highlight) the production plan to be deleted by clicking on the corresponding name in the list of plans.
   - The plan name is displayed in the Plan Names field of the Delete Plan window.

3. Click on the OK button.
   - The Delete Plan window is dismissed.
   - The production plan is deleted.

Reviewing a Plan Timeline

It is possible to display a graphic, timeline-oriented depiction of a production plan, as shown in Figure 37. The timeline application becomes available when the Production Planning Workbench is initiated. The display shows a set of processing equipment, arranged along the left side of the GUI, and some period of time as indicated across the top edge of the GUI.

The execution of DPRs on the processing equipment over a period of time is represented by several DPR bars across the GUI for that equipment. In addition, there may be bars that represent resource reservations for non-production-related purposes, which are also called “ground events.” They are scheduled through the resource planning process. Ground events include such activities as testing, preventive maintenance, or system upgrades.

- A bar represents a time period during which a DPR is to be processed or a resource reservation has been planned.
Each bar bears the name of a DPR or a resource reservation. Given the selection of a light enough color for the bar and a time span that allows a long enough bar, the name of the DPR or resource reservation can be seen on the bar.

- Placing the cursor on a bar causes the name of the DPR (or resource reservation), its description, and its start and end dates/times to appear near the bottom of the timeline GUI.

- Resource reservations are identified by the prefix “GE_”.

The procedure for reviewing a production plan timeline starts with the assumption that all applicable production planning servers are running and the Production Planning Master Timeline GUI (Figure 37) is being displayed.
Reviewing a Plan Timeline

1. Adjust the Production Planning Master Timeline window size and the view of the timeline as necessary using the mouse.
   - Grab a corner of the timeline window with the cursor and resize the window as desired.
   - Scroll up or down through the full list of equipment.
   - Scroll left or right to go backward or forward in time.

2. If a different plan is to be viewed (other than the one currently being displayed), select File → Open Plan from the pull-down menu.
   - The Open Plan window (Figure 48) is displayed.
   - The available plans are listed.

![Figure 48. Open Plan Window](image-url)
Select (highlight) the plan to be reviewed by clicking on the corresponding plan name in the list of plans.

Click on the appropriate button from the following selections:

- **OK** - to open the selected plan and dismiss the Open Plan window.
  - The timeline for the specific plan is displayed on the Production Planning Master Timeline.
  - Name is displayed in the Title bar.

- **Apply** - to open the selected plan without dismissing the Open Plan window.
  - The timeline for the specific plan is displayed on the Production Planning Master Timeline.
  - Name is displayed in the Title bar.

- **Cancel** - to dismiss the Open Plan window without opening any plan.

If a different time scale (start and end dates and times) is desired, perform Steps 6 through 8; otherwise, go to Step 9.

Select **Time → Change Plan Window** from the pull-down menu:

- The plan window edit window (Figure 49) is displayed.

![Plan Window Edit Window](image)

**Figure 49. Plan Window Edit Window**

Type date and time for the desired start and end times (in **DD MMM YYYY hh:mm:ss** format) in the **Plan Win Start** and **Plan Win End** fields of the plan window edit window.
When the appropriate date and time have been entered, click on the appropriate button from the following selections:

- **OK** - to accept the changes and dismiss the plan window edit window.
- **Apply** - to accept the changes without dismissing the plan window edit window.
- **Cancel** - to cancel the changes and dismiss the plan window edit window.

If a different time span is desired, click and hold on the **Show** option button and select (highlight then release the mouse button) the desired time span from the option menu that is displayed:

- 5 min
- 10 min
- 30 min
- 45 min
- 1 hr
- 2 hr
- 4 hr
- 6 hr
- 12 hr
- 24 hr
- 168 hr
- other

If no resources are displayed on the GUI or if different resources should be displayed, perform Steps 11 through 15; otherwise, go to Step 16.

Select **Display → Change resources** from the pull-down menu:

- The **Resource edit** window (Figure 50) is displayed.

If adding resource(s) from the **Available Resources** list to the **Viewed Resources** list, select (highlight) the resource(s) to be added, then click on the **Add** button to move the resource(s) to the **Viewed Resources** list.

- Highlighted resource(s) appear(s) on the **Viewed Resources** list.

If deleting resource(s) from the **Viewed Resources** list, select (highlight) the resource(s) to be removed, then click on the **Del** button to remove the resource(s) from the **Viewed Resources** list.

- Highlighted resource(s) disappear(s) from the **Viewed Resources** list.
14 If changing the order in which resources are listed in the **Viewed Resources** list, select (highlight) the resource to be moved, then click on the up or down arrow as necessary to reposition the selected resource.

- Highlighted resource changes position in the **Viewed Resources** list.

15 When the **Viewed Resources** list contains the desired set of resources, click on the appropriate button from the following selections:

- **OK** - to accept the changes and dismiss the **Resource edit** window.
- **Apply** - to accept the changes without dismissing the **Resource edit** window.
- **Cancel** - to cancel the changes and dismiss the **Resource edit** window.

16 If different color coding of the timeline is desired, perform Steps 17 through 21; otherwise, go to Step 22.

17 Select **Display → Change colors** from the pull-down menu:

- The Color Selections window (Figure 51) is displayed.

**Figure 50. Resource Edit Window**
Figure 51. Color Selections Window
18 Click on the name of one of the DPRs or resource reservations to be recolored.
   • The DPR or resource reservation is highlighted.
19 Click on the desired color (in the color palette) to be applied to the highlighted DPR or resource reservation.
20 Repeat Steps 18 and 19 as necessary.
21 When the appropriate color changes have been made, click on the appropriate button from the following selections:
   • **OK** - to accept the changes and dismiss the *Color Selections* window.
   • **Apply** - to accept the changes without dismissing the *Color Selections* window.
   • **Cancel** - to cancel the changes and dismiss the *Color Selections* window.
22 Observe the production scheduling information displayed on the *Production Planning Master Timeline* GUI.
23 Repeat the previous steps as necessary.
24 To start the process of exiting from the *Production Planning Master Timeline* GUI select **File → Exit** from the pull-down menu.
   • A *Do you really want to exit?* dialogue box is displayed.
25 Click on the appropriate button from the following selections:
   • **OK** - to exit from the *Production Planning Master Timeline* GUI.
      – The *Production Planning Master Timeline* GUI is dismissed.
   • **Cancel** - to return to the *Production Planning Master Timeline* GUI.
Resetting/Cleaning the PDPS Database

Saving and Resetting the PDPS Database

The utilities directory (/usr/ecs/MODE/CUSTOM/utilities) contains the following three scripts that are used in resetting the database:

- reset_db.
- list_db.
- save_db.

Saving the database using the save_db script produces one ASCII file (with a “.dat” extension) for each database table and writes each file to a specified directory. The saved data can be restored to the database by running the reset_db script with the name of the saved database as an argument.

Resetting the database involves clearing (“wiping out”) the data in the database tables and loading values from a specified “saved database” file. It is important to take into consideration the consequences of resetting the database before performing the procedure. Resetting the database removes and replaces all Resource Definitions, Resource Reservations (Ground Events), Production Requests, Data Processing Requests, and Production Plans. There should be coordination with all affected parties, including the Resource Planner, Production Planner, and Production Monitors concerning the effects of resetting the database as well as its after-effects (e.g., recreating resource definitions, resource reservations, and production requests).

Whenever the PDPS database is reset (not including database cleanup by running the EcPIdbClean script) it is also necessary to remove all PLS subscriptions in the Communications Subsystem (CSS) Subscription Server database (where the subscriber is Subscription Manager). Production personnel can remove the subscriptions using the Subscription Server GUI (EcSbSubServerGUI) if they have access to the GUI. Otherwise, they can request User Services personnel to remove the subscriptions.

As a result of removing the subscriptions, no subscription notification will come through for existing jobs in the newly loaded database. Only new jobs generated using the Production Request Editor will work normally with regard to subscriptions.

The procedure for saving and resetting the PDPS database starts with the assumption that the applicable servers are running and the Production Planner has logged in to the ECS system.
Saving and Resetting the PDPS Database

NOTE: Commands in Steps 1 through 7 are typed at a UNIX system prompt.

NOTE: It is important to log in as a user who has “write” permission in the saved_dumps directory (/usr/ecs/MODE/CUSTOM/utilities/saved_db/saved_dumps); otherwise it will not be possible to save database contents.

1 Type `setenv DISPLAY clientname:0.0` then press the Return/Enter key.

   • Use either the X terminal/workstation IP address or the machine-name for the clientname.

   • When using secure shell, the DISPLAY variable is set just once, before logging in to remote hosts. If it were to be reset after logging in to a remote host, the security features would be compromised.

2 Start the log-in to the Planning/Management Workstation by typing `/tools/bin/ssh hostname` (e.g., e0pls03, g0pls01, or l0pls02) in the new window then press the Return/Enter key.

   • If you receive the message, Host key not found from the list of known hosts. Are you sure you want to continue connecting (yes/no)? type yes (“y” alone will not work).

   • If you have previously set up a secure shell passphrase and executed sshremote, a prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with Step 3.

   • If you have not previously set up a secure shell passphrase; go to Step 4.

3 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your Passphrase then press the Return/Enter key.

   • Go to Step 5.

4 At the '<user@remotehost>'s password: prompt type your Password then press the Return/Enter key.

5 Type `setenv ECS_HOME /usr/ecs/` then press the Return/Enter key.

   • When logging in as a system user (e.g., cmshared), the ECS_HOME variable may be set automatically so it may not be necessary to perform this step.

6 Type `cd /usr/ecs/MODE/CUSTOM/utilities` then press Return/Enter.

   • Change directory to the directory containing the production planning startup scripts (e.g., EcPIPRE_IFStart).
• The **MODE** will most likely be one of the following operating modes:
  − OPS (for normal operation).
  − TS1 (for Science Software Integration and Test (SSI&T)).
  − TS2 (new version checkout).
• Note that the separate subdirectories under /usr/ecs apply to (describe) different operating modes.

7  If saving the current database is desired, type `save_db Saved_DB_Name` then press **Return/Enter** to start the process of saving the database.
• *Saved_DB_Name* is the desired name for the directory into which the data files will be written.
• If there is not already a directory with the specified *Saved_DB_Name*, a "Making directory..." message is displayed.
• If there is already a directory with the specified *Saved_DB_Name*, the following prompt is displayed:

  **Are you sure you wish you overwrite previously saved version of Saved_DB_Name**? (Y/N)

8  If the prompt to *Are you sure you wish you overwrite previously saved version of Saved_DB_Name*? (Y/N) appears, type the appropriate response (Y or N) then press the **Return/Enter** key.
• If y is entered, the data are saved in the specified directory, replacing the data that had previously been saved there.
• If n is entered, an “Exiting without saving database...” message is displayed.

9  If obtaining a listing of saved databases is desired, type `list_db` then press **Return/Enter** to generate a listing of the saved databases.
• A listing of saved databases is displayed.
• The listing is a useful tool to display the options for resetting the database.

10 If resetting the current database is desired, type `reset_db Saved_DB_Name` then press **Return/Enter** to start the database reset process.
• *Saved_DB_Name* refers to the name of the directory containing the data files to be loaded into the database.
• The data in the database are replaced with the data from the specified directory.
• When the database has been reset a "Successfully reset the database to Saved_DB_Name" message is displayed.
Cleaning the PDPS Database

In the /usr/ecs/MODE/CUSTOM/utilities directory on the Planning/Management Workstation there is a script (i.e., EcPlDbClean) that can be run to clean up some tables in a PDPS database. When it runs, the script tries to delete applicable records in the following order:

- Data Processing Requests based on timeSlot and completionState(SUCC_DEL) (deletes all DPR records with a completionState value of SUCC_DEL that are older than the specified number of months/days).
- Production Requests that have no associated DPRs (e.g., deletes the Production Requests that are older than the specified number of months/days and for which all of the DPRs were successfully completed and subsequently deleted).
- Dynamic data granules that are not used by any DPR or by the Data Processing Subsystem (i.e., cleans up the PlDataGranuleShort table of entries for dynamic granules that are older than the specified number of months/days, are no longer needed by any DPR, and are not being used by DPS).
- PGEs that are marked with a deleteFlag [deletes PGE information in the PlPgeMaster table for any PGE for which the deleteFlag is set (not equal to zero) and assuming that there are no DPRs associated with the PGE(s)].
- Science Software that has no associated PGE [cleans up the PlResourceRequirement table if there is no PGE that has a particular sswId [science software ID] (e.g., the associated PGE(s) was/were previously deleted)].

In addition to deleting the previously mentioned database entries, the script compiles a list of data granules that are not deleted because the Data Processing Subsystem currently needs to use them.

The procedure for cleaning the PDPS database starts with the assumption that the applicable servers are running and the Production Planner has logged in to the ECS system.

Cleaning the PDPS Database

NOTE: Commands in Steps 1 through 7 are typed at a UNIX system prompt.

1. Type `setenv DISPLAY clientname:0.0` then press the Return/Enter key.
   - Use either the X terminal/workstation IP address or the machine-name for the `clientname`.
   - When using secure shell, the DISPLAY variable is set just once, before logging in to remote hosts. If it were to be reset after logging in to a remote host, the security features would be compromised.
Start the log-in to the Planning/Management Workstation by typing `/tools/bin/ssh hostname` (e.g., e0pls03, g0pls01, or l0pls02) in the new window then press the Return/Enter key.

- If you receive the message, **Host key not found from the list of known hosts. Are you sure you want to continue connecting (yes/no)?** type **yes** (“y” alone will not work).

- If you have previously set up a secure shell passphrase and executed `sshremote`, a prompt to **Enter passphrase for RSA key '<user@localhost>'** appears; **continue with Step 3**.

- If you have not previously set up a secure shell passphrase; go to **Step 4**.

3 If a prompt to **Enter passphrase for RSA key '<user@localhost>'** appears, type your **Passphrase** then press the Return/Enter key.

   - Go to Step 5.

4 At the `<user@remotehost>’s password:` prompt type your **Password** then press the Return/Enter key.

5 Type **setenv ECS_HOME /usr/ecs/** then press the Return/Enter key.

   - When logging in as a system user (e.g., cmshared), the ECS_HOME variable may be set automatically so it may not be necessary to perform this step.

6 Type **cd /usr/ecs/MODE/CUSTOM/utilities** then press **Return/Enter**.

   - Change directory to the directory containing the production planning startup scripts (e.g., EcPIPRE_IFStart).

   - The **MODE** will most likely be one of the following operating modes:
     - OPS (for normal operation).
     - TS1 (for Science Software Integration and Test (SSI&T)).
     - TS2 (new version checkout).

   - Note that the separate subdirectories under /usr/ecs apply to (describe) different operating modes.

7 Type **EcPlDbClean MODE dbserver dbuser dbpassword months days** then press **Return/Enter** to start the database cleaning process.

   - **dbserver** refers to the name of the PDPS database server (e.g., x0pls02_srvr).

   - **dbuser** is the user name for logging in to interactive structured query language (isql).

   - **dbpassword** is the password for isql login.
• **months** is a number specifying the removal of records that are older than that number of months.

• **days** is an optional argument. It is a number that specifies the removal of records that are older than that number of days.

• Both **months** and **days** are taken into account by the cleaning script.

8 Observe the results as the script runs.

• A UNIX command line prompt is displayed when the script has finished.

---

**Cleaning DPS Disks**

In the `/usr/ecs/MODE/CUSTOM/utilities` directory on the Queuing Server there is a script (i.e., `EcDpPrRmFilesWOGranules.pl`) that can be run to ensure consistency between the file references in various tables in the PDPS database and the files actually staged on the data processing disks. When it runs, the script performs the following functions:

• Generates a list of files with consistent references among various tables in the PDPS database for the specified mode.

• Checks for files on the disk that are not included in the list of files referenced in the PDPS database and either lists the inconsistent files or generates a script to delete them (as specified by the person running the script).

• Checks to determine whether the disk partitions referenced in the PDPS database actually exist on the disk(s).
  
  – If the disk partitions are not on the disk(s), the script removes references to them from the database.

• Removes all file references in the PDPS database that are not included in the list of files.
  
  – The script resets the `PlRscDiskPartition` according to the remaining `DpPrDiskPartition` entries (if specified by the person running the script).

The procedure for cleaning the DPS disks starts with the assumption that the applicable servers (including the PDPS database server) are running and the Production Planner has logged in to the ECS system.
Cleaning the DPS Disks

NOTE: Commands in Steps 1 through 6 are typed at a UNIX system prompt.

1 Type `setenv DISPLAY clientname:0.0` then press the Return/Enter key.
   • Use either the X terminal/workstation IP address or the machine-name for the `clientname`.
   • When using secure shell, the DISPLAY variable is set just once, before logging in to remote hosts. If it were to be reset after logging in to a remote host, the security features would be compromised.

2 Start the log-in to the Queuing Server by typing `/tools/bin/ssh hostname` (e.g., `e0sps04`, `g0sps06`, or `l0sps03`) in the new window then press the Return/Enter key.
   • If you receive the message, Host key not found from the list of known hosts. Are you sure you want to continue connecting (yes/no)? type yes (“y” alone will not work).
   • If you have previously set up a secure shell passphrase and executed `sshremote`, a prompt to Enter passphrase for RSA key `<user@localhost>` appears; continue with Step 3.
   • If you have not previously set up a secure shell passphrase; go to Step 4.

3 If a prompt to Enter passphrase for RSA key `<user@localhost>` appears, type your Passphrase then press the Return/Enter key.
   • Go to Step 5.

4 At the `<user@remotehost>`’s password: prompt type your Password then press the Return/Enter key.

5 Type `cd /usr/ecs/MODE/CUSTOM/utilities` then press Return/Enter.
   • Change directory to the directory containing the production processing utility/startup scripts.
   • The MODE will most likely be one of the following operating modes:
     − OPS (for normal operation).
     − TS1 (for Science Software Integration and Test (SSI&T)).
     − TS2 (new version checkout).
   • Note that the separate subdirectories under /usr/ecs apply to (describe) different operating modes.

6 Type `EcDpPrRmFilesWOGranules.pl dbuser dbpassword MODE dbserver fix [or nofix]` then press Return/Enter to start the DPS disk cleaning process.
- **dbuser** is the user name for logging in to interactive structured query language (isql).
- **dbpassword** is the password for isql login.
- **dbserver** refers to the name of the PDPS database server (e.g., x0pls02_srvr).
- **fix** (or **nofix**) specifies whether or not inconsistent files are removed from the data processing disks.
- An option is to add `>& fix.log` or `>& /usr/ecs/MODE/CUSTOM/logs/fix.log` to the end of the command line to direct the output of the script to a log file.
- For example, the following command:

```
EcDpPrRmFilesWOGranules.pl pdpsUsers password1 OPS x0pls01_srvr nofix
```

produced the following results:

```
server = x0pls01_srvr; username = pdpsUsers; mode = OPS;
fix = nofix
```

This script will do the following:

a) Get a consistent set of files from database pdps for mode OPS

b) If the staging disk(s) is(are) readable:

   i) Check for files that do not belong to the consistent set; List them
      in nonfix option, and in fix option generate a delete script called
      `EcDpPrRmFilesWOGranulesDelScript`

   ii) Check the consistent set to ensure that the entries pertaining to
      the readable partitions exist on disk; List them in nonfix, and
      remove them from the consistent set in both cases

c) Finally remove all entries in the PDPS database that don't belong to this consistent set; If in fix option, reset PlRscDiskPartition according to the DpPrDiskPartition entries remaining. Found the following partitions on your database pdps:

```
partitionName : partitionId
x0spg01_disk : 1
x0aqg02_disk : 2
```

Getting consistent database entries.. please wait
DpPrDiskAllocation done
DpPrFile done
Created temporary table
Synced with DpPrDiskAllocation
Added met files
Processing data returned from SQL

Reading in filenames from disk

Files on disk having no consistent entry in the database for partition x0spg01_disk
Path of staging disk: 
/usr/ecs/OPS/CUSTOM/pdps/x0spg01/data//DpPrRm/x0spg01_disk

0 total invalid files found

Files absent on disk but with consistent entries in the database for partition x0spg01_disk
fileName: AIRXADCM#001O20000000; granuleId: AIRXADCM#001O2000

1 total invalid dB entries found

no path for partition x0aqg02_disk

Analyzing PDPS database.. please wait

Looking for invalid entries

------ DpPrFile ------

<table>
<thead>
<tr>
<th>fileName</th>
<th>partitionId</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIRXADCM#001O20000000</td>
<td>1</td>
</tr>
<tr>
<td>AIRXADCM#001O20000000.met</td>
<td>0</td>
</tr>
<tr>
<td>AM1ATTF#0011231199922000000000.FDD</td>
<td>1</td>
</tr>
<tr>
<td>AM1ATTF#0011231199922000000000.met</td>
<td>0</td>
</tr>
<tr>
<td>AM1ATTF#0010101200000000000000.FDD</td>
<td>1</td>
</tr>
<tr>
<td>AM1ATTF#0010101200000000000000.met</td>
<td>0</td>
</tr>
<tr>
<td>AM1ATTF#0010101200000020000000.FDD</td>
<td>1</td>
</tr>
<tr>
<td>AM1ATTF#0010101200000020000000.met</td>
<td>0</td>
</tr>
<tr>
<td>MOD021KM#00101012000000004000000000000000</td>
<td>1</td>
</tr>
<tr>
<td>MOD021KM#00101012000000004000000000000000.met</td>
<td>0</td>
</tr>
<tr>
<td>MOD021KM#00101012000000004500000000000000</td>
<td>1</td>
</tr>
<tr>
<td>MOD021KM#00101012000000004500000000000000.met</td>
<td>0</td>
</tr>
<tr>
<td>MOD021KM#00101012000000005000000000000000</td>
<td>1</td>
</tr>
<tr>
<td>MOD021KM#00101012000000005000000000000000.met</td>
<td>0</td>
</tr>
<tr>
<td>MOD021KM#00101012000000005500000000000000</td>
<td>1</td>
</tr>
<tr>
<td>MOD021KM#00101012000000005500000000000000.met</td>
<td>0</td>
</tr>
<tr>
<td>MOD021KM#00101012000000001000000000000000</td>
<td>1</td>
</tr>
<tr>
<td>MOD021KM#00101012000000001000000000000000.met</td>
<td>0</td>
</tr>
<tr>
<td>MOD021KM#00101012000000001050000000000000</td>
<td>1</td>
</tr>
<tr>
<td>MOD021KM#00101012000000001100000000000000.met</td>
<td>0</td>
</tr>
<tr>
<td>MOD021KM#00101012000000001100000000000000</td>
<td>1</td>
</tr>
<tr>
<td>MOD021KM#00101012000000001450000000000000.met</td>
<td>0</td>
</tr>
<tr>
<td>MOD021KM#00101012000000001450000000000000</td>
<td>1</td>
</tr>
<tr>
<td>MOD021KM#00101012000000001400000000000000.met</td>
<td>0</td>
</tr>
<tr>
<td>MOD021KM#00101012000000001400000000000000</td>
<td>1</td>
</tr>
<tr>
<td>MOD021KM#00101012000000001500000000000000.met</td>
<td>0</td>
</tr>
<tr>
<td>MOD021KM#00101012000000001500000000000000</td>
<td>1</td>
</tr>
<tr>
<td>MOD29#00101012000000050000000000000000.met</td>
<td>0</td>
</tr>
</tbody>
</table>
68 Invalid entries in DpPrFile

------- DpPrDiskAllocation -------

<table>
<thead>
<tr>
<th>fileName</th>
<th>partitionId</th>
</tr>
</thead>
<tbody>
<tr>
<td>GDAS_0ZF#00101000000</td>
<td>1</td>
</tr>
<tr>
<td>GDAS_0ZF#00101001000</td>
<td>1</td>
</tr>
<tr>
<td>AST_ANC#001098001000</td>
<td>1</td>
</tr>
<tr>
<td>AIRXADCM#00102000000</td>
<td>1</td>
</tr>
<tr>
<td>AST_ANC#001010101000</td>
<td>1</td>
</tr>
<tr>
<td>AST_ANC#001010101000</td>
<td>1</td>
</tr>
<tr>
<td>AST_ANC#001010101000</td>
<td>1</td>
</tr>
<tr>
<td>AST_ANC#001010101000</td>
<td>1</td>
</tr>
<tr>
<td>AST_ANC#001010101000</td>
<td>1</td>
</tr>
<tr>
<td>AST_ANC#001010101000</td>
<td>1</td>
</tr>
</tbody>
</table>
Invalid entries in DpPrDiskAllocation

<table>
<thead>
<tr>
<th>granuleId</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIRXADCM#001O2000</td>
</tr>
</tbody>
</table>

1 Invalid entries in DpPrGranuleLocation

Invalid entries in PlDataGranuleShort

<table>
<thead>
<tr>
<th>granuleId</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACT#syn1#004130123OPS::PH#001</td>
</tr>
<tr>
<td>AIRXADCM#001O2001</td>
</tr>
<tr>
<td>AIRXAGEO#00106000</td>
</tr>
<tr>
<td>AIRXARYL#00105001</td>
</tr>
<tr>
<td>AIRXATCM#00103001</td>
</tr>
<tr>
<td>AIRXATCS#00104001</td>
</tr>
<tr>
<td>AST_ANC#001L1000</td>
</tr>
<tr>
<td>AST_ANC#001L1002</td>
</tr>
<tr>
<td>AST_ANC#001L1004</td>
</tr>
<tr>
<td>AST_ANC#001L200000</td>
</tr>
<tr>
<td>AST_ANC#001L201000</td>
</tr>
<tr>
<td>AST_ANC#001L202000</td>
</tr>
<tr>
<td>AST_ANC#001L203000</td>
</tr>
<tr>
<td>AST_ANC#001L204000</td>
</tr>
<tr>
<td>AST_ANC#001L205000</td>
</tr>
<tr>
<td>AST_ANC#001L206000</td>
</tr>
<tr>
<td>AST_ANC#001L207000</td>
</tr>
<tr>
<td>AST_ANC#001L208000</td>
</tr>
<tr>
<td>AST_ANC#001L209000</td>
</tr>
<tr>
<td>AST_ANC#001L210000</td>
</tr>
<tr>
<td>AST_ANC#001L211000</td>
</tr>
<tr>
<td>AST_ANC#001L212000</td>
</tr>
<tr>
<td>AST_ANC#001L213000</td>
</tr>
<tr>
<td>AST_ANC#001L214000</td>
</tr>
<tr>
<td>AST_ANC#001L215000</td>
</tr>
<tr>
<td>AST_ANC#001L216000</td>
</tr>
</tbody>
</table>
7 Observe the results as the script runs.

- A UNIX command line prompt is displayed when the script has finished.
Troubleshooting Production Planning Problems

Trouble Symptoms

Troubleshooting is a process of identifying the source of problems on the basis of observed trouble symptoms. One common source of problems involves connections with other subsystems for the transmission of messages or data. Like many other operational areas in ECS, Planning has interfaces with many other subsystems. Consequently, problems with processing can be traced to either the Planning Subsystem or one of many other ECS subsystems, including (but not necessarily limited to) those in the following list:

- Data Processing Subsystem (DPS).
- Data Server Subsystem (DSS).
- Interoperability Subsystem (IOS).
- Communications Subsystem (CSS).

Table 1 describes actions to be taken in response to some common Planning problems. If the problem cannot be identified and fixed without help within a reasonable period of time, the appropriate response is to call the help desk and submit a trouble ticket in accordance with site Problem Management policy.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to log in to the Planning Subsystem host (e.g., g0pls01).</td>
<td>Check with the Operations Controller/System Administrator to ensure that the host is &quot;up.&quot;</td>
</tr>
<tr>
<td>GUI not displayed when the start-up script has been properly invoked.</td>
<td>Ensure that the DISPLAY variable was set properly.</td>
</tr>
<tr>
<td></td>
<td>[For detailed instructions refer to the applicable procedure, either Launching the Production Request Editor or Launching Planning Workbench-Related GUIs (previous sections of this lesson).]</td>
</tr>
</tbody>
</table>
| Error message indicating that SNS (System Name Server) and/or Resource Model is/are in use using the selected Application ID. | 1. Use another Application ID if working in a different mode from the person using the selected Application ID.  
2. If working in the same mode as the other user, coordinate use of Planning applications with the other user and/or the System Administrator.  
[For detailed instructions refer to the procedure for Launching Planning Workbench-Related GUIs (previous section of this lesson).] |
| Error message associated with the Production Request Editor.           | Refer to Table 2, Production Request Editor User Messages  
(adapted from the corresponding table in 609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project). |
Table 1. Troubleshooting Production Planning Problems

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error message associated with the Production Strategies GUI.</td>
<td>Refer to Table 3, Production Strategy User Messages (adapted from the corresponding table in 609-CD-600-001, <em>Release 6A Operations Tools Manual for the ECS Project</em>).</td>
</tr>
<tr>
<td>Error message associated with the Planning Workbench.</td>
<td>Refer to Table 4, Planning Workbench User Messages (adapted from the corresponding table in 609-CD-600-001, <em>Release 6A Operations Tools Manual for the ECS Project</em>).</td>
</tr>
</tbody>
</table>
| Production Request fails (DPR generation fails).                        | 1. Ensure (e.g., using ECS Assistant) that the necessary hosts and servers (listed in Table 5) are “up.”  
2. If hosts/servers have gone down, notify the Operations Controller/System Administrator to have servers brought back up.  
3. If hosts/servers are all “up,” perform the procedure for **Handling a Failure to Generate DPRs** (subsequent section of this lesson).  
4. Retry generating DPRs by resaving the Production Request.  
[For detailed instructions refer to the section on **Editing/Modifying a Production Request** (previous section of this lesson).]                                                                                                                                                        |
| PR or DPR deletion hangs.                                               | 1. Ensure that enough time has passed to allow DPR deletion (deleting a DPR can require as much time as creating a DPR).  
2. Ensure (e.g., using ECS Assistant) that the necessary hosts and servers (especially Job Management server and Deletion Server – list in Table 5) are “up.”  
(Both the Job Management Server and Deletion Server are called to clean up all PDPS database tables associated with the DPR or PR.)  
3. If hosts/servers have gone down, notify the Operations Controller/System Administrator to have servers brought back up.  
4. If hosts/servers are all “up,” check for a database lock or resource lock in the PDPS database.  
[For detailed instructions refer to the section on **Responding to PR or DPR Deletion that Hangs** (subsequent section of this lesson).]                                                                                                                                 |
| DPR deletion fails.                                                     | 1. Ensure that enough time has passed to allow DPR deletion (deleting a DPR can require as much time as creating a DPR).  
2. Ensure (e.g., using ECS Assistant) that the necessary hosts and servers (especially Job Management server and Deletion Server – list in Table 5) are “up.”  
(Both the Job Management Server and Deletion Server are called to clean up all PDPS database tables associated with the DPR or PR.)  
3. If hosts/servers have gone down, notify the Operations Controller/System Administrator to have servers brought back up.  
4. If hosts/servers are all “up,” check the Deletion Server Debug log (EcDpPrDeletionDebug.log).  
[For detailed instructions refer to the section on **Responding to DPR Deletion that Fails** (subsequent section of this lesson).]                                                                                                                                                     |
Table 1. Troubleshooting Production Planning Problems

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Response</th>
</tr>
</thead>
</table>
| DPR scheduling fails (DPR is not passed to Data Processing)             | 1. Ensure (e.g., using ECS Assistant) that the necessary hosts and servers (listed in Table 5) are “up.”  
2. If hosts/servers have gone down, notify the Operations Controller/System Administrator to have servers brought back up.  
3. If hosts/servers are all “up,” perform the procedure for **Handling a DPR Scheduling Failure** (subsequent section of this lesson).  
4. If necessary, delete the affected DPRs.  
   [For detailed instructions refer to the section on **Creating a New Production Plan** (previous section of this lesson).]  
5. If affected DPRs were deleted, recreate the DPRs.  
   [For detailed instructions refer to the section on **Editing/Modifying a Production Request** (previous section of this lesson).]  
6. If affected DPRs were recreated, create a new production plan.  
   [For detailed instructions refer to the section on **Creating a New Production Plan** (previous section of this lesson).] |
| Other problems.                                                         | 1. Ensure (e.g., using ECS Assistant) that the necessary hosts and servers (listed in Table 5) are “up.”  
2. If hosts/servers have gone down, notify the Operations Controller/System Administrator to have servers brought back up.  
3. If hosts/servers are all “up,” check the log files (e.g., EcPIPREditor.ALOG, EcPIPREditorDebug.log, EcPIWb.ALOG, EcPIWbDebug.log, EcPITI.ALOG) in the `/usr/ecs/MODE/CUSTOM/logs` directory for error messages.  
   [For detailed instructions refer to the section for **Checking Log Files** (subsequent section of this lesson).] |

Table 2. Production Request Editor User Messages

<table>
<thead>
<tr>
<th>Message Text</th>
<th>Cause and Corrective Action</th>
</tr>
</thead>
</table>
| Data Processing Request not open, Data Processing Request to be open must be selected. | 1. Select (highlight) a DPR from the DPR List.  
2. Open the DPR using **File → Open** from the pull-down menu.  
[For detailed instructions refer to the procedure for **Reviewing Data Processing Requests** (previous section of this lesson).] |
| Do you want to delete this DPR "DPRID"?                                    | 1. Select **Yes** to delete the DPR.  
2. Select **No** to keep the DPR.                                                                                                                                                                                             |
| Do you want to delete this PR "PRNAME"?                                    | 1. Select **Yes** to delete the PR.  
2. Select **No** to keep the PR.                                                                                                                                                                                             |
### Table 2. Production Request Editor User Messages

<table>
<thead>
<tr>
<th>Message Text</th>
<th>Cause and Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>DPR Delete Failed.</td>
<td>Check the log files (e.g., EcPIPREditor.ALOG) in the <code>/usr/ecs/MODE/CUSTOM/logs</code> directory for error messages. [For detailed instructions refer to the procedure for Checking Log Files (subsequent section of this lesson).]</td>
</tr>
</tbody>
</table>
| Dpr Generation Incomplete for PR "PRNAME". Do you want to complete Dpr explosion? | 1. Select **Yes** to complete the Dpr generation.  
2. Select **No** to display another message that will show how many DPRs have been generated so far. |
| Environment variable PL_NEW not set. | 1. Submit a request to the Database Administrator to check the value assigned to `PL_NEW` (associated with EcPIPREditor) in the Configuration Registry.  
2. If no value is specified for `PL_NEW`, submit a request to the Database Administrator to add the value `PL_NEW = New` for the EcPIPREditor in the Configuration Registry. |
| Invalid Time is entered or End time is less than Begin Time. | Ensure that the **Begin** and **End** dates/times entered on the **PR Edit** screen are valid. |
| Must select a PGE for Production Request before saving. | 1. Open the **PGE** screen by clicking the mouse on the **PGE** button of the **PR Edit** screen.  
2. Select (highlight) a PGE from the PGE list.  
3. Click on the **OK** button. |
| MyDprPIPProductionRequest Construct from Database Failed. | Call the help desk and submit a trouble ticket in accordance with site Problem Management policy. |
| MyPIPge Construct from Database Failed. | Call the help desk and submit a trouble ticket in accordance with site Problem Management policy. |
| MyPIPProductionRequestInstance Construct from Database Failed. | Call the help desk and submit a trouble ticket in accordance with site Problem Management policy. |
| MyPIUserParametersCollection Construct from Database Failed. | Call the help desk and submit a trouble ticket in accordance with site Problem Management policy. |
| “NoOfDprs” Dpr(s) have previously been generated. Are you sure you want to delete this PR? | 1. Select **Yes** to delete the PR.  
2. Select **No** to clear the message. |
| PIDpr Construct from Database Failed. | 1. Select (highlight) a DPR from the DPR List.  
2. Open the DPR using either **File → Open** from the pull-down menu or the keyboard **Ctrl-O**. [For detailed instructions refer to the procedure for Reviewing Data Processing Requests (previous section of this lesson).] |
<table>
<thead>
<tr>
<th>Message Text</th>
<th>Cause and Corrective Action</th>
</tr>
</thead>
</table>
| Please select a Dpr you want to delete from the DPR List.                  | 1. Select (highlight) a DPR from the DPR List.  
2. Delete the DPR using either Edit → Delete from the pull-down menu or the keyboard Ctrl-D.  
[For detailed instructions refer to the procedure for Deleting a Data Processing Request (previous section of this lesson).] |
| Please select a PR you want to delete from the PR List.                    | 1. Select a PR from the PR List.  
2. Delete the PR using either Edit → Delete from the pull-down menu or the keyboard Ctrl-D.  
[For detailed instructions refer to the procedure for Deleting a Production Request (previous section of this lesson).] |
| Please specify production request to filter by                            | The Filter button (File Selection window) acts on the pattern specified in the Filter text entry area.  
(Filters all production requests by the specified pattern.)  
1. Type text (the pattern for filtering production requests) in the Filter text entry area.  
2. Click on the Filter button.                                                                                      |
| PR Failed - Need to include 1st orbit in the Orbit model.                 | 1. Enter sql commands for checking the PDPS database PIPgeOrbitModel table to determine whether the orbit information for the first orbit is in the table.  
[For detailed instructions refer to the procedure for Using ISQL to Check Database Tables (subsequent section of this lesson).]  
2. If the orbit information for the first orbit is not in the PIPgeOrbitModel table, notify the SSI&T team.       |
| PR Failed - Read failure from PIORbitModel.                               | Unable to read the PIPgeOrbitModel table from the PDPS database.  
1. Check the database connections.  
[For detailed instructions refer to the procedure for Checking Database Connections (subsequent section of this lesson).]  
2. If the problem recurs, call the help desk and submit a trouble ticket in accordance with site Problem Management policy. |
| Production Request "PRNAME" Deleted; "NoOfDprs" DPR(s) deleted from the database. | For information only. The message indicates how many DPRs associated with the PR were deleted.                                                                                                                                         |
| Production Request Delete Failed.                                         | Unable to delete a PR from the database.  
Check the EcPIPREditor.ALOG file in the /usr/ecs/MODE/CUSTOM/logs directory for error messages.  
[For detailed instructions refer to the procedure for Checking Log Files (subsequent section of this lesson).] |
<table>
<thead>
<tr>
<th>Message Text</th>
<th>Cause and Corrective Action</th>
</tr>
</thead>
</table>
| Production Request Explosion into DPR(s) Failed.                           | 1. Ensure (e.g., using ECS Assistant) that the necessary hosts and servers (listed in Table 5) are “up.”  
2. If hosts/servers have gone down, notify the Operations Controller/System Administrator to have servers brought back up.  
3. If hosts/servers are all “up,” perform the procedure for Handling a Failure to Generate DPRs (subsequent section of this lesson).  
4. Retry generating DPRs by resaving the Production Request.  
[For detailed instructions refer to the section on Editing/Modifying a Production Request (previous section of this lesson).] |
| Production Request Explosion into DPRs Failed, zero DPRs Generated.         | Same as the preceding entry.                                                                                                                                                                                                 |
| Production Request Explosion into DPRs ok. "NoOfDprs" DPR(s) Generated.    | For information only. The message indicates how many DPR(s) were generated during the PR Explosion.                                                                                                                                 |
| Production Request Explosion into DPR(s) ok. "NoOfDprs" more DPR(s) Generated. | For information only. The message indicates how many more DPRs were generated for the PR.                                                                                                                                       |
| Production Request not open, Production Request to be open must be selected. | 1. Select a PR from the PR List.  
2. Open the PR using either File → Open from the pull-down menu or the keyboard Ctrl-O.  
[For detailed instructions refer to the procedure for Editing/Modifying a Production Request (previous section of this lesson).] |
| Production Request not saved, Production Request already exists.            | 1. Enter a new name for the production request.  
2. Save the PR.  
[For detailed instructions refer to the procedure for Editing/Modifying a Production Request (previous section of this lesson).] |
| Production Request not saved, Production Request must have a name shorter than 20 characters before its saved | 1. Enter a PR name with fewer than 20 characters.  
2. Save the PR.  
[For detailed instructions refer to the procedure for Editing/Modifying a Production Request (previous section of this lesson).] |
| Production Request not saved, Production Request must have a name before its saved. | 1. Enter a new name for the production request.  
2. Save the PR.  
[For detailed instructions refer to the procedure for Creating a New Production Request (previous section of this lesson).] |
### Table 2. Production Request Editor User Messages

<table>
<thead>
<tr>
<th>Message Text</th>
<th>Cause and Corrective Action</th>
</tr>
</thead>
</table>
| Production Request not saved, save Production Request first. | Save the modified PR before opening a new PR.  
[For detailed instructions refer to the procedure for **Editing/Modifying a Production Request** (previous section of this lesson).] |
| SECURITY VIOLATION: no write permission. | User does not have the permission to save a production request.  
1. Exit from the Production Request Editor  
   ([File → Exit](#) from the pull-down menu).  
2. Log in as a user with write permission.  
   [Contact the System Administrator for assistance if necessary.]  
3. Launch the Production Request Editor.  
   [For detailed instructions refer to the procedure for **Launching the Production Request Editor** (previous section of this lesson).]  
4. Create the Production Request.  
   [For detailed instructions refer to the procedure for **Creating a New Production Request** (previous section of this lesson).] |
| Unable to Initialize PIDpr Pool. | Unable to read the DPR table from the database.  
1. Check the database connections.  
   [For detailed instructions refer to the procedure for **Checking Database Connections** (subsequent section of this lesson).]  
2. If the problem recurs, call the help desk and submit a trouble ticket in accordance with site Problem Management policy. |
| Unable to Initialize PIDge Pool. | Unable to read the PGE table from the database.  
1. Check the database connections.  
   [For detailed instructions refer to the procedure for **Checking Database Connections** (subsequent section of this lesson).]  
2. If the problem recurs, call the help desk and submit a trouble ticket in accordance with site Problem Management policy. |
| Unable to Initialize PIDProductionRequest Pool. | Unable to read the PR table from the database.  
1. Check the database connections.  
   [For detailed instructions refer to the procedure for **Checking Database Connections** (subsequent section of this lesson).]  
2. If the problem recurs, call the help desk and submit a trouble ticket in accordance with site Problem Management policy. |
### Table 2. Production Request Editor User Messages

<table>
<thead>
<tr>
<th>Message Text</th>
<th>Cause and Corrective Action</th>
</tr>
</thead>
</table>
| Write to Database of Production Request Failed.                             | Unable to write the data to the database.  
1. Check the database connections.  
[For detailed instructions refer to the procedure for Checking Database Connections (subsequent section of this lesson).]  
2. If the problem recurs, call the help desk and submit a trouble ticket in accordance with site Problem Management policy. |
| Zero DPR Generated. Production Request Not Saved.                            | The proposed Production Request might result in the creation of a duplicate DPR.  
1. Compare the characteristics of the proposed PR and existing DPRs to determine whether the Production Request would result in the creation of a duplicate DPR.  
[For detailed instructions refer to the procedure for Reviewing Data Processing Requests (previous section of this lesson).]  
2. Ensure (e.g., using ECS Assistant) that the necessary hosts and servers (listed in Table 5) are “up.”  
3. If hosts/servers have gone down, notify the Operations Controller/System Administrator to have servers brought back up.  
4. If hosts/servers are all “up,” perform the procedure for Handling a Failure to Generate DPRs (subsequent section of this lesson).  
5. Retry generating DPRs by resaving the Production Request.  
[For detailed instructions refer to the section on Editing/Modifying a Production Request (previous section of this lesson).] |

### Table 3. Production Strategy User Messages

<table>
<thead>
<tr>
<th>Message Text</th>
<th>Cause and Corrective Action</th>
</tr>
</thead>
</table>
| Invalid StrategyID. Please enter a StrategyID.                              | Enter a valid Strategy ID.  
[For detailed instructions refer to the procedure for Defining a Production Strategy (previous section of this lesson).] |
| No StrategyID selected. Please select one.                                  | Select a Strategy ID from the list.                                                                                                                                                                                           |
| This StrategyID already exists.                                             | Enter a new name for the Strategy ID.                                                                                                                                                                                         |
| Total Weight must be 100 – Normalize weights.                               | Click on the Normalize push button.                                                                                                                                                                                           |
### Table 3. Production Strategy User Messages

<table>
<thead>
<tr>
<th>Message Text</th>
<th>Cause and Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value out of range (0-10).</td>
<td>Enter a value in the range of 0 – 10.</td>
</tr>
<tr>
<td>Value out of range (0-100).</td>
<td>Enter a value in the range of 0 – 100.</td>
</tr>
</tbody>
</table>

### Table 4. Planning Workbench User Messages

<table>
<thead>
<tr>
<th>Message Text</th>
<th>Cause and Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date entered ‘date that was entered’ is invalid.</td>
<td>Improper date format. Enter the date in <strong>mm/dd/yyyy</strong> format.</td>
</tr>
<tr>
<td>Start Time must be less than Stop Time</td>
<td>Improper time interval setting for plan activation. Enter a start time that is earlier than the stop time.</td>
</tr>
<tr>
<td>The following dpr jobs were failed when you activated the plan &lt;plan name&gt; &lt;list of failed dpr s, one per line&gt; Do you want to recover the failed dpr jobs?</td>
<td>Planning Workbench detects that Job Management has not received the DPRs correctly. The operator needs to be aware that there is (are) failed job(s). Click on <strong>Recover</strong>; the failed jobs will be resubmitted.</td>
</tr>
</tbody>
</table>
| You cannot reschedule with the current active plan. Do you want to create new plan to schedule production request(s) and to reactivate the plan? | Cannot replan under the same plan name.  
1. Select **Yes** to create a new plan that can be used for replanning.  
2. Select **No** and use an existing plan to activate and replan. |
| You have already submitted the plan, <plan name> and this plan is currently active. Do you want to create a new plan? | If the operator has already submitted this plan for activation, PWB will not allow it to be submitted twice.  
1. Select **Yes** to create a new plan that can be used for replanning.  
2. Select **No** and use an existing plan to activate and replan. |
| You need to save the current plan before you activate the plan!!!           | Insures consistency between the database active plan and what actually gets activated.  
Select **Yes** to save the plan. The next time activation is attempted there will be no error message. |
Table 5. Hosts, Servers, Clients and Other Software Relevant to Production Planning

<table>
<thead>
<tr>
<th>HOST</th>
<th>SERVER/CLIENT/OTHER SOFTWARE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning/Management Workstation</td>
<td>Production Request Editor (EcP1PREditor)</td>
</tr>
<tr>
<td></td>
<td>Planning Workbench GUI (EcPIWb)</td>
</tr>
<tr>
<td></td>
<td>Production Strategies GUI (EcPIProdStrat)</td>
</tr>
<tr>
<td></td>
<td>Production Planning Master Timeline (EcPIPlt)</td>
</tr>
<tr>
<td></td>
<td>Message Handler (EcPIMsh)</td>
</tr>
<tr>
<td></td>
<td>System Name Server (EcPISnS)</td>
</tr>
<tr>
<td></td>
<td>Resource Model (EcPIRm)</td>
</tr>
<tr>
<td>PDPS DBMS Server</td>
<td>Subscription Manager (EcPISubMgr)</td>
</tr>
<tr>
<td></td>
<td>Sybase server (e.g., x0pls01_svr)</td>
</tr>
<tr>
<td>Queuing Server (e.g., x0sp04)</td>
<td>Job Management Server (EcDpPrJobMgmt)</td>
</tr>
<tr>
<td></td>
<td>Deletion Server (EcDpPrDeletion)</td>
</tr>
<tr>
<td></td>
<td>On-Demand Manager (EcPIOdMgr)</td>
</tr>
<tr>
<td>SDSRV Server (e.g., x0acs03)</td>
<td>Science Data Server (EcDsScienceDataServer)</td>
</tr>
<tr>
<td>Ingest Server (e.g., x0icg01)</td>
<td>Registry Server (EcCsRegistry)</td>
</tr>
<tr>
<td>Interface Server 01 (e.g., x0ins02)</td>
<td>Advertising Server (EcLoAdServer)</td>
</tr>
<tr>
<td>Interface Server 02 (e.g., x0ins01)</td>
<td>Subscription Server (EcSbSubServer)</td>
</tr>
</tbody>
</table>

NOTE: Depending on the installation, software may be loaded on hosts other than the examples provided.

Handling a Failure to Generate DPRs

There are several possible reasons for the Planning Subsystem to fail to generate DPRs. A failure to generate DPRs could be a normal consequence of one of the production rules. For example, if the Closest Granule production rule applies, there may be times when no acceptable input granules are found. However, a failure to generate DPRs is most likely due to one of the following problems:

• Error creating a subscription for input data.
• Production Request Editor does not query DSS.
• Too many granules meet the criteria for input granules for a particular DPR.

A failure due to “too many granules” is caused when too many granules meet the criteria for input granules for a particular DPR.

• At PGE registration, the number of granules expected for each input ESDT is defined.
  − The definition includes the minimum number and the maximum number of granules expected.
• If the number of granules found is not between the minimum and maximum number, the request fails.
  − The failure occurs either when trying to save the production request or when the PCF file is generated (AutoSys pre-processing step).

Whether the failure to generate DPRs is due to an error creating a subscription for input data or “too many granules,” the first step in investigating the problem is to check the Production Request Editor application log (ALOG) file.

**Checking the Production Request Editor ALOG File**

The procedure for checking the Production Request Editor ALOG file starts with the assumption that the operator has logged in to the ECS system and the Planning/Management Workstation (e.g., e0pls03).

**Checking the Production Request Editor ALOG File**

1. Access a terminal window logged in to the Planning/Management Workstation (e.g., e0pls03, g0pls01, or l0pls02).

2. Type `cd /usr/ecs/MODE/CUSTOM/logs` then press Return/Enter.
   - Change directory to the directory containing the planning log files (e.g., EcPIPREditor.ALOG).

3. Type `pg filename` then press Return/Enter.
   - *filename* refers to the log file to be reviewed (e.g., EcPIPREditor.ALOG).
   - The first page of the log file is displayed.
   - Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., *vi*, *view*, *more*) can be used to review the log file.

4. Review the log file to determine whether the log contains an error message that indicates why the DPR generation failed.
   - For example:

     ```
     Msg: PlPge::GetInputForDpr - Extr input to process DPR
     MoPGE01#2007081600OPS, for data type id MOD000#001, with logical id 599001. PlDataTypeReq has a scienceGroup of for this datatype.
     Expected 2 max inputs, but got 3. Priority : 2 Time : 07/09/99 17:10:52
     ```

     − In the example the Production Request Editor queried the PDPS database for granules that would satisfy the data needs for the DPR and found three granules instead of the two it expected (i.e., “Expected 2 max inputs, but got 3”).
Consequently, the Production Request failed due to “too many granules.”

5 If there is an error in the log file indicating that too many granules meet the criteria for input granules for a particular DPR, go to the procedure for Checking the PDPS Database for Causes of Failure to Generate DPRs (subsequent section of this lesson).

6 If there is an error in the log file indicating that Advertising could not find an entry for a specific ESDT in its database, notify the Science Data Specialist or whoever else installs ESDTs to verify that the corresponding ESDT(s) has/have been properly installed.

- Advertising receives information concerning ESDTs when they are installed in Science Data Server.
- Advertising puts entries in its database for each ESDT installed and lists the UR of the Data Server (the server UR) that provides services for the ESDT (inserts/acquires/searches).
- If Advertising cannot find an entry for the ESDT in question it indicates either of the following conditions:
  - The ESDT was not installed.
  - The ESDT was not installed properly.

7 If there is an error in the log file indicating a subscription error, notify the Science Data Specialist or whoever else installs ESDTs to verify that the corresponding ESDT(s) has/have been properly installed.

- If subscription errors exist in the log, it is most likely that the ESDT in question (for the input) was either not installed or improperly installed.
- Notify the Science Data Specialist or whoever else installs ESDTs to verify that the corresponding ESDT(s) has/have been properly installed.

8 If there is an error in the log file indicating DCE problems, notify the Operations Controller/System Administrator of the suspected DCE problems.

9 If there is an error in the log file indicating database problems, log in to the PDPS DBMS Server host (e.g., e0pls02, g0pls02, or l0pls01) as described in Steps 1 through 4 of the procedure for Launching the Production Request Editor (previous section of this lesson).

10 If there is an error in the log file indicating database problems, type `ps -ef | grep sybase` then press Return/Enter.

- The following type of message is displayed:

  `x0pls01(cmshared)43: ps -ef | grep sybase`
In the example the entry that includes “/usr/ecs/OPS/COTS/sybase/bin/dataserver -d/dev/rdsk/c0t2d0s4 -sx0pls01_srvr -e/” indicates that the PDPS database server is running.

If the PDPS database server were not running, the following type of message only would be displayed:

```
cmshared 15516 15405 0 14:20:33 pts/6 0:00 grep sybase
```

If there is an error in the log file indicating database problems and the database servers are running, go to the procedure for Checking the PDPS Database for Causes of Failure to Generate DPRs (subsequent section of this lesson).

- Check for lack of (or corruption of) data in the database.

If the database servers are not running, notify the Database Administrator of the problem.

If there is an error in the log file indicating lack of disk space, type `cd /path` then press Return/Enter.

- Change directory to a directory on the full disk from which files can be deleted.

If there is an error in the log file indicating lack of disk space, type `rm filename1 … filenamex` then press Return/Enter.

- `filename1 … filenamex` represent unnecessary files to be removed.

- Use wild cards if appropriate.
  - For example:
    ```
    rm * .hdf
    ```
    would prompt the system to remove all files with a suffix of .hdf.
If removing files from a full disk, respond appropriately to system prompts.

- For example:
  
  `rm: remove trashfile.rs (yes/no)? y`

If there is a recurring disk space problem, notify the Operations Controller/System Administrator of the problem.

If the log contains an error message which indicates that a configuration item in another subsystem may be the source of the problems, consult with the relevant technician (e.g., Ingest/Distribution Technician) to request assistance in isolating the problem.

If the log does not contain an error message that indicates why the DPR generation failed, perform the procedure for **Checking the PDPS Database for Causes of Failure to Generate DPRs** (subsequent section of this lesson).

When the problem has been corrected, use the procedure for **Creating a New Production Request** (previous section of this lesson) to re-create the Production Request that led to discovery of the problem.

---

**Using ISQL to Check Database Tables**

The PDPS database is the repository of data concerning PGEs, Production Requests, Data Processing Requests, Production Strategies, Production Plans and other production-related data. The data stored in the database can be checked using either a database browser or isql commands. The procedure in this section describes how to check the tables using isql commands.

The procedure for using isql to check database tables starts with the assumption that the operator has logged in to the ECS system and the Planning/Management Workstation (e.g., e0pls03).

**Using ISQL to Check Database Tables**

1. Access a terminal window logged in to the Planning/Management Workstation (e.g., e0pls03, g0pls01, or l0pls02).

2. Type `isql –UuserID -SDBServer` then press Return/Enter.
   - For example:
     
     `isql –Updps_role –Sx0pls01_srvr`

3. At the **Password:** prompt type `dbpassword` then press Return/Enter.
   - The `dbpassword` is the password for logging in to the database using the specified `userID`.
4 Type **use dbname** at the **1>** prompt then press **Return/Enter**.
   - The **dbname** is likely to be one of the following names:
     - **pdps** [OPS mode].
     - **pdps_TS1** [TS1 mode].
     - **pdps_TS2** [TS2 mode].

5 Type **go** at the **2>** prompt then press **Return/Enter**.

6 Type **select * from TableName** at the **1>** prompt then press **Return/Enter**.
   - Alternatively, type **select columnName from TableName** at the **1>** prompt then press **Return/Enter**.
   - Another alternative is to type **select columnName1,columnName2[,columnName3,…] from TableName** at the **1>** prompt then press **Return/Enter**.

7 Type **go** at the **2>** prompt then press **Return/Enter**.
   - Table contents are displayed.
     - If * was specified, all entries in the table are displayed.
     - If specific columnNames were entered, the data associated with those columns only are displayed.

8 To exit from isql type **quit** at the **1>** prompt then press **Return/Enter**.

---

**Checking the PDPS Database for Causes of Failure to Generate DPRs**

The PDPS database is a useful resource for troubleshooting a failure to generate DPRs. Certain values must be entered in tables in the PDPS database during the DPR generation process in order for the DPRs to be successfully generated.

- The subscriptionFlag values (PIDataTypeMaster table) for all the data types (ESDTs) needed for the PGE are set.
- The Science Data Server UR is entered in the dataServUrString column (PIDataTypeMaster table) for all data types (ESDTs) needed for the PGE.
- If the PGE specified in the Production Request requires static files, the URs for the static files are included in PIDataGranuleShort table (universalReference column).

The procedure to check the PDPS database for causes of failure to generate DPRs starts with the assumption that the operator has logged in to the ECS system and the Planning/Management Workstation (e.g., e0pls03).
Checking the PDPS Database for Causes of Failure to Generate DPRs

1. Log in to the PDPS database as described in Steps 1 through 5 of the procedure for Using ISQL to Check Database Tables (previous section of this lesson).

2. Type `select dataTypeId,subscriptionFlag from PlDataTypeMaster` at the 1> prompt then press Return/Enter.
   - Prepare a request to view PlDataTypeMaster table subscriptionFlag column values for all data types (dataTypeId column).

3. Type `go` at the 2> prompt then press Return/Enter.
   - Contents of specified columns of the PlDataTypeMaster table are displayed.
   - For example:

   ```
   1> select dataTypeId,subscriptionFlag from PlDataTypeMaster
   2> go
   dataTypeId       subscriptionFlag
   -----------------------  ---------------
   AM1ATTNF#001       40
   AM1EPHN0#001       39
   AP#001             1
   ActSched#001       38
   DAP#001            1
   MIBB1#001          0
   MIBB2E#001         0
   MIBB2T#001         0
   MIANCAGF#001       0
   MIANCARP#001       0
   MIANCSSC#001       0
   MIANPP#001         0
   MIANRCCH#001       0
   MIBILM#001         0
   MIB2GEOP#001       42
   MICNFG#001         0
   MILIA#001          0
   PGEEXE#001         1
   PH#001             1
   SSAPC#001          1
   (20 rows affected)
   ```

   - During DPR generation, the DPR executable should turn the subscriptionFlag for all the data types (ESDTs) needed for the PGE from zero to non-zero.
   - If the subscriptionFlag values for the data types did not turn to non-zero, subscription trouble is indicated.

4. If the subscriptionFlag value for any ESDT needed for the PGE is *zero*, make a note of the fact for subsequent reporting of the problem.
Type `select dataTypeId, dataServUrString from PlDataTypeMaster` at the 1> prompt then press `Return/Enter`.

- Prepare a request to view PlDataTypeMaster table dataServUrString column values for all data types.

Type `go` at the 2> prompt then press `Return/Enter`.

- Contents of specified columns of the PlDataTypeMaster table are displayed.
- For example:

```
1> select dataTypeId, dataServUrString from PlDataTypeMaster
2> go
dataTypeId     dataServUrString
-------------------­-----------------------------------------
AM1ATTNF#001     UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]
AM1EPHN0#001     UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]
AP#001           NULL
ActSched#001     UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]
DAP#001          NULL
MI1B1#001        UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]
MI1B2E#001       UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]
MI1B2T#001       UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]
MIANCAGP#001     UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]
MIANCARP#001     UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]
MIANCSSC#001     UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]
MIANPP#001       UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]
MIANRCCH#001     UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]
MIB1LM#001       NULL
MIB2GEOP#001     UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]
MICNFG#001       UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]
MILA1#001        UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]
PGEXE#001        UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]
PH#001
```
During DPR generation, the DPR executable should turn the dataServUrString for all the ESDTs needed for the PGE from “NULL” to the UR value for Science Data Server (e.g., UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]).

If the dataServUrString value for any ESDTs needed for the PGE does not have the UR value for the Science Data server (e.g., is NULL), make a note of the fact for subsequent reporting of the problem.

If the PGE specified in the Production Request requires static files, type `select dataTypeId,universalReference from PlDataGranuleShort` at the 1> prompt then press Return/Enter.

- Prepare a request to view PlDataGranuleShort table universalReference column for the URs of the necessary static files.
- If there is data on many data types in the PlDataGranuleShort table, it may be advisable to limit the search, for example:

```sql
1> select dataTypeId,universalReference from PlDataGranuleShort where dataTypeId = "AM1ATTNF#001"
```

- In the example AM1ATTNF#001 is the data type being checked.

Type `go` at the 2> prompt then press Return/Enter.

- Contents of specified columns of the PlDataGranuleShort table are displayed.
- For example:

```sql
1> select dataTypeId,universalReference from PlDataGranuleShort where dataTypeId = "AM1ATTNF#001"
2> go
   dataTypeId
   universalReference
   -------------------­
   -----------------------------------------------

AM1ATTNF#001
   UR:10:DsShESDTUR:UR:15:DsShSciServerUR:13:[MDC:DSSDSRV]:20:
   SC:AM1ATTNF.001:1449
```

(1 row affected)
• If the PGE requires static files, the URs for the static files must be included in the PlDataGranuleShort table in order for a DPR to be successfully generated.

• For dynamic granules, the corresponding UR values may become available during DPR generation; however, if the dynamic granules’ URs do not become available during DPR generation, there is no effect on DPR generation.

10 If the PGE requires static files, and the URs for the static files are not in the PlDataGranuleShort table, make a note of the fact for subsequent reporting of the problem.

11 To exit from isql type quit at the 1> prompt then press Return/Enter.

12 If any problems were noted in the PDPS database (e.g., subscriptionFlag value zero or no static file UR), report the problem(s) to the SSI&T team and/or call the help desk and submit a trouble ticket in accordance with site Problem Management policy.

• There may be a problem with PGE registration (especially if no other PGEs are affected) or other problem associated with the SSI&T process.

13 If no problems were noted in the PDPS database and the production request failed because too many granules met the criteria for input granules for a particular DPR, consider requesting the Database Administrator to adjust the values assigned to the MaxSlippagePerc and/or AcceptableCertainty parameters for the Production Request Editor (EcPIPREditor) in the Configuration Registry.

• The MaxSlippagePerc parameter specifies the padding that is added to each side of the range for a query (for input granules).
  – If the padding (MaxSlippagePerc) were decreased, excessive granules might not be found.

• The AcceptableCertainty parameter specifies the minimum size that the Planning Subsystem recognizes as a valid granule.
  – If the AcceptableCertainty value were set closer to 100%, granules that are too small might be filtered out.

---

**DPR Explosion Fails Because Production Request Editor does Not Query DSS for Data**

If the Production Request Editor reports a failure creating a DPR that is subject to the Metadata Query production rule, the process for responding to the problem consists of the following activities:

• Check the "debug" log for evidence that the Science Data Server was queried for metadata values.
If there is no message in the debug log indicating that the Science Data Server was queried for metadata values, the SSI&T team should check for an error in the appropriate PGE science metadata ODL file.

Checking the Production Request Editor Debug File for Evidence of Metadata Queries

The procedure for checking the Production Request Editor Debug file starts with the assumption that the operator has logged in to the ECS system and the Planning/Management Workstation (e.g., e0pls03).

Checking the Production Request Editor Debug File for Evidence of Metadata Queries

1. Access a terminal window logged in to the Planning/Management Workstation (e.g., e0pls03, g0pls01, or l0pls02).
2. Type `cd /usr/ecs/MODE/CUSTOM/logs` then press Return/Enter.
   - Change directory to the directory containing the planning log files (e.g., EcPIPREditorDebug.log).
3. Type `pg filename` then press Return/Enter.
   - `filename` refers to the log file to be reviewed (e.g., EcPIPREditorDebug.log).
   - The first page of the log file is displayed.
   - Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., `vi`, `view`, `more`) can be used to review the log file.
4. Review the log file to determine whether the log contains a message that indicates why the DPR generation failed.
   - When the Production Request Editor queries the Science Data Server to search for the PGE’s input(s), the query should include the metadata value(s) desired by the PGE.
   - Note that events are recorded in the debug log in chronological order and are preceded by a time and date stamp.
   - If there is no message which indicates that the Science Data Server was queried for the metadata value(s) desired by the PGE, there may be an error in the PGE Metadata ODL File for the PGE.
5. If there was no message in the debug log indicating that the Science Data Server was queried for metadata values, submit a request to the SSI&T team to check for an error in the appropriate PGE science metadata ODL file and re-register the PGE.
   - After the SSI&T team has edited the ODL file and re-registered the PGE it should be possible to successfully create DPRs for the PGE.
Responding to PR or DPR Deletion that Hangs

When deleting DPRs or PRs from the Production Request Editor, the Job Management server and Deletion Server (both in DPS) are called to clean up all PDPS database tables associated with the DPR or PR. It is possible that any failure or "hung" condition can be attributed to the Production Request Editor itself or the Deletion or Job Management server. If the servers are functioning properly, there are two other possible causes:

- The database is locked.
- There may be resource locks in the PDPS database.

Checking for Database Deadlocks

A deadlock occurs when a database transaction locks a record that another transaction needs and the second transaction locks the record that first transaction needs. Each program must wait until the other completes. However, neither can complete (because each is waiting for the other) so both end up waiting indefinitely.

The procedure for checking for database deadlocks starts with the assumption that the operator has logged in to the ECS system and the Planning/Management Workstation (e.g., e0pls03).

Checking for Database Deadlocks

1 Log in to the PDPS database as described in Steps 1 through 5 of the procedure for Using ISQL to Check Database Tables (previous section of this lesson).

2 Type `sp_lock` at the `1>` prompt then press Return/Enter.

3 Type `go` at the `2>` prompt then press Return/Enter.

- The following type of result is displayed:

```
   ---  locktype          table_id   page  dbname
       class          ------  -------------  -------
    ------  ---------------------------- -------
     17  Sh_intent Non Cursor Lock  197575742  0  pdps
     20  Sh_intent Non Cursor Lock  197575742  0  pdps
     23  Sh_intent Non Cursor Lock  448004627  0  master
     24  Ex_intent-blk Non Cursor Lock  85575343  0  pdps
     24  Ex_page   Non Cursor Lock  85575343  1225  pdps
     24  Ex_page   Non Cursor Lock  85575343  1257  pdps
```
Non Cursor Lock
24 Ex_table-blk  85575343  0 pdps
Non Cursor Lock
24 Ex_intent  197575742  0 pdps
Non Cursor Lock
24 Ex_page-blk  197575742  1313 pdps

(9 rows affected, return status = 0)

• In the preceding example the...
  – spid column shows the process id. The database user that owns a process can be determined using the sp_who isql command.
  – locktype column indicates a problem if the entry starts with "Ex_" (exclusive).
  – table_id column identifies the table that the corresponding spid has locked. The name of the table can be determined using the select command [i.e., select object_name (table_id)].

• In the example the locks of concern are related to spid 24, Table IDs 197575742 and 85575343.

4 Type select object_name (table_id) at the 1> prompt then press Return/Enter.
• For example, to check the exclusive locks related to spid 24, table ID 197575742 in the preceding example, type:
  1> select object_name (197575742)

5 Type go at the 2> prompt then press Return/Enter.
• The following type of result is displayed:

-------------
PlDprData

(1 row affected)

– Table ID 197575742 refers to the PlDprData table in the database.

• To check the exclusive locks related to spid 24, table ID 85575343 in the preceding example, type:

  1 select object_name (85575343)
  2 go

– The following type of result is displayed:

-------------
PlDataGranuleShort
Table ID 85575343 refers to the PlDataGranuleShort table in the database.

6 Type `sp_who` at the `1>` prompt then press Return/Enter.

7 Type `go` at the `2>` prompt then press Return/Enter.

- The following type of result is displayed:

<table>
<thead>
<tr>
<th>spid</th>
<th>status</th>
<th>dbname</th>
<th>loginame</th>
<th>cmd</th>
<th>hostname</th>
<th>blk</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>recv</td>
<td>pdps_TS2</td>
<td></td>
<td>EcPlSubMgr</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>recv</td>
<td>pdps_TS2</td>
<td></td>
<td>EcPlSubMgr</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>recv</td>
<td>pdps_TS2</td>
<td></td>
<td>EcDpPrDeletion</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>recv</td>
<td>pdps_TS2</td>
<td></td>
<td>EcDpPrJobMgmt</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>11</td>
<td>recv</td>
<td>pdps_TS1</td>
<td></td>
<td>EcPlSubMgr</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>12</td>
<td>recv</td>
<td>pdps_TS1</td>
<td></td>
<td>EcPlSubMgr</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>13</td>
<td>recv</td>
<td>pdps_TS1</td>
<td></td>
<td>EcDpPrDeletion</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>14</td>
<td>recv</td>
<td>pdps_TS1</td>
<td></td>
<td>EcDpPrJobMgmt</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>15</td>
<td>lock</td>
<td>pdps</td>
<td></td>
<td>EcDpPrDeletion</td>
<td></td>
<td>24</td>
</tr>
<tr>
<td>16</td>
<td>recv</td>
<td>pdps</td>
<td></td>
<td>EcDpPrJobMgmt</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>17</td>
<td>lock</td>
<td>pdps</td>
<td></td>
<td>EcPlSubMgr</td>
<td></td>
<td>24</td>
</tr>
<tr>
<td>18</td>
<td>recv</td>
<td>pdps</td>
<td></td>
<td>EcPlSubMgr</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>19</td>
<td>recv</td>
<td>pdps_TS2</td>
<td></td>
<td>pdps_role</td>
<td>10ais01</td>
<td>0</td>
</tr>
<tr>
<td>20</td>
<td>lock</td>
<td>pdps</td>
<td></td>
<td>EcDpPrEM</td>
<td></td>
<td>24</td>
</tr>
<tr>
<td>21</td>
<td>recv</td>
<td>pdps</td>
<td></td>
<td>EcDpPrJobMgmt</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>22</td>
<td>lock</td>
<td>pdps</td>
<td></td>
<td>EcDpPrDM</td>
<td></td>
<td>24</td>
</tr>
<tr>
<td>23</td>
<td>running</td>
<td>pdps</td>
<td></td>
<td>EcPlWb</td>
<td>10pls01</td>
<td>0</td>
</tr>
<tr>
<td>24</td>
<td>recv</td>
<td>pdps</td>
<td></td>
<td>EcPlSubMgr</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>25</td>
<td>recv</td>
<td>pdps</td>
<td></td>
<td>EcPlSubMgr</td>
<td></td>
<td>0</td>
</tr>
</tbody>
</table>

(25 rows affected, return status = 0)
• The **blk** column shows the spid of the process that is doing the blocking.
• The **command** column shows the command that the blocked process is trying to complete.

### 8 Analyze the results of the request.

• In the example shown, EcPlSubMgr (spid 24) is blocking SELECT transactions by the following database users:
  - EcDpPrDM (spid 22).
  - EcDpPrEM (spid 20).
  - Itself (spid 17 - presumably another thread).
  - EcDpPrDeletion (spid 15).

### 9 To exit from isql type **quit** at the 1> prompt then press **Return/Enter**.

### 10 If there is a deadlock in the database, ask the Operations Controller to bounce the server that is causing the deadlock.

• In the preceding example, the Subscription Manager (EcPlSubMgr) should be bounced.

### 11 If there is no deadlock, perform the procedure for **Checking for Resource Locks in the PDPS Database** (subsequent section of this lesson).

---

### Checking for Resource Locks in the PDPS Database

Resource locks used to occur if there was an attempt to delete DPRs/PRs while their corresponding jobs were still running in AutoSys or jobs had been explicitly killed before the DPRs/PRs were deleted. However, resource locking has been removed for all Resource Management calls (e.g., for allocating CPUs and disk space). The locks have been replaced with the following features:

• Sybase stored procedures that use transactions.
• Database triggers.

Resource locking is still used for disk space reclamation. Momentary system interruptions occur during the process of disk space reclamation. The interruptions may happen several times a day. The system may look like it is "hung" during such periods. The procedure that follows should be performed to verify that disk space reclamation is proceeding normally:

Although the procedure for checking for resource locks in the PDPS database includes the use of isql commands, an acceptable alternative is to use a database browser to check the contents of the DpPrResourceLock table. The procedure for checking for resource locks in the PDPS
database starts with the assumption that the operator has logged in to the ECS system and the Planning/Management Workstation (e.g., e0pls03).

Checking for Resource Locks in the PDPS Database

1. Log in to the PDPS database as described in Steps 1 through 5 of the procedure for Using ISQL to Check Database Tables (previous section of this lesson).

2. Type `select * from DpPrResourceLock` at the 1> prompt then press Return/Enter.
   - Prepare a request to view the contents of the DpPrResourceLock table.

3. Type `go` at the 2> prompt then press Return/Enter.
   - The contents of the DpPrResourceLock table are displayed.
   - For example:
     
     ```
     jobId priority ecsUnit
     attempts
     state pid queuePosition
     ---------------------------------------- ----------- ----------- ------------------­
     --­
     --­
     --­
     
     (0 rows affected)
     ```
   - There are no resource locks in the example.

4. Type `go` at the 2> prompt then press Return/Enter.

5. Analyze the results of the request.
   - A jobId with a state <> 0 would indicate a resource lock.
     - If there are entries in the DpPrResourceLock table and there are no other jobs running in AutoSys, all entries in the table need to be deleted before the DPR/PR deletion can complete.
     - If other jobs (DPRs) are currently being executed in AutoSys and the other jobs should not be deleted, the entries in the table that need to be deleted are those related to the job to be deleted only. The entries concerning the other (running) jobs must be left in the table.
   - If there is no evidence of a resource lock, go to Step 9.

6. If all entries in the DpPrResourceLock table are to be deleted, type `delete DpPrResourceLock` at the 1> prompt then press Return/Enter.
   - Go to Step 8.
If some (but not all) entries in the DpPrResourceLock table are to be deleted, type `delete DpPrResourceLock where jobId like "jobId"` at the 1> prompt then press Return/Enter.

- `jobId` specifies the job whose entries are to be deleted.

Type `go` at the 2> prompt then press Return/Enter.

- Entries in the DpPrResourceLock table are deleted.
- The DPR/PR deletion that was delayed by the resource lock should go to completion.

To exit from isql type `quit` at the 1> prompt then press Return/Enter.

- If entries were deleted from the DpPrResourceLock table the procedure is finished; otherwise, continue with Step 10.

Access a terminal window logged in to the Queuing Server (e.g., e0sp04, g0sp06, or l0sp03).

Type `cd /usr/ecs/MODE/CUSTOM/logs` then press Return/Enter.

- Change directory to the directory containing the data processing log files (e.g., EcDpPrJobMgmt.ALOG, EcDpPrDeletion.ALOG).

Type `cd /usr/ecs/MODE/CUSTOM/logs` then press Return/Enter.

- Change directory to the directory containing the planning log files (e.g., EcPlPREditorDebug.log).

Type: `tail -f jobId.err` then press Return/Enter.

- `jobId.err` refers to the data processing log file to be reviewed.

Observe the log file to determine whether messages are being entered in the file.

- If messages are being entered in the log file, there is probably no resource lock.

If no there is no database deadlock or resource lock and the servers (especially Deletion Server and Job Management Server) are up, call the help desk and submit a trouble ticket in accordance with site Problem Management policy.

### Responding to DPR Deletion that Fails

When deleting DPRs or PRs from the Production Request Editor, both the Job Management server and Deletion Server (both DPS servers) are called to clean up all PDPS database tables associated with the DPR or PR. It is possible that any failure or "hung" condition can be attributed to the Production Request Editor itself or to the Job Management server or Deletion Server.
The procedure for responding to DPR deletion that fails starts with the assumption that the operator has logged in to the ECS system and the Planning/Management Workstation (e.g., e0pls03).

**Responding to DPR Deletion that Fails**

1. Access a terminal window logged in to the appropriate host.

2. Type `cd /usr/ecs/MODE/CUSTOM/logs` then press **Return/Enter**.  
   - Change directory to the directory containing the planning log files (e.g., EcPlPREditorDebug.log).

3. If there is a Deletion Server Debug log, type `pg filename` then press **Return/Enter**.  
   - `filename` refers to the data processing log file to be reviewed (e.g., EcDpPrDeletionDebug.log).  
   - The first page of the log file is displayed.  
   - Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., `vi`, `view`, `more`) can be used to review the log file.

4. If there is a Deletion Server Debug log, review the log file for error messages.  
   - For example:
     ```
     Could not make database interface to DpPrFile
     Aborting: will report error to client.
     ```
   - The message in the example indicates a compilation problem in Deletion Server so Deletion Server cannot communicate with the PDPS database.  
     - When Deletion Server was compiled the RogueWave database (RWDB) libraries were not linked correctly.  
     - The most likely cause is the fact that the Deletion Server Imakefile was changed so that the DPS make.options was included.

5. If an error message of the type shown in the previous step was present in the log, notify the Operations Controller/System Administrator of the problem.
Handling a DPR Scheduling failure

There are three principal sources of information concerning failures to activate DPRs from the Planning Workbench:

- The Planning Workbench GUI itself may provide an error message.
  - The message would indicate either success or failure.
  - It would not indicate why the request failed.
- The Planning Workbench Message Handler (the window that comes up before the Planning Workbench and to which the Workbench logs various messages).
  - Any error encountered should be logged to the Message Handler.
- The Planning Workbench logs (debug log and ALOG).
  - The logs are located in the /usr/ecs/{MODE}/CUSTOM/logs directory and begin with “EcPlWb” (e.g., EcPlWbDebug.log, EcPlWb.ALOG).
  - The logs can further refine the cause of the error.

If job activation fails from the Planning Workbench, one of the following errors is likely to be reported:

- "DPR Validation Failed"
- "information (INFO) Production Request {Production Request Id} has unschedulable DPR {DPR Id}"

Responding to a "DPR Validation Failed" Error

There are two conditions that may cause a "DPR Validation Failed" error to be reported:

- Performance data for the PGE are missing from the PDPS PlPgePerformance database table.
- Resource information for the PGE is missing from the PDPS PlResourceRequirement database table.

Consequently, it is necessary to check the appropriate PDPS database tables to determine whether the necessary PGE information is in the database.

Although the procedure for responding to a "DPR Validation Failed" error includes the use of isql commands, an acceptable alternative is to use a database browser to check the contents of the PlPerformance and PlPgePerformance tables. The procedure for responding to a "DPR Validation Failed" error starts with the assumption that the operator has logged in to the ECS system and the Planning/Management Workstation (e.g., e0pls03).
Responding to a "DPR Validation Failed" Error

1. Log in to the PDPS database as described in Steps 1 through 5 of the procedure for Using ISQL to Check Database Tables (previous section of this lesson).

2. Type `select * from PlPgePerformance` at the `1>` prompt then press Return/Enter.
   - Prepare a request to view the contents of the PlPgePerformance table.

3. Type `go` at the `2>` prompt then press Return/Enter.
   - The contents of the PlPgePerformance table are displayed.
   - For example:

```
1> select * from PlPgePerformance
2> go
   pgeId     cpuTime    pgeElapsedTime  dprElapsedTime  
 maxMemory  faults    swaps           
 blockInputOperation runCpuTime  runMaxMemory 
 runPgeElapsed
 runDprElapsed  runFaults    runSwaps    runBlockInOperation 
 runBlockOutOperation sharedMemory  runSharedMemory
----------------- ----------- -------------- -------------
-------------------- ----------- ----------- ---------------
-------------------- ----------- -------------------- ------
------------------- -------------------- ... 100
100 0.000000 0.000000
ETS#syn1#01 55 1800 1800
100 10.000000 100 100
100 1800
100 55 10.000000
1800
100 0.000000
ETS#syn1#01
100 10.000000 100
100 100 55 10.000000
1800
1800 100 100 100
```
The PGEs in the example have appropriate entries for performance data.

- For the PGE(s) that is (are) not schedulable, verify there are non-zero values for the entries in the table.

- As shown in the example, zero may be appropriate for some columns but not for all.

4 Type `select * from PlResourceRequirement` at the `1>` prompt then press `Return/Enter`.

- Prepare a request to view the contents of the PlResourceRequirement table.

5 Type `go` at the `2>` prompt then press `Return/Enter`.

- The contents of the PlResourceRequirement table are displayed.

- For example:

```
1> select * from PlResourceRequirement
2> go

<table>
<thead>
<tr>
<th>sswId</th>
<th>numOfCPUs</th>
<th>computer</th>
<th>diskSpace</th>
<th>topLevelShellName</th>
<th>mcfName</th>
<th>ramSize</th>
<th>exeUntarFileDiskSpace</th>
<th>exeTarUR</th>
<th>pgeId</th>
<th>toolkitArchitecture</th>
<th>pgeCommands</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACT#syn1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x0spg01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

(2 rows affected)
The PGEs in the example have appropriate entries for resource data.

- For the PGE(s) that is (are) not schedulable, verify that there are non-zero values for the entries in the table.
  - As shown in the example, zero may be appropriate for some columns but not for all.

6 Exit from isql. (Type quit at the 1> prompt then press Return/Enter.)

7 If the entries in either the PIPgePerformance or PIResourceRequirement table are not appropriate, make a request to the SSIT team to have the correct values entered.

8 Delete the affected DPR(s) as described in the procedure for Deleting a Data Processing Request (previous section of this lesson).

9 When the SSIT team has completed updating the PGE information in the PDPS database, create a new Production Request to replace the affected DPR(s) as described in the procedure for Creating a New Production Request (previous section of this lesson).

10 Create and activate a new Production Plan (to send the replacement DPR(s) to data processing) as described in the procedure for Creating a New Production Plan (previous section of this lesson).
Responding to an "information (INFO) Production Request {Production Request Id} has unschedulable DPR {DPR Id}" Error

When an "information (INFO) Production Request {Production Request Id} has unschedulable DPR {DPR Id}" error is reported on the Message Handler, one of two problems is likely:

- A predecessor DPR exited in a "bad" state.
  - The unschedulable DPR depends on the predecessor DPR for input data.
  - The predecessor DPR is in either a completed or an error status, or was not included in the activated plan.
- The current DPR has a "QA_FAILURE."
  - A metadata check or query for the DPR failed so the DPR cannot be scheduled.

Consequently, it is necessary to check the appropriate PDPS database tables and possibly the Planning Workbench debug log to localize the problem.

Although the procedure for responding to an "information (INFO) Production Request {Production Request Id} has unschedulable DPR {DPR Id}" error includes the use of isql commands, an acceptable alternative is to use a database browser to check the contents of the appropriate tables. The procedure starts with the assumption that the operator has logged in to the ECS system and the Planning/Management Workstation (e.g., e0pls03).

**Responding to an "information (INFO) Production Request {Production Request Id} has unschedulable DPR {DPR Id}" Error**

1. Log in to the PDPS database as described in Steps 1 through 5 of the procedure for Using ISQL to Check Database Tables (previous section of this lesson).

2. Type `select * from PlDataProcessingRequest` at the `1>` prompt then press Return/Enter.
   - Prepare a request to view the contents of the PlDataProcessingRequest table.
   - If there is data on many DPRs in the PlDataProcessingRequest table, it may be advisable to limit the search, for example:
     ```sql
     1> select * from PlDataProcessingRequest where dprId like "AM1Eph#30002282200TS2"
     ```
     - In the example `AM1Eph#30002282200TS2` is the predecessor DPR being checked.

3. Type `go` at the `2>` prompt then press Return/Enter.
   - The contents of the PlDataProcessingRequest table are displayed.
• For example:

```sql
1> select * from PlDataProcessingRequest
2> go
dprId productionRequestId priority
predictedStart productionRequestId priority
actualStart
completionState
pgeId baselineTime
name dataStartTime
dataStopTime sswId dprCollectionId
alarmTime lateMessagesSent autosysId
tileId timeStamp
```

<table>
<thead>
<tr>
<th>ACT#syn1#004130123TS2</th>
<th>Aster_Pr</th>
<th>250</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan 18 2000 7:39PM</td>
<td>Jan 18 2000 7:39PM</td>
<td></td>
</tr>
</tbody>
</table>

**STARTED**

<table>
<thead>
<tr>
<th>ACT#syn1#01</th>
<th>Jan 18 2000 7:39PM</th>
</tr>
</thead>
</table>

**SUCCESS**

| AM1Eph#3000102 | Jan 12 2000 2:00PM |
| AM1Eph#3000030012200TS2 | Feb 28 2000 5:00PM |

- For the predecessor DPR to the unschedulable DPR, verify that the completionState is SUCCESS.

4 Exit from isql. (Type `quit` at the `1>` prompt then press `Return/Enter`.)
If the **completionState** for the predecessor DPR to the unschedulable DPR is **not SUCCESS** (for example, if completionState is FAILEDPGE or CANCELED), perform Steps 6 through 8; otherwise, go to Step 9.

Delete the unschedulable DPR(s) and its predecessor(s) as described in the procedure for **Deleting a Data Processing Request** (previous section of this lesson).

Create new Production Request(s) to replace the affected DPR(s) as described in the procedure for **Creating a New Production Request** (previous section of this lesson).

Create and activate a new Production Plan (to send the replacement DPR(s) to data processing) as described in the procedure for **Creating a New Production Plan** (previous section of this lesson).

If the **completionState** for the predecessor DPR to the unschedulable DPR is **SUCCESS**, type **cd /usr/ecs/MODE/CUSTOM/logs** then press Return/Enter.

- For **MODE** type the desired operating mode.
- Change directory to the directory containing the appropriate log files (e.g., EcPlWbDebug.log).

Type **pg filename** then press Return/Enter.

- **filename** refers to the data processing log file to be reviewed (e.g., EcPlWbDebug.log).
- The first page of the log file is displayed.
- Although this procedure has been written for the **pg** command, any UNIX editor or visualizing command (e.g., vi, view, more) can be used to review the log file.

Review the log file to determine whether the log contains an error message (concerning the unschedulable DPR) that indicates why the DPR generation failed.

- Look for an entry for the unschedulable DPR that contains either "QA_FAILURE" or "INVALID."
  - "QA_FAILURE" indicates a problem with a metadata check/query so the DPR cannot be scheduled.
  - "INVALID" indicates that DPR validation failed.

If the log contains an error message that includes the term "INVALID", perform the procedure for **Responding to a "DPR Validation Failed" Error** (previous section of this lesson).

If the log contains a "QA_FAILURE" error message, log in to the PDPS database as described in Steps 1 through 4 of the procedure for **Using ISQL to Check Database Tables** (previous section of this lesson).
14  Type select * from PlDprData at the 1> prompt then press Return/Enter.

- Prepare a request to view the contents of the PlDprData table.
- If there is data on many DPRs in the PlDprData table, it may be advisable to limit the search, for example:

  1> select * from PlDprData where dprId like "ACT#syn1#004130123TS2"

  In the example ACT#syn1#004130123TS2 is the DPR being checked.

15  Type go at the 2> prompt then press Return/Enter.

- The contents of the PlDprData table are displayed.
- For example:

```sql
1> select * from PlDprData
2> go

 dprId
 granuleId
 logicalId primaryType accepted theOrder
type temporalFlag timeWait ioFlag timerExp timerStart
numNeeded waitForFlag linkId minGranReq
-------------------------------
---------------------------------------------------------
----------- -------------------- ----------- -----------
----------- ----------- ----------- -------- ----------
----------- ----------- -----------
ACT#syn1#004130123TS2
AST_09T#00107041997130123000
2000 NULL 0 1
0
0 0 1 0 0
0 0 1
1 NULL 0
ACT#syn1#004130123TS2
AST_ANC#001L1000
1200 1200
1 1
```
Note that for each DPR there are separate entries for the different data types.

For all entries for the unschedulable DPR, verify that the values in the **accepted** column are **not** equal to 2.

- A value of 2 in the **accepted** column indicates that the metadata check/query for the corresponding input (**granuleId** column) failed.

16 Type **select * from PlEsdtParam** at the 1> prompt then press **Return/Enter**.

- Prepare a request to view the contents of the PlEsdtParam table.
- If there is data on many data types in the PlEsdtParam table, it may be advisable to limit the search, for example:

  1> select * from PlEsdtParam where dataTypeId like "AST_L1B#001"

  - In the example **AST_L1B#001** is the data type being checked.

17 Type **go** at the 2> prompt then press **Return/Enter**.

- The contents of the **PlEsdtParam** table are displayed.
- For example:

  1> select * from PlEsdtParam
  2> go
Verify that there are entries for the appropriate `dataTypeId` in the PLEstdParam table.

Note that in the example there are no entries for any data type.

If no entry for the unschedulable DPR has a value equal to 2 in the `accepted` column, type `select * from PLEstdParmValues` at the `1>` prompt then press `Return/Enter`.

- Prepare a request to view the contents of the PLEstdParmValues table.

Type `go` at the `2>` prompt then press `Return/Enter`.

- The contents of the `PLEstdParmValues` table are displayed.

- For example:

  ```
  1> select * from PLEstdParmValues
  2> go
  esdtParmName
  esdtParmVal
  granuleId
  secondParm
  secondValue
  ------------------------------------------------------------------
  ------------------------------------------------------------------
  ------------------------------------------------------------------
  ------------------------------------------------------------------
  ---------------------------------------------------------------
  ```
Verify that there are entries for the appropriate data type (in the `granuleId` column) in the `PlEsdtParmValues` table.

Note that in the example there are no entries for any data type.

20 If there are entries for the appropriate data type in the `PlEsdtParam` and `PlEsdtParmValues` tables, type `select * from PlMetadataChecks` at the `1>` prompt then press `Return/Enter`.

- Prepare a request to view the contents of the `PlMetadataChecks` table.
- If there is data on many data types in the `PlMetadataChecks` table, it may be advisable to limit the search, for example:

```
1> select * from PlMetadataChecks where dataTypeId like "AST_L1B#001"
```

- In the example `AST_L1B#001` is the data type being checked.

21 Type `go` at the `2>` prompt then press `Return/Enter`.

- The contents of the `PlMetadataChecks` table are displayed.
- For example:

```
1> select * from PlMetadataChecks
2> go
paraName logicalId type
operator value
ioFlag queryFlag queryType
secondParm secondValue
```

---

(0 rows affected)
Verify that the entries for the appropriate data type in the PlEsdtParam and PlEsdtParmValues tables match the expected values in the PlMetadataChecks table.

− Note that in the example there are no entries for any data type.

22 If an entry for the unschedulable DPR has a value equal to 2 in the accepted column of the PldprData table (Step 15), make a record of the fact that the PGE cannot be run on the specified input data.

• The metadata check/query for the corresponding input failed.
• It may be possible to either reingest or reprocess the input data that failed the metadata check or query.
  − Steps 17 through 21 can give indications as to which applies, based on the data type(s) involved.

23 If no problem is identified in the preceding steps, call the help desk and submit a trouble ticket in accordance with site Problem Management policy.

Checking Log Files

Log files can provide indications of the following types of problems:

• DCE problems.
• Database problems.
• Lack of disk space.

The procedure for checking log files starts with the assumption that the operator has logged in to the ECS system.

Checking Log Files

NOTE: Commands in Steps 1 through 6 are typed at a UNIX system prompt.

1 Type setenv DISPLAY clientname:0.0 then press the Return/Enter key.

• Use either the X terminal/workstation IP address or the machine-name for the clientname.
When using secure shell, the DISPLAY variable is set just once, before logging in to remote hosts. If it were to be reset after logging in to a remote host, the security features would be compromised.

2 Start the log-in to the Planning/Management Workstation, Queuing Server, or PDPS DBMS Server as applicable by typing `/tools/bin/ssh hostname` then press the Return/Enter key.

- In general Planning Subsystem applications are installed on the Planning/Management Workstation (e.g., e0pls03, g0pls01, or l0pls02) and Data Processing Subsystem (PRONG) applications are installed on the Queuing Server (e.g., e0sp04, g0sp06, or l0sp03). Note the following exceptions:
  - QA Monitor is on the Planning/Management Workstation.
  - Subscription Manager is on the PDPS DBMS Server (e.g., e0pls02, g0pls02, or l0pls01).

- If you receive the message, Host key not found from the list of known hosts. Are you sure you want to continue connecting (yes/no)? type yes ("y" alone will not work).

- If you have previously set up a secure shell passphrase and executed sshremote, a prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with Step 3.

- If you have not previously set up a secure shell passphrase; go to Step 4.

3 If a prompt to Enter passphrase for RSA key '<user@remotehost>' appears, type your Passphrase then press the Return/Enter key.

- Go to Step 5.

4 At the <user@remotehost>'s password: prompt type your Password then press the Return/Enter key.

5 Type cd /usr/ecs/MODE/CUSTOM/logs then press Return/Enter.

- Change directory to the directory containing the production planning log files (e.g., EcPilPREditor.ALOG, EcPilPREditorDebug.log, EcPilWb.ALOG, EcPilWbDebug.log, EcPilTl.ALOG).

6 Type pg filename then press Return/Enter.

- filename refers to the production planning log file to be reviewed (e.g., EcPilPREditor.ALOG, EcPilPREditorDebug.log, EcPilWb.ALOG, EcPilWbDebug.log, EcPilTl.ALOG, EcPilProdStrat.ALOG).

- The first page of the log file is displayed.
• Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., `more`, `view`, `vi`) can be used to review the log file.

7 Review the log file to identify problems that have occurred.

8 Respond to problems as follows:

• DCE problems.
  – Notify the Operations Controller/System Administrator of suspected DCE problems.

• Database problems.
  – Verify that relevant database servers are running.
  – Check for lack of (or corruption of) data in the database using either a database browser or `isql` commands.
  – Notify the Database Administrator of suspected database problems.

• Lack of disk space.
  – Remove unnecessary files.
  – Notify the Operations Controller/System Administrator of recurring disk space problems.

---

**Checking Database Connections**

If applications (including the GUIs) are unable to connect to the database, data cannot be retrieved or (in the case of the GUIs) displayed. Consequently, if a GUI does not display data or if the display does not refresh, checking the database connections is a logical step in trying to isolate the problem.

The procedure for checking database connections starts with the assumption that the operator has logged in to the ECS system and the Planning/Management Workstation (e.g., `e0pls03`, `g0pls01`, or `l0pls02`).

**Checking Database Connections**

1 Submit a request to the Database Administrator to identify the values for parameters associated with the appropriate application.

• The following parameters are should be requested:
  – `DBName`.
  – `DBServer`. 
- **DBMaxConnections.**

- The preceding parameters are associated with the following applications:
  - EcPIPREditor.
  - EcPIProdStrat.
  - EcPIRm.
  - EcPISubsEdit.
  - EcPITI.
  - EcPIWb.

2 Access a terminal window logged in to the Planning/Management Workstation (e.g., e0pls03, g0pls01, l0pls02, or n0pls02).

3 Type `isql -U userId -S DBServer` then press Return/Enter.

- For example:
  ```bash
  isql -Updps_role -St1pls01_srvr
  ```

4 At the **Password:** prompt type `dbpassword` then press Return/Enter.

- The `dbpassword` is the password for logging in to the database using the specified `userId`.

5 Type `sp who` at the `1>` prompt then press Return/Enter.

6 Type `go` at the `2>` prompt then press Return/Enter.

- A listing similar to the following one is displayed (some lines have been deleted):

<table>
<thead>
<tr>
<th>spid</th>
<th>status</th>
<th>dbname</th>
<th>loginame</th>
<th>cmd</th>
<th>hostname</th>
<th>blk</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>recv/sleep</td>
<td>pdps_Ts1</td>
<td>EcDpPrDeletion</td>
<td>AWAITING COMMAND</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>sleeping</td>
<td>master</td>
<td>NULL</td>
<td>NETWORK HANDLER</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>sleeping</td>
<td>master</td>
<td>NULL</td>
<td>DEADLOCK TUNE</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>sleeping</td>
<td>master</td>
<td>NULL</td>
<td>MIRROR HANDLER</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>sleeping</td>
<td>master</td>
<td>NULL</td>
<td>HOUSEKEEPER</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>sleeping</td>
<td>master</td>
<td>NULL</td>
<td>CHECKPOINT SLEEP</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>sleeping</td>
<td>master</td>
<td>NULL</td>
<td>AUDIT PROCESS</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>recv/sleep</td>
<td>pdps</td>
<td>EcPlSubMgr</td>
<td>AWAITING COMMAND</td>
<td></td>
<td>0</td>
</tr>
</tbody>
</table>
7 Type `sp_configure "user connections"` at the 1> prompt then press Return/Enter.
8 Type `go` at the 2> prompt then press Return/Enter.

- A listing similar to the following one is displayed:

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Run Value</th>
<th>Default</th>
<th>Memory Used</th>
<th>Config Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>number of user connections</td>
<td>25</td>
<td>7503</td>
<td>100</td>
<td></td>
</tr>
</tbody>
</table>

(28 rows affected)
(return status = 0)
Type `quit` at the `1>` prompt then press `Return/Enter`.

Compare the number of actual connections (results of `sp_who`) with the number of connections for which the database has been configured (results of `sp_configure "user connections"`).

If the number of actual connections is very close to the number of connections for which the database has been configured, notify the Database Administrator of the fact.

If the number of actual connections is **not** very close to the number of connections for which the database has been configured, compare the number of actual connections with the value for `DBMaxConnections` that the Database Administrator specified (Step 1).

If the number of actual connections is very close to the value for `DBMaxConnections`, notify the Database Administrator of the fact.

- It may be advisable to increase the value assigned to the `DBMaxConnections` parameter in the Configuration Registry.
Production Processing

Processing Considerations

DPR Chaining

The identification of chain heads was described in a previous section of this lesson dealing with Production Planning. The Job Management server in the DPS schedules chains of DPRs through the use of stored procedures in the PDPS database.

To improve the processing of chains of DPRs the following two new tables were added to the PDPS database for use by Job Management:

- DpPrPgeLimits.
- DpPrClassSchedulingLimits.

DpPrPgeLimits limits the number of chain-head DPRs of a particular PGE that can run simultaneously on the same virtual machine. A record should be defined for each PGE ID and virtual computer combination that will be run.

The DpPrPgeLimits table has the following columns:

- pgeId.
- computerName – virtual computer name.
- maxConcurrent - defines the maximum number of these chain heads that can run at the same time on the specified virtual computer.
- numConcurrent - shows how many chain heads with that PGE ID are running at the same time on that virtual computer.
- numScheduled - shows how many chain heads with that PGE ID are currently scheduled on that virtual computer.

If there were no record in the DpPrPge table for a particular PGE ID/computer combination that was scheduled, the DPR would not be prevented from running and there would be no limits placed on how many of those DPRs could run on the same virtual machine.

The DpPrPgeLimits table can be loaded by running the script EcDpPrLoadTable.pl from the Job Management Client Tool. The script involves updating an input file for each table that contains the needed values.

Instructions for using the script are available at the following location on the Queuing Server host:

- /usr/ecs/MODE/CUSTOM/data/DPS/EcDpPrLoadTable.README
DpPrClassSchedulingLimits limits the classes of DPRs that can run at any point in time. The classes correspond to the following types of processing that ECS supports:

- Routine.
- On Demand.
- Reprocessing.

Consequently, the DpPrClassSchedulingLimits table has three records one for each type of processing. Each record has the following fields:

- dprClass - assigned value identifies the type of processing.
  - 0 = Routine Processing.
  - 1 = On-Demand Processing.
  - 2 = Reprocessing.
- maxDprs - defines the maximum number of jobs of the type (specified in dprClass) that are allowed to run on the system.
- minDprs - currently not used.
- currentDprs - the number of jobs of the type (specified in dprClass) that are currently running.

If the DpPrClassSchedulingLimits table has no record for a particular type of processing, DPRs of that type are not allowed into AutoSys.

Values for the maxDprs and minDprs columns in the DpPrClassSchedulingLimits table are loaded at Job Management Server startup using data from the following two configuration parameters:

- DpPrMaxConcurrentDPRs - maximum allowed jobs
- DpPrMinConcurrentDPRs - minimum allowed jobs

Each parameter has three integer values; the first for routine processing; the second for on-demand processing; and the third for reprocessing jobs.

- For example, the Configuration Registry may have the following entries:

  DpPrMaxConcurrentDPRs = 100 60 40
  DpPrMinConcurrentDPRs = 0 0 0

  - In this case the maximum allowed jobs is 100 for routine processing, 60 for on-demand processing, and 40 for reprocessing.
  - The minimum allowed jobs is 0 for each type of processing.
The total number of completed jobs allowed in AutoSys is defined by the following new configuration parameter:

- DpPrAutoSysMaxDPRs

Within the restrictions of the DpPrClassSchedulingLimits and DpPrPgeLimits database tables classes of DPR chains are scheduled by DPS with chains of DPRs (identified by their chain heads) being scheduled on the same machine whenever possible. When scheduling a chain-head DPR, attempts are made to schedule it on the machine that has the highest number of accepted inputs if accepted inputs are found. The chain-head DPR’s children should be scheduled on the same machine.

Load balancing is done among virtual computers on the same string when selecting a computer for a DPR chain. If a DPR does not have its PGE identified in the DpPrPgeLimits table, that does not prevent it from being scheduled on a particular machine if most of the DPR's inputs are staged on that machine.

If there is more than one chain head for a set of DPRs, the DPRs are combined into a single chain.

- For example…
  - DPR#1 and DPR#2 are both parents of DPR#3.
  - Marking DPRs#1 and #2 as chain heads results in a single chain consisting of all three DPRs.
- Another example (MODIS processing)…
  - If the Production Planner defines both the MODPGE01 PR and the MODPGE02 PR as chain heads, they are combined in one chain with the MODPGE01 DPR ID as the chainId.
  - MODPGE01 is designated the chain head because its outputs are used as inputs to MODPGE02 and MODPGE08.
  - MODPGE02 outputs are used as input to MODPGE08.

The PGEs that will be used as chain heads should be identified before installation. In selecting potential chain heads, it is recommended that PGEs which create substantial (i.e.,large or many) inputs for other PGEs be so designated. MODPGE01 is an example of an appropriate chain head. DPRP PGEs would not be good candidates for chain heads although their outputs are used as input to other PGEs.
Copy on Demand Feature

The term "copy on demand" describes a feature whereby the DPS code stages granules locally; i.e., granule files are staged to the processor on which the PGE is running. The implementation of the copy on demand feature included taking the following actions:

- Adding the following column to the PlDataTypeMaster database table in the PDPS database:
  - onDemandCopy  [The value of the onDemandCopy flag is used by the system to determine whether input files need to be locally staged.]

- Including the following flag in the ESDT ODL files after DATA_TYPE and DATA_TYPE_VERSION:
  \[
  \text{ON\_DEMAND\_COPY} = \text{"Y"}
  \]
  - The ON_DEMAND_COPY flag indicates whether or not the DPS code should always stage the granule locally.
  - Whenever a PGE that uses the ESDT is registered, the value assigned to ON_DEMAND_COPY is put in the onDemandCopy column in the PlDataTypeMaster table of the PDPS database.

- Modifying code to remove files from all science processors when delete on a granule is invoked.

DPR Output Files Immediately Available as Input

Output files are immediately available as input when generated as output of a DPR. It is no longer necessary to wait for Subscription Server notification before using the output of a parent DPR as input to a child DPR.

AutoSys/AutoXpert Production Scheduling Tool

The Planning and Data Processing Subsystems provide a batch processing environment to support the generation of data products. They manage, queue and execute Data Processing Requests (DPR) on the processing resources at a DAAC. The DPRs are submitted from the Planning Subsystem. The Planning and Data Processing Subsystems provide the operational interfaces needed to monitor the execution of science software PGEs specified in the DPRs.

The AutoSys/AutoXpert software is a production scheduling tool intended to support the operational activities surrounding production processing. It assists with the following activities (among others):

- Job monitoring.
- Job scheduling.
• Fault notification.
• Job restart.
• Determining the effects of failure of a DPR.
• Determining the cause and actions to be taken due to the failure of a DPR.

AutoSys recognizes the following three categories of jobs:

• Box jobs.
• Command jobs.
• File-watcher jobs.

A box job is a collection of other jobs. It performs no processing action other than providing an organizational structure for a group of jobs that should be run within the same time period. Box jobs can be nested; i.e., box jobs can be included in other box jobs. Box jobs are particularly useful for organizing, managing, and administering large numbers of jobs, which are interrelated or have complex logic flows.

Box jobs are subject to the following rules:

• If no other starting conditions are specified at the job level, a job within a box job runs as soon as the starting conditions for the box are satisfied.
• If there are no job-level starting conditions for some of the jobs in a box, those jobs will run in parallel.
  – The jobs will run only once even if multiple start times are specified for some of the individual jobs.
  – Consequently, jobs in boxes will not be run several times inadvertently.
• Whenever any job in a box changes state, all jobs in the box are checked to see if they are eligible to be run.

A command job is the type most commonly thought of as a “job.” The “command” can be a shell script, the name of an executable program, a file transfer, or any other command that causes execution of a UNIX command on a client machine. When all of the starting conditions for the particular job have been met, AutoSys performs the following functions:

• Executes the command (runs the job).
• Captures the exit code at job completion.
• Sends the exit event (success or failure) and code back to the relational database management system (RDBMS).

A file-watcher job functions in a manner that is similar to a command job; however, it has a special purpose, i.e., to monitor the creation and size of a particular operating system file. When the file has reached a specified minimum size and is no longer increasing in size, the file-
watcher job sends AutoSys an event indicating that the file has arrived. The file-watcher job allows AutoSys to know the status of external files that are needed in the processing of command jobs or box jobs.

When determining whether to start a job of any type, AutoSys evaluates the job with respect to the following starting parameters:

- Date and time scheduling parameters are met.
- Starting Conditions specified in the job definition evaluate to “true.”
- For jobs in a box, the box must be in the RUNNING state.
- The current status of the job is not ON_HOLD or ON_ICE.

Every time there is an event that changes the truth of any of the preceding parameters, AutoSys finds all jobs that may be affected by the change and determines whether or not to start them.

In ECS each DPR generated by the Planning Subsystem defines a box job for AutoSys. Every DPR/box job is composed of three command jobs that run in the following order:

- Preprocessing (EcDpPrEM and EcDpPrDM)
- Execution (EcDpPrRunPGE)
- Postprocessing (EcDpPrEM and EcDpPrDM)

The number of command jobs in an AutoSys Job box was reduced from seven to three in order to reduce overhead. The change reduces the load on the AutoSys Event Processor by about one half. It has no effect on the DPS Queueing Server CPU loading.

To create the new Preprocessing job the following old command jobs were combined:

- Allocation.
- Staging.
- Pre-processing.

To create the new Postprocessing job the following old command jobs were combined:

- Post-processing.
- Destaging.
- Deallocation.

The value in the database column dprState correlates to the seven old job states.

In general ECS job names indicate the mode in which the DPR was generated and the stage of processing. The following list of job names for a DPREP DPR provides an illustration:

- AM1Eph#2.012302200TS2
- AM1Eph#2.012302200TS2R
The first job name in the list is a DPR/box job-level name. The first few characters identify the PGE (i.e., AM1Eph - Step 1 DPREP). The last three characters of the DPR/box job-level name (i.e., TS2) indicate the mode in which the DPR was generated. The last four characters of the remaining (command) job names in the list indicate the mode (i.e., TS2) and the stage of processing. The job name that ends in “R” is the preprocessing job; the job name that ends in “E” is the execution job; and the job name that ends in “P” is the postprocessing job.

Execution and postprocessing command jobs are dependent on successful completion of the command job that precedes them. For example, execution does not start until preprocessing has been successfully completed. The start of preprocessing depends on the box having started.

For postprocessing to start, the execution job must have completed. Postprocessing does not depend on execution having been “successful,” just on being done. If execution failed, postprocessing handles failed PGE processing.

Just as most of the command jobs within a box job are dependent on the completion of other jobs, a DPR/box job itself may be dependent on the successful completion of some other box job(s). Such dependencies usually involve a need for the output of another DPR as input.

The following rules apply to DPR dependencies:

- Any DPRs that depend on data which are not yet available are kept in a "held" state by Job Management until their data availability subscriptions are fulfilled.
- The Subscription Manager software, which is part of the Planning Subsystem, receives subscription notifications for the DPRs and informs the DPS (Job Management) to release jobs to AutoSys after all data subscriptions for a given DPR are fulfilled.
- The Data Processing Subsystem (as monitored by the AutoSys Job Scheduling engine) runs the PGEs and associated jobs as the resources required for the tasks become available.
- The procedure continues until all scheduled DPRs have completed.

Starting in Release 6A each mode has multiple Job Management queues (i.e., one for each type of processing) and there is a maximum number of jobs allowed in AutoSys for each type of processing. For example, in each mode a DAAC would have queues for the following types of processing:

- Routine Processing.
- On-Demand Processing.
- Reprocessing

The DAAC Production Monitor uses AutoSys/AutoXpert when performing the following functions:
• Transferring/deleting/suspending/resuming DPRs as required (e.g., requests, resource problems, input data schedule problems, special events, schedules replans, etc.).

• Monitoring and providing processing status upon request.

The Production Monitor can configure some aspects of AutoSys/AutoXpert, including the runtime options.
Launching the AutoSys GUI Control Panel

The following software applications are associated with Production Processing (excluding Science Software Integration and Test (SSI&T) and Science Data Processing Toolkit applications):

- Subscription Manager.
- Job Management.
- Data Management.
- Execution Management.
- PGE Management.
- Deletion Server.
- AutoSys/AutoXpert.
  - Event Processor (AutoSys daemon).
  - Event Server (Sybase database server for the AutoSys database).
  - AutoSys GUIs.
  - AutoXpert GUIs.
- QA Monitor.
- Sybase ASE Server for the PDPS database.

Access to the Production Processing tools must be gained through the use of UNIX commands.

Launching the AutoSys GUI Control Panel starts with the assumption that the applicable servers are running and the Production Monitor has logged in to the ECS system.

**Launching the AutoSys GUI Control Panel**

**NOTE:** Commands in Steps 1 through 11 are typed at a UNIX system prompt.

1. Type `setenv DISPLAY clientname:0.0` then press the **Return/Enter** key.
   - Use either the X terminal/workstation IP address or the machine-name for the `clientname`. 
• When using secure shell, the DISPLAY variable is set just once, before logging in to remote hosts. If it were to be reset after logging in to a remote host, the security features would be compromised.

2 Start the log-in to the Queuing Server host by typing /tools/bin/ssh hostname (e.g., e0sps04, g0sps06, or l0sps03) in the new window then press the Return/Enter key.

• If you receive the message, Host key not found from the list of known hosts. Are you sure you want to continue connecting (yes/no)? type yes (“y” alone will not work).

• If you have previously set up a secure shell passphrase and executed sshremote, a prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with Step 3.

• If you have not previously set up a secure shell passphrase; go to Step 4.

3 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your Passphrase then press the Return/Enter key.

• Go to Step 5.

4 At the <user@remotehost>’s password: prompt type your Password then press the Return/Enter key.

5 Type setenv ECS_HOME /usr/ecs/ then press the Return/Enter key.

• When logging in as a system user (e.g., cmshared), the ECS_HOME variable may be set automatically so it may not be necessary to perform this step.

6 Type cd /path then press Return/Enter.

• Change directory to the directory (e.g., /usr/ecs/MODE/COTS/autotreeb/autouser, /usr/ecs/MODE/COTS/autotree/autouser, /data1/SHARED/COTS/autotree/autouser) containing the set-up files (e.g., FMR.autosys.csh.g0sps06).

• The particular path to be typed may vary from site to site.

7 Type source AUTOSYSINSTANCE.autosys.csh.hostname then press Return/Enter.

• An AUTOSYSINSTANCE (also called an AUTOSERV instance) is installed as part of the Data Processing Subsystem and is identified by three capital letters.

– AutoSys instances at the DAACs are typically identified as FMR.

• It is possible that multiple AutoSys instances could be installed at a DAAC.

8 Type cd /usr/ecs/MODE/CUSTOM/utilities then press Return/Enter.

• Change directory to the directory containing the AutoSys start script (e.g., EcDpPrAutosysStart).
• The MODE will most likely be one of the following operating modes:
  − OPS (for normal operation).
  − TS1 (for SSI&T).
  − TS2 (new version checkout).
• Note that the separate subdirectories under /usr/ecs apply to (describe) different operating modes.

9 Type EcDpPrAutosysStart  MODE AUTOSYSINSTANCE then press Return/Enter.
• The AutoSys GUI Control Panel (Figure 52) is displayed.

![AutoSys GUI Control Panel](image)

*Figure 52. AutoSys GUI Control Panel*
Configuring AutoSys/AutoXpert Runtime Options

This section explains how to configure AutoSys/AutoXpert runtime options. The Production Monitor can define the following runtime options:

- **Refresh Interval.**
  - Determines how often the View Region (the area on the right side of the GUI display where data are presented) will be updated.

- **Ping Interval.**
  - Defines how often the connectivity will be evaluated.

- **Hang Time.**
  - Specifies the length of time jobs will continue to be displayed within a machine after they have completed running.

- **Inches/Hr.**
  - Indicates how much information is displayed on the screen.

There are default values that apply to the runtime options until the Production Monitor modifies them.

Table 6 lists the runtime options available for HostScape, TimeScape, and JobScape. Not all options are available for all GUI’s.

<table>
<thead>
<tr>
<th>Interface</th>
<th>Refresh Interval</th>
<th>Hangtime</th>
<th>PING</th>
<th>Inches/Hour</th>
</tr>
</thead>
<tbody>
<tr>
<td>HostScape</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>TimeScape</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JobScape</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

The procedure for configuring AutoSys/AutoXpert runtime options assumes that AutoSys has been launched and the **AutoSys GUI Control Panel** (Figure 53) is being displayed. Perform only the steps that are applicable to the changes to be made (as specified in Table 6). Note that if the Freeze Frame feature is enabled, any changes entered will not take place until Freeze Frame has been disabled.
Configuring AutoSys/AutoXpert Runtime Options

1. Click on either the **HostScape**, **TimeScape**, or **JobScape** button as applicable.
   - The AutoXpert GUI corresponding to the selected button is displayed (Figures 51-53).

2. Select **Options → Edit Runtime Options** from the pull-down menu.
   - The **Runtime Options** dialogue box is displayed.
   - Figure 57 shows the **Runtime Options** dialogue box for the JobScape GUI.
Figure 54. AutoXpert HostScape GUI
Figure 55. AutoXpert TimeScape GUI
If the refresh interval is to be modified, click on Refresh Interval (Seconds) and either type in a value between 1 and 99999 or click on the < or > keys as necessary to decrease or increase the current numerical value until the desired value is reached.

- Default value is 30 seconds.
- The Reloading Job Data window reappears as often as specified in the Refresh Interval (Seconds) field.
If the ping interval is to be modified, click on Ping Interval (Seconds) and either type in a value between 1 and 99999 or click on the < | and > keys as necessary to decrease or increase the current numerical value until the desired value is reached.

- Default value is 300 seconds.
- If 99999 is entered, no ping commands are issued.

If the hang time is to be modified, click on Hang Time (Minutes) and either type in a value between 1 and 99999 or click the < | and > keys as necessary to decrease or increase the current numerical value until the desired value is reached.

- Default value is 1 minute.

If the number of inches/hour is to be modified, click on Inches/Hr (inches) and either type in a value or click the < | and > keys as necessary to decrease or increase the current numerical value until the desired value is reached.

- Default value is 2 inches/hr.

When all desired modifications have been entered, click on the OK button.

- The runtime options are set.
- The dialogue box closes.

If another of the AutoXpert GUIs needs to have its runtime options configured, repeat Steps 2 through 7 for the next GUI.

To start the process of exiting from any of the AutoXpert GUIs (HostScape, JobScape or TimeScape) select File → Exit from the pull-down menu.

- An Exit dialogue box is displayed.

Click on the appropriate button from the following selections:

- OK - to exit from the AutoXpert GUI.
  - The AutoXpert GUI is dismissed.
- Cancel - to return to the AutoXpert GUI.

To start the process of exiting from AutoSys click on the Exit button of the AutoSys GUI Control Panel.

- An AutoSys GUIs Exit dialogue box is displayed.

Click on the appropriate button from the following selections:

- OK - to exit from the AutoSys GUIs.
  - The AutoSys GUI Control Panel is dismissed.
- Cancel - to keep the AutoSys GUI Control Panel.
Selecting Jobs to Be Displayed on AutoSys/AutoXpert GUIs

This section explains how to select jobs to be displayed on AutoSys/AutoXpert GUIs. The Production Monitor can select jobs on the basis of the following criteria:

- Job Name.
- Job Status.
- Machine.

The following default values apply to the job selection criteria until the Production Monitor modifies them:

- All Jobs.
- All Statuses.
- All Machines.

The procedure for selecting jobs to be displayed on AutoSys/AutoXpert GUIs assumes that AutoSys has been launched and the AutoSys GUI Control Panel (Figure 52) is being displayed.

Selecting Jobs to Be Displayed on AutoSys/AutoXpert GUIs

1. Click on either the HostScape, TimeScape, or JobScape button as applicable.
   - The AutoXpert GUI corresponding to the selected button is displayed (Figures 51-53).

2. Select View → Select Jobs to Display from the pull-down menu.
   - Job Selection dialogue box (Figure 58) is displayed.
   - Job selection has the following default settings:
     - All Jobs for Select by Name.
     - All Statuses for Select by Status.
     - All Machines for Select by Machine.
   - If the default settings are the desired settings, proceed to Step 10.

3. To have all jobs displayed on the AutoXpert GUI verify that the All Jobs toggle button is selected (click on the All Jobs button to change state from unselected to selected or vice versa).
   - When the All Jobs option is selected, the All Jobs button color is yellow.
   - Leave the Box Hierarchies: Show Number of Levels set at all.
   - Proceed to Step 7.
To select a particular job or set of jobs by name first verify that the **All Jobs** button is unselected (click on the **All Jobs** button to change state from selected to unselected or vice versa).

To select a particular job or set of jobs by name type the appropriate name(s) in the **Name Matching Patterns** fields.

- The asterisk (*) wildcard character can be used for entering a partial job name (e.g., type *OPS* to select jobs with “OPS” in their name).

To have jobs displayed regardless of status verify that the **All Statuses** toggle button is selected (click on the **All Statuses** button to change state from unselected to selected or vice versa).

- When the **All Statuses** option is selected, the **All Statuses** button color is yellow.

To select jobs by status click on whichever of the following **Select by Status** toggle buttons properly describe(s) the status(es) to be selected:

- **All Statuses**.
- **Starting**.
• Running.
• Success.
• Failure.
• Terminated.
• Restart.
• Que Wait.
• Activated.
• Inactive.
• On Hold.
• On Ice.

8 To select jobs on all machines verify that the All Machines toggle button is selected (click on the All Machines button to change state from unselected to selected or vice versa).

• When the All Machines option is selected, the All Machines button color is yellow.

9 To select jobs on a particular machine or set of machines click on the name(s) of the desired machine(s) in the Select by Machine list.

• To select multiple machines press and hold either the Ctrl key or the Shift key while clicking on individual machines in the Select by Machine list.

• Alternatively, to select multiple machines press and hold either the Ctrl key or the Shift key then click on the first machine and drag the cursor to the name of the last machine to be selected and release the mouse button.

  – Selected machine(s) is (are) highlighted.

10 When the Job Selection dialogue box contains the desired set of job selection criteria, click on the appropriate button from the following selections:

• OK - to accept all specified job selection criteria and dismiss the Job Selection dialogue box.

  – Original AutoXpert GUI is displayed.

  – Jobs are displayed on the AutoXpert GUI based on the specified selection criteria.
**Apply** - to accept all specified job selection criteria without dismissing the **Job Selection** dialogue box.

- Repeat Steps 3 through 10 as necessary to specify additional job selection criteria.

**Cancel** - to dismiss the **Job Selection** dialogue box without accepting any job selection criteria.

- Original AutoXpert GUI is displayed

---

**Setting the Current Job on AutoSys/AutoXpert GUIs**

This section explains how to set the “current job” on AutoSys/AutoXpert GUIs. Setting the current job causes the job name to be displayed in the **Current Job Name** field in the Control Region of the AutoXpert GUI. Subsequently clicking on the **Job Console** button on the AutoXpert GUI causes the **Job Activity Console** GUI (also known as the **Ops Console** GUI) to be displayed with information concerning the current job.

Either of the following two methods can be used to set the current job:

- Click on the name of a job displayed on an AutoXpert GUI.
- Set the current job using the AutoXpert GUI pull-down menu.

The procedure for setting the current job on an AutoSys/AutoXpert GUI using the pull-down menu assumes that AutoSys has been launched and the **AutoSys GUI Control Panel** (Figure 52) is being displayed.

### Setting the Current Job on AutoSys/AutoXpert GUIs Using the Pull-Down Menu

1. Click on either the **HostScape**, **TimeScape**, or **JobScape** button as applicable.
   - The AutoXpert GUI corresponding to the selected button is displayed (Figures 51-53).

2. Select **View → Set Current Job** from the pull-down menu.
   - **Set Current Job** dialogue box (Figure 59) is displayed.

3. Type the **jobname** or a portion of the **jobname** in the **Filter** field.
   - The asterisk (*) wildcard character can be used for entering a partial job name (e.g., type *AM1* to list all jobs with “AM1” in their name).
4 Click on the **Filter** button.
   - All jobs that meet the criteria specified in the **Filter** field are displayed in the **Jobs** field.

5 Select (highlight) the job to be designated the “current job” from the jobs listed in the **Jobs** field.
   - The name of the selected job is displayed in the **Selected Job** field of the **Set Current Job** dialogue box.
When the **Selected Job** field of the **Set Current Job** dialogue box contains the desired job name, click on the appropriate button from the following selections:

- **OK** - to accept the selected job and dismiss the **Set Current Job** dialogue box.
  - Selected job is displayed in the **Current Job Name** field in the Control Region of the AutoXpert GUI.
  - Original AutoXpert GUI is displayed.

- **Apply** - to accept the selected job without dismissing the **Set Current Job** dialogue box.
  - Selected job is displayed in the **Current Job Name** field in the Control Region of the AutoXpert GUI.

- **Cancel** - to dismiss the **Set Current Job** dialogue box without setting a “current job.”
  - Original AutoXpert GUI is displayed.

---

**Configuring Hardware Groups**

This section explains how to configure AutoSys hardware groups. The purpose of configuring hardware groups is to make it easier to monitor the hardware associated with a particular function (e.g., SSI&T, training, or processing in support of a particular instrument) rather than having to find those items in the default group, which is “All Machines.”

The Production Monitor may define a specific set of machines to be monitored as a group. The Production Monitor must know which machines are to be included in the group and should devise a useful name for the group.

The Production Monitor must have access to UNIX commands in order to perform the procedure.

**Configuring Hardware Groups**

**NOTE:** Commands in Steps 1 through 7 are typed at a UNIX system prompt.

1. Type `setenv DISPLAY clientname:0.0` then press the **Return/Enter** key.
   - Use either the X terminal/workstation IP address or the machine-name for the `clientname`.
   - When using secure shell, the DISPLAY variable is set just once, before logging in to remote hosts. If it were to be reset after logging in to a remote host, the security features would be compromised.
Start the log-in to the Queuing Server host by typing `/tools/bin/ssh hostname` (e.g., e0sp04, g0sp06, or l0sp03) in the new window then press the Return/Enter key.

- If you receive the message, **Host key not found from the list of known hosts. Are you sure you want to continue connecting (yes/no)?** type yes (“y” alone will not work).

- If you have previously set up a secure shell passphrase and executed `sshremote`, a prompt to **Enter passphrase for RSA key '<user@localhost>’** appears; continue with Step 3.

- If you have not previously set up a secure shell passphrase; go to Step 4.

If a prompt to **Enter passphrase for RSA key '<user@localhost>’** appears, type your **Passphrase** then press the Return/Enter key.

- Go to Step 5.

At the `<user@remotehost>`’s password: prompt type your **Password** then press the Return/Enter key.

Type `cd /path` then press Return/Enter.

- Change directory to the directory (e.g., /usr/ecs/MODE/COTS/autotreeb/autouser, /usr/ecs/MODE/COTS/autotreeb/autouser, /data1/SHARED/COTS/autotreeb/autouser) containing the set-up files (e.g., FMR.autosys.csh.g0sp06).

- The particular path to be typed may vary from site to site.

Type `source AUTOSYSINSTANCE.autosys.csh.hostname` then press Return/Enter.

Type `vi xpert.groups.AUTOSYSINSTANCE` then press Return/Enter.

- The configuration file is displayed by the vi text editor.

- Although this procedure has been written for the **vi** editor, any UNIX editor can be used to create the machine group file.

Using vi editor commands create/modify hardware groups as necessary.

- An example of a hardware group file is shown in Figure 60.

- The first line of each machine group is in the format **groupname: groupname**.

- The name of each machine to be included in the group is on a separate line.

- The following vi editor commands are useful:
  - h (move cursor left).
  - j (move cursor down).
  - k (move cursor up).
  - l (move cursor right).
groupname: Training
g0pls02
g0sps06
g0spg01
groupname: SSI&T
g0ais01
g0sps06
g0spg01

Figure 60. AutoSys Hardware Group File

- a (append text).
- i (insert text).
- x (delete a character).
- u (undo previous change).
- Esc (switch to command mode).

9 Press the Esc key.

10 Type ZZ.
   - New hardware groups are entered and saved in the file.
   - UNIX prompt is displayed.

11 Launch the AutoSys GUI Control Panel as described in the procedure for Launching the AutoSys GUI Control Panel.
   - The AutoSys GUI Control Panel (Figure 52) is displayed.

12 Click on the HostScape button.
   - The HostScape GUI (Figure 54) is displayed.

13 Select View → Select Machine Group from the pull-down menu.
   - The Machine Group Selection dialogue box is presented.
14 Select (highlight) the machine group to be applied.
   • The **machine group** is highlighted.
15 Click on the **OK** button.
   • The selected **machine group** is applied.
   • The **Machine Group Selection** dialogue box closes.
Reviewing Hardware Status, DPR Dependency, DPR Production Timeline, Alarms, and Job Activities

Reviewing Hardware Status

Hardware status is displayed on the AutoXpert HostScape GUI. The Production Monitor uses the HostScape GUI to determine the status of processors, the condition of the AutoSys queue, whether any processors are overloaded while others are idle, whether there are any system problems, etc.

HostScape displays jobs on a machine-by-machine basis, indicating which AutoSys server/client machines are up and active, and which jobs are running or have recently run on each machine. HostScape allows the Production Monitor to check hardware status in real-time.

The procedure for reviewing hardware status starts with the assumption that all applicable servers are currently running and the AutoSys GUI Control Panel (Figure 52) is being displayed.

**Reviewing Hardware Status**

1. **Click on the **HostScape** button on the AutoSys GUI Control Panel.**
   - The **HostScape** GUI (Figure 54) is displayed.
   - View presented is **Normal View**.
2. **Review the Control Region (left side of the display) to identify the color codes for the status of the machines.** In the View Region (right side of the display) the color code is displayed on the border of each machine box.
   - **MACHINE UP** (active) is green.
   - **MACHINE DOWN** (inactive and cannot be reached) is red.
   - **MACHINE INACTIVE** is black. (The color code is not shown in the Control Region)
3. **Review the machine type in the View Region (right side of the display).**
   - The name of the machine is displayed in the upper left-hand corner of each machine box.
   - Event Server (database server) name appears below the list of jobs, if applicable.
   - Event Processor (AutoSys server/daemon) name appears below the list of jobs, if applicable.
4 Review the machine boxes in the View Region to determine the status of individual machines.
   - The total number of jobs STARTING or RUNNING.
   - All jobs RUNNING are listed.
   - The View Region is scrollable.
5 Review the Alarm indicating buttons of individual machines in the View Region.
   - Alarm button is in the upper right-hand corner of the box.
   - Red indicates that an alarm has been generated.
   - Gray (default color) indicates normal operation.
   - If an alarm is present, clicking an alarm button brings up the Alarm Manager (described in a subsequent section).
6 Review the machine connection status in the View Region.
   - Solid black line indicates that AutoSys can communicate with the client machine Internet daemon.
   - Solid red line indicates that AutoSys cannot communicate with the client machine Internet daemon; however, the daemon does respond to ping commands.
   - Dashed red line indicates that AutoSys cannot communicate with the client machine; the machine is probably turned off.
7 To start the process of exiting from HostScape select File → Exit from the pull-down menu.
   - A HostScape Exit dialogue box is displayed.
8 Click on the appropriate button from the following selections:
   - **OK** - to exit from the HostScape GUI.
     - The HostScape GUI is dismissed.
   - **Cancel** - to return to the HostScape GUI.

---

**Changing the Hardware Status View**

The View Options provide the Production Monitor with the following three methods of viewing hardware status:

- Normal.
- Global.
• Zoom.

In the Normal (default) view three rows of machines with job activities are displayed. In the Global view seven rows of machines but no job activities are displayed. In the Zoom view one machine is displayed in great detail. The details include job name, description, status, and commands.

The Production Monitor selects the Global view to monitor the entire system and uses the Zoom view to focus on a specific machine, especially in case of a malfunction.

The procedure for changing hardware status views starts with the assumption that AutoSys is running in the HostScape mode with the default Normal view displayed.

**Changing Hardware Status Views**

1. **Select a machine in the View Region by clicking on its name, then select View → Select View Level → Global View from the pull-down menu.**
   - The Global view is displayed.
   - No job information is displayed.

2. **Select a specific machine by clicking on its name, then select View → Zoom in Machine from the pull-down menu.**
   - The Zoom view is displayed.
   - A table listing the following data is displayed:
     - Job Name.
     - Description.
     - Status.
     - Command.

3. **Select Dismiss.**
   - The Global view is displayed.

4. **Select View → Select View Level → Normal View from the pull-down menu.**
   - The Normal view is displayed.
   - Limited job information is displayed.
Reviewing DPR Dependencies

DPR dependencies are displayed on the AutoXpert JobScape GUI. JobScape presents a Pert-like view of job processing from a logical (or job dependency) point of view. JobScape depicts both command jobs and box jobs. In addition, it depicts the nesting of jobs within boxes and the dependencies among jobs within a box.

JobScape can be used for monitoring job flow in real-time. It allows the Production Monitor to identify potential problems, try to prevent them from becoming actual problems, stop problem jobs in favor of letting good jobs run, etc.

AutoSys defines job status in the terms listed in Table 7. The different states are color-coded on the JobScape display. However, the codes can be changed. The color codes listed in the table are the default values.

Table 7. Job States

<table>
<thead>
<tr>
<th>Status</th>
<th>Color Code</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTIVATED</td>
<td>white</td>
<td>The top-level box that the job is in is now in the “running” state but the job itself has not started yet.</td>
</tr>
<tr>
<td>STARTING</td>
<td>green</td>
<td>The Event Processor has initiated the start procedure with the Remote Agent. The job is in the process of “coming up.”</td>
</tr>
<tr>
<td>RUNNING</td>
<td>green</td>
<td>The job is running. If the job is a box job, “running” means that the jobs within the box may be started (other conditions permitting). If the job is a command job, “running” means that the process is actually running on the remote machine.</td>
</tr>
<tr>
<td>SUCCESS</td>
<td>light blue</td>
<td>When the job had completed running, it had an exit code equal to or less than the “maximum exit code for success.” By default, only the exit code “0” is interpreted as “success.” However, a range of values up to the “maximum exit code for success” may be reserved for each job to be interpreted as success. If the job is a box job, “success” means that all jobs within the box had exit codes indicating “success” (default) or the “exit condition for box success” was “true.”</td>
</tr>
<tr>
<td>FAILURE</td>
<td>red</td>
<td>When the job had completed running, it had an exit code greater than the “maximum exit code for success.” The default is any non-zero exit code. If the job is a box job, “failure” means that at least one job within the box had an exit code greater than zero (the default meaning) or the “exit condition for box failure” was “true.”</td>
</tr>
<tr>
<td>TERMINATED</td>
<td>red</td>
<td>The job terminated while in the “running” state. Termination may be the result of a user sending a “killjob” event, or a job may have been terminated because the job itself (or the box it is in) failed. If the job itself fails, it has a “failure” status rather than a “terminated” status.</td>
</tr>
<tr>
<td>RESTART</td>
<td>orange</td>
<td>The job was unable to start due to hardware or application problems and has been scheduled to restart.</td>
</tr>
<tr>
<td>QUE_WAIT</td>
<td>yellow</td>
<td>The job can logically run (i.e., all starting conditions have been met); however, there are not enough machine resources available to allow it to run.</td>
</tr>
</tbody>
</table>
Table 7. Job States

<table>
<thead>
<tr>
<th>Status</th>
<th>Color Code</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON_ICE</td>
<td>dark blue</td>
<td>The job is removed from all conditions and logic but is still defined to AutoSys. Operationally it is as though the job had been deactivated. The job remains “on_ice” until it receives the “job_off_ice” event. Downstream dependent jobs behave as though the “on_ice” job ran successfully. A job that is “starting” or “running” cannot be put “on_ice.”</td>
</tr>
<tr>
<td>ON_HOLD</td>
<td>dark blue</td>
<td>The job is on hold and will not run until it receives the “job_off_hold” event. Downstream jobs will not run until the job is taken off hold. A job that is “starting” or “running” cannot be put “on_hold.”</td>
</tr>
<tr>
<td>INACTIVE</td>
<td>dark blue</td>
<td>The job has not yet been processed. Either the job has never been run or its status was intentionally altered to “turn off” its previous completion status.</td>
</tr>
</tbody>
</table>

The procedure for reviewing DPR Dependencies starts with the assumption that all applicable servers are currently running and the AutoSys GUI Control Panel (Figure 52) is being displayed.

Reviewing DPR Dependencies

1. Click on the JobScape button on the AutoSys GUI Control Panel.
   - The JobScape GUI (Figure 56) is displayed.

2. Review the Control Region (left side of display) to identify the True/False dependency legend.
   - True is indicated by a solid arrow, which indicates that job dependencies have been met.
     - The solid arrow is the default code for True; the codes can be changed.
   - False is indicated by a dashed arrow, which indicates that job dependencies have not been met.
   - Dependency arrows indicate only that a job dependency exits for a job. They do not define time-related starting conditions, nor do they describe the type of job dependency, e.g., “success,” “started,” or “running.”

3. Review the Job Display to determine the status (color-coded) of DPRs.
   - Default colors representing job statuses are listed in Table 7.

4. Review the Job Display to determine the types of jobs:
   - Rectangle = Box Job.
   - Ellipse = Command Job.
• Hexagon = **File Watcher Job** (not displayed in ECS implementation of AutoXpert).

5 Select a job (for which descendants are to be determined) by placing the mouse cursor on the job and clicking with the **left** mouse button.

• Color of the border around the selected job changes to **yellow**.

• Name of the job appears in the **Current Job Name** area of the Control Region.

6 Review the job’s descendants by placing the mouse cursor on the job and clicking and holding the **right** mouse button.

• Pop-up menu appears. It has the following entries:
  - `jobname`.
  - Show Children.
  - Show All Descendants.
  - Hide All Descendants.
  - Show Job Arrows.
  - Hide Job Arrows.
  - Show Box Arrows.
  - Hide Box Arrows.
  - Job Definition.
  - View Dependencies.
  - Set Simulation Overrides [grayed out].
  - Start Job.
  - Kill Job.
  - Force Start Job.
  - On Hold.
  - Off Hold.
  - On Ice.
  - Off Ice.

7 Select (highlight) **Show Children** from the pop-up menu (release the right mouse button).

• Job’s first-level Command and Box Jobs appear.

• Repeat Step 5 to select a different job.
8 Select **Show All Descendants** from the pop-up menu.
   - Job’s Command and Box Jobs appear for all levels.

9 Select **Hide All Descendants** from the pop-up menu.
   - Default view is displayed.
   - All descendants are hidden.

10 To change the JobScape view using the **View** pull-down menu perform the procedure for
    **Changing the JobScape View Using the Pull-Down Menu** (subsequent section of this
    lesson).

11 To start the process of exiting from **JobScape** select **File → Exit** from the pull-down
    menu.
   - A **JobScape Exit** dialogue box is displayed.

12 Click on the appropriate button from the following selections:
   - **OK** - to exit from the **JobScape** GUI.
     - The **JobScape** GUI is dismissed.
   - **Cancel** - to return to the **JobScape** GUI.

---

**Changing the JobScape View Using the Pull-Down Menu**

This section explains how to change the view on the JobScape GUI. Changing the view affects
the level of detail displayed for each job shown in the View Region of the GUI.

As previously mentioned the view can be changed in some ways by simply clicking with the
**right** mouse button on the name of a job displayed on an AutoXpert GUI and selecting the
desired option from the pop-up menu. The following options related to changing the view and
display levels are displayed on the menu:

- **Show Children**.
- **Show All Descendants**.
- **Hide All Descendants**.
- **Show Job Arrows**.
- **Hide Job Arrows**.
- **Show Box Arrows**.
- **Hide Box Arrows**.
Another method for changing the view on the JobScape GUI involves using the View pull-down menu. Many of the same choices plus some additional options can be selected using the pull-down menu.

The procedure for changing the view on the JobScape GUI using the pull-down menu assumes that AutoSys has been launched and the JobScape GUI (Figure 56) is being displayed.

**Changing the JobScape View Using the Pull-Down Menu**

1. Select **View → Set View** from the pull-down menu.
   - The following menu options are displayed:
     - **Normal Text View**.
     - **Small Text View**.
     - **No Text View**.
     - **Show Arrows**.
     - **Hide Arrows**.
     - **View by Id**.
     - **View by Name** [grayed out].

2. Select the desired option from the pull-down menu.
   - **Normal Text View** is the default view (Figure 56).
   - **Small Text View** (Figure 61) is similar to **Normal Text View** but the text and graphics are smaller.
   - No text is displayed in the **No Text View** (Figure 62), which provides a global or big-picture view of the jobs currently in processing without specifically identifying them by name.
   - **Show Arrows** displays the lines/arrows between jobs.
     - Is characteristic of the default view.
   - **Hide Arrows** removes the lines/arrows between jobs from the display.
   - **View by Id** changes the display to provide a sequential reference number for each job rather than showing the job name.
   - **View by Name** changes the display to show job names rather than reference numbers.
     - Is characteristic of the default view.
     - Is accessible only when the current display is by **Id** number.
Select **View → Set Display Levels** from the pull-down menu.

- The following menu options are displayed:
  - 1.
Select the desired option from the pull-down menu.

- **All** is the default type of view (Figure 56).
- Selecting 1 provides a display of the box level only, as shown in Figure 63.
- If any other selection (i.e., 2, 3, 4, 5, or All) is made (in the ECS implementation), the boxes and command jobs with the boxes are displayed.

**Figure 63. JobScape GUI “One Level” View**

**Reviewing the DPR Production Timeline**

AutoXpert TimeScape presents a Gantt-like view of a job processing from a temporal (time-related) point of view. TimeScape depicts both command jobs and box jobs. It also depicts the nesting of jobs within boxes and the duration of time it will take for jobs to complete. TimeScape is used for monitoring job flow in real-time.
The procedure for reviewing the DPR production timeline starts with the assumption that all applicable servers are currently running and the **AutoSys GUI Control Panel** (Figure 52) is being displayed.

**Reviewing the DPR Production Timeline**

1. Click on the **TimeScape** button on the **AutoSys GUI Control Panel**.
   - The **TimeScape** GUI (Figure 55) is displayed.
   - Current time is displayed in red in the View Region (right side of the display).

2. Review the Control Region (left side of display) to identify the **Actual/Projected** legend for making comparisons in the View Region. (Refer to Figure 64.)
   - **Projected** is a rectangular (blue filled) graphic, to show average job completion time.
   - **Actual** is a striped (white and blue) ribbon, to show how much of the job has completed.
     - If there is a green stripe, the job is running.
     - If there is a black stripe, the job has been completed.

**Good vs Bad**

<table>
<thead>
<tr>
<th>Projected</th>
<th>Actual</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Looks Good!**

<table>
<thead>
<tr>
<th>Projected</th>
<th>Actual</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Trouble!**

*Figure 64. Evaluating Actual versus Projected Job Processing Time*
3 Review a job’s descendants by placing the **mouse cursor** on a job and clicking and holding the **right** mouse button.
   - Pop-up menu appears.
   - An asterisk (*) indicates that a Box Job’s descendants have been hidden.

4 Select (highlight) **Show Children** from the pop-up menu and release the mouse button.
   - Job’s first-level Command, and Box Jobs appear.
   - Return to Step 3 to select a different job.
   - Go to Step 5 to change the view.

5 Select (using the right mouse button) **Show All Descendants** from the pop-up menu.
   - Job’s Command and Box Jobs appear with all levels.

6 Select (using the right mouse button) **Hide All Descendants** from the pop-up menu.
   - All descendants are removed.

7 To start the process of exiting from **TimeScape** select **File → Exit** from the pull-down menu.
   - A **TimeScape Exit** dialogue box is displayed.

8 Click on the appropriate button from the following selections:
   - **OK** - to exit from the **TimeScape** GUI.
     - The **TimeScape** GUI is dismissed.
   - **Cancel** - to return to the **TimeScape** GUI.

---

**Reviewing Alarms**

Alarms indicate problems with job processing. They may involve a failure of job processing, a database problem, a communication problem, hardware or software failure or some other error in the data processing system.

The Production Monitor reviews alarms using the AutoSys Alarm Manager. The Alarm Manager allows the Production Monitor to perform the following functions:

- View alarms as they arrive.
- Provide a response to an alarm.
- Change alarm status.
The Production Monitor can configure the Alarm Manager to display certain types of alarms only. The Production Monitor may wish to see only certain types of alarms (e.g., job failure alarms) or only those alarms that are open (have not yet been acknowledged) or only the alarms that have occurred within the last thirty minutes.

The Production Monitor can select alarms to be displayed based on any or all of the following three criteria:

- Type of alarm
- Alarm state
- Time of the alarm

The procedure for reviewing alarms starts with the assumption that all applicable servers are currently running and the AutoSys GUI Control Panel (Figure 52) is being displayed.

**Reviewing Alarms**

1. Click on the Ops Console button on the AutoSys GUI Control Panel.
   - The Job Activity Console GUI, also known as the Ops Console GUI, (Figure 65) is displayed.

2. Click on the Alarm button.
   - The Alarm Manager GUI (Figure 66) is displayed.
   - Alarms are displayed in reverse order of occurrence; i.e., the most recent alarm appears at the top of the list.
   - The following information is displayed:
     - Alarm Type.
     - Job Name.
     - Time.
     - State.
     - Comment.

3. Configure alarm selection as described in the procedure for Configuring Alarm Selection (subsequent section of this lesson).

4. If desired, verify that the freeze-frame feature of the Alarm Manager GUI is activated (click on the Freeze Frame button if necessary).
   - The freeze-frame feature prevents the Alarm Manager from being updated, disrupting the display.
Figure 65. Job Activity Console (Ops Console) GUI
Click on an alarm in the **Alarm List**.

- Alarm is displayed in detail in the **Currently Selected Alarm** region of the display.
- Table 8 contains descriptions of AutoSys alarms.

### Table 8. AutoSys Alarms

<table>
<thead>
<tr>
<th>ALARM</th>
<th>CODE*</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO_PING</td>
<td></td>
<td>The <strong>autoping</strong> command has found a problem in trying to communicate with the Remote Agent on a client machine.</td>
</tr>
<tr>
<td>CHASE</td>
<td>514</td>
<td>The <strong>chase</strong> command has found a problem with a job that is supposedly running. The job and problem are listed.</td>
</tr>
<tr>
<td>DATABASE_COMM</td>
<td>516</td>
<td>The Remote Agent had trouble sending an event to the database. The job probably ran successfully. Inspect the Remote Agent Log file to determine what happened.</td>
</tr>
<tr>
<td>DB_PROBLEM</td>
<td>523</td>
<td>There is a problem with one of the AutoSys databases. This alarm can trigger a user-specified notification procedure.</td>
</tr>
<tr>
<td>DB_ROLLOVER</td>
<td>519</td>
<td>AutoSys has rolled over from Dual Server to Single Server Mode. This alarm can trigger a user-specified notification procedure.</td>
</tr>
<tr>
<td>DUPLICATE_EVENT</td>
<td>524</td>
<td>Duplicate events have been received in the Event Server. Typically, this means that two Event Processors are running, although “duplicate events” can also be caused by Event Server configuration errors.</td>
</tr>
<tr>
<td>ALARM</td>
<td>CODE*</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EP_HIGH_AVAIL</td>
<td>522</td>
<td>The Event Processor High Availability system has detected some system or network problems. This alarm can trigger a user-specified notification procedure.</td>
</tr>
<tr>
<td>EP_ROLLOVER</td>
<td>520</td>
<td>The Shadow Event Processor is taking over processing. This alarm can trigger a user-specified notification procedure.</td>
</tr>
<tr>
<td>EP_SHUTDOWN</td>
<td>521</td>
<td>The Event Processor is shutting down. This may be due to a normal shutdown (SEND_EVENT) or due to an error condition. This alarm can trigger a user-specified notification procedure.</td>
</tr>
<tr>
<td>EVENT_HDLR_ERROR</td>
<td>507</td>
<td>The Event Processor had an error while processing an event. The job associated with the event should be inspected to see if manual intervention is required.</td>
</tr>
<tr>
<td>EVENT_QUEUE_ERROR</td>
<td>508</td>
<td>An event could not be marked as processed. This is usually due to a problem with the Event Server.</td>
</tr>
<tr>
<td>FORKFAIL</td>
<td>501</td>
<td>The Remote Agent was unable to start the user command because it was unable to get a process slot on the machine. AutoSys automatically attempts a RESTART when this happens.</td>
</tr>
<tr>
<td>INSTANCE_UNAVAILABLE</td>
<td>525</td>
<td>When different AutoSys instances communicate with each other, this alarm is generated when a receiving AutoSys instance (i.e., its Event Server) cannot be reached. The Event Server is probably down.</td>
</tr>
<tr>
<td>JOBFailure</td>
<td>503</td>
<td>A job has failed. Its current status is FAILURE.</td>
</tr>
<tr>
<td>JOBNOT_ONICEHOLD</td>
<td>509</td>
<td>To place a job either ON_HOLD or ON_ICE, a JOB_ON_HOLD or JOB_ON_ICE event (as applicable) is sent. There are certain conditions when the job cannot be placed ON_HOLD or ON_ICE (e.g., if it is already running). In such cases the alarm is sent alerting the operator that the job could not be put ON_HOLD or ON_ICE (as applicable).</td>
</tr>
<tr>
<td>MAXRUNALARM</td>
<td>510</td>
<td>The job has been running for a time greater than that defined in the Maximum Run Alarm (max_run_alarm) field for the job. The job may continue to run; however, a warning alarm is generated.</td>
</tr>
<tr>
<td>MAX_RETRIES</td>
<td>505</td>
<td>AutoSys continues attempting to restart a job if there are system problems or if the job is configured for application restarts (n_retries). There is a limit to the number of times it will attempt a restart, as defined in the configuration files (using Max Restart Trys). When that limit has been reached, the MAX_RETRIES alarm is sent to alert operators that AutoSys has given up trying to start the job. After the problem has been fixed the job must be started manually.</td>
</tr>
<tr>
<td>MINRUNALARM</td>
<td>502</td>
<td>The job has completed running in a time less than that defined in the Minimum Run Alarm (min_run_alarm) field for the job.</td>
</tr>
</tbody>
</table>
Table 8. AutoSys Alarms

<table>
<thead>
<tr>
<th>ALARM</th>
<th>CODE*</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>MISSING_HEARTBEAT</td>
<td>513</td>
<td>A job has not sent a HEARTBEAT within the interval specified for the job. The operator should inspect the job to determine the cause.</td>
</tr>
<tr>
<td>RESOURCE</td>
<td>512</td>
<td>A resource needed for the job was not available. The types of resources are: (a) number of process slots and (b) file space. Specific information about the problem is in the comment associated with the alarm. If AutoSys encounters a resource problem, it attempts to restart the job after a suitable delay.</td>
</tr>
<tr>
<td>STARTJOBFAIL</td>
<td>506</td>
<td>AutoSys was unable to start the job. This is generally due to communication problems with the remote machine. AutoSys attempts to restart the job.</td>
</tr>
<tr>
<td>VERSION_MISMATCH</td>
<td>518</td>
<td>Generated by the Remote Agent when calling the routine (e.g., Event Processor, chase, clean_files, autoping, etc.) has a different version number than the Remote Agent. Inspect the Remote Agent Log file for the exact version mismatch. The proper Remote Agent version should be installed.</td>
</tr>
</tbody>
</table>

*The code number is used for viewing the event in the event table in the AutoSys database.

6 Click the Response edit box and type in a response, if desired, then press the Tab key on the keyboard.
   • Response is updated on the GUI (but not yet recorded).

7 Update the Alarm State by clicking on the radio button that appropriately describes the Alarm State.
   • The following Alarm State radio buttons are available:
     - Open.
     - Acknowledged.
     - Closed.
   • The Alarm State is updated on the GUI (but not yet recorded).

8 Click on the appropriate button from the following selections:
   • OK - to enter all alarm responses and dismiss the Alarm Manager GUI.
     - Job Activity Console (Ops Console) GUI is displayed.
   • Apply - to enter all alarm responses without dismissing the Alarm Manager GUI.
     - Repeat Steps 5 through 8 as necessary to review and update additional alarms.
• **Cancel** - to return to the **Job Activity Console (Ops Console)** GUI without entering any alarm responses.
  
  – **Job Activity Console (Ops Console)** GUI is displayed.

9  If the **Alarm Manager** GUI has not been dismissed, information concerning a job for which there is an alarm can be reviewed by performing Steps 10 through 14.

10  Verify that the alarm has been highlighted in the **Currently Selected Alarm** region of the display (click on the alarm in the **Alarm List** if necessary).

11  Click on the **Select Job** button.

  • **Job Activity Console (Ops Console)** GUI is displayed with information concerning the selected job.

12  When all job activities have been adequately reviewed, start the process of exiting from the **Job Activity Console (Ops Console)** GUI by clicking on the **Exit** button.

  • An **AutoSys JAC Exit** dialogue box is displayed to confirm the decision to quit the display.

13  Click on the appropriate button from the following selections:

  • **OK** - to exit from the **Job Activity Console (Ops Console)** GUI.
    
    – The **Job Activity Console (Ops Console)** GUI is dismissed.

  • **Cancel** - to return to the **Job Activity Console (Ops Console)** GUI.

14  Return to Step 9.

By configuring the AutoSys Alarm Manager the Production Monitor can control which alarms are displayed. Alarms can by selected by type, state, or time.

The procedure for configuring the Alarm Manager starts from the assumption that the **Alarm Manager** is currently running.

**Configuring Alarm Selection**

1  Select **View → Select Alarms...** from the pull-down menu of the **Alarm Manager** GUI.

  • **Alarm Selection** GUI (Figure 67) is displayed.

  • **Alarm Selection** has the following defaults:
    
    – **All Types** for **Select by Type**.
    
    – **Open** and **Acknowledged** for **Select by State**.
If all types of alarms are to be displayed on the Alarm Manager GUI, verify that the All Types toggle button is selected in the Select by Type area.

- Click on the All Types button to change state from unselected to selected or vice versa.
  - When the All Types option is selected, the All Types button color is yellow.
- Proceed to Step 4.

If selecting a particular type of alarm or set of alarm types, click on the name(s) of the desired alarm(s) in the Select by Type list.

- To select multiple types of alarms press and hold either the Ctrl key or the Shift key while clicking individual alarms in the Alarm List.
- Alternatively, to select multiple types of alarms press and hold either the Ctrl key or the Shift key, then click on the first type of alarm and drag the cursor to the last type of alarm to be selected and release the mouse button.
  - Selected alarm(s) is (are) highlighted.
- Refer to Table 8 for descriptions of AutoSys alarms.
4 If all alarm states are to be displayed on the Alarm Manager GUI, verify that the All States toggle button is selected in the Select by State area.
   • Click on the All States button to change state from unselected to selected or vice versa.
     – When the All States option is selected, the All States button color is yellow.
   • Proceed to Step 6.

5 If selecting a particular alarm state or set of alarm states to be displayed on the Alarm Manager GUI, click on the name(s) of the desired alarm state(s) in the Select by State list.
   • The following options are available:
     – Open.
     – Acknowledged.
     – Closed.
   • Any or all buttons can be selected.
   • Button turns yellow when selected.

6 To select alarms by time perform Steps 7 through 12 (as applicable); otherwise, go to Step 13.

7 If alarms at all times are to be displayed on the Alarm Manager GUI, verify that the All Times toggle button is selected in the Select by Time area.
   • Click on the All Times button to change state from unselected to selected or vice versa.
     – When the All Times option is selected, the All Times button color is yellow.
   • Proceed to Step 13.

8 If selecting a particular date/time range for alarms to be displayed on the Alarm Manager GUI, first verify that the All Times toggle button is unselected.
   a. Single-click on the All Times button to change state from unselected to selected or vice versa.

9 Type the starting date (in MM/DD/YYYY format) in the From Date field and press the Tab key on the keyboard to advance to the next field.
   • Starting date is entered.

10 Type the starting time (in hh:mm format) in the From Time field and press the Tab key on the keyboard to advance to the next field.
   • Starting time is entered.
11 Type the end date (in *MM/DD/YYYY* format) in the **To Date** field, and press the **Tab** key on the keyboard to advance to the next field.

- End date is entered.

12 Type the end time (in *hh:mm* format) in the **To Time** field.

- End time is entered.

13 When the **Alarm Selection** GUI contains the desired set of alarm display criteria, click on the appropriate button from the following selections:

- **OK** - to accept all specified alarm selections and dismiss the **Alarm Selection** GUI.
  - **Alarm Manager** GUI is displayed.

- **Apply** - to accept all specified alarm selections without dismissing the **Alarm Selection** GUI.
  - Repeat Steps 2 through 13 as necessary to specify additional alarm selection criteria.

- **Cancel** - to dismiss the **Alarm Selection** GUI without accepting any alarm selections.
  - **Alarm Manager** GUI is displayed.

14 If alarm sound is desired, select **Options → Sound On** from the pull-down menu of the **Alarm Manager** GUI.

- **Sound On** toggle button is yellow when the sound is on.

---

**Specifying Job Selection Criteria**

The Production Monitor reviews job activities using the AutoSys **Job Activity Console** as described in the section of the lesson that follows this one. The AutoSys **Job Selection** GUI is used for specifying (filtering) the jobs to be reviewed, including setting the criteria for displaying jobs by name, status and/or machine.

The procedure for specifying job selection criteria starts with the assumption that all applicable servers are currently running and the **AutoSys GUI Control Panel** (Figure 52) is being displayed.

**Specifying Job Selection Criteria**

1 Click on the **Ops Console** button on the **AutoSys GUI Control Panel**.

- The **Job Activity Console** GUI, also known as the **Ops Console** GUI, (Figure 65) is displayed.
Select **View → Select Jobs** from the pull-down menu.

- The **Job Selection** GUI (Figure 68) is displayed.
- **Job Selection** has the following default values:
  - **All Jobs/Job Name** for **Select by Name**.
  - **All Statuses** for **Select by Status**.
  - **All Machines** for **Select by Machine**.
  - **Unsorted** for **Sort Order**.
- If the default settings are the desired settings, proceed to Step 10.

3 To select all jobs click on the **All Jobs** button.

- When the **All Jobs** option is selected, the **All Jobs** button color changes to yellow.

4 To select a particular job by name, type the name of the desired job in the **Job Name** field.

- When typing in either the **Job Name** field or the **Box Name** field, the corresponding toggle button is automatically turned on. (You do not have to click on the button, just start typing in the desired field.)
- The asterisk (*) wildcard character can be used for entering a partial job or box name (e.g., *.ceres*).

5 To select a particular box by name, type the name of the desired box in the **Box Name** field then type in the **Box Levels** field how many levels of nesting you want to view for the box job.

- In the **Box Levels** field any valid positive integer can be entered or the word “all.”
  - 0 - indicates that only the top-level box specified in the **Box Name** field is to be displayed.
  - 1 - indicates that the specified top-level box and all direct descendant boxes and enclosed jobs are to be displayed.
  - all - indicates that all jobs in the box are to be displayed.

6 To select jobs by status click on whichever of the following **Select by Status** toggle buttons properly describe(s) the status(es) to be selected:

- **All Statuses**.
- **Starting**.
- **Running**.
- **Success**.
Figure 68. Job Selection GUI

- Failure.
- Terminated.
- Restart.
- Que Wait.
- Activated.
- Inactive.
- On Hold.
• On Ice.

7 To select all machines click on the All Machines button.

• All Machines button turns yellow.

• Proceed to Step 9.

8 To select jobs by the particular machine click on the name of the desired machine in the Select by Machine list.

• To select multiple machines press and hold either the Ctrl key or the Shift key while clicking on individual machines in the Select by Machine list.

• Alternatively, to select multiple machines press and hold either the Ctrl key or the Shift key then click on the first machine and drag the cursor to the name of the last machine to be selected and release the mouse button.
  – Selected machine(s) is (are) highlighted.

9 Click on whichever of the following Sort Order toggle buttons properly describes the Sort Order to be selected:

• Start Time.

• End Time.

• Job Name.

• Job Status.

• Machine Name.

• Unsorted.

10 When the Job Selection GUI contains the desired set of job selection criteria, click on the appropriate button from the following selections:

• OK - to accept all specified job selection criteria and dismiss the Job Selection GUI.
  – Job Activity Console GUI is displayed.
  – Job list based on the specified selection criteria is displayed in the Job List region of the Job Activity Console.

• Apply - to accept all specified job selection criteria without dismissing the Job Selection GUI.
  – Repeat Steps 3 through 10 as necessary to specify additional job selection criteria.
• **Cancel** - to dismiss the **Job Selection** GUI without accepting any job selection criteria.
  
  - **Job Activity Console** GUI is displayed.

---

**Reviewing Job Activities**

The Production Monitor reviews job activities using AutoSys. The Job Activity Console is the primary interface that allows the operator to monitor all jobs that have been defined for AutoSys. The Job Selection GUI (described in the preceding section) is used for defining the criteria for displaying jobs on the Job Activity Console.

The procedure for reviewing job activities starts with the assumption that all applicable servers are currently running and the **AutoSys GUI Control Panel** (Figure 52) is being displayed.

**Reviewing Job Activities**

1. Click on the **Ops Console** button on the **AutoSys GUI Control Panel**.

   - The **Job Activity Console** GUI, also known as the **Ops Console** GUI, (Figure 65) is displayed.

2. Generate a list of jobs to be displayed on the **Job Activity Console** GUI by performing the procedure for **Specifying Job Selection Criteria** (preceding section of this lesson).

   - Job list based on the specified selection criteria is displayed in the **Job List** region of the **Job Activity Console**.

3. Review the **Job List** region of the **Job Activity Console**.

   - The following job characteristics are displayed in a table:
     
     - **Job Name**.
     - **Description**.
     - **Status**.
     - **Command**.
     - **Machine**.

4. Click anywhere on a job row in the **Job List** region to have detailed information for that job displayed in the **Currently Selected Job** region of the display.
5 Review the data in the **Currently Selected Job** region of the display.

- The following job details are displayed in the **Currently Selected Job** region of the **Job Activity Console**:
  - *jobname* (Currently Selected Job).
  - **Machine Time** (current time or time at which the frame was frozen).
  - **Description**.
  - **Command**.
  - **Start Time** (and date).
  - **End Time** (and date).
  - **Run Time**.
  - **Status**.
  - **Exit Code**.
  - **Next Start**.
  - **Machine**.
  - **Queue Name**.
  - **Priority**.
  - **Num. of Tries**.

6 Review the data in the **Starting Conditions** region of the display.

- The following job starting conditions are displayed:
  - Overall starting conditions (including all atomic conditions).
  - Identification of each **Atomic Condition**.
    - **Current State**.
    - **T/F** (true or false).

- The starting conditions can be useful in determining what “upstream” job may be preventing the currently selected job from running.

- An **Atomic Condition** is one of the most basic components of an overall starting condition; for example, if SUCCESS(JOB_X) and SUCCESS(JOB_Y) define the overall starting condition for a job, there are two atomic conditions, one of which is SUCCESS(JOB_X) and the other of which is SUCCESS(JOB_Y).

- The **T/F** (true/false) flag indicates whether the corresponding atomic condition has been satisfied.
Clicking on one of the **Atomic Conditions** causes the job associated with that condition to become the currently selected job, with its details displayed in the **Currently Selected Job** region of the display. By checking the atomic conditions, it is possible to check the path of upstream dependencies to determine which job (if any) is preventing a particular job from running.

- Figure 69 shows how atomic conditions relate to job dependencies as displayed using JobScape. (In this case JOBOPSR is an atomic condition for JOBOPSE.)
- Note that clicking on one of the atomic conditions listed on the Job Activity Console does **not** actually cause the JobScape GUI to be displayed.

![Figure 69. Atomic Conditions and Upstream Dependencies](image)

In the **Reports** list click on the type of report to be reviewed then review the report in the **Event Report** region of the display:

- The following types of reports can be selected:
  - **Summary**, which shows the result of the last execution of the job including the following types of information:
    - Job Name.
    - Last Start.
    - Last End.
Event, which lists all events from the last execution of the job including the following types of information:

- Status [Event].
- Time.
- Ntry [number of tries].
- EventState [e.g., “Processed”].
- ProcessTime.
- Machine.

None.

- The selected report is displayed. The color of the button corresponding to the selected report changes to yellow.

- For a better view of a report, it is possible to expand the size of the GUI by grabbing a corner of the GUI with the mouse cursor and resizing as desired.

- An example of a Summary Report is shown in Figure 70.

![Summary Report]

Figure 70. Example of a Summary Report on the Job Activity Console
To change the state of the freeze-frame feature of the **Job Activity Console (Ops Console)** GUI click on the **Freeze Frame** toggle button.

- The freeze-frame feature prevents the **Job Activity Console (Ops Console)** GUI from being updated, disrupting the display.
- Deactivating the freeze-frame feature allows the display to be updated with new information.
- By default the freeze-frame feature is activated.
- The **Freeze Frame** toggle button is yellow when the freeze-frame feature is activated.

When all job activities have been adequately reviewed, start the process of exiting from the **Job Activity Console (Ops Console)** GUI by clicking on the **Exit** button.

- An **AutoSys JAC Exit** dialogue box is displayed to confirm the decision to quit the display.
- Subsequent sections of this lesson describe features that are accessible through the **Actions** and **Show** regions of the **Job Activity Console**.
- Use and configuration of **Alarm** functions were described in previous sections.

Click on the appropriate button from the following selections:

- **OK** - to exit from the **Job Activity Console (Ops Console)** GUI.
  - The **Job Activity Console (Ops Console)** GUI is dismissed.
- **Cancel** - to return to the **Job Activity Console (Ops Console)** GUI.
Modifying Job Status

Methods for Modifying Job Status

At times the Production Monitor may need to modify a particular job in any of the following ways:

- Start the job.
- Kill the job.
- Force the job to start.
- Place the job on hold.
- Take the job off hold.

The Production Monitor has the option of the following three methods for making those types of modifications to a particular job:

- Buttons in the Actions region of the Job Activity Console (Ops Console).
- Menu accessed by clicking the right mouse button on the relevant job name on either the JobScape or TimeScape GUI.
- AutoSys Send Event GUI.

In AutoSys terms a control action such as starting or killing a job is accomplished by sending an “event” to the job. An event is basically a message. For example, clicking on the Start Job button on the AutoSys Job Activity Console begins the process by which AutoSys sends a “start” message to the Currently Selected Job.

In addition to the previously mentioned modifications to job status, the buttons in the Actions region of the Job Activity Console (Ops Console) allow the Production Monitor to generate one of the following types of reports:

- Jobs Completed (Figure 71).
- Jobs Waiting (Figure 72).

The menu accessed using the right mouse button on one of the AutoXpert GUIs allows the Production Monitor to initiate either of the following actions (in addition to the previously mentioned modifications to job status):

- Put the job on ice.
- Take the job off ice.
**Figure 71. Jobs Completed Report**
The **Send Event** GUI (Figure 73) allows the Production Monitor to initiate a very broad range of actions, including any of the following items:

- Start the job.
- Kill the job.
- Force the job to start.
- Force the job to start.
- Place the job on hold.

### Figure 72. Jobs Waiting Report

The **Jobs Waiting** GUI allows the Production Monitor to initiate a very broad range of actions, including any of the following items:

- Start the job.
- Kill the job.
- Force the job to start.
- Force the job to start.
- Place the job on hold.

<table>
<thead>
<tr>
<th>DPR ID</th>
<th>COMPLETION STATE</th>
<th>PRIORITY</th>
<th>PREDICTED START TIME</th>
</tr>
</thead>
<tbody>
<tr>
<td>AM1Eph#2.0073106200PS</td>
<td>CQ_HOLD</td>
<td>250</td>
<td>10/27/98 18:44:01.000</td>
</tr>
<tr>
<td>AM1Eph#2.0073108200PS</td>
<td>CQ_HOLD</td>
<td>250</td>
<td>10/27/98 18:44:16.000</td>
</tr>
<tr>
<td>AM1Eph#2.0073110200PS</td>
<td>CQ_HOLD</td>
<td>250</td>
<td>10/27/98 18:44:31.000</td>
</tr>
<tr>
<td>AM1Eph#2.0073112200PS</td>
<td>CQ_HOLD</td>
<td>250</td>
<td>10/27/98 18:44:43.000</td>
</tr>
</tbody>
</table>

**TOTAL JOBS WAITING = 4**
**TOTAL JOBS WAITING ON DATA (CQ_HOLD) = 4**
**TOTAL JOBS WAITING ON RESOURCES (CQ_RELEASE) = 0**
**Figure 73. Send Event GUI**

- Take the job off hold.
- Change the job’s status.
- Change the job’s queue priority.
- Put the job on ice.
- Take the job off ice.
- Stop the daemon (stop the Event Processor in an emergency).
- Set a global value.
- Send a signal concerning the job.
• Make a comment (for example, why a job start was forced).

Guidelines for Reporting Unsuccessful Completion of On-Demand Jobs

• Under any of the following circumstances involving an on-demand job notify User Services of the problem in accordance with the applicable local policy:
  – Job is killed.
  – Job terminates and cannot be restarted.
  – A FAILPGE granule is created.
• The DAAC is obliged to send an e-mail message to the requester of an unsuccessful on-demand job to explain why the request cannot be fulfilled.

Guideline for Putting Jobs “On Ice” or “On Hold”

• Ensure that the job to be put either “on hold” or “on ice” is not already in a “starting” or “running” state. (A job that is either “starting” or “running” cannot be put “on hold” or “on ice.”)

Guidelines for Force-Starting Jobs

• Force-start command jobs (e.g., preprocessing or postprocessing) only; do not attempt to force-start a box job.
  – The software does not support box job force-starts. (Although it may work fine in some cases, it can cause the PDPS database to get out of sync and prevent the DPR (and possibly other DPRs) from running successfully.)
  – If a box job were force-started, the allocation portion of the preprocessing job would run again. Allocation might choose a different science processor than was chosen the previous time the job ran. Using a different science processor could cause failure of the job.
  – After each job (and often within each job) the state of the DPR is tracked in various tables in the database. Box job force-starts lack the code needed to check the state of the box and perform the cleanup activities necessary for starting over.
• Ensure that the GUI has refreshed and the job to be force-started is not already running before trying to force-start a job. (If a job is already running, it should not be force-started.)
  – If using AutoSys/AutoXpert 3.4.2 or a later version, it should not be possible to force-start jobs that are already running.
• If any command job other than execution fails, force-start the job that failed only. Do not force start any preceding or succeeding jobs in the box.
• If execution fails, it is not safe to restart it unless the postprocessing job had been put on hold and the failure was detected before postprocessing started running.

• If execution fails and the failure was not detected before postprocessing started running, the DPR must run to completion as a failed PGE and the DPR must be deleted and recreated.

In any case the Production Monitor may implement certain changes of job status only when the Production Monitor “owns” the job affected by the modification.

Determining the Ownership of an AutoSys Job

AutoSys is very much ownership-aware. Only the “owner” of a job has “edit” privileges and can make changes to the status of an owned job.

AutoSys recognizes ownership in terms of two factors:

• UserID.

• Machine where the operator (user) logged in.

For example, cmshared@g0spso6 identifies the Production Monitor who logged in as “cmshared” at machine g0spso6. Any operator who logs in as “cmshared” at another machine (e.g., g0plso1) would not be able to change the status of a job “owned” by cmshared@g0spso6. Consequently, to have any real effect on a job first it is necessary to log in as the job’s owner and launch the AutoSys GUIs as that owner.

The procedure for determining the ownership of a job starts with the assumption that all applicable servers are currently running and the AutoSys GUI Control Panel (Figure 52) is being displayed.

Determining the Ownership of an AutoSys Job

1 Click on the JobScape button on the AutoSys GUI Control Panel.

   • The JobScape GUI (Figure 56) is displayed.
   • The TimeScape GUI (Figure 55) may be used instead of the JobScape GUI.

2 Place the mouse cursor on the relevant job and click and hold the right mouse button.

   • Pop-up menu appears. It has the following entries:

     – jobname.
     – Show Children.
     – Show All Descendants.
     – Hide All Descendants.
- Show Job Arrows.
- Hide Job Arrows.
- Show Box Arrows.
- Hide Box Arrows.
- Job Definition.
- View Dependencies.
- Set Simulation Overrides [grayed out].
- Start Job.
- Kill Job.
- Force Start Job.
- On Hold.
- Off Hold.
- On Ice.
- Off Ice.

3 Select (highlight) Job Definition from the pop-up menu (release the right mouse button).

- The Job Definition GUI (Figure 74) is displayed.
- If the current UserID does not "own" (have edit permissions on) the job, a Job Security MESSAGE window (Figure 75) is displayed.

4 If a Job Security MESSAGE window (Figure 75) is displayed, click on the Ok button.

- The Job Security MESSAGE window is dismissed.

5 Review the entry in the Owner field of the Job Definition GUI.

- Job owner is identified in the Owner field of the Job Definition GUI.
- Job name is listed in the Job Name field of the Job Definition GUI.

NOTE: Jobs should not be deleted using the AutoSys Job Definition GUI because it does not communicate with the PDPS database.

6 To exit from the Job Definition GUI, click on the Exit button.
Figure 74. Job Definition GUI
Sending an Event to a Job

As previously mentioned there are three methods for making certain types of modifications (e.g., start or kill) to a particular job:

- Menu accessed by clicking the right mouse button on the relevant job name on either the JobScape or TimeScape GUI.
- Buttons in the Actions region of the Job Activity Console (Ops Console).
- AutoSys Send Event GUI.

Sending an Event to a Job from an AutoXpert GUI

The procedure for sending an event to a job from an AutoXpert GUI (i.e., JobScape or TimeScape) starts with the assumption that all applicable servers are currently running and the AutoSys GUI Control Panel (Figure 52) is being displayed.

Sending an Event to a Job from an AutoXpert GUI

1. Click on either the JobScape button or the TimeScape button (as desired) on the AutoSys GUI Control Panel.
   - The selected GUI [i.e., JobScape (Figure 56) or TimeScape (Figure 55)] is displayed.

2. Place the mouse cursor on the relevant job and click and hold the right mouse button.
   - Pop-up menu appears.
   - Of the options displayed on the pop-up menu the following choices are relevant:
     - Start Job.
     - Kill Job.
- **Force Start Job.**
- **On Hold** (Put job on hold).
- **Off Hold** (Take job off hold).
- **On Ice** (Put job on ice).
- **Off Ice** (Take job off ice).

3 Select the event (e.g., **Force Start Job**) to be sent to the job from the pop-up menu (release the right mouse button).

- A confirmation dialogue box similar to Figure 76 is displayed requesting permission to proceed with sending the event.
- If there is no option corresponding to the desired action, modify job status from either the **Job Activity Console** or the **Send Event GUI** as described in the procedure for **Sending an Event to a Job from the Job Activity Console** or the procedure for **Sending an Event to a Job from the Send Event GUI** (subsequent sections of this lesson).

![Figure 76. Confirmation Dialogue Box](image)

4 Click on the appropriate button from the following selections:

- **Yes** - to send the event to the job.
  - The confirmation dialogue box is dismissed.
  - The specified action is taken.
- **No** – to dismiss the confirmation dialogue box without sending the event to the job.

5 To start the process of exiting from the **JobScape** or **TimeScape** GUI select **File → Exit** from the pull-down menu.

- **JobScape** [or **TimeScape**] Exit GUI is displayed.
Single-click on the appropriate button from the following selections:

- **OK** - to dismiss the **JobScape** or **TimeScape** GUI.
  - AutoXpert **JobScape** or **TimeScape** GUI is dismissed.
- **Cancel** - to return to the **JobScape** or **TimeScape** GUI.

### Sending an Event to a Job from the Job Activity Console

The procedure for sending an event to a job from the **Job Activity Console (Ops Console)** starts with the assumption that all applicable servers are currently running and the **AutoSys GUI Control Panel** (Figure 52) is being displayed.

#### Sending an Event to a Job from the Job Activity Console

1. Specify job selection criteria for the AutoSys **Job Activity Console** by performing the procedure for **Specifying Job Selection Criteria** (preceding section of this lesson).
2. Verify that the job with the status to be modified is listed in the **Currently Selected Job** field of the **Job Activity Console** (Ops Console).
   - Click on the job row in the **Job List** region of the **Job Activity Console** if necessary.
   - Information concerning the selected job is displayed in the **Currently Selected Job** region of the **Job Activity Console**.
3. Click on the button corresponding to the desired action to be taken with respect to the selected job (if there is a corresponding button in the **Actions** region of the **Job Activity Console**).
   - The following options are displayed:
     - **Start Job**.
     - **Kill Job**.
     - **Force Start Job**.
     - **On Hold** (Put job on hold).
     - **Off Hold** (Take job off hold).
   - A confirmation dialogue box similar to Figure 76 is displayed requesting permission to proceed with sending the event.
   - If there is no button corresponding to the desired action, modify job status using the **Send Event GUI** as described in the procedure for **Sending an Event to a Job from the Send Event GUI** (subsequent section of this lesson).
4. **Single-click** on the appropriate button from the following selections:
   - **Yes** - to send the event to the job.
     - The confirmation dialogue box is dismissed.
     - The specified action is taken.
   - **No** – to dismiss the confirmation dialogue box without sending the event to the job.

5. Start the exit from the **Job Activity Console (Ops Console)** GUI by clicking on the **Exit** button.
   - **AutoSys JAC Exit** GUI is displayed.
   - Subsequent sections of the lesson describe features that are accessible through the **Actions** and **Show** regions of the **Job Activity Console**.
   - Use and configuration of **Alarm** functions were described in previous sections.

6. Click on the appropriate button from the following selections:
   - **OK** - to dismiss the **Job Activity Console (Ops Console)** GUI.
     - AutoSys **Job Activity Console (Ops Console)** GUI is dismissed.
   - **Cancel** - to return to the **Job Activity Console (Ops Console)** GUI.

---

**Sending an Event to a Job from the Send Event GUI**

The procedure for sending an event to a job using the **Send Event** GUI starts with the assumption that all applicable servers are currently running and the **AutoSys GUI Control Panel** (Figure 52) is being displayed.

**CAUTION**

Once an event has been sent from the **Send Event** dialogue, it may not be possible to cancel or modify it.

**Sending an Event to a Job from the Send Event GUI**

1. Specify job selection criteria for the AutoSys **Job Activity Console** by performing the procedure for **Specifying Job Selection Criteria** (preceding section of this lesson)

2. In the **Job List** region of the **Job Activity Console** click on the job row corresponding to the job with the status to be modified.
   - Information concerning the selected job is displayed in the **Currently Selected Job** region of the **Job Activity Console**.
Click on the **Send Event** button in the **Actions Region** of the **Job Activity Console**.

- The **Send Event** GUI (Figure 73) is displayed.
- **Send Event** has the following defaults:
  - **Start Job** for **Event Type**.
  - **Now** for **Time**.
  - **Normal** for **Send Priority**.
- If the default settings are the desired settings, proceed to Step 18.

Verify that the correct job is listed in the **Job Name** field of the **Send Event** GUI.

- If not, click on the **Cancel** button and select the correct job (return to Step 2).

Click on the **Event Type** to be sent to the job in AutoSys.

- The following options are displayed:
  - **Start Job**.
  - **Job On Hold**.
  - **Job Off Hold**.
  - **Comment**.
  - **Stop Demon**.
  - **Force Start Job**.
  - **Job On Ice**.
  - **Job Off Ice**.
  - **Kill Job**.
  - **Change Status**.
  - **Change Priority**.
  - **Set Global**.
  - **Set Signal**.
- Remember that a job with status of either “starting” or “running” cannot be put “on hold” or “on ice.”
- Note that the GUI has an option to **Cancel Previously Sent Event**.
To select a future time for sending the event to the job click on the **Future** button.

- If **Now** (the default value) is desired, proceed to Step 10.
  - Current date and time are default values.

Type the date (in **MM/DD/YYYY** format) for future execution in the **Date** field.

Type the time (in **hh:mm** format) for future execution in the **Time** field.

Click on either the **A.M.** or **P.M.** button as applicable.

If **Comment** was selected as the **Event Type**, type the appropriate comment in the **Comment** field.

- **Comment** is a free-form field for entering text to be sent to the specified job.

Verify that the entry in the **AUTOSEV Instance** field is the current AutoSys instance identifier.

- Type the correct **AUTOSEV Instance** in the **AUTOSEV Instance** field if necessary.
- **AUTOSEV Instance** field specifies the instance of AutoSys to which the event will be sent. (You can send events to instances of AutoSys other than the one you are running.)
- The current AutoSys instance should be displayed by default in the **AUTOSEV Instance** field.

If **Set Global** was selected as the **Event Type**, type the appropriate name in the **Global Name** field.

- **Global Name** and **Global Value** are accessible only if **Set Global** was selected in the **Event Type** region.
- The name in the **Global Name** field identifies a variable that is made available to all jobs in AutoSys; consequently, it is a “global” variable.

If **Set Global** was selected as the **Event Type**, type the appropriate value (for the variable specified in the **Global Name** field) in the **Global Value** field.

If either **Send Signal** or **Kill Job** was selected as the **Event Type**, in the **Signal** field type the number corresponding to the UNIX signal to be sent to the job.

- The **Signal** field is accessible only if **Send Signal** or **Kill Job** was selected in the **Event Type** region.
- Numbers corresponding to UNIX signals are shown in Table 9.
<table>
<thead>
<tr>
<th>NAME</th>
<th>VALUE</th>
<th>DEFAULT</th>
<th>EVENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>HUP</td>
<td>1</td>
<td>Exit</td>
<td>Hangup.</td>
</tr>
<tr>
<td>INT</td>
<td>2</td>
<td>Exit</td>
<td>Interrupt.</td>
</tr>
<tr>
<td>QUIT</td>
<td>3</td>
<td>Core</td>
<td>Quit.</td>
</tr>
<tr>
<td>ILL</td>
<td>4</td>
<td>Core</td>
<td>Illegal Instruction.</td>
</tr>
<tr>
<td>TRAP</td>
<td>5</td>
<td>Core</td>
<td>Trace/Breakpoint Trap.</td>
</tr>
<tr>
<td>ABRT</td>
<td>6</td>
<td>Core</td>
<td>Abort.</td>
</tr>
<tr>
<td>EMT</td>
<td>7</td>
<td>Core</td>
<td>Emulation Trap.</td>
</tr>
<tr>
<td>FPE</td>
<td>8</td>
<td>Core</td>
<td>Arithmetic Exception.</td>
</tr>
<tr>
<td>KILL</td>
<td>9</td>
<td>Exit</td>
<td>Killed.</td>
</tr>
<tr>
<td>BUS</td>
<td>10</td>
<td>Core</td>
<td>Bus Error.</td>
</tr>
<tr>
<td>SEGV</td>
<td>11</td>
<td>Core</td>
<td>Segmentation Fault.</td>
</tr>
<tr>
<td>SYS</td>
<td>12</td>
<td>Core</td>
<td>Bad System Call.</td>
</tr>
<tr>
<td>PIPE</td>
<td>13</td>
<td>Exit</td>
<td>Broken Pipe.</td>
</tr>
<tr>
<td>ALRM</td>
<td>14</td>
<td>Exit</td>
<td>Alarm Clock.</td>
</tr>
<tr>
<td>TERM</td>
<td>15</td>
<td>Exit</td>
<td>Terminated.</td>
</tr>
<tr>
<td>USR1</td>
<td>16</td>
<td>Exit</td>
<td>User Signal 1.</td>
</tr>
<tr>
<td>USR2</td>
<td>17</td>
<td>Exit</td>
<td>User Signal 2.</td>
</tr>
<tr>
<td>CHLD</td>
<td>18</td>
<td>Ignore</td>
<td>Child Status Changed.</td>
</tr>
<tr>
<td>PWR</td>
<td>19</td>
<td>Ignore</td>
<td>Power Fail/Restart.</td>
</tr>
<tr>
<td>WINCH</td>
<td>20</td>
<td>Ignore</td>
<td>Window Size Change</td>
</tr>
<tr>
<td>URG</td>
<td>21</td>
<td>Ignore</td>
<td>Urgent Socket Condition.</td>
</tr>
<tr>
<td>POLL</td>
<td>22</td>
<td>Exit</td>
<td>Pollable Event.</td>
</tr>
<tr>
<td>STOP</td>
<td>23</td>
<td>Stop</td>
<td>Stopped (signal).</td>
</tr>
<tr>
<td>TSTOP</td>
<td>24</td>
<td>Stop</td>
<td>Stopped (user).</td>
</tr>
<tr>
<td>CONT</td>
<td>25</td>
<td>Ignore</td>
<td>Continued.</td>
</tr>
<tr>
<td>TTIN</td>
<td>26</td>
<td>Stop</td>
<td>Stopped (tty input).</td>
</tr>
<tr>
<td>TTOU</td>
<td>27</td>
<td>Stop</td>
<td>Stopped (tty output).</td>
</tr>
<tr>
<td>VTALRM</td>
<td>28</td>
<td>Exit</td>
<td>Virtual Timer Expired.</td>
</tr>
<tr>
<td>PROF</td>
<td>29</td>
<td>Exit</td>
<td>Profiling Timer Expired.</td>
</tr>
<tr>
<td>XCPU</td>
<td>30</td>
<td>Core</td>
<td>CPU time limit exceeded.</td>
</tr>
<tr>
<td>XFSZ</td>
<td>31</td>
<td>Core</td>
<td>File size limit exceeded.</td>
</tr>
<tr>
<td>WAITING</td>
<td>32</td>
<td>Ignore</td>
<td>Concurrency signal reserved by threads library</td>
</tr>
<tr>
<td>LWP</td>
<td>33</td>
<td>Ignore</td>
<td>Inter-LWP signal reserved by threads library.</td>
</tr>
<tr>
<td>FREEZE</td>
<td>34</td>
<td>Ignore</td>
<td>Check point Freeze</td>
</tr>
<tr>
<td>THAW</td>
<td>35</td>
<td>Ignore</td>
<td>Check point Thaw</td>
</tr>
<tr>
<td>CANCEL</td>
<td>36</td>
<td>Ignore</td>
<td>Cancellation signal reserved by threads library.</td>
</tr>
<tr>
<td>RTMIN</td>
<td>*</td>
<td>Exit</td>
<td>First real time signal</td>
</tr>
</tbody>
</table>
Table 9. UNIX Signals

<table>
<thead>
<tr>
<th>NAME</th>
<th>VALUE</th>
<th>DEFAULT</th>
<th>EVENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>(RTMIN+1)</td>
<td>*</td>
<td>Exit</td>
<td>Second real time signal</td>
</tr>
<tr>
<td>(RTMAX-1)</td>
<td>*</td>
<td>Exit</td>
<td>Second-to-last real time signal.</td>
</tr>
<tr>
<td>RTMAX</td>
<td>*</td>
<td>Exit</td>
<td>Last real time signal</td>
</tr>
</tbody>
</table>

*The symbols RTMIN through RTMAX are evaluated dynamically in order to permit future configurability.

15 If Change Status was selected as the Event Type, click on the Status option menu button and select the desired status from the pick list.

- Status can be changed only if Change Status was selected in the Event Type region.
- Status has the following options.
  - Running.
  - Success.
  - Failure.
  - Terminated.
  - Starting.
  - Inactive.

16 If Change Priority was selected as the Event Type, type the new priority in the Queue Priority field.

- Queue priority can be changed only if Change Priority was selected in the Event Type region.
- The queue priority is not relevant to box jobs (DPR-level jobs).

17 If sending the event to the job is due to an emergency condition, single-click on the High button in the Send Priority area.

- Send Priority refers to the priority for sending the selected event to the job (not the job priority).
- Send Priority has the following options.
  - Normal.
  - High.
- **High** priority is reserved for emergencies.

18 **Single-click** on the **Execute** button.

- A confirmation dialogue box similar to Figure 77 is displayed requesting permission to proceed with sending the event.

19 Click on the appropriate button from the following selections:

- **yes** - to send the event to the job.
  - The confirmation dialogue box is dismissed.
  - The selected event is sent to the specified job.
  - **Job Activity Console (Ops Console)** GUI is displayed.
  - Once an event has been sent from the **Send Event** dialogue, it may not be possible to cancel or modify it.

- **no** - to dismiss the dialogue box and return to the **Send Event** GUI without sending the event to the job.

20 Start the exit from the **Job Activity Console (Ops Console)** GUI by clicking on the **Exit** button.

- **AutoSys JAC Exit** GUI is displayed.

- Subsequent sections of the lesson describe features that are accessible through the **Actions** and **Show** regions of the **Job Activity Console**.

- Use and configuration of **Alarm** functions were described in previous sections.

21 Click on the appropriate button from the following selections:

- **OK** - to dismiss the **Job Activity Console (Ops Console)** GUI.
  - **AutoSys Job Activity Console (Ops Console)** GUI is dismissed.

- **Cancel** - to return to the **Job Activity Console (Ops Console)** GUI.

---

**Canceling a Sent Event**

It may be possible to cancel an event sent to an AutoSys job, especially if the event was previously scheduled for *sometime in the future*.

The Production Monitor uses the AutoSys **Send Event** GUI to cancel an event sent to a job. The procedure starts with the assumption that all applicable servers are currently running and the **Job Activity Console** GUI (Figure 65) is being displayed.
Canceling a Sent Event

1. Click on the **Send Event** button in the **Actions** Region of the **Job Activity Console**.
   - The **Send Event** GUI (Figure 73) is displayed.

2. Click on **Event Type** to select the type of event that was sent to the job and is to be canceled.

3. Click on the **Cancel Previously Sent Event** radio button.

4. Verify that the correct job is listed in the **Job Name** field of the **Send Event** GUI.
   - Type the job name in the **Job Name** field if necessary.
   - **Not** necessary for the following types of events:
     - SET_GLOBAL
     - STOP_DEMON
     - ALARM
     - COMMENT

5. Click on the **Execute** button.
   - A confirmation dialogue box similar to Figure 77 is displayed requesting permission to proceed with canceling the event.

![Question]

**Figure 77. Send Event GUI Confirmation Dialogue Box**
Click on the appropriate button from the following selections:

- **yes** - to send the request to cancel the event.
  - The event is cancelled.
  - **Job Activity Console (Ops Console)** GUI is displayed.
- **no** - to dismiss the dialogue box and return to the **Send Event** GUI without sending the request to cancel the event.

---

**Performing Job Management Client Functions**

The Job Management Client tool is a set of utility programs intended primarily for use by software developers. However, if necessary, it is possible to gain access to the following Job Management Client functions from AutoSys by clicking on the **Client Tool** button in the **Actions** region of the **Job Activity Console** (Figure 65):

- Create DPR Job.
- Release DPR Job.
- Cancel DPR Job.
- Change DPR ID.
- View Job Management DPR Queue.
- Create Ground Event Job.
- Cancel Ground Event Job.
- Change Max Jobs for Autosys Instance.

The Production Monitor starts the process of performing Job Management Client functions from the AutoSys **Job Activity Console (Ops Console)**. The procedure starts with the assumption that all applicable servers are currently running and the AutoSys **Job Activity Console** (Figure 65) is being displayed.

---

**Performing Job Management Client Functions**

1. Verify that the box job with the status to be modified is listed in the **Currently Selected Job** field of the **Job Activity Console (Ops Console)**.
   - Click on the job row in the **Job List** region of the **Job Activity Console** if necessary.
     - Information concerning the selected job is displayed in the **Currently Selected Job** region of the **Job Activity Console** (Figure 65).
Click on the **Client Tool** button in the **Actions Region** of the **Job Activity Console**.

- A confirmation dialogue box similar to Figure 76 is displayed.

Click on the **yes** button.

- The dialogue box closes.
- The **Job Activation User Interface** window (Figure 78) is displayed.
- The following menu options are displayed:
  
  0) **Exit**  
  1) **Create Dpr Job**  
  2) **Release Dpr Job**  
  3) **Cancel Dpr Job**  
  4) **Change Dpr Id**  
  5) **View Job Management Dpr Queue**  
  6) **Create Ground Event Job**  
  7) **Cancel Ground Event Job**  
  8) **Change Max Jobs for Autosys Instance**

Enter the number corresponding to the desired function at the **enter an option** prompt.

Enter responses to Job Management Client prompts.

To quit the Job Management Client enter 0 at the **enter an option** prompt.
This page intentionally left blank.
Reviewing Activity and Job Dependency Reports

Reviewing a Job Activity Report

The Production Monitor reviews the job activity report to obtain the following types of information:

- Which jobs are currently in the AutoSys queue.
- Which jobs have been completed.
- The completion status of jobs that have been completed.
- Which jobs are currently running.

The Production Monitor reviews the job activity report using the AutoSys `autorep` command. The `autorep` command reports information about a job, jobs within boxes, machines, and machine status. Figure 79 shows a sample job activity report.

![Sample Job Activity Report](image)

**Figure 79. Sample Job Activity Report**

The procedure starts with the assumption that the Production Monitor has logged in to the system.
NOTE: Commands in Steps 1 through 7 are typed at a UNIX system prompt.

1 Type `setenv DISPLAY clientname:0.0` then press the Return/Enter key.
   - Use either the X terminal/workstation IP address or the machine-name for the `clientname`.
   - When using secure shell, the DISPLAY variable is set just once, before logging in to remote hosts. If it were to be reset after logging in to a remote host, the security features would be compromised.

2 Start the log-in to the Queuing Server host by typing `/tools/bin/ssh hostname` (e.g., e0sp04, g0sp06, or l0sp03) in the new window then press the Return/Enter key.
   - If you receive the message, **Host key not found from the list of known hosts. Are you sure you want to continue connecting (yes/no)?** type `yes` (“y” alone will not work).
   - If you have previously set up a secure shell passphrase and executed `sshremote`, a prompt to **Enter passphrase for RSA key '<user@localhost>'** appears; continue with Step 3.
   - If you have not previously set up a secure shell passphrase; go to Step 4.

3 If a prompt to **Enter passphrase for RSA key '<user@localhost>'** appears, type your **Passphrase** then press the Return/Enter key.
   - Go to Step 5.

4 At the `<user@remotehost>`’s password: prompt type your **Password** then press the Return/Enter key.

5 Type `cd /path` then press Return/Enter.
   - Change directory to the directory (e.g., `/usr/ecs/MODE/COTS/autotreeb/autouser`, `/usr/ecs/MODE/COTS/autotree/autouser`, `/data1/SHARED/COTS/autotree/autouser`) containing the set-up files (e.g., FMR.autosys.csh.g0sp06).
   - The particular path to be typed may vary from site to site.

6 Type `source AUTOSYSINSTANCE.autosys.csh.hostname` then press Return/Enter.
   - The `source` command sets the environment variables.

7 Type `autorep -J ALL` unless the command needs to be modified in one of the following ways:
   - To specify a particular job, type the job name instead of **ALL**.
• To obtain a machine report, type -M machine_name after either ALL or the job name.

• To obtain a summary report, type -s after either ALL or the job name.

• To obtain a detailed report, type -d after either ALL or the job name.

• To obtain a query report, type -q after either ALL or the job name.

• To display the document one page at a time, type either | pg or | more after typing the code for whichever of the preceding options are desired.

• To print the document, type | lp after typing the code for whichever of the preceding options are desired.

• To save the report in a file, type > /path/filename after either ALL or the job name.

8 Press the Return/Enter key on the keyboard to obtain access to the Job Activity Report.

• The Job Activity Report (Figure 79) is displayed.

• If | lp was typed on the command line, the Job Activity Report is printed.

• If > /path/filename was typed on the command line, the Job Activity Report has been saved under the specified filename.

9 Review the Job Activity Report to determine job states.

• Completed.

• Currently running.

• In the AutoSys queue.

Reviewing a Job Dependency Report

The Production Monitor reviews a job dependency report using the AutoSys job_depends command. The job_depends command reports information about the dependencies and conditions of jobs. The command can be used for determining the current state of a job, its job dependencies, the dependencies and nested hierarchies (for boxes) as specified in the job definition, and a forecast of what jobs will run during a given period of time.

The procedure starts with the assumption that the Production Monitor has logged in to the system.

Reviewing a Job Dependency Report
1 Set up AutoSys as described in Steps 1 through 8 of the procedure for Reviewing a Job Activity Report.

2 Type `job_depends -c -J ALL` unless the command needs to be modified in one of the following ways:
   - To specify a particular job, type the job name instead of ALL.
   - To obtain the current condition status, type `-c` before `-J`.
   - To obtain the dependencies only, type `-d` before `-J`.
   - To obtain the time dependencies, type `-t` before `-J`.
   - To display the document one page at a time, type either `| pg` or `| more` after typing the code for whichever of the preceding options are desired.
   - To print the document, type `| lp` after typing the code for whichever of the preceding options are desired.
   - To save the report in a file, type `>` `/path/filename` after either ALL or the job name.

3 Press the Return/Enter key on the keyboard to obtain access to the Job Dependency Report.
   - The Job Dependency Report (Figure 80) is displayed.
   - If `| lp` was typed on the command line, the Job Dependency Report is printed.
   - If `>` `/path/filename` was typed on the command line, the Job Dependency Report has been saved under the specified filename.

4 Review the Job Dependency Report to determine job status, including the status of atomic conditions.
Figure 80. Sample Job Dependency Report
This page intentionally left blank.
Defining Monitors/Browsers

The current edition of the *Release 6A Operations Tools Manual for the ECS Project* (609-CD-600-001) indicates that ECS does not support the AutoSys monitor/browser capabilities. However, they are functional and the Production Monitor can use them (with no expectation of ECS support if problems are encountered).

Although some Production Monitors may wish to monitor all events, it is more likely that they will prefer to limit monitoring to alarms and changes of job status (e.g., from “running” to “success” or “failure”). The browser function (Figure 81) is particularly useful for determining the eventual status of jobs run during the preceding shift or day; for example, which jobs were successful, which jobs failed, and which jobs are still running.

![Sample Browser Screen](image)

*Figure 81. Sample Browser Screen*
The procedure for defining monitors or browsers starts with the assumption that all applicable servers are currently running, AutoSys has been launched, and the **AutoSys GUI Control Panel** (Figure 52) is being displayed.

**Defining Monitors/Browsers**

1. Click on the **Monitor/Browser** button on the **AutoSys GUI Control Panel**.
   - The **Monitor/Browser** GUI (Figure 82) is displayed.

![Figure 82. Monitor/Browser GUI](image)
2 Type a name for the monitor or browser in the **Name** field near the top of the GUI.
   - Name must be in valid file-name format.
   - If a pre-defined monitor or browser is desired, use the **Search** button under the **Name** field to call it up.

3 Click on either the **Alarms** button or the **ALL EVENTS** button for **Types of Events**.

4 Click on either **ALL Job Status Events** or the corresponding toggle button(s) to select individual **Job Status Events**.
   - Any or all of the following **Job Status Events** can be selected:
     - **Running**.
     - **Success**.
     - **Failure**.
     - **Terminated**.
     - **Starting**.
     - **ReStarting**.
     - **On Ice**.
     - **On Hold**.

5 Click on the corresponding toggle button to select the desired **Job Selection Criteria**.
   - Job selection criteria options are as follows:
     - **All Jobs**.
     - **Box with its Jobs**.
     - **Single Job**.

6 If **Single Job** was selected in the previous step, type the job name in the **Job Name** field.

7 Click on the corresponding toggle button to select the desired **Monitor Options**.
   - **Monitor Options** refers to one of the following choices:
     - **Sound**.
     - **Verification Required for Alarms**.

8 Click on **Yes** or **No** to select the desired **Current Run Time** and/or **Events After Date/Time**, which are the **Browser Time Criteria**.

9 If **Events After Date/Time** was selected in the previous step, type the starting date and time (in **MM/DD/YY hh:mm** formats) in the **Events After Date/Time** field.
10 Click on the corresponding toggle button to select the desired **Mode**.
   - The following options are available:
     - **Monitor**.
     - **Browser**.
   - If **Monitor** is selected, settings are defined for a monitor.
   - If **Browser** is selected, settings are defined for a report.

11 Click on the **Save** button.
   - The monitor or browser definition is saved to the database.
   - Before running a monitor or browser you must **Save** the monitor/browser definition first.

12 Click on the **Run MonBro** button to run the monitor/browser that has just been defined.

13 Review the monitor/browser results.

14 To exit from a browser or monitor type **Ctrl-C** in the monitor/browser window.

---

**Running Monitors/Browsers**

There are two procedures for running monitors/browsers. Monitors/browsers may be run from the **Monitor/Browser** GUI or they may be run using UNIX commands. In either case, the procedure starts with the assumption that the Production Monitor has logged in to the system.

**Running Monitors/Browsers from the Monitor/Browser GUI**

1. Click on the **Monitor/Browser** button on the **AutoSys GUI Control Panel**.
   - The **Monitor/Browser** GUI (Figure 82) is displayed.
2. If the name of the monitor or browser is known exactly, type the name in the **Name** field.
   - Go to Step 6.
3. If the name of the monitor or browser is **not** known exactly, type % (percent sign wildcard) in the **Name** field.
4. Click on the **Search** button.
5. Double-click on the name of the monitor/browser in the list displayed in the dialogue box to retrieve the desired monitor/browser definition.
6. Click on the **Run MonBro** button.
   - Monitor/browser is displayed in a separate window.
Click on the Exit button to exit from the **Monitor/Browser** GUI.

Review the monitor/browser results.

To exit from the browser or monitor type **Ctrl-C** in the browser/monitor window.

---

**Running Monitors/Browsers Using UNIX Commands**

1. Set up **AutoSys** as described in Steps 1 through 8 of the procedure for **Reviewing a Job Activity Report**.

2. Type `monbro -N name &` then press the **Return/Enter** key on the keyboard to run the previously defined monitor/browser.
   - The monitor or report (browser) must have been previously defined and saved under an appropriate file `name` using the **Monitor/Browser** GUI.
   - The report is displayed.
   - Refer to the *AutoSys User Manual* for all options and displays for all **monbro** reports.

3. Review the monitor/browser results.

4. To exit from the browser or monitor type **Ctrl-C**.
This page intentionally left blank.
Changing the Database Maintenance Time

Database Maintenance Time

Once a day the Event Processor (also known as the AutoSys daemon) goes into an internal database maintenance cycle. During this time, it does not process any events and it waits for the maintenance activities to be completed before resuming normal operations. The time of day for start-up of the maintenance cycle is pre-set to 3:30 AM. The database maintenance cycle takes approximately one minute. If it is necessary to change the time when the maintenance cycle occurs, whoever has “write” access to the configuration file can reset it, preferably to a time when there is minimal activity.

The procedure for changing the database maintenance time starts with the assumption that the Production Monitor has logged in to the system.

Changing the Database Maintenance Time

NOTE: Commands in Steps 1 through 6 are typed at a UNIX system prompt.

1. Type `setenv DISPLAY clientname:0.0` then press the Return/Enter key.
   - Use either the X terminal/workstation IP address or the machine-name for the clientname.
   - When using secure shell, the DISPLAY variable is set just once, before logging in to remote hosts. If it were to be reset after logging in to a remote host, the security features would be compromised.

2. Start the log-in to the Queuing Server host by typing `/tools/bin/ssh hostname` (e.g., `e0sps04`, `g0sps06`, or `l0sps03`) in the new window then press the Return/Enter key.
   - If you receive the message, Host key not found from the list of known hosts. Are you sure you want to continue connecting (yes/no)? type yes (“y” alone will not work).
   - If you have previously set up a secure shell passphrase and executed sshremote, a prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with Step 3.
   - If you have not previously set up a secure shell passphrase; go to Step 4.

3. If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your Passphrase then press the Return/Enter key.
   - Go to Step 5.
4  At the <user@remotehost>’s password: prompt type your Password then press the Return/Enter key.

5  Type cd /path then press Return/Enter.

   •  Change directory to the directory (e.g., /usr/ecs/MODE/COTS/autotreeb/autouer, /usr/ecs/MODE/COTS/autotree/autouer, /data1/SHARED/COTS/autotree/autouer) containing the config.AUTOSYSINSTANCE file.

   •  The particular path to be typed may vary from site to site.

6  Type vi config.AUTOSYSINSTANCE then press Return/Enter.

   •  The configuration file is displayed by the vi text editor.

   •  Although this procedure has been written for the vi command, any UNIX editor can be used to edit the configuration file.

7  Using vi editor commands find DBMaintTime= and replace the existing time with the desired time in 24 hour format (hh:mm).

   •  The time may already have been changed to some value other than 03:30 (e.g., DBMaintTime=04:00).

   •  The following vi editor commands are useful:

     -  h (move cursor left).
     -  j (move cursor down).
     -  k (move cursor up).
     -  l (move cursor right).
     -  a (append text).
     -  i (insert text).
     -  x (delete a character).
     -  u (undo previous change).
     -  Esc (switch to command mode).

8  Press the Esc key.

9  Type ZZ.

   •  New database maintenance time is entered and saved in the configuration file.

   •  UNIX prompt is displayed.
Tuning System Parameters

Tuning System Configuration Parameters

The values assigned to system parameters affect the functioning and performance of the system. When certain parameters are modified, the system operates differently. Changes to some other parameters may not appear to affect the system although there may in fact be subtle effects. In any case before system parameters are modified it is essential to understand what will happen to system functioning and performance.

Many system parameters may be subject to control by Configuration Management (CM). When making or requesting a change to system parameters, the CM process at the particular site must be followed (if applicable).

Values are assigned to Data Processing Subsystem and Planning Subsystem parameters in the following databases:

- PDPS database.
- Configuration Registry database.

The Configuration Registry Server provides a single interface (via a Sybase server) for retrieving configuration attribute-value pairs for ECS servers from the Configuration Registry database. When ECS servers are started, they access the Configuration Registry Database to obtain needed configuration parameters.

The Database Administrator has access to a Configuration Registry GUI for viewing and editing configuration data in the database. Therefore, it is necessary to coordinate with the Database Administrator when changes to configuration parameters are needed. Also, as previously mentioned, changes to configuration-controlled parameters are subject to approval through the site CM process.

Default and adjusted values assigned to system parameters vary from site to site. For guidance concerning the assignment of values to parameters included in the Configuration Registry refer to document 910-TDA-022 rev2, Custom Configuration Parameters for ECS Release 6A. The document is available at [http://cmdm.east.hitc.com/baseline/](http://cmdm.east.hitc.com/baseline/) under “Technical Documents.”

The following parameters are examples of parameters whose values may be modified to enhance system functioning or performance:

- **AppLogSize**
  - Maximum size of the application log (ALOG) file for a particular application.

- **AppLogLevel**
  - Level of detail provided in the ALOG file for a particular application.
• **DebugLevel**
  – Level of detail provided in the debug log file for a particular application.

• **DpPr_MAX_RETRIES**
  – Number of retries to the Science Data Server for acquires/inserts before giving up.

• **DpPr_WAIT_PERIOD**
  – Time (in seconds) to wait between retries to the Science Data Server.

• **ListenThreads**
  – Number of listen threads assigned to a particular application.

• **DpPrRM_MAX_RETRIES**
  – Number of retries when creating a Data Manager object (trying to allocate).

• **DpPrRM_RETRY_PERIOD**
  – Amount of time (in seconds) between retries when creating a Data Manager object (trying to allocate).

• **DpPrMaxConcurrentDPRs**
  – Maximum allowed jobs.
  
  – Three integer values are assigned to DpPrMaxConcurrentDPRs; the first for routine processing; the second for on-demand processing; and the third for reprocessing jobs.

• **DpPrMinConcurrentDPRs**
  – Minimum allowed jobs.
  
  – Three integer values are assigned to DpPrMaxConcurrentDPRs; the first for routine processing; the second for on-demand processing; and the third for reprocessing jobs.

• **DpPrAutoSysMaxDPRs**
  – Total number of completed jobs allowed in AutoSys.

• **MaxSlippagePerc**
  – Percentage by which a granule can slip and still be considered a match.

• **AcceptableCertainty**
  – Minimum overlap a granule must have.
• **DBConnections**
  - Number of connections needed by a particular application. Subscription Manager maintains only one connection to the database.

• **SleepDelayForFailures**
  - Amount of time (in seconds) to wait before reprocessing failed notifications. If the specified value is less than 60, a default value of 60 seconds would be assumed.

• **SleepDelayForTimers**
  - Amount of time (in seconds) the Subscription Manager should sleep between checking for expired timers. It should be set to the minimum amount of time a timer will be set for at this DAAC. The minimum it can be set to is 60 seconds.

When the value assigned to a parameter has been changed and saved in the Configuration Registry, the modified value does not take effect until the affected server has been restarted. For example, if the debug level for the Subscription Manager log has been changed from “2” to “3” in the Configuration Registry, the modification does not affect the recording of data in the log until after a warm restart of the Subscription Manager (at which time the server would read the parameters in the Configuration Registry).

**Monitoring the Load on Processing Resources**

The Production Planner and Production Monitor should work with the Resource Planner to make optimum use of processing resources. The Resource Planner allocates the disk partitions, CPUs, and RAM available for processing among the active modes (e.g., OPS, TS1, TS2). The Production Planner and Production Monitor monitor the load on the processing resources.

The Resource Planner assigns the bulk (typically 60% - 80%) of the processing resources to the OPS mode. The remainder of the processing assets are divided among the modes used for SSI&T and new version software checkout.

The Production Planner and Production Monitor monitor the load on the processing resources to identify whether the actual load is appropriately distributed among modes. They inform the Resource Planner of under- or over-use of resources as allocated.

When monitoring the load on the processing resources, the Production Planner and Production Monitor should take the following considerations into account:

• Disk space allocated to OPS mode is likely to be used to capacity.

• Disk space assigned to the other two modes may not fill up.

• There is no one-to-one mapping of CPU allocation with actual CPUs on the science processor.
• The operating system (OS) takes care of true CPU and RAM allocation.
  – Actual CPU usage during processing is limited by the OS.
  – If ten CPUs have been specified for a particular mode, only ten Data Processing Requests (DPRs) can be running the Execute job at a given time.
  – What is really being defined is the maximum number of DPRs that will execute at a given time.

• CPUs can be over-allocated or under-allocated as necessary to get the most out of the CPUs on each science processor.

• If monitoring indicates that the processor is underused when OPS mode is at full processing capacity, the number of CPUs allocated to OPS mode could probably be increased.

• If the science processor is at full capacity when OPS mode is at full processing capacity (and the processor may be overworked) the number of CPUs allocated to OPS mode should be reduced.

• Random-access memory (RAM) is subject to the same considerations as CPUs.
  – RAM can be over-allocated or under-allocated as necessary to get the most out of the memory on each science processor.
Troubleshooting Processing Problems

Trouble Symptoms

Troubleshooting is a process of identifying the source of problems on the basis of observed trouble symptoms. One common source of problems involves connections with other subsystems for the transmission of messages or data. Like many other operational areas in ECS, processing has interfaces with many other subsystems. Consequently, problems with processing can be traced to either the Data Processing Subsystem or one of many other ECS subsystems, including (but not necessarily limited to) those in the following list:

- Planning Subsystem (PLS).
- Data Server Subsystem (DSS).
- Interoperability Subsystem (IOS).
- Communications Subsystem (CSS).

Table 10 describes actions to be taken in response to some common Processing problems. If the problem cannot be identified and fixed without help within a reasonable period of time, the appropriate response is to call the help desk and submit a trouble ticket in accordance with site Problem Management policy.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to log in to the Queuing Server host (e.g., g0sp06).</td>
<td>Check with the Operations Controller/System Administrator to ensure that the host is &quot;up.&quot;</td>
</tr>
<tr>
<td>GUI not displayed when the start-up script has been properly invoked.</td>
<td>Ensure that the DISPLAY variable was set properly. [For detailed instructions refer to the procedure for Launching the AutoSys GUI Control Panel (previous section of this lesson).]</td>
</tr>
<tr>
<td>Entire processing system hangs (no jobs change state over time ).</td>
<td>Refer to the procedure for Responding to Hanging of the Processing System (subsequent section of this lesson).</td>
</tr>
<tr>
<td>Jobs are activated but do not get started in AutoSys.</td>
<td>Refer to the procedure for Responding to Failure of Jobs to Start in AutoSys (subsequent section of this lesson).</td>
</tr>
<tr>
<td>AutoSys box job hangs (does not change state over time).</td>
<td>Refer to the procedure for Handling a Box Job that is Hanging in AutoSys (subsequent section of this lesson).</td>
</tr>
<tr>
<td>“Preprocess” function fails (job either does not change state over time or has turned red on JobScape or TimeScape).</td>
<td>Refer to the procedure for Handling a Hanging or Failed Preprocessing Job (subsequent section of this lesson).</td>
</tr>
<tr>
<td>Symptom</td>
<td>Response</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>“Execute” job hangs (job has turned orange or oscillates between orange and green on JobScape or TimeScape).</td>
<td>Refer to the procedure for <strong>Handling a Hanging Execution Job</strong> (subsequent section of this lesson).</td>
</tr>
<tr>
<td>“Execute” job fails (job has turned red on JobScape or TimeScape).</td>
<td>Refer to the procedure for <strong>Handling a Failed Execution Job</strong> (subsequent section of this lesson).</td>
</tr>
<tr>
<td>“Postprocess” job fails (job has turned red on JobScape or TimeScape).</td>
<td>Refer to the procedure for <strong>Handling a Failed Postprocessing Job</strong> (subsequent section of this lesson).</td>
</tr>
<tr>
<td>Both the “Execute” and “Postprocess” jobs fail (jobs have both turned red on JobScape or TimeScape).</td>
<td>Refer to the procedure for <strong>Handling Failure of Both Execution and Postprocessing Jobs</strong> (subsequent section of this lesson).</td>
</tr>
<tr>
<td>On-Demand Processing Request fails.</td>
<td>Refer to the procedure for <strong>Handling a Failed On-Demand Processing Request</strong> (subsequent section of this lesson).</td>
</tr>
<tr>
<td>Other problems.</td>
<td>Check the log files (e.g., EcDpPrJobMgmt.ALOG, EcDpPrJobMgmt.Debug.log, EcDpPrDeletion.ALOG, DPR#.ALOG, DPR#.err, etc.) in the /usr/ecs/MODE/CUSTOM/logs directory for error messages. [For detailed instructions refer to the procedure for <strong>Checking Log Files</strong> (subsequent section of this lesson).]</td>
</tr>
</tbody>
</table>

**Table 10. Troubleshooting Processing Problems**
### Table 11. Hosts, Servers, Clients and Other Software Relevant to ECS Data Processing Phases

<table>
<thead>
<tr>
<th>HOST</th>
<th>SERVER/CLIENT/OTHER SOFTWARE</th>
<th>PROCESSING PHASE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>PRE-PROCESS</td>
</tr>
<tr>
<td></td>
<td>NOTE: Depending on the installation, software may be loaded on hosts other than the examples provided.</td>
<td></td>
</tr>
<tr>
<td>Science Processor (e.g., x0spg01)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>PGE Management (EcDpPrRunPGE)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Resource Usage (EcDpPrUsage)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>PGE</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Queuing Server (e.g., x0sp04)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Job Management Server (EcDpPrJobMgmt)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Deletion Server (EcDpPrDeletion)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Data Management (EcDpPrDM)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Execution Management (EcDpPrEM)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>AutoSys Event Processor (event_demon)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>AutoSys Event Server (Sybase server) (e.g., x0sp03_svr)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>On-Demand Manager (EcPIOdMgr)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>PDPS DBMS Server</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subcription Manager (EcDpPISubMgr)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sybase server (e.g., x0pls01_svr)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Distribution Server (e.g., x0dis02)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Distribution Server (EcDsDistributionServer)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>SDSRV Server (e.g., x0acs05)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Science Data Server (EcDsScienceDataServer)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>APC Server (e.g., x0acg01)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Archive Server (EcDsStArchiveServer)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>FTP Distribution Server (EcDsStFtpDisServer)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Staging Monitor Server (EcDsStStagingMonitorServer)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Staging Disk Server (EcDsStStagingDiskServer)</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Pull Monitor Server (EcDsStPullMonitorServer)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 11. Hosts, Servers, Clients and Other Software Relevant to ECS Data Processing Phases

<table>
<thead>
<tr>
<th>HOST</th>
<th>PROCESSING PHASE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PRE-PROCESS</td>
</tr>
<tr>
<td><strong>NOTE:</strong> Depending on the installation, software may be loaded on hosts other than the examples provided.</td>
<td></td>
</tr>
<tr>
<td>Ingest Server (e.g., x0icg01)</td>
<td></td>
</tr>
<tr>
<td>Registry Server (EcCsRegistry)</td>
<td></td>
</tr>
<tr>
<td>Interface Server 01 (e.g., x0ins02)</td>
<td>X</td>
</tr>
<tr>
<td>Advertising Server (EcoAdServer)</td>
<td>X</td>
</tr>
<tr>
<td>Interface Server 02 (e.g., x0ins01)</td>
<td>X</td>
</tr>
<tr>
<td>Subscription Server (EcSbSubServer)</td>
<td>X</td>
</tr>
<tr>
<td>Event Server (EcSbEventServer)</td>
<td></td>
</tr>
<tr>
<td>Data Dictionary (EcDmDictServer)</td>
<td></td>
</tr>
</tbody>
</table>

Processing Problems

This section contains information concerning the following processing problems:

- The entire processing system is hanging
- Jobs are activated, but do not get started in AutoSys.
- Single job has failed or is hanging.
- An On-Demand Processing Request fails.

Responding to Hanging of the Processing System

If the entire processing system is hanging (if no jobs are changing state), it is probably due to one of the following conditions:

- AutoSys is not functional (e.g., the AutoSys event processor is not running).
- Database is deadlocked (preceding section of this lesson).

Checking AutoSys Status

Like any other program AutoSys can crash or experience connectivity problems between its server and its clients.
The procedure for checking AutoSys status starts with the assumption that the applicable servers are running and the Production Monitor has logged in to the ECS system and the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03).

**Checking AutoSys Status**

1. If the AutoSys .csh file has not already been sourced, type `cd /path` then press Return/Enter.
   - Change directory to the directory (e.g., `/usr/ecs/MODE/COTS/autotreeb/autouser, /usr/ecs/MODE/COTS/autotreeb/autouser, /data1/SHARED/COTS/autotreeb/autouser`) containing the set-up files (e.g., `FMR.autosys.csh.x0sps02`).
   - The particular path to be typed may vary from site to site.

2. Type `source AUTOSYSINSTANCE.autosys.csh.hostname` then press Return/Enter.
   - An `AUTOSYSINSTANCE` (also called an AUTOSERV instance) is installed as part of the Data Processing Subsystem and is identified by three capital letters.
     - AutoSys instances at the DAACs are typically identified as `FMR`.
   - It is possible that multiple AutoSys instances could be installed at a DAAC.

3. Type `chk_auto_up` then press Return/Enter.
   - The following type of message is displayed:

```
Attempting (1) to Connect with Database: x0sps02_srvr:FMR
*** Have Connected successfully with Database: x0sps02_srvr:FMR. ***
Connected with Event Server: x0sps02_srvr:FMR
Checking Machine: x0sps02
Primary Event Processor is RUNNING on machine: x0sps02
Checking Machine: x0pls02
No Event Processor is RUNNING on machine: x0pls02
```
In the example the statement “**Primary Event Processor is RUNNING on machine: x0sps02**” indicates that the Primary Event Processor is running on the Queuing Server (as it should).

If the Primary Event Processor is not running, notify the Operations Controller/System Administrator to have the server brought back up.

If the Primary Event Processor does not stay up (AutoSys administrator brings it up and it goes down right away) one of the following problems may be occurring:

- It may be possible that too many events were queued up to AutoSys while it was down. If AutoSys detects a certain number of events in a short time period, it brings itself down. The only way to handle this is to keep bringing AutoSys back up. Each time it will work through a few of the events before it detects "too many" and shuts down. Eventually the events will be cleared out and AutoSys will stay up.

- It may be that the Sybase ASE server for AutoSys (the Event Server) is not up.

If the Event Processor is running, check for database-related error messages in the AutoSys log as described in the procedure for **Checking the AutoSys Log** (subsequent section of this lesson) or when attempting to bring up the JobScape GUI.

For example:

```
Couldn't create DBPROCES
Unable to get encoded and plaintext passwords for x0sps02_srvr:FMR
```

The error messages in the example indicate that the AutoSys Event Server (database server) may not be up.

Type `ps –ef | grep sybase` then press Return/Enter.

The following type of message is displayed:

```
sybase 265 264 3 Apr 04 ? 620:51
/usr/ecs/OPS/COTS/sybase/bin/dataserver -d/dev/rdsk/c0t2d0s4 -sx0sps02_srvr -e/
sybase 270 269 0 Apr 04 ? 0:05
/usr/ecs/OPS/COTS/sybase/bin/backupserver –Sx0sps02_backup_srvr -e/usr/ecs/OPS/
```
In the example the entry that includes “/usr/ecs/OPS/COTS/sybase/bin/dataserver -d/dev/rdsk/c0t2d0s4 –sx0sps02_srvr -e/” indicates that the AutoSys Event Server (database server) is running.

If the AutoSys Event Server (database server) were not running, the following type of message would be displayed:

cmts1 25260 23874 0 09:31:45 pts/12 0:00 grep sybase

If the AutoSys Event Server (database server) is not running, notify the Operations Controller/System Administrator to have the server brought back up.

If the AutoSys Event Processor and Event Server are running, launch the AutoSys HostScape GUI.

HostScape indicates whether AutoSys processors are connected and communicating.

Verify that all computers on which AutoSys is running (both the Queuing Server and the Science Processor(s)) are up (e.g., have green borders).

Refer to the procedure for Reviewing Hardware Status (previous section of this lesson).

Verify that one (and only one) Event Processor is running.

If there is a host down, no Event Processor running, or multiple Event Processors running, notify the Operations Controller/System Administrator to have the host/server problem corrected.

If one (or more) Science Processor(s) has (have) a red Alarm box, click on an Alarm box.

The Alarm Manager GUI (Figure 66) is displayed.

Observe the AutoSys Alarm log that is displayed.

Refer to the procedure for Reviewing Alarms (previous section of this lesson).

The Alarm Manager may indicate a missing file or a permission problem with starting the job.

If the review of alarms indicates a problem, correct the problem.
If a Science Processor was rebooted while jobs were running, type `chase` at the UNIX prompt then press Return/Enter.

- The AutoSys `chase` command verifies and corrects the AutoSys database.

## Checking the AutoSys Log

The AutoSys event demon log tells how a DPR has progressed through AutoSys, showing failures and force-starts of jobs.

The procedure that follows describes the use of the UNIX `grep` command on the DPR Id in the event demon log file. An alternative is to use the `vi` command to view the full log, which contains timestamps. Another alternative is to request either a Summary Report or an Event Report from the Job Activity Console (Ops Console) as described in the procedure for Reviewing Job Activities (previous section of this lesson).

The procedure for checking the AutoSys event demon log starts with the assumption that the applicable servers are running and the Production Monitor has logged in to the Queuing Server (e.g., e0sp04, g0sp06, or l0sp03).

### Checking the AutoSys Log

1. Type `cd /path` then press Return/Enter.
   - Change directory to the directory (e.g., `/usr/ecs/MODE/COTS/autotreeb/autouser/out`, `/usr/ecs/MODE/COTS/autotree/autouser/out`, `/data1/SHARED/COTS/autotree/autouser/out`) containing the event demon log file (e.g., `event_demon.FMR`).
   - The AutoSys event demon log is named `event_demon.Autosys_Instance`.
     - The AutoSys Instance at the DAACs is typically `FMR`.
   - The particular path to be typed may vary from site to site.

2. Type `grep jobname event_demon.Autosys_Instance` then press Return/Enter.
   - If there were no problems, the results should appear as follows:

```
EVENT: STARTJOB     JOB: MoPGE02#2014193500OPS
EVENT: CHANGE_STATUS STATUS: RUNNING     JOB: MoPGE02#2014193500OPS
EVENT: CHANGE_STATUS STATUS: STARTING     JOB: MoPGE02#2014193500OPSR
EVENT: CHANGE_STATUS STATUS: RUNNING     JOB: MoPGE02#2014193500OPSR
```
• When there are no problems, each command job goes through the following changes of status: STARTING, RUNNING, SUCCESS.

• If there are problems, something similar to the following results may be obtained:

```
grep MoPGE02#2014193500OPS event_demon.FMR
```

```
EVENT: STARTJOB  JOB: MoPGE02#2014193500OPS
EVENT: CHANGE_STATUS  STATUS: RUNNING  JOB: MoPGE02#2014193500OPS
EVENT: CHANGE_STATUS  STATUS: STARTING  JOB: MoPGE02#2014193500PSR
EVENT: CHANGE_STATUS  STATUS: RUNNING  JOB: MoPGE02#2014193500PSR
EVENT: CHANGE_STATUS  STATUS: FAILURE  JOB: MoPGE02#2014193500PSR
EVENT: ALARM  ALARM: JOBFailure  JOB: MoPGE02#2014193500PSR
EVENT: FORCE_STARTJOB  JOB: MoPGE02#2014193500PSR
EVENT: CHANGE_STATUS  STATUS: STARTING  JOB: MoPGE02#2014193500PSR
EVENT: CHANGE_STATUS  STATUS: RUNNING  JOB: MoPGE02#2014193500PSR
EVENT: CHANGE_STATUS  STATUS: SUCCESS  JOB: MoPGE02#2014193500PSR
......
```

• The preceding job had some failures and a force-start.

3 If the AutoSys event log does not indicate any problems, perform the procedure for Checking for Database Deadlocks (preceding section of this lesson).
Responding to Failure of Jobs to Start in AutoSys

Subscriptions are processed and cause jobs to be released into AutoSys by means of the following process:

- An ESDT is "registered" to the Science Data Server (SDSRV). The ESDT information includes three events (insert, delete, and update metadata) and a datatype. It is possible to enter a subscription for any of the events.

- SDSRV sends information concerning the "subscribable events" to the Advertising Server (IOADV).

- The Production Request Editor (PRE) gets the event IDs from IOADV for datatypes that are needed for processing and sends the event ID and the Subscription Manager (SubsMgr) name to the Subscription Server (SubsSrv) in order to get a subscription ID back. The event ID is not saved in the PDPS database. The subscription is saved in the subscriptionFlag column in the PlDataTypeMaster table in the PDPS database.

- When an “insert” event (or a “delete” event or an “update metadata” event) occurs, SDSRV sends notification to SubsSrv, which sends the Subscription ID to the PLS Subscription Manager. The Subscription Manager is identified by name in the SubsSrv database in connection with the Subscription ID.

- Subscription Manager gets the UR for the inserted granule from the SDSRV and updates the UR information in the PlDataGranule table in the PDPS database. In the simple case (e.g., for Production Requests that do not require optional inputs or alternate inputs) SubsMgr checks to see if all of the datatypes in PlDprData that have an ioFlag of 0 (input) for the DPR are present in the data archive and can be acquired. If this is the case, SubsMgr sends a ReleaseDprJob request to the Job Management Server to release the job into AutoSys.

Jobs that are activated may not get started in AutoSys for any of the following reasons:

- Job Management server is down.
- DPR is waiting in the AutoSys queue (never got released).
- DPR was released but failed due to an AutoSys ID failure.
- DPR was released but failed due to invalid DPR.
- DPR was released but was not received by the Job Management server.

Checking Job Management Server Status

The procedure for checking Job Management server status starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03).
Checking Job Management Server Status

1. Ensure (e.g., using ECS Assistant) that the Job Management Server (EcDpPrJobMgmt) is “up.”

2. If the server has gone down, notify the Operations Controller/System Administrator to have the server brought back up.

3. If the Job Management Server (EcDpPrJobMgmt) is “up,” continue with the procedure for Checking to Determine Whether the DPR Is Waiting in the AutoSys Queue (subsequent section of this lesson).

Checking to Determine Whether the DPR Is Waiting in the AutoSys Queue (Never Got Released)

The Job Management server may have never received a ReleaseDprJob command from the PLS Subscription Manager.

The procedure for checking to determine whether the DPR is waiting in the AutoSys queue starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03).

Checking to Determine Whether the DPR Is Waiting in the AutoSys Queue

1. Perform the procedure for Using ISQL to Check Database Tables (previous section of this lesson) or use a database browser to check for an entry for the job (by searching on the dprId column) in the DpPrCreationQueue table in the applicable PDPS database.

   - For example:

   ```
   x0sps02{cmshared}43: isql -UpdpsUsers -Sx0pls01_srvr
   Password:
   1> use pdps
   2> go
   1> select * from DpPrCreationQueue
   2> go
   dprId | autosysId | priority | hold
   ------------- | ------------- | -------- | ----
   ETS#syn1#014020000OPS | FMR | 250 | 1
   ETS#syn1#0140200100OPS | FMR | 250 | 1
   ETS#syn1#0140200200OPS | FMR | 250 | 1
   ETS#syn1#0140200300OPS | FMR | 250 | 1
   ETS#syn1#0140200400OPS | FMR | 250 | 1
   ```
If the job is listed in the **DpPrCreationQueue** table, it probably never got a ReleaseDprJob command from the PLS Subscription Manager (unless AutoSys is full). (Refer to the procedure for **Checking to Determine Whether AutoSys Is Full**, which is a subsequent section of this lesson.)

2 In the terminal window logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03) type `cd /usr/ecs/MODE/CUSTOM/logs` then press **Return/Enter**.

• Change directory to the directory containing the log files (e.g., EcDpPrJobMgmt.ALOG, EcDpPrDeletion.ALOG, **DPR#**.ALOG, **DPR#**.err, EcPlSubMgrDebug.log, EcDpPrJobMgmtDebug.log).

3 Type **pg EcDpPrJobMgmtDebug.log** then press **Return/Enter**.

• The first page of the log file is displayed.

• Although this procedure has been written for the **pg** command, any UNIX editor or visualizing command (e.g., **vi**, **view**, **more**) can be used to review the log file.

4 Review the Job Management debug log file for an entry indicating that Job Management received the ReleaseDprJob command for the job.

• For example:

```
03/30/00 11:38:09: ----------------------------------------------
DpPrScheduler_1_0_Mgr::ReleaseDprJob( dpr_id dpr ) CALLED.
ETS#syn1#004130123OPS
03/30/00 11:38:09: In DpPrScheduler::ReleaseDprJob, dpr=
ETS#syn1#004130123OPS
03/30/00 11:38:09: DpPrCreationQueue::SetDprHoldStatus, dprId=
ETS#syn1#004130123OPS
DpPrCreationQueue::SetDprHoldStatus, autoSysId= VAT
DpPrCreationQueue::SetDprHoldStatus, holdStatus= 0
03/30/00 11:38:09: DpPrCreationQueue::HasAutosysId, autosysId=
0xee4534d8
03/30/00 11:38:09: DpPrCreationQueue::HasAutosysId, autosysId=
0xee4534d8
03/30/00 11:38:09: removed ETS#syn1#004130123OPS
there are now 0entries on this queue
```
queue priority of this node is now 250

- If Job Management received the ReleaseDprJob command for the job, there may have been a JIL (AutoSys Job Information Language) processor problem. [Refer to Responding to a Condition Where a DPR Was Released But Failed Due to a JIL Failure (subsequent section of this lesson).]

- If there is no evidence that Job Management received the ReleaseDprJob command for the job, the PLS Subscription Manager did not send the command.
  - Subscription Manager does not send the ReleaseDprJob command unless it thinks that all of the DPR's required inputs have been received.

If the DPR is a regular one (e.g., with no alternate or optional inputs), perform the procedure for Using ISQL to Check Database Tables (previous section of this lesson) or use a database browser to check the PldprData table and find all of the granuleId column entries with an ioFlag column entry of 0 (an input granule) for the DPR (dprId column).

- For example:

```bash
x0sps02{cmshared}43: isql -UpdpsUsers -Sx0pls01_srvr
Password:
1> use pdps
2> go
1> select dprId,granuleId,ioFlag from PldprData where dprId like "ETS#syn1#004130123OPS"
2> go

<table>
<thead>
<tr>
<th>dprId</th>
<th>granuleId</th>
<th>ioFlag</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETS#syn1#004130123OPS</td>
<td>AST_05#00102141998020120000</td>
<td>1</td>
</tr>
<tr>
<td>ETS#syn1#004130123OPS</td>
<td>AST_08#00102141998020120000</td>
<td>1</td>
</tr>
<tr>
<td>ETS#syn1#004130123OPS</td>
<td>AST_09T#00102141998020120000</td>
<td>0</td>
</tr>
<tr>
<td>ETS#syn1#004130123OPS</td>
<td>AST_ANC#001L1004</td>
<td></td>
</tr>
</tbody>
</table>
```

361 625-CD-606-001
In the preceding example there are four granuleId column entries for the DPR (ETS#syn1#004130123OPS); two have an ioFlag column entry of 0 (an input granule) and two have an ioFlag column entry of 1 (output granule).

In the PlDataGranule table observe the universalReference column for each applicable granuleId.

- If all of the input granules have URs (as opposed to granuleId), the Subscription Manager should have sent a ReleaseDprJob command to Job Management.

- To check the preceding example observe the entries for the following granuleId:
  - AST_09T#00102141998020120000
  - AST_ANC#001L1004

- For example:

  1> select universalReference from PlDataGranule where granuleId like "AST_09T#00102141998020120000"
  2> go

  universalReference
  ----------------------------------------------------------------------------------------------------------------------------------------------------------------
  ----------------------------------------------------------------------------------------------------------------------------------------------------------------
  ----------------------------------------------------------------------------------------------------------------------------------------------------------------
  ----------------------------------------------------------------------------------------------------------------------------------------------------------------


  (1 row affected)

- In the example there is a universalReference for the granuleId. The same search should be performed for the other granuleId.
Perform the procedure for **Checking Log Files** (subsequent section of this lesson) to search the Subscription Manager debug log file (EcPlSubMgrDebug.log) for an entry indicating that Subscription Manager sent the ReleaseDprJob command for the job to Job Management.

- Subscription Manager log files are on the PDPS DBMS Server (e.g., e0pls02, g0pls02, or l0pls01).
- For example:

  ```
  DpPrSchedulerProxy::ReleaseDprJob :
  ETS#syn1#004130123OPS
  03/30/00 11:37:07: Destroying DpPrSchedulerProxy object
  ```

Search the Subscription Manager debug log file for subscription notification from the Subscription Server concerning dynamic data that the DPR needs.

- For example:

  ```
  03/30/00 11:36:58: ******* Begining of PlSubMsgCb::HandleCbMsg() *******
  03/30/00 11:36:58: Entire message = Subscription Notification::
  .001:5478
  ESDT Information: AST_09T.001:INSERT
  User Information: SubsMgr
  EventID: 805
  Subscription ID: 82
 Qualifier List:
  .001:5478 AsterGranule 03/30/2000 16:36:27 Day This is a quality flag Passed 30 20 GuruTej 1 AST_09T
  .001:5400
  .001:5369 (((90.0000, -180.0000), (90.0000, 180.0000), (-90.0000, 180.0000), (-90.0000, -180.0000)) 13:01:23.000000Z 07/04/1997 1.0
  ```
• The preceding example shows subscription notification for a granule of AST_09T (input for ETS) that has been inserted into the archive.

7 If there is no Subscription Server notification to Subscription Manager or if you believe that all of the necessary input files for the DPR have been inserted by another DPR, there may be Subscription Server problems. [Refer to the procedure for Handling Subscription Server Problems (subsequent section of this lesson).]

8 If there are no Subscription Server Problems, all of the input granules for the DPR have URs, and/or Subscription Manager received notification for all dynamic granules, notify the Operations Controller/System Administrator that there may be a problem with the Subscription Manager.

---

### Checking to Determine Whether AutoSys Is Full

This is an unlikely problem and would occur only under the following conditions:

- The number of job boxes in AutoSys is equal to the maximum number of jobs.
- The DPR completionState in the PlDataProcessingRequest database table is CQ_RELEASE.

The procedure for checking to determine whether AutoSys is full starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03) and started the **AutoSys GUI Control Panel** and the **JobScape** GUI.

---

#### Checking to Determine Whether AutoSys Is Full

1. Submit a request to the Database Administrator to identify the value assigned to the DpPrAutoSysMaxJobs parameter (for EcDpPrJobMgmt) in the Configuration Registry.

   - For example:
     
     ```
     DpPrAutoSysMaxJobs = 240
     ```

2. Divide the value assigned to the DpPrAutoSysMaxJobs parameter by four (4) to determine the maximum number of box jobs in AutoSys.

   - For example, if the value assigned to DpPrAutoSysMaxJobs in the Configuration Registry is 240, that value divided by four (4) would be 60.

3. Count the number of job boxes active in AutoSys as displayed on the **JobScape** GUI.
If the number of job boxes active in AutoSys is equal to the maximum number of box jobs in AutoSys, there is probably no problem.

- The job is probably just waiting its turn in the AutoSys queue.

Perform the procedure for "Using ISQL to Check Database Tables" (previous section of this lesson) or use a database browser to determine the value in the completionState column for the job (by searching on the dprId column) in the PiDataProcessingRequest table in the applicable PDPS database.

- For example:

```
x0ps02(cmshared)43: isql -UpdpsUsers -Sx0pls01_srvr
Password:
1> use pdps
2> go
1> select dprId,completionState from PiDataProcessingRequest where dprId like "ETS#syn1#014020000OPS"
2> go
dprId completionState
----------------------------- ---------------
ETS#syn1#014020000OPS CQ_HOLD
```

(1 row affected)

If the value in the completionState column for the DPR in the PDPS database PiDataProcessingRequest table is "CQ_RELEASE" wait for a DPR to finish, so that the next waiting one can be put into AutoSys.

- The Job Management server got the command from Subscription Manager to release the job but AutoSys cannot accommodate any more jobs at present.

If the value in the completionState column for the DPR in the PDPS database PiDataProcessingRequest table is "JIL_FAILUR," go to the procedure for Responding to a Condition Where a DPR Was Released But Failed Due to a JIL Failure.

---

**Responding to a Condition Where a DPR Was Released But Failed Due to a JIL Failure**

A "JIL Failure" means that the Job Management Server had some problem placing the DPR in AutoSys. The Job Interface Language (JIL) processor rejected the “create job” command sent to it by the Job Management Server. The principal reasons for a JIL failure are as follows:

- There is already a job with an identical name in AutoSys.
The AutoSys event processor is down. (Refer to Checking the AutoSys Event Processor Status (preceding section of this lesson).)

The job had a problem when it was loaded into AutoSys and a malformed or mutant job box is the result.

The procedure for responding to a condition where a DPR was released but failed due to a JIL failure starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03) and started the AutoSys GUI Control Panel.

### Responding to a Condition Where a DPR Was Released But Failed Due to a JIL Failure

1. Check whether there is already a job with an identical name in AutoSys using the procedure for Reviewing Job Activities (preceding section of this lesson).

   - When specifying job selection criteria (refer to the procedure for Specifying Job Selection Criteria (preceding section of this lesson)) type a portion of the job name in the "Job Name" box, bracketed by the "*" or "%" wildcard character.

2. If there is a job with an identical name already in AutoSys, either request the Production Planner to delete it using the Production Request Editor or delete the job using the Job Management Client tool (refer to the procedure for Performing Job Management Client Functions (preceding section of this lesson)).

   - Jobs should not be deleted using the AutoSys Job Definition GUI because it does not communicate with the PDPS database.

3. If there is not a job with an identical name already in AutoSys, observe the characteristics of the job box in JobScape using the procedure for Reviewing DPR Dependencies (preceding section of this lesson).

   - If the job box is malformed or mutant, it will stay dark blue (meaning that it was not activated) and will be missing one of the seven job steps.

4. If the job box is malformed or mutant, in JobScape place the mouse cursor on the job and click and hold the right mouse button.

   - Pop-up menu appears.

5. If the job box is malformed or mutant, select (highlight) Job Definition from the pop-up menu (release the right mouse button).

   - The Job Definition GUI (Figure 74) is displayed.

6. If the job box is malformed or mutant, click on the Delete button.

**NOTE:** In general, it is bad practice to delete a job from AutoSys using the AutoSys Job Definition GUI because the AutoSys database and PDPS database lose their synchronization. However, there is no other solution in this case and the PDPS database must be updated manually.
To exit from the Job Definition GUI, click on the Exit button.

- The Job Definition GUI is dismissed.

Log in to the appropriate PDPS database as described in Steps 1 through 5 of the procedure for Using ISQL to Check Database Tables (previous section of this lesson).

Update the completionState of the DPR in the PlDataProcessingRequest table of the PDPS database for which the mutant job box was created.

- Set completionState equal to NULL using the update command.
- For example:

  1> update PlDataProcessingRequest set completionState="" where dprId like "MoPGE02#2014193500OPS"
  2> go

Request the Production Planner to delete (using the procedure for Deleting a Data Processing Request) the DPR that maps to the job then recreate the DPR and any subsequent DPRs.

- Only the DPR that had the mutant job box and any DPRs that depend on it have to be deleted. It may not necessary to delete entire production requests.

Handling Subscription Server Problems

Handling Subscription Server problems involves determining whether the Subscription Manager is getting notification from Subscription Server after a dynamic granule has been inserted.

The procedure for handling Subscription Server problems starts with the assumption that the Production Monitor has logged in to ECS.

Handling Subscription Server Problems

NOTE: Commands in Steps 1 through 4 are typed at a UNIX system prompt.

1. Type setenv DISPLAY clientname:0.0 then press the Return/Enter key.
   - Use either the X terminal/workstation IP address or the machine-name for the clientname.
   - When using secure shell, the DISPLAY variable is set just once, before logging in to remote hosts. If it were to be reset after logging in to a remote host, the security features would be compromised.
Start the log-in to the Subscription Server host by typing /tools/bin/ssh hostname then press the Return/Enter key.

- The Subscription Server is typically installed on Interface Server 02 (e.g., x0ins01).
- If you receive the message, Host key not found from the list of known hosts. Are you sure you want to continue connecting (yes/no)? type yes (“y” alone will not work).
- If you have previously set up a secure shell passphrase and executed sshremote, a prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with Step 3.
- If you have not previously set up a secure shell passphrase; go to Step 4.

If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your Passphrase then press the Return/Enter key.

Go to Step 5.

At the <user@remotehost>’s password: prompt type your Password then press the Return/Enter key.

Log in to the appropriate Subscription Server database as described in Steps 1 through 5 of the procedure for Using ISQL to Check Database Tables (previous section of this lesson).

- For example:

```
x0ins01{cmshared}45: isql -Ucss_role -Sx0ins01_srvr
Password:
1> use SubServer
2> go
```

- If the Subscription Manager debug log file was previously searched for subscription notification from the Subscription Server concerning dynamic data that the DPR needs, the following types of information will have been discovered (if not for the specific granule required, at least for the datatype):
  - ESDT Information (data type and event).
  - User (i.e., Subscription Manager).
  - Event ID.

- For example:

```
03/30/00 11:36:58: Entire message = Subscription Notification::
```
6 Type select * from EcSbSubscription where eventID=n at the 1> prompt then press Return/Enter.
   • The n represents the relevant eventID (e.g., from the Subscription Manager debug log file).
7 Type go at the 2> prompt then press Return/Enter.
   • Table contents are displayed.
   • For example:

```
1> select * from EcSbSubscription where eventID=805
2> go
   subID  eventID  userID
       expDate
       object
------------------------
------------------------
     82     805 SubsMgr
   Jan 18 2001 12:00AM

82 805
7
"SubsMgr"26
"Subscription\x20Notification:"0
"17
"SubscriptionQueue"4
"VATC"2451563
2451928
```
In the example note that subID 82 is entered for eventID 805 (AST_09T.001:INSERT) and the userID is SubsMgr.

8 To exit from isql type `quit` at the 1> prompt then press `Return/Enter`.

9 Perform the procedure for Checking Log Files (subsequent section of this lesson) to search the .err file for the DPR that inserted data (ACT#syn1#004130123OPS.err) for an entry indicating that the data were in fact inserted.

- The .err log files containing output file insertion information are on the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03).

- For example:

```
03/30/00 11:38:02: DpPrDSSInterface::CheckStatusParameters The request results returned from request.GetStatus() is :
-ReqUpdate[CmdCount(1) ReqSuccess(1)]
03/30/00 11:38:02: Request status indicates success
03/30/00 11:38:02: DpPrDSSInterface::CheckResultParameters The request results returned from request.GetResults() is :
--ReqResults[
---CmdResults[---Insert results[---
DATAFILEGROUP [userDataFile(/usr/ecs/OPS/CUSTOM/pdps/x0spg01/data//DpPrRm/x0spg01_disk/AST_09T#001070419971301230000000) ESDTStatus(1)
archiveDescription(None)]
03/30/00 11:38:02: DpPrDSSInterface::RequestOK, The request results returned from this method is :
--ReqResults[
---CmdResults[
```
---Insert results[
----
DATABFILEGROUP[userDataFile(/usr/ecs/OPS/CUSTOM/pdps/x0spg01/data/\DpPrRm/x0spg01_disk/AST_09T#001070419971301230000000) ESDTStatus(1)
archiveDescription(Nonne)]
03/30/00 11:38:02: ~~~~ RPC ID completed ACT#syn1#004130123OPSAST_09T
03/30/00 11:38:02: DpPrDSSInterface::~DpPrDSSInterface()
03/30/00 11:38:02: inserted
1:5478 into ursVector =
ursVector.length() = 1
1:5478
03/30/00 11:38:02: About to update PlDataGranule
granuleId = AST_09T#00107041997130123000
03/30/00 11:38:02: Successfully updated PlDataGranule
granuleId = AST_09T#00107041997130123000

10  In the terminal window logged in to the Subscription Server host (e.g., x0ins01) type cd /usr/ecs/MODE/CUSTOM/logs then press Return/Enter.

•  Change directory to the directory containing the log files (e.g., EcSbSubServer.ALOG, EcSbSubServerDebug.log).

11  Type pg EcSbSubServer.ALOG then press Return/Enter.

•  The first page of the log file is displayed.

•  Although this procedure has been written for the pg command, any UNIX editor or visualizing command (e.g., vi, view, more) can be used to review the log file.

12  Correlate the data insertion time (as specified in the .err file for the DPR that inserted data) with activity in the Subscription Server ALOG file:

•  For example, the following entries are in the Subscription Server ALOG file around AST_09T data insertion time of 11:38 (as discovered in the
ACT#syn1#004130123OPS.err log file):

    Msg: Getting event for EventID = 805 Priority: 0 Time : 03/30/00
11:38:07
    PID : 25042:MsgLink :0 meaningfulname :DsDbInterface::Connect()
    Msg: Connected to server: Priority: 2 Time : 03/30/00 11:38:07
    PID : 25042:MsgLink :0 meaningfulname
    :EcSbTriggerEventRequestTriggerTrigger
    Msg: Triggering event for EventID = 805 Priority: 0 Time : 03/30/00
11:38:08
    PID : 25042:MsgLink :0 meaningfulname
    :EcSbSubscriptionExecuteExecute
    371 625-CD-606-001
In the example note that at 11:38 Subscription Server received Event 805 and recorded a log entry "Msg: Firing subscriptions for event #805" but that this did not include any event for SubsMgr for subId 82. Note, in particular:

```
Msg: Firing subscriptions for event #805 Priority: 0 Time : 03/30/00 11:38:16
```

In the example, it is clear that a file was inserted at 11:38, but that the Subscription Server never sent event notification to the PLS Subscription Manager.

13 If a Subscription Server problem has been identified, notify the Operations Controller/System Administrator of the problem.

14 If no Subscription Server problem has been identified, return to the procedure that specified Handling Subscription Server Problems [e.g., Checking to Determine Whether the DPR Is Waiting in the AutoSys Queue (preceding section of this lesson)].
Responding to a DPR That Was Released But Failed Due to an AutoSys ID Failure

An "AutoSys ID" failure occurs when the Job Management server cannot associate the AutoSys ID with the DPR that was activated. When the Job Management server is started, it reads various tables in the PDPS database that provide the linkage between processing resources and the AutoSys instance. If data is missing from the tables or was added after the Job Management server was started, an "AutoSys ID" failure can occur when any jobs are activated by the Planning Workbench.

The procedure for responding to a DPR that was released but failed due to an AutoSys ID failure starts with the assumption that the Production Monitor has logged in to ECS and the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03).

**Responding to a DPR That Was Released But Failed Due to an AutoSys ID Failure**

1. In the terminal window logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03) type `cd /usr/ecs/MODE/CUSTOM/logs` then press Return/Enter.
   - Change directory to the directory containing the log files (e.g., EcDpPrJobMgmt.ALOG, EcDpPrDeletion.ALOG, DPR#.ALOG, DPR#.err, EcPlSubMgrDebug.log, EcDpPrJobMgmtDebug.log).

2. Type `pg EcDpPrJobMgmt.ALOG` then press Return/Enter.
   - The first page of the log file is displayed.
   - Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., `vi`, `view`, `more`) can be used to review the log file.

3. Review the Job Management ALOG file for an “unable to find autosys id” message.
   - For example:

```
PID : 7668:MsgLink :0 meaningfulname
   :DpPrAutosysMapList::GetAutosysIDByDpr
   Msg: unable to find autosys id for dpr: ACT#syn1#004130123TS1
Priority: 2 Time : 03/09/001:33:51
PID : 7668:MsgLink :9 meaningfulname :CantFindAutoSysId
   Msg: Unable to find autosys id Priority: 2 Time : 03/09/00 11:33:51
PID : 7668:MsgLink :10 meaningfulname
   :DpPrSchedulerDObjSmainCreateFailed
   Msg: RqFailed=CreateDpr DprID=ACT#syn1#004130123TS1 Priority: 2 Time : 03/09/00 11:33:51
```
If there is an "unable to find autosys id" message in the Job Management ALOG file, log in to the appropriate PDPS database as described in Steps 1 through 5 of the procedure for Using ISQL to Check Database Tables (previous section of this lesson).

- For example:

```
x0sps02:/usr/ecs/TS1/CUSTOM/[4] > isql -UpdpsUsers -Sx0pls01_srvr
Password:
1> use pdps_TS1
2> go
```

If there is an "unable to find autosys id" message in the Job Management ALOG file, verify that the PlResource table in the PDPS database has at least one entry for a processing string and at least one entry for an AutoSys Instance.

- For example:

```
1> select * from PlResource
2> go
```

```
<table>
<thead>
<tr>
<th>resourceId</th>
<th>resourceName</th>
<th>resourceState</th>
<th>resourceType</th>
<th>activityTypeId</th>
<th>onLineState</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>x0spg01_disk</td>
<td>1</td>
<td>DEVICE</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>x0spg01_vc</td>
<td>1</td>
<td>MACHINE</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>x0spg01</td>
<td>0</td>
<td>REALCOMP</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>x0spg01_string</td>
<td>0</td>
<td>VIRTUAL</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>FMR</td>
<td>0</td>
<td>AUTOSYS</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>x0aqg02_disk</td>
<td>0</td>
<td>DEVICE</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>7</td>
<td>x0aqg02_vc</td>
<td>0</td>
<td>MACHINE</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>8</td>
<td>x0aqg02</td>
<td>0</td>
<td>REALCOMP</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>9</td>
<td>x0aqg02_string</td>
<td>0</td>
<td>VIRTUAL</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

(9 rows affected)
• In the example resourceId 4 is a string (x0spg01_string) and resourceId 5 is an AutoSys Instance (FMR).

6 If the PlResource table in the PDPS database either has no entry for a processing string or no entry for an AutoSys Instance, make a request to the Resource Planner to create the necessary entry(ies).

7 Verify that the PlRscString table in the PDPS database has at least one entry and that autosysIdKey matches the entry in the PlResource table.

• For example:

```
1> select * from PlRscString
2> go
   stringId   stringName     autosysIdKey
  ----------- -------------------------------------------------------
  -----------
  4 x0spg01_string  
  5     
  9 x0aqg02_string  
  5

(2 rows affected)
```

• In the example the PlRscString table in the PDPS database has at least one entry and the autosysIdKey for each matches the entry (i.e., 5) in the PlResource table.

8 If the PlRscString table in the PDPS database either has no entry or if the autosysIdKey does not match the entry in the PlResource table, make a request to the Resource Planner to make the necessary adjustments.

9 Verify that the DpPrAutosysMapList table in the PDPS database has at least one entry and that resourceString and autosysIdKey match the entries in the PlRscString table.

• For example:

```
1> select * from DpPrAutosysMapList
2> go
   resourceString   autosysId   autosysIdKey
  ------------------- ------------------- ----------
  x0aqg02_string    x0aqg02_string    FMR 5
  x0spg01_string    x0spg01_string    FMR 5

(2 rows affected)
```
In the example the DpPrAutosysMapList table in the PDPS database has at least one entry and the resourceString and autosysIdKey entries match the entries in the PlRscString table.

10 To exit from isql type quit at the 1> prompt then press Return/Enter.

11 If the DpPrAutosysMapList table in the PDPS database either has no entry or if either the resourceString or autosysIdKey does not match the corresponding entry in the PlRscString table, make a request to the Resource Planner to make the necessary adjustments.

12 If Resource Planning has been done since the Job Management server was brought up, make a request to the Operations Controller/System Administrator to bounce the server.

• The Job Management server reads resource information at start-up; any changes since it was brought up will not have taken effect.

Responding to a DPR That Was Released But Failed Due to Invalid DPR

The procedure for responding to a DPR that was released but failed due to an invalid DPR starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03).

Responding to a DPR That Was Released But Failed Due to Invalid DPR

1 In the terminal window logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03) type cd /usr/ecs/MODE/CUSTOM/logs then press Return/Enter.

• Change directory to the directory containing the log files (e.g., EcDpPrJobMgmt.ALOG, EcDpPrDeletion.ALOG, DPR#.ALOG, DPR#.err, EcPlSubMgrDebug.log, EcDpPrJobMgmtDebug.log).

2 Type pg EcDpPrJobMgmt.ALOG then press Return/Enter.

• The first page of the log file is displayed.

• Although this procedure has been written for the pg command, any UNIX editor or visualizing command (e.g., vi, view, more) can be used to review the log file.

3 Review the Job Management ALOG file for an “invalid DPR object” message.

• For example:

  PID : 13169:MsgLink :0 meaningfulname :EnteringCreateDprJob
  Msg: Enterin... Priority: 0 Time : 01/22/00 19:01:24

  PID : 13169:MsgLink :10 meaningfulname :InvalidDprObject
  Msg: invalid DPR object Priority: 2 Time : 01/22/00 19:01:24
PID : 13169:MsgLink :0 meaningfulname :CantFindAutoSysRecord
Msg: Unable to locate autosys record Priority: 2 Time : 01/22/00 19:01:24

PID : 13169:MsgLink :12 meaningfulname :CreateDprJob:ModAutoSysJobCounterProblem
Msg: ModAutoSysJobCounter problem Priority: 2 Time : 01/22/00 19:01:24

PID : 13169:MsgLink :13 meaningfulname :DpPrSchedulerDObjSmainCreateFailed
Msg: RqFailed=CreateDpr DprID=ETS#OnDema01093011DEV04 Priority: 2 Time : 01/22/00 19:01:24

- An invalid DPR object is usually caused by missing Performance or Resource information for the PGE.

Perform the procedure for Using ISQL to Check Database Tables (previous section of this lesson) or use a database browser to check for an entry for the job (by searching on the pgeId column) in the PlPgePerformance table in the applicable PDPS database.

- For example:

```
x0sps02:/usr/ecs/TS1/CUSTOM/[6] > isql -UpdpsUsers -Sx0pls01_srvr
Password:
1> use pdps_TS1
2> go
1> select * from PlPgePerformance where pgeId like "ACT#syn4#001"
2> go
```

```
pgeId    cpuTime    pgeElapsedTime    dprElapsedTime
maxMemory faults swaps blockInputOperation runCpuTime runMaxMemory
runPgeElapsed runDprElapsed runFaults runSwaps runBlockInOperation runBlockOutOperation sharedMemory runSharedMemory
------------------------- ----------- ----------- ---------------
-------------------- ----------- ----------- --------------------
-------------------- ------------------
- ------------------
------
--------
------------------
---
------------------
---
ACT#syn4#001 55 1800 1800
10.000000 100 100
```


Observe the entries in the **PlPgePerformance** table to determine whether the non-schedulable PGE(s) has (have) non-zero values in the various columns of the table.

- In the preceding example the entries for pgeId ACT#syn4#001 are mostly non-zero values whereas all of the entries for pgeID ACT#syn5#001 are zero values.

- There is performance data in the table for pgeID ACT#syn4#001 but none for pgeID ACT#syn5#001.

Perform the procedure for **Using ISQL to Check Database Tables** (previous section of this lesson) or use a database browser to check for an entry for the job (by searching on
the sswId column) in the PlResourceRequirement table in the applicable PDPS database.

- For example:

```sql
1> select * from PlResourceRequirement where sswId like "ACT#syn4"
2> go

<table>
<thead>
<tr>
<th>sswId</th>
<th>string</th>
<th>numOfCPUs</th>
<th>computer</th>
<th>diskSpace</th>
<th>topLevelShellName</th>
<th>exeTarFileDiskSpace</th>
<th>mcfName</th>
<th>exeUntarFileDiskSpace</th>
<th>ramSize</th>
<th>exeTarUR</th>
<th>toolkitArchitecture</th>
<th>pgeId</th>
<th>pgeCommands</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACT#syn4</td>
<td>x0spg01_string</td>
<td>1</td>
<td>NULL</td>
<td>10.000000</td>
<td>synpge_sgi6n32</td>
<td>1.787376</td>
<td>NULL</td>
<td>0.000000</td>
<td>1.805250</td>
<td>NULL</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>


ACT#syn4#01 | sgi32 | 1110

(1 row affected)
1> select * from PlResourceRequirement where sswId like "ACT#syn5"
Observe the entries in the \texttt{PlResourceRequirement} table to determine whether the non-schedulable PGE(s) has (have) non-zero values in the various columns of the table.

- In the preceding example the entries for sswId ACT#syn4 are mostly non-zero values whereas all of the entries for sswID ACT#syn5 are either zero or NULL values.
- There is resource data in the table for sswID ACT#syn4 but none for sswID ACT#syn5.
If entries for the non-schedulable PGE(s) in either the `PlPgePerformance` table or `PlResourceRequirement` table are all zero (0) or NULL (e.g., ACT#syn5 in the preceding examples), request the SSI&T team to run the SSIT Operational Metadata GUI and enter correct performance values.

If entries for the non-schedulable PGE(s) in either the `PlPgePerformance` table or `PlResourceRequirement` table are all zero (0) or NULL, request the Production Planner to delete and re-create the applicable DPRs (after the SSI&T team has run the SSIT Operational Metadata GUI and entered correct performance values).

- Activation should succeed on the next attempt after the corrections have been made.

---

**Responding to a DPR That Was Released But Failed to Be Received by Job Management Server**

If a DPR was released but failed to be received by the Job Management server, the Planning Workbench would think it had successfully activated the DPR(s) but the Job Management Server would not have received the proper notification.

The procedure for responding to a DPR that was released but failed to be received by Job Management Server starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03).

**Responding to a DPR That Was Released But Failed to Be Received by Job Management Server**

1. In the terminal window logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03) type `cd /usr/ecs/MODE/CUSTOM/logs` then press Return/Enter.
   - Change directory to the directory containing the log files (e.g., `EcDpPrJobMgmt.ALOG`, `EcDpPrDeletion.ALOG`, `DPR#.ALOG`, `DPR#.err`, `EcPlSubMgrDebug.log`, `EcDpPrJobMgmtDebug.log`).

2. Type `pg EcDpPrJobMgmtDebug.log` then press Return/Enter.
   - The first page of the log file is displayed.
   - Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., `vi`, `view`, `more`) can be used to review the log file.
Review the EcDpPrJobMgmtDebug.log file for a “Failed in CdsEntryRead” message.

- A “Failed in CdsEntryRead” message indicates a problem with communication (i.e., a DCE problem).
  - DCE problems can be verified (if desired) by running dceverify on the Job Management and Planning Workbench hosts and checking the debug logs of other servers for "Invalid Bindings" messages.

Notify the Operations Controller/System Administrator of suspected DCE problems.

### Single DPS Job Has Failed or Is Hanging

A single DPS job that has failed or is hanging represents one of the following conditions:

- Entire job box is hanging.
- Allocation function is hanging.
- Allocation function has failed.
- Staging function is hanging.
- Staging function has failed.
- Preprocessing job has failed.
- Execution job is hanging.
- Execution job has failed.
- Postprocessing job has failed.
- Insertion function has failed.

### Handling a Box Job that is Hanging in AutoSys

This condition is determined by noting that the entire Job Box on JobScape (including all three job steps) is the same color, and that color is either the one indicated for "Inactive" jobs or the one for "On Hold" jobs.

- The AutoSys Event server or one of the AutoSys clients could be down.
  - Refer to Checking AutoSys Status (previous section of this lesson).
- A "glitch" could have caused the job to go into AutoSys in an "inactive" state.
Handling a Hanging Allocation Function

A hanging allocation function may be indicated when the Preprocessing job, which had turned green on JobScape or TimeScape to indicate that it was running, never turns either red (failed) or blue (success). Any of the following conditions may cause the allocation function to hang:

- The Science Data Server (SDSRV) may be waiting for a request to Data Distribution (DDIST) to distribute the PGE tar file, but the file cannot be distributed because Storage Management (STMGT) is down.
- The Science Data Server (SDSRV) may be waiting for a request to Data Distribution (DDIST) to distribute the PGE tar file, but the file cannot be distributed because Storage Management cannot ftp the file to the data directory on the science processor disk.
- The request may be waiting for the archive to stage the file. If there are several other requests in progress, the PGE “acquire” request may have to wait until one or more of the other requests completes.

The procedure for handling a hanging allocation function starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03) and started the AutoSys GUI Control Panel.

Handling a Hanging Allocation Function

1 Access a terminal window logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03).

2 Type `tail -f /usr/ecs/MODE/CUSTOM/logs/jobname.err` then press Return/Enter.
   - `jobname` refers to the name of the AutoSys job for which the .err log file (e.g., ACT#syn1#004130123OPS.err) is to be reviewed.
   - If there is no activity or if the job is in a retry loop, the job is hanging.

3 If there is no activity in the .err log, request the Ingest/Distribution Technician or Operations Controller (as appropriate) to determine the status of the distribution request for the PGE tar file.
   - The requester should be EcDpPrEM.
   - If the status is "Suspended with Errors," Storage Management servers may have to be bounced, then the Ingest/Distribution Technician can resume the request.
   - If the status is "Staging," the request may be waiting for the archive to stage the file.
     - If there are several other requests in progress, the PGE acquire may have to wait until one or more of them completes.
     - If the request is in the "Staging" state, it may eventually complete.
If distribution of the PGE tar file does not resume, type `cd /usr/ecs/MODE/CUSTOM/pdps/processor/data/DpPrRm/processor_disk` then press Return/Enter.

- **processor** refers to the Science Processor host (e.g., e0spg01, g0spg01, or l0spg01).
- The **processor_disk** directory (e.g., g0spg01_disk) or one of its subdirectories is the target directory where the data server puts the inputs needed for processing.

If distribution of the PGE tar file does not resume, type `ls -al` then press Return/Enter.

- A listing of the files and subdirectories on the science processor disk (for the mode) is displayed.
- The target directory for the PGE tar file is a subdirectory identified by the sswID (science software identification) of the PGE.
  - For example, if the job in AutoSys is `ACT#syn1#004130123OPS` on the science processor disk there should be an **ACT#syn1** subdirectory.

If the target directory does not exist, notify the Operations Controller/System Administrator of the problem.

If the target directory does exist, try to ftp a file to the target directory.

- For example:

```
x0sp02:/usr/ecs/OPS/CUSTOM/logs[109] > ftp x0spg01
Connected to x0spg01.vatc.ecs.nasa.gov.
220- NOTICE: ,
220-*******************************************************************************
220- THIS U.S. GOVERNMENT COMPUTING SYSTEM IS FOR AUTHORIZED USERS
220- ONLY. ANYONE USING IT IS SUBJECT TO MONITORING AND RECORDING
220- OF ALL KEystrokes WITHOUT FURTHER NOTICE. THIS RECORD MAY BE
220- PROVIDED AS EVIDENCE TO LAW ENFORCEMENT OFFICIALS.
220-
220-*******************************************************************************
220-
220- x0spg01.vatc.ecs.nasa.gov FTP server ready.
Name (x0spg01:cmshared):
331 Password required for cmshared.
Password:
230 User cmshared logged in.
ftp> cd
/usr/ecs/OPS/CUSTOM/pdps/x0spg01/data/DpPrRm/x0spg01_disk/ACT#syn1
250 CWD command successful.
```
In the example the log file ACT#syn1#004130123OPS.ALOG was successfully transferred by ftp from x0sps02 /usr/ecs/OPS/CUSTOM/logs to x0spg01 /usr/ecs/OPS/CUSTOM/pdps/x0spg01/data/DpPrRm/x0spg01_disk/ACT#syn1 as verified by changing directory to the x0spg01_disk/ACT#syn1 subdirectory and performing a long listing of the directory contents.

If the ftp fails, notify the Operations Controller/System Administrator to have the ftp problem fixed.

If the Allocation job is in a retry loop, ensure (e.g., using ECS Assistant) that the necessary hosts and servers (listed in Table 11) are “up.”

Note that the first retry is designed to fail, because the software is retrieving server-side information to refresh the client-side at this point. However, multiple subsequent retries indicate a “retry loop.”

If hosts/servers have gone down, notify the Operations Controller/System Administrator to have servers brought back up.

If no problem has been identified and the job is still hanging, run the Execution Manager in the debugger as described in the procedure for Running EM/DM Outside of AutoSys (subsequent section of this lesson).

Execution Manager (EcDpPrEM) is the DPS program that runs during allocation.
Running EM/DM Outside of AutoSys

To debug problems or to run unit tests, it is sometimes necessary to run Execution Manager (EcDpPrEM) and Data Manager (EcDpPrDM) outside of AutoSys.

The procedure for running EM/DM outside of AutoSys starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03) and started the AutoSys GUI Control Panel and the JobScape GUI.

**Running EM/DM Outside of AutoSys**

1. Click on the name of the job displayed on the JobScape GUI.
   - The job name is displayed in the Current Job Name field in the Control Region of the JobScape GUI.

2. Click on the Job Console button on the JobScape GUI.
   - The Job Activity Console GUI (also known as the Ops Console GUI) is displayed with information concerning the current job.

3. In a terminal window logged in to the Queuing Server type `cd /usr/ecs/MODE/CUSTOM/bin/DPS` then press Return/Enter.

4. Type `sh` then press Return/Enter.
   - A Bourne shell is started.

5. Type `. auto.profile` then press Return/Enter.

6. If running in the debugger is desired, type either `debugger EcDpPrEM &` or `debugger EcDpPrDM &` (as applicable) then press Return/Enter.
   - The applicable program is brought up in the debugger.

7. Type the command listed in the Command field of the Job Activity Console GUI (Ops Console GUI) then press Return/Enter.
   - EcDpPrEM or EcDpPrEM (as applicable) starts running.
   - The command listed in the Command field of the Job Activity Console GUI (Ops Console GUI) is the command that AutoSys was going to use to run EM or DM.
   - For example:
     ```
     EcDpPrEM ConfigFile /usr/ecs/OPS/CUSTOM/cfg/EcDpPrEM.CFG ecs_mode
     OPS --alloc PGE07#1.0#01080596155400
     ```
**Handling a Failed Allocation Function**

If allocation fails, the Preprocessing job turns red on JobScape or TimeScape.

The procedure for handling a failed allocation function starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03) and started the AutoSys GUI Control Panel and the JobScape GUI.

**Handling a Failed Allocation Function**

1. Access a terminal window logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03).
2. Type `cd /usr/ecs/MODE/CUSTOM/logs` then press Return/Enter.
   - Change directory to the directory containing the data processing log files (e.g., EcDpPrJobMgmt.ALOG, EcDpPrDeletion.ALOG).
3. If there is an ALOG file for the job, type `pg filename` then press Return/Enter.
   - `filename` refers to the data processing log file to be reviewed (e.g., DPR#.ALOG).
   - The first page of the log file is displayed.
   - Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., vi, view, more) can be used to review the log file.
4. If there is an ALOG file for the job, review the log file for the following types of error messages.
   - **Error: unable to update Machine in Autosys**
   - **Unable to determine type of UR**
   - An "Error: unable to update Machine in Autosys" message means that DPS is unable to access the AutoSys database. The auto.profile in /usr/ecs/MODE/CUSTOM/bin/DPS has the wrong settings for AUTOSYS and AUTOUSER parameters.
     - Although they may differ slightly from DAAC to DAAC, the expected values are generally as follows:

```plaintext
AUTOSYS = /usr/ecs/MODE/COTS/autotreeb/autosys
AUTOUSER = /usr/ecs/MODE/COTS/autotreeb/autouser
```
   - A message of "Unable to determine type of UR" means that the PGE tar file has not been inserted.
5 If an “Error: unable to update Machine in Autosys” message was present in the log, notify the Operations Controller/System Administrator to have the auto.profile file corrected.

- Either AutoSys Mkcfg has to be run again or the auto.profile file has to be changed manually.

6 If an "Unable to determine type of UR" message was present in the log, perform the procedure for Using ISQL to Check Database Tables (previous section of this lesson) or use a database browser to check the PIResourceRequirement table in the PDPS database for a non-null entry for the field exeTarUR.

- For example:

```sql
x0sps02:/usr/ecs/OPS/CUSTOM[127] > isql -UpdpsUsers -Sx0pls01_srvr
Password:
1> use pdps
2> go
1> select sswId,exeTarUR from PIResourceRequirement where sswId like "ACT#syn1"
2> go
sswId       exeTarUR
-------------------
ACT#syn1


(1 row affected)
1> select sswId,exeTarUR from PIResourceRequirement where sswId like "AM1Eph#2.0"
2> go
sswId       exeTarUR
-------------------
AM1Eph#2.0
```
• In the first query of the example (where sswId like "ACT#syn1"), there is a value listed for the exeTarUR for ACT#syn1.

• In the second query of the example (where sswId like "AM1Eph#2.0"), there is a null value for the exeTarUR for AM1Eph#2.0.

7 If the value for the **exeTarUR** in the **PRIResourceRequirement** table in the PDPS database is null, make a request to the SSI&T team to have the EXE Tar File inserted.

• When the EXE Tar File has been inserted, it should be possible to restart the job and have it complete successfully. (Refer to **Force-Starting a Job**.)

8 If there is no ALOG file for the job, click on the name of the job displayed on the **JobScape** GUI.

• The job name is displayed in the **Current Job Name** field in the Control Region of the **JobScape** GUI.

9 Click on the **Job Console** button on the **JobScape** GUI.

• The **Job Activity Console** GUI (Ops Console GUI) is displayed with information concerning the current job.

10 Review the entry in the **Exit Code** field on the **Job Activity Console** GUI.

• A value of 122 means that owner of the job does not have “write” permission to the log files directory.

11 Determine the ownership of the job using the procedure for **Determining the Ownership of an AutoSys Job** (previous section of this lesson).

12 In the terminal window type **ls –al** then press **Return/Enter**.

• A long listing of the logs directory is displayed.

• For example:

```
x0sp02:/usr/ecs/OPS/CUSTOM/logs[137] > ls -al
total 178600
drwxrwxr-x  2 cmops   cmops  3584 Apr 17 12:55 .
drwxrwxr-x 18 cmops   cmops  1024 Oct 11 1999 ..
-rwxrwxrwx  1 cmshared cmshared 12898 Mar 30 11:38 ACT#syn1#004130123OPS.ALOG
-rw-rw-r--  1 cmshared cmshared 105397 Mar 30 11:38 ACT#syn1#004130123OPS.err
```
Compare the “write” permission for logs in the logs directory with the owner of the job.

- In the preceding example the user cmshared (and others in the “cmshared” group) has “write” permission for the log files listed.
- If cmshared is the “owner” of the jobs listed in the directory, there should be no problem.

If there is a discrepancy between the “write” permission for logs in the logs directory and the owner of the job, report the problem to the Operations Controller/System Administrator for resolution.

If there is no discrepancy between the “write” permission for logs in the logs directory and the owner of the job, type `pg /var/adm/messages` then press Return/Enter.

- The first page of the “messages” file is displayed.
- For example:

```
x0sps02:/usr/ecs/OPS/CUSTOM/logs[139] > pg /var/adm/messages
Apr 4 10:13:39 x0sps02 unix: NFS server x0mss04 not responding still trying
Apr 4 10:13:39 x0sps02 unix: NFS server x0mss04 not responding still trying
Apr 4 10:14:39 x0sps02 unix: NFS server x0mss04 ok
Apr 4 10:14:39 x0sps02 unix: NFS server x0mss04 ok
Apr 4 10:16:37 x0sps02 reboot: rebooted by root
Apr 4 10:16:37 x0sps02 syslogd: going down on signal 15
Apr 4 10:20:04 x0sps02 unix: cpu0: SUNW,UltraSPARC (upaid 6 impl 0x10 ver 0x40 clock 168 MHz)
Apr 4 10:20:04 x0sps02 unix: cpu1: SUNW,UltraSPARC (upaid 7 impl 0x10 ver 0x40 clock 168 MHz)
```

- Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., `vi`, `view`, `more`) can be used to review the log file.

Review the entries in the message log for a message indicating that the security file EcSeRandomDataFile could not be found.
If there is a message indicating that the security file EcSeRandomDataFile could not be found, notify the Operations Controller/System Administrator to have the file created.

- The allocation function should run successfully when the security file has been created.

If no problem has been identified, run the Execution Manager in the debugger as described in the procedure for Running EM/DM Outside of AutoSys (subsequent section of this lesson).

- Execution Manager (EcDpPrEM) is the DPS program that runs during Allocation.

---

### Force-Starting a Job

To solve or recover from many problems it is necessary to restart the job by force-starting it.

#### Guidelines for Force-Starting Jobs:

- Force-start command jobs (e.g., preprocessing, postprocessing) only; do not attempt to force-start a box job.
  - The software does not support box job force-starts. (Although it may work fine in some cases, it can cause the PDPS database to get out of sync and prevent the DPR (and possibly other DPRs) from running successfully.)
  - If a box job were force-started, the allocation function would run again. Allocation might choose a different science processor than was chosen the previous time the job ran. Using a different science processor could cause failure of the job.
  - After each job (and often within each job) the state of the DPR is tracked in various tables in the database. Box job force-starts lack the code needed to check the state of the box and perform the cleanup activities necessary for starting over.

- Ensure that the GUI has refreshed and the job to be force-started is not already running before trying to force-start a job. (If a job is already running, it should not be force-started.)
  - If using AutoSys/AutoXpert 3.4.2 or a later version, it should not be possible to force-start jobs that are already running.
  - If you need to restart a job that is still running, you need to kill it via the AutoSys menu (the same one that has the Force Start choice) and then Force Start it.
• If any command job other than execution fails, force-start the job that failed only. Do not force start any preceding or succeeding jobs in the box.

• If execution fails, it is not safe to restart it unless the postprocessing job had been put on hold and the failure was detected before postprocessing started running.

• If execution fails and the failure was not detected before postprocessing started running, the DPR must run to completion as a failed PGE and the DPR must be deleted and recreated.

The procedure for force-starting a job starts with the assumption that the Production Monitor has launched the AutoSys GUI Control Panel and either JobScape or TimeScape is being displayed.

Force-Starting a Job

1. Click and hold on the applicable job symbol in the AutoXpert JobScape or TimeScape GUI with the right mouse button.
   - Pop-up menu appears.

2. Select (highlight) Force Start Job from the pop-up menu (release the right mouse button).
   - The job symbol in AutoXpert JobScape or TimeScape GUI should turn green (“starting”) within a short period of time.

3. If the job symbol in AutoXpert JobScape or TimeScape GUI does not turn green (“starting”) within a short period of time, return to Step 1.

Responding to a Restart of a Job That Fails Although All Known Problems Have Been Corrected

If a job fails to restart although all known problems have been corrected, the retry information in the DpPrRpcID database table may not be synchronized between servers.

The procedure for responding to a restart of a job that fails although all known problems have been corrected starts with the assumption that the Production Monitor has logged in to ECS.
Responding to a Restart of a Job That Fails Although All Known Problems Have Been Corrected

1. Examine the **readableTag** column in the **DpPrRpcID** table of the applicable PDPS database to identify the out-of-sync entry.

   - For example:

     ```
     $x0sps02:/usr/ecs/OPS/CUSTOM[140] > isql -UpdpsUsers -Sx0pls01_srvr
     Password:
     1> use pdps
     2> go
     1> select * from DpPrRpcID
     2> go
     readableTag
     object
     -------------------------------------------------------------
     ----------------------------------------------------------------
     (0 rows affected)
     ```

2. Remove the out-of-sync entry.

3. Restart the job using the procedure for **Force-Starting a Job** (previous section of this lesson).

Handling a Hanging Staging Function

The problems that cause a staging function to hang are generally the same as those that cause an allocation function to hang. Likely causes include the following problems:

- The Science Data Server (SDSRV) may be waiting for a request to Data Distribution (DDIST) to distribute the PGE tar file, but the file cannot be distributed because Storage Management (STMGT) is down.

- The Science Data Server (SDSRV) may be waiting for a request to Data Distribution (DDIST) to distribute the PGE tar file, but the file cannot be distributed because Storage Management cannot ftp the file to the data directory on the science processor disk.
• The request may be waiting for the archive to stage the file(s). If there are several other requests in progress, the “acquire” request may have to wait until one or more of the other requests completes.

Refer to the procedure for **Handling a Hanging Allocation Function**, keeping in mind the fact that Data Management (EcDpPrDM) performs staging functions for input data files whereas Execution Management (EcDpPrEM) performs allocation, including requesting staging of the PGE tar file.

**Handling a Failed Staging Function**

If staging fails, the Preprocessing job turns red on JobScape or TimeScape.

The procedure for handling a failed staging function starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03) and started the **AutoSys GUI Control Panel** and the **JobScape GUI**.

**Handling a Failed Staging Function**

1. Access a terminal window logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03).

2. Type `cd /usr/ecs/MODE/CUSTOM/logs` then press **Return/Enter**.
   - Change directory to the directory containing the data processing log files (e.g., EcDpPrJobMgmt.ALOG, EcDpPrDeletion.ALOG).

3. If there is an ALOG file for the job, type `pg filename` then press **Return/Enter**.
   - `filename` refers to the data processing log file to be reviewed (e.g., `DPR#.ALOG`).
   - The first page of the log file is displayed.
   - Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., `vi`, `more`) can be used to review the log file.

4. If there is an ALOG file for the job, review the log file for the following types of error messages.
   - **ESDT Acquire Failed for UR....**
     - A message of "**ESDT Acquire Failed for UR....**" means that SDSRV had trouble processing one of the acquire requests.
   - **found no meta data entry for UR....**
     - A message of "**found no meta data entry for UR....**" means that for some reason the tables that DPS uses to keep track of files on the local disks are no longer synchronized (have gotten out of sync).
   - **GetESDTRefereReferenceFailed**
A message of "GetESDTReferenceFailed" means that the ESDT Reference could not be created for the UR displayed in the message containing "Inside AcquireOneGranuleToSDSRV".

It is likely that the granule that is attempting to stage was not inserted into the Data Server or has been deleted.

- **Database deadlock error messages.**
  
  A deadlock problem accessing the PDPS database is indicated by the following type of message:

```
SybaseErrorCode1 =1205;SybaseErrorMesage1 ="g0pls02_srvr"
SybaseErrorCode2 =13;SybaseErrorMesage2 ="40001"
Priority : 0 Time : 10/19/99 01:53:48
PID : 19909:MsgLink :0 meaningfulname :EcPoErrorA1
   Msg: EcPoError::HandleRWE Error RogueWaveDBToolsError#
RogueWaveDBToolsErrorCode =21;RogueWaveDBToolsErrorMesage ="[NOREADER] This object cannot support readers"
Priority : 0 Time : 10/19/99 01:53:48
PID : 19909:MsgLink :0 meaningfulname
   :DpPrDbIF::SelectAndReadColumns
   Msg: SelectAndReadColumns failed due to [NOREADER] This object cannot support readers Priority : 2 Time : 10/19/99 01:53:48
```

- While most deadlock problems are retried, deadlocks on the reading of tables (though rare) currently cannot be retried.
- The error in the example could indicate that a “read” deadlock occurred.

5 If an "ESDT Acquire Failed for UR...." message was present in the log, restart the job using the procedure for **Force-Starting a Job** (previous section of this lesson).

- The job should restart and run successfully.

6 If a "found no meta data entry for UR...." message was present in the log, restart the job using the procedure for **Force-Starting a Job** (previous section of this lesson).

7 If a "found no meta data entry for UR...." message was present in the log and restarting the job was not successful, clean up the DPS file tables using the procedure for **Cleaning Up the DPS File Tables** (subsequent section of this lesson).

8 If a "found no meta data entry for UR...." message was present in the log and the DPS file tables have been cleaned up, restart the job using the procedure for **Force-Starting a Job** (previous section of this lesson).

- The job should restart and run successfully.
If a "GetESDTReferenceFailed" message was present in the log, notify the Production Planner to take the following actions:

• Request to have the granule re-inserted.
• Delete the affected DPR(s).
• Re-create the affected DPR(s).

If a message indicating a “read” deadlock was present in the log (as shown in the preceding example), restart the job using the procedure for **Force-Starting a Job** (previous section of this lesson).

• The job should restart and run successfully.

If no problem has been identified, run the Data Manager in the debugger as described in the procedure for **Running EM/DM Outside of AutoSys** (preceding section of this lesson).

• Data Manager (EcDpPrDM) is the DPS program that runs during staging.

---

### Cleaning Up the DPS File Tables

To solve or recover from some problems, it is necessary to clean up the DPS file tables in the applicable PDPS database. The DPS file tables are as follows:

- **DpPrFile** - a list of staged files and metadata files.
- **DpPrGranuleLocation** - the location of the staged files.
- **DpPrDiskAllocation** - how much disk space the files require.

The offending entries have to be deleted from the tables. The "offending entries" are found using a universalReference (for DpPrFile), a granuleId (for DpPrGranuleLocation), or a fileName (for DpPrDiskAllocation).

The procedure for cleaning up the DPS file tables starts with the assumption that the Production Monitor has logged in to ECS.

---

### Cleaning Up the DPS File Tables

1. Log in to the appropriate PDPS database as described in Steps 1 through 5 of the procedure for **Using ISQL to Check Database Tables** (previous section of this lesson).

• For example:

```
x0sps02:/usr/ecs/OPS/CUSTOM[4] > isql -UpdpsUsers -Sx0pls01_srvr
Password:
```
2 Observe the entries in the **granuleId** column of the **PlDprData** table to determine what granules affect the job (e.g., ACT#syn1#014020000OPS).

- For example:

```sql
1> select dprId,granuleId from PlDprData where dprId like
"ACT#syn1#014020000OPS"
2> go
dprId
granuleId
----------------------------­
-------------------------------------------------------------
ACT#syn1#014020000OPS
AST_09T#00102141998020000000
ACT#syn1#014020000OPS
AST_ANC#001L1004
ACT#syn1#014020000OPS
AST_L1B#00102141998020000000

(3 rows affected)
```

3 Use the **granuleId** entries from the **PlDprData** table to locate the correct entries in the **DpPrGranuleLocation** table.

- For example:

```sql
1> 1> select * from DpPrGranuleLocation where granuleId like
"AST_L1B#00102141998020000000"
2> go

granuleId
machineId
stageState dprId
----------------------------­
-------------------------------------------------------------
----------- -----------------------------
AST_L1B#00102141998020000000
x0spg01
397 625-CD-606-001
```
Delete from the \texttt{DpPrGranuleLocation} table the entries that match the \texttt{granuleId} entries from the \texttt{PlDprData} table.

- For example:

  ```
  1> delete * from DpPrGranuleLocation where granuleId like
     "AST_L1B#00102141998020000000"
  2> go
  ```

Use the \texttt{granuleId} entries from the \texttt{PlDprData} table to verify that the applicable entries have been deleted from the \texttt{DpPrGranuleLocation} table.

- Refer to the example in Step 3.

Use the \texttt{granuleId} entries from the \texttt{PlDprData} table to locate the corresponding entries in the \texttt{PlDataGranuleShort} table.

- For example:

  ```
  1> select granuleId, dataTypeId, universalReference from
     PlDataGranuleShort where granuleId like
     "AST_L1B#00102141998020000000"
  2> go
  ```

<table>
<thead>
<tr>
<th>granuleId</th>
<th>dataTypeId</th>
<th>universalReference</th>
</tr>
</thead>
</table>
  | AST_L1B#00102141998020000000 | AST_L1B#001 | UR:10:DsShESDTUR:UR:15:DsShSciServerUR:13:[VTC:DSSDSRV]:19:SC:AST_L1B.001:5528

Use the `universalReference` entries from the `PlDataGranuleShort` table to identify corresponding `fileName` entries in the `DpPrFile` table.

- For example:

```sql
1> select fileName, universalReference from DpPrFile where
   universalReference like "%AST_L1B.001:5528"
2> go

<table>
<thead>
<tr>
<th>fileName</th>
<th>universalReference</th>
</tr>
</thead>
</table>
```

(2 rows affected)

- The use of a wild card (as shown by the use of the percent sign in the example) is recommended because `isql` will not provide a reliable search on a `universalReference`.

- There should be two `fileName` entries in the `DpPrFile` table (i.e., one `.hdf` and one `.met` file) for each `universalReference`. 
8. Delete from the **DpPrFile** table the entries that match the **universalReference** entries from the **PlDataGranuleShort** table.
   
   - For example:
     
     ```
     1> delete * from DpPrFile where fileName like
        "AST_L1B#00102141998020000000%"
     2> go
     ```
     
     - In the example the .hdf and .met **fileName** entries are of different lengths; consequently, the shorter of the two (the .hdf **fileName**) has been used with the wild card to specify which files are to be deleted.

9. Use the **universalReference** entries from the **PlDataGranuleShort** table to verify that the applicable entries have been deleted from the **DpPrFile** table.
   
   - Refer to the example in Step 7.

10. Use the **fileName** entries from the **DpPrFile** table to locate the correct entries in the **DpPrDiskAllocation** table.
    
    - For example:
      
      ```
      1> select * from DpPrDiskAllocation where fileName like
         "AST_L1B#00102141998020000000%"
      2> go
      ```
      
      | diskAllocationId | computerId | diskPartitionId | diskAllocationType | path                | diskAllocationSize | diskAllocationUser | diskAllocationActual | fileName                        |
      |------------------|------------|----------------|--------------------|---------------------|-------------------|-------------------|-------------------|--------------------------------|
      | 2001957          | 3          | 1              | 1                  | /x0spg01_disk/      | 50.085064         | ACT#syn1#014020000OPS | 50.085064          | AST_L1B#00102141998020000000.hdf |
      
      (1 row affected)
11 Delete from the **DpPrDiskAllocation** table the entries that match the **fileName entries from the DpPrFile** table.

- For example:

```
1> delete * from DpPrDiskAllocation where fileName like "AST_L1B#0010214199802000000%"
2> go
```

12 Use the **fileName entries from the DpPrFile** table to verify that the applicable entries have been deleted from the **DpPrDiskAllocation** table.

- Refer to the example in Step 10.

---

**Handling a Failed Preprocessing Job**

If preprocessing fails, the Preprocessing job turns red on JobScape or TimeScape.

The procedure for handling a failed Preprocessing job starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03) and started the **AutoSys GUI Control Panel** and the **JobScape GUI**.

**Handling a Failed Preprocessing Job**

1 Access a terminal window logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03).

2 Type `cd /usr/ecs/MODE/CUSTOM/logs` then press **Return/Enter**.

- Change directory to the directory containing the data processing log files (e.g., EcDpPrJobMgmt.ALOG, EcDpPrDeletion.ALOG).

3 If there is an ALOG file for the job, type `pg filename.ALOG` then press **Return/Enter**.

- **filename** refers to the data processing log file to be reviewed (e.g., DPR#.ALOG).
- The first page of the log file is displayed.
- Although this procedure has been written for the **pg** command, any UNIX editor or visualizing command (e.g., **vi**, **view**, **more**) can be used to review the log file.
If there is an ALOG file for the job, review the log file for the following types of error messages:

- **NOFREECPUS**
  - A message of "NOFREECPUS" means that all of the Science Processor CPUs are busy and the Preprocessing job went through its maximum number of retries to find an available CPU, possibly for one of the following reasons:
    - PGEs are taking longer to run than expected. DPS plans for execution times specified during SSIT, and if those times are exceeded by a large margin (by an executing PGE) it is possible that a PGE that is "ready to run" will be CPU-starved.
    - Somebody has scheduled a PGE that takes up more CPUs than will ever be available. If a PGE is defined (at SSIT) to require five CPUs and there are only three on any given machine, the job will never succeed.

- **No ads returned when searching IOS database for....**
  - A message similar to the example that follows means that PDPS contacted the Advertising Service (IOS) and Advertising could not find an entry for the specified ESDT in its database.

    *** No ads returned when searching IOS database for {ESDT Name}Getqueryableparameters

If a "NOFREECPUS" message was present in the log, restart the job using the procedure for **Force-Starting a Job** (previous section of this lesson).

If a "No ads returned when searching IOS database for...." message was present in the log, notify the Science Data Specialist or whoever else installs ESDTs to verify that the corresponding ESDT(s) has/have been properly installed.

- Advertising receives information concerning ESDTs when they are installed in Science Data Server.
- Advertising puts entries in its database for each ESDT installed and lists the UR of the Data Server (the server UR) that provides services for the ESDT (inserts/acquires/searches).
- If Advertising cannot find an entry for the ESDT in question it indicates either of the following conditions:
  - The ESDT was not installed.
  - The ESDT was not installed properly.
If a "No ads returned when searching IOS database for..." message was present in the log, after the problem has been corrected restart the job using the procedure for Force-Starting a Job (previous section of this lesson).

If neither of the preceding problems was mentioned in the log file, type `pg filename.err` then press Return/Enter.

- `filename` refers to the data processing log file to be reviewed (e.g., `DPR#.err`).
- The first page of the log file is displayed.
- Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., `vi`, `view`, `more`) can be used to review the log file.

If using the `pg` or `more` command, at the : prompt type `/-prep` then press Return/Enter.

- The start of the Preprocessing job log is displayed.
- The following type of entry indicates the start of the Preprocessing job:

```
Command used => 'EcDpPrEM ConfigFile
/usr/ecs/OPS/CUSTOM/cfg/EcDpPrEM.CFG ecs_mode OPS -preproc
AM1Eph#30012312200OPS' START_TIME: 03/30/00 10:50:32
```

- The `--preproc` indicates “Preprocessing.”

Review the Preprocessing portion of the .err log file for the “rm: Unable to remove directory long_directory_pathname: File exists” type of error message:

- The “rm: Unable to remove directory long_directory_pathname: File exists” type of error message means that there is a permission problem and the Execution Manager job could not delete the files within the directory.

- The `long_directory_pathname` will be similar to the following example:

```
/usr/ecs/OPS/CUSTOM/pdps/x0spg01/data/DpPrRm/x0spg01_disk/
AM1Eph#30001/AM1Eph#30012312200OPS_x0spg01/
```

If the “rm: Unable to remove directory long_directory_pathname: File exists” type of message was present in the Preprocessing portion of the .err file, in the terminal window type `cd long_directory_pathname` then press Return/Enter.

In the terminal window type `ls -al` then press Return/Enter.

- A long listing of the directory is displayed, for example:

```
x0sps02:/usr/ecs/OPS/CUSTOM/pdps/x0spg01/data/DpPrRm/x0spg01_disk/
AM1Eph#30001/AM1Eph#30012312200OPS_x0spg01[82] > ls -al
  total 3712
dwxr-xr-x 2 cmshared cmshared 65536 Apr 18 11:00 .
```
Determine who has write permission for files in the directory.

- In the preceding example the user cmshared and members of the cmshared group have write permission for the directory.

If possible (assuming write permission) type `mv filename1 [... filenamex] destination_directory` then press Return/Enter to move the files to another directory.

If write permission is not available, notify the System Administrator of the need to remove the files from the directory.
If no problem has been identified, run the Execution Manager in the debugger as described in the procedure for Running EM/DM Outside of AutoSys (preceding section of this lesson).

- Execution Manager (EcDpPrEM) is the DPS program that runs during Preprocessing.

Handling a Hanging Execution Job

This condition is determined by noting that the Execution job has turned orange or oscillates between orange and green on JobScape or TimeScape. It is most likely that the AutoSys client is down. Perform the procedure for Checking AutoSys Status (preceding section of this lesson).

Handling a Failed Execution Job

This condition is indicated when the Execution (PGE) job only is red on JobScape or TimeScape. This is hard to do, because the AutoSys job definition for this job says to allow any exit code to indicate success. It is set up this way so the next job, the Postprocessing job, continues even when the Execution job fails. The Execution job goes to a "success" state even when the PGE Wrapper job, EcDpPrRunPGE, does not exist. However, the Execution job can fail if AutoSys cannot see the machine. Consequently, if the Execution job (only) fails, perform the procedure for Checking AutoSys Status (preceding section of this lesson).

Responding to Execution Job and/or Postprocessing Job That Have (Has) Failed

This condition is determined by noting that the Execution job has turned red in JobScape or TimeScape or the entire job box has turned red (failedPGE scenario).

Responding to Execution Job That Has Failed and the DPR Has Gone into "Failed-PGE" Processing

This condition is indicated when the entire job box has turned red in JobScape or TimeScape along with the Postprocessing job. A Failed PGE tar file has been created and archived. A PGE may fail for many reasons. Some of the possible causes are documented here:

- The PGE has the wrong architecture.
- One of the expected inputs for the PGE is missing.
- The leap seconds file is incorrect.
- The file-watcher program detected that the PGE was writing files much larger than expected.
- There are problems accessing the Toolkit on the Science Processor.
- The PGE has not been staged.
The procedure for responding to an Execution job that has failed and the DPR has gone into "Failed-PGE" processing starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sp04, g0sp06, or l0sp03) and started the AutoSys GUI Control Panel and the JobScape GUI.

Responding to Execution Job That Has Failed and the DPR Has Gone into "Failed-PGE" Processing

1. Notify the SSI&T team to check the PGE architecture using the SSIT tools.
   - If the PGE has the wrong architecture, it is probably because the PGE was improperly defined as New32, Old32 or 64 from the SSIT Operational Metadata GUI.
     - The PGE core dumps because of this problem.
   - After the SSI&T team has entered the correct architecture using the SSIT Operational Metadata GUI the Production Planner has to delete and recreate all DPRs created for that PGE.

2. Access a terminal window logged in to the Queuing Server (e.g., e0sp04, g0sp06, or l0sp03).

3. Type `cd /path` then press Return/Enter.
   - Change directory to the run-time directory for the job (e.g., /usr/ecs/OPS/CUSTOM/pdps/x0spg01/data/DpPrRm/x0spg01_disk/ACT#syn1/ACT#syn1#004130123OPS_x0spg01/).

4. In the terminal window type `ls` then press Return/Enter.
   - A listing of the directory is displayed, for example:

```
x0sp02:/usr/ecs/OPS/CUSTOM/pdps/x0spg01/data/DpPrRm/x0spg01_disk/
AMLeph#30001/AMLeph#30012312200OPS_x0spg01[82] > ls
AMLATTH0#001.MCF
AMLATTN0#001.MCF
AMLEPH0#001.MCF
AMLEPH0#001.MCF
AMLeph#30012312200OPS.Log
AMLeph#30012312200OPS.Pcf
AMLeph#30012312200OPS.Profile
AMLeph#30012312200OPS.TkReport
AMLeph#30012312200OPS.TkStatus
AMLeph#30012312200OPS.TkUser
AMLeph#30012312200OPS_PGE.IN
MCFWrite.temp
pc19811823201201485810900110024
```
Review the contents of the runtime directory of the PGE/DPR to determine whether status logs (e.g., DPR#.TkStatus, DPR#.Tkuser, and DPR#.TkLog) were created for the PGE.

- DPS uses a Toolkit command to start the PGE. So if no status logs were created for the PGE, it is very likely that the Toolkit was not installed properly on the Science Processor.

6 If no status logs were created for the PGE, type `cd /path` then press Return/Enter.

- Change directory to the CUSTOM directory for the mode (e.g., /usr/ecs/OPS/CUSTOM).

7 If no status logs were created for the PGE, type `ls -al` then press Return/Enter.

- The following type of directory listing is displayed:

```
x0spg01:/usr/ecs/OPS/CUSTOM[45] > ls -al
total 392
  drwxrwxrwx 20 cmops cmops 4096 Apr  6 17:05 .
  drwxr-xr-x  4 root  sys 37 Oct  7 1997 ..
  -rw-rw-r--  1 cmops cmops  3834 Mar 27 12:41 .applications
  -rw-rw-r--  1 cmops cmops  1603 Mar 27 12:42 .cache
  -rw-rw-r--  1 cmops cmops 16547 Mar 27 12:41 .cfgpatch
  -rw-rw-r--  1 cmops cmops  6160 Mar 27 12:41 .envvars
  -rw-rw-r--  1 cmops cmops 22841 Mar 27 12:41 .executables
  -rw-rw-r--  1 cmops cmops  4368 Mar 27 12:41 .hostmap
  drwxrwxr-x  6 cmops cmops  61 Oct  8 1999 .installed
  -rw-rw-r--  1 cmops cmops 12616 Mar 27 12:41 .installtypes
  -rw-rw-r--  1 cmops cmops  8657 Mar 27 12:41 .sitehostmap
  -rw-rw-r--  1 cmops cmops  72760 Mar 27 12:41 .sitemap
  -rw-rw-r--  1 cmops cmops  1845 Mar 27 12:41 .subsystems
  drwxr-xr-x  6 cmops cmops  4096 Dec 14 09:14 AAdata
  drwxrwxr-x  9 cmops cmops 122 Mar 27 12:35 HDF
  drwxrwxr-x  4 cmops cmops  45 Nov 18 15:01 HDFEOS
  drwxrwxrwx  3 cmops cmops  25 Oct 11 1999 TOOLKIT
  drwxrwxr-x  3 cmops cmops  21 Oct 11 1999 WWW
  drwxr-xr-x 27 cmops cmops 4096 Nov 18 15:02 backup
  drwxrwxr-x  6 cmops cmops 142 Nov 30 15:38 bin
  drwxrwxr-x  2 cmops cmops  9 Oct 11 1999 cfg
  drwxr-xr-x  4 cmops cmops 4096 Sep 27 1999
daac_toolkit_f77
  drwxrwxr-x  7 cmops cmops  69 May  7 1999 data
  drwxrwxr-x  3 cmops cmops  21 Oct 11 1999 dbms
```
There should be a “toolkit” subdirectory as shown in the example.

8 If the Toolkit was not properly installed, notify the Operations Controller/System Administrator to have the problem corrected.

9 If the Toolkit was properly installed and there are status logs in the runtime directory, type `cd /path` then press Return/Enter.
   - Change directory to the run-time directory for the job (e.g., 
     `/usr/ecs/OPS/CUSTOM/pdps/x0spg01/data/DpPrRm/x0spg01_disk/ACT#syn1/ACT#syn1#004130123OPS_x0spg01/`).

10 Type `pg DPR#.TkStatus` then press Return/Enter.
   - `DPR#` refers to the name of the job (e.g., AM1Eph#30012312200OPS or ACT#syn1#004130123OPS).
   - The first page of the log file is displayed.
   - Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., `vi`, `view`, `more`) can be used to review the log file.

11 Review the `DPR#.TkStatus` log in the runtime directory of the PGE/DPR for messages concerning a missing input or inability to get number of files.
   - If the PGE is missing an input, it is probably because the DPR was released into AutoSys although not all of its inputs were available at the Data Server.

12 If a `logicalId` is mentioned in the context of a missing input or inability to get number of files, review the `DPR#.Pcf` file in the runtime directory of the PGE/DPR to determine whether that `logicalId` is present in the file.
   - If the PGE is missing an input, the `logicalId` will not be present in the `DPR#.Pcf` file.

13 Log in to the appropriate PDPS database as described in Steps 1 through 5 of the procedure for Using ISQL to Check Database Tables (previous section of this lesson).
   - For example:

```bash
x0spso2:/usr/ecs/OPS/CUSTOM[4] > isql -UpdpsUsers -Sx0pls01_srvr
Password:
```
Search on the **dprId** for the **logicalId** and the corresponding value in the **accepted** column in the **PlDprData** table.

- For example:

```
1> use pdps
2> go

14
```

1> select dprId,granuleId,logicalId,accepted from PlDprData where dprId like "ACT#syn1#014020000OPS"
2> go

dprId
granuleId
logicalId accepted
----------------------------
------------------------------------------------------------
ACT#syn1#014020000OPS
AST_09T#00102141998020000000
2000 6
ACT#syn1#014020000OPS
AST_ANC#001L1008
1200 5
ACT#syn1#014020000OPS
AST_L1B#00102141998020000000
1100 5
ACT#syn1#014020000OPS
GDAS_0ZF#001O1006
1101 5

(4 rows affected)
```

```
15
```

If the **accepted** field has “0” as its value, notify the Production Planner to delete the DPR and re-create it.

- If the **accepted** field has “0” as its value, the DPR was released without all of its inputs and that is why the PGE failed.

```
16
```

Type **cd /path** then press **Return/Enter**.

- Change directory to the directory containing the log files for the DPR (e.g., /usr/ecs/OPS/CUSTOM/logs).
Type `ls` then press Return/Enter.

- A listing of files in the logs directory is displayed.

Type `pg filename` then press Return/Enter.

- The *filename* refers to the name of the log file (e.g., ACT#syn1#014020000OPS.err, ACT#syn1#014020000OPS.ALOG).

- The first page of the log file is displayed.

- Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., *vi*, *view*, *more*) can be used to review the log file.

Review the DPR log file(s) for message(s) concerning a missing *logicalId*.

- Search for error messages concerning a missing Logical Id.
  - The error message may refer to either “missing” or “Logical Id” in lower case or upper case depending on the type of log file.
  - “Logical Id” may be one word or two (e.g., Logical Id, logicalId) depending on the type of log file.

- If one of the expected inputs for the PGE is missing, it is possible that an expected input of the PGE is not defined in the PGE ODL file.

Log in to the AIT Workstation (e.g., e0ais02, g0ais05, l0ais09).

Type `cd /path` then press Return/Enter.

- Change directory to the directory containing the ODL files (e.g., /usr/ecs/OPS/CUSTOM/data/DPS/ODL).

Type `ls` then press Return/Enter.

- A listing of files in the ODL directory is displayed.

Type `pg PGE_PGE#.odl` then press Return/Enter.

- *PGE#* refers to the name of the PGE (e.g., ACT#syn1#01).

- The first page of the ODL file is displayed.

- Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., *vi*, *view*, *more*) can be used to review the log file.

Review the PGE ODL file for the expected *logicalId* (listed as *LOGICAL_ID* in the ODL file).

- For example:

  ```
  OBJECT = PCF_ENTRY
  ```
CLASS = 11
LOGICAL_ID = 1100
PCF_FILE_TYPE = 1
DATA_TYPE_NAME = "AST_L1B"
DATA_TYPE_VERSION = "001"
DATA_TYPE_REQUIREMENT = 1
BEGIN_PERIOD_OFFSET = 0
END_PERIOD_OFFSET = 0
INPUT_TYPE = "Required"
NUMBER_NEEDED = 1
KEY_INPUT = "Y"

/**** Entry needed for all I/O (except for Temporary) ****/
/**** Only modify if multiple files and/or file types for this PCF
entry ****/

OBJECT = FILETYPE

FILETYPE_NAME = "Single File Granule"
CLASS = 1

END_OBJECT = FILETYPE
END_OBJECT = PCF_ENTRY

The example shows the PGE ODL entry for logicalId 1100 (AST_L1B), which is
input for ACT PGEs. There are additional PCF_ENTRY objects in the ODL file for
the other files associated with the PGE.

If the PGE is synthetic, it is possible that the ODL was filled out incorrectly because
of special parameters that the synthetic PGE expects.

If the ODL file is incorrect, notify the SSI&T team to have the file corrected.
Log in to the applicable PDPS database if not still logged in.

Refer to the example in Step 13.

Observe the entries in the PlDataGranuleShort table to determine whether all inputs to
the DPR have “1” as their availability flag setting.

For example:

1> select granuleId,availability from PlDataGranuleShort where
   granuleId like "AST_L1B#00102141998020000000"
2> go

    granuleId
    availability

-----------------------------------------------
-----------------------------------------------
In the example the availability flag of the granule is set at “1,” which indicates that the granule is available.

The same sort of query would be accomplished for the other two inputs; i.e., granuleId AST_ANC#001L1008 and granuleId GDAS_0ZF#001O1006.

Observe the entries in the PlDprData table to determine whether all inputs to the DPR have “1” in their “accepted” field.

As shown in Step 14, the “accepted” fields for the inputs for the example have the following values:

- AST_ANC#001L1008 5
- AST_L1B#00102141998020000000 5
- GDAS_0ZF#001O1006 5

Note that AST_09T#00102141998020000000 is an output, not an input.

A miscommunication can cause the Subscription Manager to release a PGE despite the fact that it is missing one (or more) input(s).

In a terminal window logged in to the Queuing Server review the DPR#.TkStatus log (see Steps 10 and 11) in the runtime directory of the PGE/DPR for an error message indicating that the Toolkit had trouble processing some time associated with the PGE.

An error message indicating that the Toolkit had trouble processing some time associated with the PGE may indicate that the leap seconds file is incorrect.

If it is suspected that the leap seconds file is incorrect (e.g., the TkStatus log has an error message indicating that the Toolkit had trouble processing some time associated with the PGE), notify the SSI&T team to have the leap seconds file updated.

Review the DPR#.Log file for the PGE in the runtime directory of the PGE/DPR for a message from the file watcher indicating that the PGE was killed because of output file size.

The file watcher runs in the background and verifies that the PGE does not exceed its output file sizes by a configurable amount.

If a PGE creates a file that is "too large" the file watcher kills the PGE.
If file watcher killed the PGE because the output file exceeded its expected size, notify the SSI&T team of the problem.

If no file watcher-associated problem was found in the DPR#.Log file, type `cd /path` then press Return/Enter.

- Change directory to the directory where the PGE should have been staged (e.g., /usr/ecs/OPS/CUSTOM/pdps/x0spg01/data/DpPrRm/x0spg01_disk/ACT#syn1/).

Type `ls` then press Return/Enter.

- A listing of files in the directory is displayed.

Review the directory listing to determine the presence of the PGE executable.

- DPS must acquire (stage) the PGE from Science Data Server before it runs for the first time.

- In the subdirectory that matches the PGE_Name#Ssw_Id (i.e., ACT#syn1 in the example) the PGE should have been staged and untarred. If no PGE executable exists in the directory, that is the reason for the PGE failure.

- Possible reasons why DPS would have run the PGE execution job without a PGE:
  - The DpPrExecutable table has entries after the database has been cleaned.
  - There is a file permission problem.

Log in to the applicable PDPS database if not still logged in.

- Refer to the example in Step 13.

Observe the entries in the DpPrExecutable table to determine whether there is an entry for the failing PGE with a setting of “0” in the execLayer column.

- For example:

```
1> select sswId,execLayer from DpPrExecutable where sswId like "ACT#syn1"
2> go

sswId execLayer
----------- -----------
ACT#syn1 0

(1 row affected)
```

- If there is an entry for the failing PGE in the DpPrExecutable database table and it has an entry of “0” in the execLayer column, DPS thinks that it has already staged the PGE.
If there is an entry for the failing PGE in the **DpPrExecutable** database table and it has an entry of “0” in the execLayer column, delete the entry from the **DpPrExecutable** table.

- For example:

```bash
1> delete * from DpPrExecutable where sswId like "ACT#syn1"
2> go
```

If there was an entry for the failing PGE in the **DpPrExecutable** database table that was deleted, make a request to the Production Planner to replan the DPR(s).

If the **DpPrExecutable** database table has an entry of some value other than “0” in the execLayer column, review the DPR#.TkStatus log (see Steps 10 and 11) in the runtime directory of the PGE/DPR to identify the file or type of file (i.e., metadata file or data file) to which the PGE is having trouble writing.

Type `cd /path` then press **Return/Enter**.

- Change directory to the directory containing the file to which the PGE is having trouble writing.

- The directory structure under which DPS manages its files is all defined by the machines (science processors), what are called the DataRoots for those machines, and the disks defined by the system. The directory structure can be represented as follows:

```
{machine name}_DataRoot
   {disk one} {disk two} . . .
   {PGENAME}#{software version}
   {DPR Name}_(machine name)
```

- The `{machine name}_DataRoot` parameter is found in the Configuration Registry for Execution Management (EcDpPrEM) or Data Management (EcDpPrDM). The `{machine name}` is the name(s) of the science processor(s). There is a data root for each science processor in the system. The `{machine name}_DataRoot` is considered the top-level directory, where a directory for each disk in the system is placed. So under this directory are directories named after the various disks on the system.

  - In the disk directories input and output files are acquired and produced.
  - Underneath the disk directories are directories for each PGE of the form `{PGENAME}#{Software Version}`. This is where the PGE tar files and toolkit files are staged.
Beneath the PGE directories is a directory for each DPR ({DPR Name}_{machine name}) which is where the toolkit status files, PGE logs and temporary files are placed.

- The PGE creates the following files:
  - An output file for every granule that it produces.
    - Each output file has the form {granuleId}.{file number}, where the Granule Id matches the granuleId in the {PlDataGranuleShort} and {DpPrGranuleLocation} database tables. File number is added to differentiate different files within a granule.
  - A .met file for every granule that it produces.
    - Each .met file has the form {granule Id}.met.
  - Toolkit status logs.
    - The toolkit status logs have the form {DPRID}.Tkstatus, {DPRID}.Tkuser and {DPRID}.TkLog. They are placed in the runtime directory of the PGE/DPR.

42 Type `ls -al` then press Return/Enter.

- A long listing of files in the directory is displayed.
- For example:

```
x0sps02:/usr/ecs/OPS/CUSTOM/pdps/x0spg01/data/DpPrRm/x0spg01_disk[94]
            > ls -al | pg
            total 14185088
            drwxrwxr-x  26 cmshared cmshared  65536 Apr 18 19:52 .
            drwxrwxr-x  3 cmops cmops  30 Apr 30 1999 ..
            drwxrwxr-x  2 cmshared cmshared  65536 Apr 17 10:49 ACT#syn1
            -rw-r--r--  1 EcDpPrDM users  384 Apr 18 16:06
              AM1ANC#001010120000000000000000
            -rw-r--r--  1 EcDpPrDM users  20988 Apr 18 16:06
              AM1ANC#001010120000000000000000.met
            -rw-r--r--  1 EcDpPrDM users  450048 Apr 18 16:06
              AM1ANC#001010120000000000000001
            -rw-r--r--  1 EcDpPrDM users  384 Apr 18 16:11
              AM1ANC#001010120000000000000000
            -rw-r--r--  1 EcDpPrDM users  20988 Apr 18 16:11
              AM1ANC#001010120000000000000000.met
            -rw-r--r--  1 EcDpPrDM users  449984 Apr 18 16:11
              AM1ANC#001010120000000000000001
            -rw-r--r--  1 EcDpPrDM users  384 Nov 23 13:32
              AM1ANC#001073119970600000000000
```
Determine who has “write” permission for the file to which the PGE is having trouble writing.

- In the preceding example the user **EcDpPrDM** (the Data Manager in DPS) has “write” permission for the AM1ANC files shown; the user **cmshared** and members of the cmshared group have “write” permission for the AST_09T files (output of the ACT PGE) shown.

- The PGE must be able to write to the directory where the data is kept (for its PGE outputs and .met files) and to the runtime directory where the log files and temporary files are kept.

- Both the DPS jobs and the PGE must be able to write to the directories.
  - Although it is unlikely, it is possible that the DPS jobs and the PGE have different owners.

If there is a discrepancy between the “write” permission for the file and the owner of the job, report the problem to the Operations Controller/System Administrator for resolution.
When the problem has been resolved, make a request to the Production Planner to replan the affected DPR(s).

Handling a Failed Postprocessing Job

If postprocessing fails, the Postprocessing job turns red on JobScape or TimeScape.

The procedure for handling a failed Postprocessing job starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03) and started the AutoSys GUI Control Panel and the JobScape GUI.

Handling a Failed Postprocessing Job

1. Access a terminal window logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03).

2. Type `cd /usr/ecs/MODE/CUSTOM/logs` then press Return/Enter.
   - Change directory to the directory containing the data processing log files (e.g., EcDpPrJobMgmt.ALOG, EcDpPrDeletion.ALOG).

3. If there is an ALOG file for the job, type `pg filename.ALOG` then press Return/Enter.
   - `filename` refers to the data processing log file to be reviewed (e.g., DPR#.ALOG).
   - The first page of the log file is displayed.
   - Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., `vi`, `more`) can be used to review the log file.

4. If there is an ALOG file for the job, review the log file for an error message concerning DPS having trouble finding a log file.
   - This means that the PGE probably did not run due to one of the following problems:
     - The toolkit links on the science processor are not correct.
     - The `auto.profile` configuration file has not been generated correctly.

5. Access a terminal window logged in to the applicable Science Processor (e.g., e0spg01, g0spg01, or l0spg01).

6. Type `cd /usr/ecs/MODE/CUSTOM` then press Return/Enter.
7 Type `ls -al` then press **Return/Enter**.

- The following type of directory listing is displayed:

```
x0spg01:/usr/ecs/OPS/CUSTOM[45] > ls -al
  total 392
  drwxr-xrwxx 20 cmops cmops 4096 Apr 6 17:05 .
  drwxr-xrwxx  4 root  sys  37 Oct 7 1997 ..
  lrwxr--rwx  1 cmops cmops  3834 Mar 27 12:41 .applications
  lrwxr--rwx  1 cmops cmops  1603 Mar 27 12:42 .cache
  drwxr-xr-x  1 cmops cmops 16547 Mar 27 12:41 .cfgpatch
  lrwxr--rwx  1 cmops cmops  6160 Mar 27 12:41 .envvars
  lrwxr--rwx  1 cmops cmops  22841 Mar 27 12:41 .executables
  lrwxr--rwx  1 cmops cmops  4368 Mar 27 12:41 .hostmap
    drwxr-xr-x  6 cmops cmops  61 Oct 8 1999 .installed
  lrwxr--rwx  1 cmops cmops 12616 Mar 27 12:41 .instalatypes
  lrwxr--rwx  1 cmops cmops  8657 Mar 27 12:41 .sitehostmap
  lrwxr--rwx  1 cmops cmops  72760 Mar 27 12:41 .sitemap
  lrwxr--rwx  1 cmops cmops  1845 Mar 27 12:41 .subsystems
    drwxr-xr-x  6 cmops cmops 4096 Dec 14 09:14 Adata
    drwxrwxr-x  9 cmops cmops 122 Mar 27 12:35 HDF
    drwxrwxr-x  4 cmops cmops  45 Nov 18 15:01 HDFEOS
    drwxrwxrwx  3 cmops cmops  25 Oct 11 1999 TOOLKIT
    drwxrwxr-x  3 cmops cmops  21 Oct 11 1999 WWW
    drwxr-xr-x  27 cmops cmops 4096 Nov 18 15:02 backup
    drwxrwxr-x  6 cmops cmops  142 Nov 30 15:38 bin
    drwxrwxr-x  2 cmops cmops  9 Oct 11 1999 config
    drwxr-xr-x   4 cmops cmops 4096 Sep 27 1999 daac_toolkit_f77
    drwxrwxr-x   7 cmops cmops  69 May 7 1999 data
    drwxrwxr-x   3 cmops cmops  21 Oct 11 1999 dbms
    drwxrwxr-x   6 cmops cmops  57 Oct 11 1999 lib
    drwxrwxr-x   2 cmops cmops 4096 Apr 18 19:52 logs
    drwxr-xr-x   4 root  sys  41 Jul 18 1998 pdps
    drwxrwxr-x   2 cmops cmops  36 Mar 27 12:41 security
    drwxr-xr-x   3 root  sys  25 Dec 18 1997 ssit
    lrwxr-xr-x   1 cmops cmops  36 Mar 27 17:13 toolkit ->
      /usr/ecs/OPS/CUSTOM/daac_toolkit_f77
    drwxrwxr-x   2 cmops cmops 4096 Mar 27 12:41 utilities
```

- There should be a “toolkit” subdirectory as shown in the example.

8 If there is no toolkit directory, notify the Operations Controller/System Administrator to have the directory created and linked correctly.
If there is a toolkit directory, notify the Operations Controller/System Administrator that the **auto.profile** file(s) may need to be corrected.

- There is an auto.profile file in the `/usr/ecs/MODE/CUSTOM/bin/DPS` directory on the Queuing Server and on each Science Processor.
- There may be a discrepancy between the auto.profile file and what is specified in the EcDpPrAutosysMkcfg or EcDpScAutosysMkcfg file (in the `/usr/ecs/MODE/CUSTOM/utilities` directory).
  - The EcDpPrAutosysMkcfg (Queuing Server) and EcDpScAutosysMkcfg (Science Processor) files are used in generating the auto.profile files.
- The AutoSys Mkcfg may have to be run again or the auto.profile file may have to be changed manually.

If no problem has been identified, run the Execution Manager in the debugger as described in the procedure for **Running EM/DM Outside of AutoSys** (preceding section of this lesson).

- Execution Manager (EcDpPrEM) is the DPS program that runs during Postprocessing.

### Handling Failure of Both Execution and Postprocessing Jobs

This condition is indicated when both the Execution and Postprocessing Jobs are red in JobScape or TimeScape, but no other jobs are red. This indicates that the Postprocessing job has read the log file created by EcDpPrRunPGE in the runtime directory and has found an exit status not equal to zero (0). However, it failed to destage (insert) the failed PGE tar file.

The procedure for handling failure of both Execution and Postprocessing jobs starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03) and started the **AutoSys GUI Control Panel** and the **JobScape** GUI.

#### Handling Failure of Both Execution and Postprocessing Jobs

1. Access a terminal window logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03).
2. Type `cd /usr/ecs/MODE/CUSTOM/logs` then press **Return/Enter**.
   - Change directory to the directory containing the data processing log files (e.g., EcDpPrJobMgmt.ALOG, EcDpPrDeletion.ALOG).
3. Type `pg filename.err` then press **Return/Enter**.
   - `filename` refers to the data processing log file to be reviewed (e.g., DPR#.err).
• The first page of the log file is displayed.
• Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., `vi`, `view`, `more`) can be used to review the log file.

4 Review the .err file for a “FAILPGE” string.

5 Review the .err file for the return value from the Science Data Server around the insertion of the failed PGE tar file.

6 If a problem with insertion of the FAILPGE tar file is suspected, continue with the procedure for Handling a Failed Insertion Job (subsequent section of this lesson).

Handling a Failed Insertion Function

If the insertion function fails, the Postprocessing job turns red on JobScape or TimeScape.

The procedure for handling a failed insertion function starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sp04, g0sp06, or l0sp03) and started the AutoSys GUI Control Panel and the JobScape GUI.

Handling a Failed Insertion Function

1 Access a terminal window logged in to the Queuing Server (e.g., e0sp04, g0sp06, or l0sp03).

2 Type `cd /usr/ecs/MODE/CUSTOM/logs` then press Return/Enter.
   • Change directory to the directory containing the data processing log files (e.g., EcDpPrJobMgmt.ALOG, EcDpPrDeletion.ALOG).

3 Type `pg filename.err` then press Return/Enter.
   • `filename` refers to the data processing log file to be reviewed (e.g., `DPR#.err`).
   • The first page of the log file is displayed.
   • Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., `vi`, `view`, `more`) can be used to review the log file.

4 Review the .err file for the following types of error messages:
   • **Failure inserting metadata into catalog**
     – Possible causes of a "Failure inserting metadata into catalog" message include the following items:
       • Problem with Storage Management.
       • Problem with a SDSRV temporary directory getting filled up.
Metadata file (and possibly the data file) cannot be located by Science Data Server because the mount point between the Science Processor and the Science Data Server machine may have been lost.

Filenames sent to the Science Data Server are invalid or null (e.g., if the DpPrFile table in the PDPS database has duplicate entries).

Duplicate file entries in the DPS file tables.

- **Error archiving files**
  
  A message that indicates "Error archiving files" means that SDSRV is having trouble getting Storage Management to place the file(s) in the archive.

- **Error modifying file usage**
  
  A message that indicates "Error modifying file usage" means that the numberOfUsage column in the DpPrFile table for a particular file is at zero (0) and the software is trying to decrement it, which it cannot do.

- **No ads returned when searching IOS database for....**
  
  A message similar to the example that follows means that PDPS contacted the Advertising Service (IOS) and Advertising could not find an entry for the specified ESDT in its database.

  *** No ads returned when searching IOS database for {ESDT Name}Getqueryableparameters

5 If a "Failure inserting metadata into catalog" message was present in the log and the problem occurred for an existing ESDT that has previously worked within the past day or two, notify the Operations Controller or Archive Manager that there may be a problem with Storage Management.

- The STMGT log files may contain information concerning changes/defects in the stored procedures.

6 If a "Failure inserting metadata into catalog" message was present in the log and the problem occurred for a new or recently installed ESDT, type cd /path then press Return/Enter.

- Change directory to the run-time directory for the job (e.g., /usr/ecs/OPS/CUSTOM/pdps/x0spg01/data/DpPrRm/x0spg01_disk/ACT#syn1/ACT#syn1#004130123OPS_x0spg01/).
If a "Failure inserting metadata into catalog" message was present in the log, type `pg DPR#.MCF` then press Return/Enter.

- `DPR#` refers to the name of the job (e.g., AM1Eph#30012312200OPS or ACT#syn1#004130123OPS).
- The first page of the MCF file is displayed.
- Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., `vi`, `view`, `more`) can be used to review the log file.

Review the `DPR#.MCF` file in the runtime directory of the PGE/DPR to determine values of the mandatory parameters in the metadata file.

If a "Failure inserting metadata into catalog" message was present in the log, report values of the mandatory parameters in the metadata file to the Operations Controller or Science Data Specialist so they can be compared with "valids" from the SDSRV database.

- In the GIParameter list from Science Data Server there may be error messages that may indicate which metadata values the Data Server did not like.

If a "Failure inserting metadata into catalog" message was present in the log, type `cd /path` then press Return/Enter.

- Change directory to the pdps mount point (e.g., `/usr/ecs/OPS/CUSTOM/pdps/x0spg01/data`).

If the mount point is missing, notify the Operations Controller/System Administrator to have it restored.

If a "Failure inserting metadata into catalog" message was present in the log, log in to the SDSRV Server host (e.g., e0acs05, g0acs03, l0acs03).

If a "Failure inserting metadata into catalog" message was present in the log, type `cd /path` then press Return/Enter.

- Change directory to the pdps mount point (e.g., `/usr/ecs/OPS/CUSTOM/pdps/x0spg01/data`).
- The pdps mount point should be visible from both the Queuing Server and the SDSRV Server hosts (and several other hosts as well).

If the mount point is missing, notify the Operations Controller/System Administrator to have it restored.
If a "Failure inserting metadata into catalog" message was present in the log, log in to the appropriate PDPS database as described in Steps 1 through 5 of the procedure for Using ISQL to Check Database Tables (previous section of this lesson).

• For example:

   x0sps02:/usr/ecs/OPS/CUSTOM[4] > isql -UpdpsUsers -Sx0pls01_srvr
   Password:
   1> use pdps
   2> go

If a "Failure inserting metadata into catalog" message was present in the log, search in the DpPrFile table on the fileName corresponding to the ".err" log filename that failed to be inserted (refer to Step 4).

• For example:

   1> select fileName from DpPrFile where fileName like
      "AST_09T#0010214199802012%"
   2> go

   fileName

   ---------------------------------------------------------------
   AST_09T#001021419980201200000000
   AST_09T#001021419980201200000000.met

   (2 rows affected)

• Look for duplicate entries in the table.

• There should be two entries for each file in the DpPrFile table; i.e., one for the data file and one for the metadata file (as shown in the example). If there are three or more entries, the table has duplicate entries that are causing the problem.

If a "Failure inserting metadata into catalog" message was present in the log and if duplicate entries were found in the DpPrFile table, notify the Production Planner to delete the DPR whose Insertion job failed.

If a "Failure inserting metadata into catalog" message was present in the log and if duplicate entries were found in the DpPrFile table, clean up the DPS file tables using the procedure for Cleaning Up the DPS File Tables (previous section of this lesson).
If a "Failure inserting metadata into catalog" message was present in the log, when the DPS file tables have been cleaned up, notify the Production Planner to recreate the DPR whose Insertion job failed.

If an "Error archiving files" message was present in the log, notify the Operations Controller or Archive Manager that there may be a problem with Storage Management.

- An "Error archiving files" message means that SDSRV is having trouble getting Storage Management to place the file(s) in the archive.
- When the "Error archiving files" has been corrected, it should be possible to restart the job and have it complete successfully. (Refer to Force-Starting a Job.)

If an "Error archiving files" message was present in the log, log in to the SDSRV Server host (e.g., e0acs05, g0acs03, l0acs03).

If an "Error archiving files" message was present in the log, type cd /path then press Return/Enter.

- Change directory to the pdps mount point (e.g., /usr/ecs/OPS/CUSTOM/pdps/x0spg01/data).

If the mount point is missing, notify the Operations Controller/System Administrator to have it restored.

If an "Error modifying file usage" message was present in the log, log in to the applicable PDPS database.

- Refer to the example in Step 15.
- A message that indicates "Error modifying file usage" means that the numberOfUsage column in DpPrFile table for a particular file is at zero (0) and the software is trying to decrement it. The column is an increment/decrement counter and is not normally decremented more times than it is incremented when under software control. However, if someone manually changes the database then the value may get out of sync.

If an "Error modifying file usage" message was present in the log, update the numberOfUsage column in DpPrFile table for the particular file so it is set at one (1).

- For example:

```
1> update DpPrFile set numberOfUsage=1 where fileName like "AST_09T#0010214199802012%"
2> go
```

- When the database has been corrected, it should be possible to restart the job and have it complete successfully. (Refer to Force-Starting a Job.)
If a "No ads returned when searching IOS database for...." message was present in the log, notify the Science Data Specialist or whoever else installs ESDTs to verify that the corresponding ESDT(s) has/have been properly installed.

- Advertising receives information concerning ESDTs when they are installed in Science Data Server.
- Advertising puts entries in its database for each ESDT installed and lists the UR of the Data Server (the server UR) that provides services for the ESDT (inserts/acquires/searches).
- If Advertising cannot find an entry for the ESDT in question it indicates either of the following conditions:
  - The ESDT was not installed.
  - The ESDT was not installed properly.

If a "No ads returned when searching IOS database for...." message was present in the log, after the problem has been corrected restart the job using the procedure for Force-Starting a Job (previous section of this lesson).

If no problem has been identified, run the Data Manager in the debugger as described in the procedure for Running EM/DM Outside of AutoSys (preceding section of this lesson).

- Data Manager (EcDpPrEM) is the DPS program that runs during insertion.

---

**Handling a Failed Deallocate Function**

If the deallocate function fails, the Postprocessing job turns red on JobScape or TimeScape.

The procedure for handling a failed deallocate function starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03) and started the AutoSys GUI Control Panel and the JobScape GUI.

**Handling a Failed Deallocate Function**

1. Ensure (e.g., using ECS Assistant) that the necessary hosts and servers (listed in Table 11) are “up.”
2. If hosts/servers have gone down, notify the Operations Controller/System Administrator to have servers brought back up.
If hosts/servers are all “up,” check the log files (e.g., DPR#.ALOG) in the /usr/ecs/MODE/CUSTOM/logs directory for error messages.

- For detailed instructions refer to the procedure for Checking Log Files (subsequent section of this lesson).

Handling a Failed On-Demand Processing Request

An On-Demand Processing request can fail for any of the following reasons:

- Failures in Submitting the On-Demand Request from ODFRM.
- Failures in OdMgr getting the On-Demand Request to Run in AutoSys.
  - The Job Management Server is down.
  - The DPR is waiting in the AutoSys queue (never got released).
  - The DPR failed in Job Management due to Invalid DPR.
  - The DPR failed in OdMgr due to a failure in getting the PGE ID.
  - Subscription Server Problems.
  - The DPR failed in Job Management due to a JIL failure.
  - The DPR failed in Job Management due to an AutoSys ID failure.
  - The DPR failed to be received by Job Management Server.
  - AutoSys is not functional.
  - AutoSys is full.
- Failures in AutoSys of the On-Demand PGE(s).
- Failures in OdMgr Distribution of the On-Demand product.

When the DPR for an On-Demand Processing Request is in AutoSys, the jobs can fail for any of the same reasons that any other type of job might fail and might be restarted in the same manner as any other type of job (as described in preceding sections).

Responding to a DPR that Failed in OdMgr because the PGE ID Could Not Be Found

If a DPR failed in OdMgr because the PGE ID could not be found, the options selected on the ODFRM screen do not match any of the Profiles for the PGE associated with the selected input. The parameters selected on ODFRM for the product are passed to OdMgr and are used to select the appropriate PGE Profile. The selection of a PGE Profile fails if the parameters passed by ODFRM to OdMgr do not exactly match those in one of the profiles.
The procedure for responding to a DPR that failed in OdMgr because the PGE ID could not be found starts with the assumption that the Production Monitor has logged in to the Queuing Server (e.g., e0sp04, g0sp06, or l0sp03).

**Responding to a DPR that Failed in OdMgr because the PGE ID Could Not Be Found**

1. Access a terminal window logged in to the Queuing Server (e.g., e0sp04, g0sp06, or l0sp03).

2. Type `cd /usr/ecs/MODE/CUSTOM/logs` then press Return/Enter.
   - Change directory to the directory containing the data processing log files (e.g., EcDpPrJobMgmt.ALOG, EcDpPrDeletion.ALOG).

3. Type `pg OdMgr.ALOG` then press Return/Enter.
   - The first page of the log file is displayed.
   - Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., `vi, view, more`) can be used to review the log file.

4. Review the ALOG file for a “Getting PGEID failed from PlOrderFactory” type of error message.
   - For example:
     
     ```
     PID : 24890:MsgLink :0 meaningfulname :READFAILED
     Msg: Getting PGEID failed from PlOrderFactory Priority: 2 Time :
     01/27/00 13:41:43
     PID : 24890:MsgLink :10 meaningfulname :PGELISTFAILED
     Msg: Getting PgeList from GlParameterList failed Priority: 2 Time :
     01/27/00 13:41:54
     PID : 24890:MsgLink :11 meaningfulname :CANTCREATEORDER
     Msg: Unable to create a PlOrder Priority: 2 Time : 01/27/00 13:41:54
     ```
   - The problem is most likely caused by not having the latest ODLs.

5. Notify the SSI&T team of the problem.
   - The SSI&T team should recopy the On Demand ODLs and re-register the PGEs.

**Checking Log Files**

Log files can provide indications of the following types of problems:

- DCE problems.
• Database problems.
• Lack of disk space.

The procedure for checking log files starts with the assumption that the operator has logged in to the ECS system.

Checking Log Files

NOTE: Commands in Steps 1 through 6 are typed at a UNIX system prompt.

1 Type `setenv DISPLAY clientname:0.0` then press the Return/Enter key.
   • Use either the X terminal/workstation IP address or the machine-name for the `clientname`.
   • When using secure shell, the DISPLAY variable is set just once, before logging in to remote hosts. If it were to be reset after logging in to a remote host, the security features would be compromised.

2 Start the log-in to the Planning/Management Workstation, Queuing Server, or PDPS DBMS Server as applicable by typing `/tools/bin/ssh hostname` then press the Return/Enter key.
   • In general Planning Subsystem applications are installed on the Planning/Management Workstation (e.g., e0pls03, g0pls01, or l0pls02) and Data Processing Subsystem (PRONG) applications are installed on the Queuing Server (e.g., e0sps04, g0sps06, or l0sps03). Note the following exceptions:
     − QA Monitor is on the Planning/Management Workstation.
     − Subscription Manager is on the PDPS DBMS Server (e.g., e0pls02, g0pls02, or l0pls01).
   • If you receive the message, Host key not found from the list of known hosts. Are you sure you want to continue connecting (yes/no)? type yes (“y” alone will not work).
   • If you have previously set up a secure shell passphrase and executed sshremote, a prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue with Step 3.
   • If you have not previously set up a secure shell passphrase; go to Step 4.

3 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your Passphrase then press the Return/Enter key.
   • Go to Step 5.
At the `<user@remotehost>’s password:` prompt type your **Password** then press the **Return/Enter** key.

Type `cd /usr/ecs/MODE/CUSTOM/logs` then press **Return/Enter**.

- Change directory to the directory containing the log files (e.g., `EcDpPrJobMgmt.ALOG`, `EcDpPrDeletion.ALOG`, `EcPlSubMgrDebug.log`, `EcDpPrJobMgmtDebug.log`).

Type `pg filename` then press **Return/Enter**.

- `filename` refers to the log file to be reviewed (e.g., `EcDpPrJobMgmt.ALOG`, `EcDpPrDeletion.ALOG`, `DPR#.ALOG`, `DPR#.err`, `EcPlSubMgrDebug.log`, `EcDpPrJobMgmtDebug.log`).

  - The first page of the log file is displayed.

  - Although this procedure has been written for the `pg` command, any UNIX editor or visualizing command (e.g., `vi`, `view`, `more`) can be used to review the log file.

Review the log file to identify problems that have occurred.

Respond to problems as follows:

- **DCE problems.**
  - Notify the Operations Controller/System Administrator of suspected DCE problems.

- **Database problems.**
  - Verify that relevant database servers are running.
  - Check for lack of (or corruption of) data in the database using either a database browser or `isql` commands.
  - Notify the Database Administrator of suspected database problems.

- **Lack of disk space.**
  - Remove unnecessary files.
  - Notify the Operations Controller/System Administrator of recurring disk space problems.
This page intentionally left blank.
Launching the QA Monitor

Access to the QA Monitor must be gained through the use of UNIX commands. The process starts with the assumption that the applicable servers are running and the Production Monitor has logged in to the ECS system.

Launching the QA Monitor

NOTE: Commands in Steps 1 through 7 are typed at a UNIX system prompt.

1. Type `setenv DISPLAY clientname:0.0` then press the Return/Enter key.
   - Use either the X terminal/workstation IP address or the machine-name for the `clientname`.
   - When using secure shell, the DISPLAY variable is set just once, before logging in to remote hosts. If it were to be reset after logging in to a remote host, the security features would be compromised.

2. Start the log-in to the Planning/Management Workstation by typing `/tools/bin/ssh hostname` (e.g., e0pls03, g0pls01, or l0pls02) in the new window then press the Return/Enter key.
   - If you receive the message, Host key not found from the list of known hosts. Are you sure you want to continue connecting (yes/no)? type yes (“y” alone will not work).
   - If you have previously set up a secure shell passphrase and executed sshremote, a prompt to Enter passphrase for RSA key '</user@localhost>' appears; continue with Step 3.
   - If you have not previously set up a secure shell passphrase; go to Step 4.

3. If a prompt to Enter passphrase for RSA key '</user@localhost>' appears, type your Passphrase then press the Return/Enter key.
   - Go to Step 5.

4. At the <user@remotehost>’s password: prompt type your Password then press the Return/Enter key.

5. Type `setenv ECS_HOME /usr/ecs/` then press the Return/Enter key.
   - When logging in as a system user (e.g., cmshared), the ECS_HOME variable may be set automatically so it may not be necessary to perform this step.
6 Type `cd /usr/ecs/MODE/CUSTOM/utilities` then press `Return/Enter`.  
- Change directory to the directory containing the QA Monitor start script (e.g., EcDpPrQaMonitorGUIStart).
- The `MODE` will most likely be one of the following operating modes:
  - OPS (for normal operation).
  - TS1 (for SSI&T).
  - TS2 (new version checkout).
- Note that the separate subdirectories under /usr/ecs apply to (describe) different operating modes.

7 Type `EcDpPrQaMonitorGUIStart MODE` then press `Return/Enter` to launch the QA Monitor GUI.  
- The QA Monitor GUI (Figure 83) is displayed.
Figure 83. Q/A Monitor GUI - QRU Data Tab
This page intentionally left blank.
Performing Science Product Quality Assurance

Science Product Quality Assurance

Science product quality assurance (QA) involves the use of the Q/A Monitor application. Science Computing Facility (SCF) personnel have the responsibility for performing QA of their products. The Production Monitor’s role in QA is limited to updating the QA metadata. The procedure for updating QA metadata is performed in response to a request from SCF personnel to set the metadata flags on specified granule(s).

The procedure for updating QA metadata starts with the assumption that all applicable servers are currently running and the Q/A Monitor GUI QRU data tab (Figure 83) (QRU = Query, Retrieve and Update) is being displayed.

Updating Quality Assurance (QA) Metadata

1. In the Data Types field, click on the data type to be checked.
   - It may be necessary to scroll through the Data Types list.
   - The selected data type is highlighted.
   - Only one data type can be selected at a time.
   - Alternatively, the Find field and button can be used for specifying a data type.
     - The Find field is case-sensitive.

2. Click in the appropriate Data Granule Insert window field(s) and either type or use the up/down arrow buttons to enter the Begin date and End date in MM/DD/YYYY format.
   - In the Data Granule Insert window it is necessary to specify the range of dates (between the Begin date and the End date) to formulate a query for searching for the desired granule(s) to be checked.
   - Time is based upon day of insert into the data server. If no dates are entered, an error message is displayed.
   - The up and down arrows next to the duration fields may be used for modifying entries in each field.
   - The Tab key may be used to move from field to field.

3. Click on the Query button.
   - Granules within the specified date range appear in the Data Granules field.
4 In the **Data Granules** field, click on the granule for which metadata is to be updated.
   - It may be necessary to scroll through the list of granules.
   - The selected granule is highlighted.
   - Alternatively, the **Find** field and button may be used for specifying a data granule.
     - The **Find** field is case-sensitive.

5 Click on the **Update Metadata** button.
   - The **Granule Parameters** window (Figure 84) is displayed.
   - The **Granule Parameters** window displays one line for each parameter for the selected granule.

6 In the **Granule Parameters** window click on a parameter for which the metadata is to be updated.
   - The **Update Meta Data** window (Figure 85) is displayed.

7 Click and hold on the **Operational QA Flag** option button, move the mouse cursor to the desired selection (highlighting it), then release the mouse button.
   - The selected metadata flag is displayed on the **Operator QA Flag** option button.
   - The following options are available:
     - **Passed**.
     - **Failed**.
     - **Being Investigated**.
     - **Not Being Investigated**.

8 Type an explanation of the QA flag selection in the **Explanation** field.

9 If the SCF has specified that the SCF Quality Flag should be set to a particular value, click and hold on the **SCF Quality Flag** option button, move the mouse cursor to the SCF-specified selection (highlighting it), then release the mouse button.
   - The selected metadata flag is displayed on the **SCF Quality Flag** option button.
   - The same options are available as those on the **Operational Quality Flag** option button.

10 Type an explanation of the QA flag selection in the **Explanation** field.

**NOTE:** The **Auto Quality Flag** option button should not be accessible.

11 When the QA flags have been set with the desired values, click on the **OK** button.
   - The settings are accepted and the **Update Meta Data** window is dismissed.
### Granule Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Operational Flag</th>
<th>Operational Flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snow Cover</td>
<td>Being Investigated</td>
<td>Default flag and comment set</td>
</tr>
</tbody>
</table>

*Figure 84. QA Monitor Granule Parameters Window*
Figure 85. QA Monitor Update Meta Data Window

- To cancel the settings and dismiss the **Update Meta Data** window click on the **Cancel** button.

- The **Granule Parameters** window (Figure 84) is displayed.

12 Observe the entries in the **Granule Parameters** window to verify that the QA flag settings have actually been applied to the granule.

- The QA flag values and explanations entered using the **Update Meta Data** window are displayed.

- Repeat Steps 6 through 11 as necessary to revise the QA metadata for the granule parameter.

13 Repeat Steps 6 through 12 to update the QA metadata for any additional granule parameters.

14 When the QA flags for all relevant parameters have been set with the desired values and verified, click on the **OK** button in the **Granule Parameters** window.

- The **Granule Parameters** window is dismissed.

- The directory for visualizing data retrieved from the archive is as follows: /usr/ecs/MODE/CUSTOM/data/DPS
Regenerating Granules

**Regenerating Granules in Response to Loss of Files from the Archive**

The reason for regenerating granules is to produce replacements for previously generated granules that have been lost or corrupted due to failure in the ECS archive. The overall process involves the following general operations:

- Retrieval of the Production History files (PH) for lost granules to determine parameters for the generation of replacement granules.
- Creating Production Requests for the generation of replacement granules.
- Creating and activating a Production Plan that includes the Production Requests for the generation of replacement granules.
- Preparing (if applicable) a “PDPS Residual Granules List,” which identifies granules that either cannot or should not be regenerated at the DAAC.
  - Some granules do not need not be reproduced; e.g., if there is a more recent version of the product available.

The regeneration process is initiated when the Production Planner receives a list of “Granules for PDPS Re-Generation.” The list contains information about the granules to be regenerated and Universal References (URs) for the associated Production History tar files. The list is the product of a Science Data Server (SDSRV) procedure concerning SDSRV Retrieval of Granule Production History Metadata.

The procedure for regenerating granules in response to loss of files from the archive starts with the assumption that all applicable production planning servers and data server servers are running.

**Regenerating Granules in Response to Loss of Files from the Archive**

1. Determine which granules in the **Granules for PDPS Re-Generation** list should be regenerated (and which granules do not need to be reproduced).

2. Add granules that either cannot or do not need to be reproduced to the **PDPS Residual Granules** list.

3. Retrieve (using the **QA Monitor GUI**) the Production History tar file from the archive for each granule in the **Granules for PDPS Re-Generation** list that needs to be reproduced.
   - Use the lost granule’s datatype, and begin date and end date values that encompass its `RangeBeginningDateTime` and `RangeEndingDateTime`.


- **QA Monitor** interprets dates in UTC format.

- For each granule that meets the query conditions and is displayed on the **QA Monitor GUI**, the granule’s UR, its Production History tar file’s UR, and the name of the Production History tar file are shown. For only one of the granules will the URs (both the granule UR and the Production History UR) match the URs for this granule in the input list.

- The Production History tar file is acquired to a directory that is configurable.
  - The name of the configuration parameter is DpPrQA_DATA_DIR.
  - The default value for the parameter is $ECS_HOME/<MODE>/CUSTOM/data/DPS.

- If more than one granule in the input list maps to the same Production History tar file, the Production History tar file need not be retrieved multiple times.

4 Extract information needed to re-run the PGE from the Process Control File (PCF) in the PH.

- Information to be extracted from the PCF:
  - PGE Name.
  - PGE Version.
  - PGE Profile ID.
  - DPR Start time.
  - DPR Stop time.
  - PGE runtime parameters and their associated values.

- Identification of information in the PCF:
  - The PGE Name, PGE Version, and the PGE Profile appear in the System Runtime Parameters section of the PCF. They are concatenated (with a # sign to separate them) and appear in the place reserved for “Software ID”.
  - DPR Start time appears in the User Defined Parameter Section of the PCF under the logical ID 10258.
  - DPR Stop time also appears in the User Defined Parameter Section of the PCF under logical ID 10259.
  - All other logical IDs in the User Defined Parameter Section of the PCF form the run time parameters and their associated values. Note the logical ID and its corresponding values.

5 If the Query failed or did not return any hit that matched, add the granule to the **PDPS Residual Granules** list.
If the PGE name (including version and profile) that is extracted from the PCF does not appear as an Existing/New PGE, add the granule to the **PDPS Residual Granules** list.

From the SSIT host, launch the **SSIT Manager** GUI and invoke the **PDPS Operational Metadata** GUI.

Invoke the **PDPS Operational Metadata** GUI.

If the PGE is not registered, register the PGE using the **PDPS Science Update Metadata Update** from the **SSIT Manager** GUI.

- The PGE must be registered before a PR can be entered.

If it is decided not to re-register the PGE, add the granule to the **PDPS Residual Granules** list.

Launch the **Production Request Editor** GUI.

Create a Production Request for the relevant PGE/version/profile ID.
- Use **Reprocessing** for the **Processing Type**.
- Use the DPR Start and Stop Time listed in the Production History for the **Begin** and **End** times.
- Compare the default PGE runtime parameters with the runtime parameters obtained from the Production History tar file.
  - Modify the runtime parameter values to match exactly what was used in the original run.
- If granules to be regenerated are produced by PGEs that are chained, the PRs must be entered in the proper order.
  - For instance, if granules A and B are to regenerated, and PGEs P1 & P2 produce them and if P1 & P2 are chained (P2 takes P1’s outputs as its inputs), then the production request for P1 must be entered before entering one for P2.

Launch the **Planning Workbench**.

Create and activate a production plan that includes the newly created Production Request(s).

Send the **PDPS Residual Granules** list to the originator of the **Granules for PDPS Regeneration** list.
This page intentionally left blank.
Practical Exercise

Introduction
This exercise is designed to give the students practice in production planning and processing activities.

Equipment and Materials
One ECS workstation per student.

Statement of the requirements for the exercise.

*Release 6A Operations Tools Manual for the ECS Project, 609-CD-600-001, one copy per student.*

*Mission Operation Procedures for the ECS Project, 611-CD-600-001, one copy per student.*

Launching the Production Request Editor
The exercise involves launching the Production Request Editor using UNIX commands. The exercise begins with a student acting in the role of Production Planner recognizing the need to launch the Production Request Editor. The student launches the Production Request Editor as specified in the requirements.

Perform the following steps:
1. Access the command shell.
2. Log in to the Planning/Management Workstation.
3. Perform DCE login.
4. Set environmental variables if necessary.
5. Start the Production Request Editor GUI in the appropriate mode.

Creating a New Production Request
The exercise involves the preparation of a new production request. The exercise begins with a student acting in the role of Production Planner receiving the necessary information/requirements for creating a new production request. The student prepares a new production request that is consistent with the requirements.
Perform the following steps:

1. Access the Production Request Editor.
2. Select the PR Edit tab on the Production Request Editor GUI.
3. Prepare a new production request that is consistent with the written or stated requirements.
4. Save the new production request.

**Editing/Modifying a Production Request**

The exercise requires the editing of a production request. The exercise begins with a student acting in the role of Production Planner receiving the necessary information/requirements for editing an existing production request. The student modifies the production request consistent with the requirements.

Perform the following steps:

1. Access the Production Request Editor.
2. Select the PR Edit tab on the Production Request Editor GUI.
3. Select the Production Request to be modified.
4. Make production request modifications consistent with the written or stated requirements.
5. Save the modified production request.

**Deleting a Production Request**

The exercise involves deleting a production request. The exercise begins with a student acting in the role of Production Planner receiving the necessary information/requirements for deleting an existing production request. The student deletes the production request as specified in the requirements.

Perform the following steps:

1. Select the PR List tab on the Production Request Editor GUI.
2. Select the production request to be deleted from those listed.
3. Delete the production request.

**Reviewing Data Processing Requests**

The exercise involves reviewing data processing requests. The exercise begins with a student acting in the role of Production Planner being directed to review specific data processing requests to determine specified characteristics. The student reviews the data processing requests consistent with the requirements.
Perform the following steps:

1. Select the DPR List tab on the Production Request Editor GUI.
2. Select a Production Request from the list on the option button.
3. Select a DPR from the list displayed.
4. Open the DPR.
5. Respond without error to questions concerning the characteristics of the DPR.

Deleting a Data Processing Request

The exercise involves deleting a data processing request. The exercise begins with a student acting in the role of Production Planner being directed to delete a specific data processing request. The student deletes the data processing request as specified in the requirements.

Perform the following steps:

1. Select the DPR List tab on the Production Request Editor GUI.
2. Select the appropriate Production Request from the list on the option button.
3. Select the DPR to be deleted from the list displayed.
4. Delete the DPR.

Launching the Production Strategies GUI

The exercise involves launching the Production Strategies GUI using UNIX commands. The exercise begins with a student acting in the role of Production Planner recognizing the need to launch the Production Strategies GUI. The student launches the Production Strategies GUI as specified in the requirements.

Perform the following steps:

1. Access the command shell.
2. Log in to the Planning/Management Workstation.
3. Set environmental variables if necessary.
4. Start the Production Strategies GUI in the appropriate mode.

Launching Planning Workbench-Related GUIs

The exercise involves launching planning workbench-related GUIs using UNIX commands. The exercise begins with a student acting in the role of Production Planner recognizing the need to launch planning workbench-related GUIs. The student launches planning workbench-related GUIs as specified in the requirements.
Perform the following steps:

1. Access the command shell.
2. Log in to the Planning/Management Workstation.
3. Set environmental variables if necessary.
4. Start the Planning Workbench GUI and the Planning Master Timeline in the appropriate mode.

**Defining a Production Strategy**

The exercise involves the preparation of a production strategy. The exercise begins with a student acting in the role of Production Planner receiving the necessary information/requirements for creating a production strategy. The student prepares a production strategy that is consistent with the requirements.

Perform the following steps:

1. Select priorities for the values for PR Type, User Type, and PGE Type.
2. Type weights for the preceding three DPR attributes (as needed).
3. Type a weight in the Production Request Editor field.
4. Click on the Normalize button.
5. Type delta priority for Late Start Delta (if needed).
6. Save the Production Strategy.

**Creating a New Production Plan**

The exercise involves the preparation of a new production plan. The exercise begins with a student acting in the role of Production Planner receiving the necessary information/requirements for creating a new production plan. The student prepares a new production plan that is consistent with the requirements.

Perform the following steps:

1. Access the Planning Workbench.
2. Prepare a new production plan that is consistent with the written or stated requirements.
3. Save the new production plan.
4. Activate the plan (if specified in the requirements).

**Reviewing a Plan Timeline**

The exercise involves reviewing a production plan timeline. The exercise begins with a student acting in the role of Production Planner receiving the necessary information/requirements for
reviewing a production plan timeline. The student reviews the specified production plan timeline and responds to questions concerning timeline characteristics.

Perform the following steps:
1. Access the specified Production Planning Master Timeline.
2. Adjust the timeline display as necessary to view the specified production requests.
3. Review the specified Production Planning Master Timeline.
4. Respond without error to questions concerning the Production Planning Master Timeline.

Cleaning the PDPS Database

The exercise involves cleaning the PDPS database. The exercise begins with a student acting in the role of Production Planner receiving the necessary information/requirements for cleaning the PDPS database. The student takes action to clean the PDPS database in accordance with the requirements.

Perform the following steps:
1. Log in to the Planning/Management Workstation using secure shell.
2. Set the ECS_HOME environmental variable if necessary.
3. Start the EcPlDbClean script using the appropriate arguments.

Troubleshooting Production Planning Problems

The exercise involves troubleshooting production planning problems. The exercise begins with a student acting in the role of Production Planner receiving the necessary trouble symptom information and requirements for troubleshooting the problem(s). The student reviews the specified trouble symptoms, takes action to correct the problem(s), and responds to questions concerning the possible cause(s).

Perform the following steps:
1. Review the trouble symptoms.
2. Check the status of relevant hosts/servers as necessary.
3. Check log files as necessary.
4. Take action to correct the problem(s).
5. Respond without error to questions concerning the possible cause(s).

Launching the AutoSys GUI Control Panel

The exercise involves launching the AutoSys GUI Control Panel using UNIX commands. The exercise begins with a student acting in the role of Production Monitor recognizing the need to
launch the AutoSys GUI Control Panel. The student launches the AutoSys GUI Control Panel as specified in the requirements.

Perform the following steps:
1. Access the command shell.
2. Log-in to the Queuing Server host.
3. Set environmental variables if necessary.
4. Source the appropriate file.
5. Start the GUI for the appropriate instance of AutoSys.

**Configuring AutoSys Runtime Options**

The exercise involves the configuration of AutoSys runtime options. The exercise begins with a student acting in the role of Production Monitor receiving the necessary information/requirements for configuring AutoSys runtime options. The student configures AutoSys consistent with the requirements.

Perform the following steps:
1. Launch the AutoSys GUI Control Panel.
2. Access the AutoSys functions specified in the written or stated requirements.
3. Select the AutoSys runtime options specified in the written or stated requirements.
4. Apply the AutoSys runtime options specified in the written or stated requirements.

**Reviewing Hardware Status (Including Changing Hardware Status Views)**

The exercise involves reviewing hardware status (including changing hardware status views) using AutoSys. The exercise begins with a student acting in the role of Production Monitor receiving the necessary information/requirements for reviewing hardware status using AutoSys. The student reviews hardware status using AutoSys as specified in the requirements.

Perform the following steps:
1. Access HostScape.
2. Review hardware status as specified in the written or stated requirements.
3. Change hardware status views as specified in the written or stated requirements.
4. Exit from HostScape.
**Reviewing DPR Dependencies**

The exercise involves reviewing DPR dependencies. The exercise begins with a student acting in the role of Production Monitor receiving the necessary information/requirements for reviewing DPR dependencies. The student reviews DPR dependencies as specified in the requirements.

Perform the following steps:

1. Access JobScape.
2. Review DPR dependencies as specified in the written or stated requirements.
3. Exit from JobScape.

**Reviewing the DPR Production Timeline**

The exercise involves reviewing the DPR production timeline. The exercise begins with a student acting in the role of Production Monitor receiving the necessary information/requirements for reviewing the DPR production timeline. The student reviews the DPR production timeline as specified in the requirements.

Perform the following steps:

2. Review the DPR production timeline as specified in the written or stated requirements.
3. Exit from TimeScape.

**Reviewing Alarms (Including Selecting Alarms to Be Displayed)**

The exercise involves reviewing AutoSys alarms and selecting alarms to be displayed. The exercise begins with a student acting in the role of Production Monitor receiving the necessary information/requirements for selecting and reviewing AutoSys alarms. The student reviews and selects AutoSys alarms as specified in the requirements.

Perform the following steps:

1. Access the Alarm Manager through the Ops Console.
2. Review alarms and select alarm to be displayed as specified in the written or stated requirements.
3. Exit from the AutoSys Alarm Manager.

**Specifying Job Selection Criteria and Reviewing Job Activities**

The exercise involves specifying job selection criteria and reviewing job activities using AutoSys. The exercise begins with a student acting in the role of Production Monitor receiving the necessary information/requirements for specifying job selection criteria and reviewing job activities.
activities using AutoSys. The student specifies job selection criteria and reviews job activities using AutoSys as specified in the requirements.

Perform the following steps:
1. Access the AutoSys Job Activity Console.
2. Specify job selection criteria as specified in the written or stated requirements.
3. Review job activities as specified in the written or stated requirements.
4. Exit from the AutoSys Job Activity Console.

**Determining the Ownership of an AutoSys Job**

The exercise involves determining the ownership of an AutoSys job using the AutoSys Job Definition GUI. The exercise begins with a student acting in the role of Production Monitor receiving the necessary information/requirements for determining the ownership of an AutoSys job. The student determines the ownership of an AutoSys job as specified in the requirements.

Perform the following steps:
1. Access the pop-up menu from the relevant job on either the AutoXpert JobScape or TimeScape GUI.
2. Access the AutoSys Job Definition GUI from the pop-up menu.
3. Review the entry in the Owner field of the Job Definition GUI.
4. Exit from the Job Definition GUI.

**Modifying Job Status (Including Sending an Event to a Job) Using AutoSys**

The exercise involves modifying job status using AutoSys. The exercise begins with a student acting in the role of Production Monitor receiving the necessary information/requirements for modifying job status using AutoSys. The student modifies job status using AutoSys as specified in the requirements.

Perform the following steps:
1. Access the AutoSys Job Activity Console (Ops Console).
2. Specify job selection criteria for the AutoSys Job Activity Console.
3. Select the job with the status to be modified.
4. Click on the button corresponding to the desired action to be taken with respect to the selected job (if there is a corresponding button in the Actions region of the Job Activity Console).
5. If there is no button corresponding to the desired action, access the Send Event GUI by clicking on the Send Event button in the Actions Region of the Job Activity Console.
6. Make appropriate entries/selections on the Send Event GUI.
7. Send the event to the job from the Send Event GUI.

**Reviewing Activity Reports and Job Dependency Reports**

The exercise involves reviewing activity reports and job dependency reports. The exercise begins with a student acting in the role of Production Monitor receiving the necessary information/requirements for reviewing activity reports and job dependency reports. The student reviews an activity report and a job dependency report as specified in the requirements.

Perform the following steps:

1. Access the command shell.
2. Type the appropriate command for an activity report as specified in the requirements.
3. Review the activity report.
4. Type the appropriate command for a job dependency report as specified in the requirements.
5. Review the job dependency report.

**Defining and Running Monitors/Browsers**

The exercise involves defining and running monitors/browsers. The exercise begins with a student acting in the role of Production Monitor receiving the necessary information/requirements for defining and running monitors/browsers. The student defines and runs monitors/browsers as specified in the requirements.

Perform the following steps:

1. Access the Monitor/Browser GUI.
2. Define monitors/browsers as specified in the requirements.
3. Save the monitors/browsers.
4. Run the monitors/browsers.

**Reviewing the Database Maintenance Time**

The exercise involves reviewing the database maintenance time. The exercise begins with a student acting in the role of Production Monitor receiving the necessary information/requirements for reviewing the database maintenance time. The student reviews the database maintenance time as specified in the requirements.

Perform the following steps:

1. Access the command shell.
3. Review the database maintenance time.

**Troubleshooting Processing Problems**

The exercise involves troubleshooting production processing problems. The exercise begins with a student acting in the role of Production Monitor receiving the necessary trouble symptom information and requirements for troubleshooting the problem(s). The student reviews the specified trouble symptoms, takes action to correct the problem(s), and responds to questions concerning the possible cause(s).

Perform the following steps:
1. Review the trouble symptoms.
2. Check the status of relevant hosts/servers as necessary.
3. Check log files as necessary.
4. Take action to correct the problem(s).
5. Respond without error to questions concerning the possible cause(s).

**Launching the QA Monitor GUI**

The exercise involves launching the QA Monitor GUI using UNIX commands. The exercise begins with a student acting in the role of Production Monitor recognizing the need to launch the QA Monitor. The student launches the QA Monitor as specified in the requirements.

Perform the following steps:
1. Access the command shell.
2. Log in to the Planning/Management Workstation.
3. Set the necessary environmental variables.
4. Start the QA Monitor GUI in the appropriate mode.

**Updating Quality Assurance (QA) Metadata**

The exercise involves updating the QA metadata of a science product granule at the request of Science Computing Facility (SCF) personnel. The exercise begins with a student acting in the role of Production Monitor receiving the necessary information/requirements for performing a science product QA metadata update. The student performs science product QA metadata update as specified in the requirements.

Perform the following steps:
1. Set up and query the database using the QA Monitor GUI.
2. Select the granule with QA metadata to be updated.
3. Set the operational and SCF quality flags to the appropriate value (as specified in the requirements).

4. Verify that the flags have actually been set in the database.

**Regenerating Granules in Response to Loss of Files from the Archive**

The exercise involves regenerating granules in response to a loss of files from the archive. The exercise begins with a student acting in the role of Production Planner receiving the necessary information/requirements for regenerating granules. The student determines which granules to regenerate, creates the necessary Production Request(s), and creates and activates a Production Plan as specified in the requirements.

Perform the following steps:

1. Retrieve the Production History files (PH) for lost granules.

2. Create Production Requests for the generation of replacement granules.

3. Create and activate a Production Plan that includes the Production Requests for the generation of replacement granules.

4. Prepare (if applicable) a “PDPS Residual Granules List.”
This page intentionally left blank.
Slide Presentation

Slide Presentation Description
The following slide presentation represents the slides used by the instructor during the conduct of this lesson.